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General safety summary

General safety summary

Review the following safety precautions to avoid injury and prevent damage to this product or any
products connected to it.

To avoid potential hazards, use this product only as specified.
Only qualified personnel should perform service procedures.

While using this product, you may need to access other parts of alarger system. Read the safety sections
of the other component manuals for warnings and cautions related to operating the system.

To avoid fire or personal injury

Use proper power cord. Use only the power cord specified for this product and certified for the country
of use.

Connect and disconnect properly. Do not connect or disconnect probes or test leads while they are
connected to a voltage source.

Connect and disconnect properly. Connect the probe output to the measurement instrument before
connecting the probe to the circuit under test. Connect the probe reference lead to the circuit under test
before connecting the probe input. Disconnect the probe input and the probe reference lead from the circuit
under test before disconnecting the probe from the measurement instrument.

Observe all terminal ratings. To avoid fire or shock hazard, observe all ratings and markings on the product.
Consult the product manual for further ratings information before making connections to the product.

Do not operate without covers. Do not operate this product with covers or panels removed.

Do not operate with suspected failures. If you suspect that there is damage to this product, have it inspected
by qualified service personnel.

Avoid exposed circuitry. Do not touch exposed connections and components when power is present.
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Terms in this manual

These terms may appear in this manual:

c WARNING. Warning statements identify conditions or practices that could result in injury or loss of life.

CAUTION. Caution statements identify conditions or practices that could result in damage to this product
or other property.
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Introduction to the Application Welcome

Welcome

DPOJET is ajitter, timing, and eye analysis tool for Tektronix Performance Digital Oscilloscopes
(DPO/M SO5000, DPO7000, DSA/DPO/M SO70000 series). DPOJET enables you to achieve new levels
of productivity, efficiency, and measurement reliability on complex clock, digital, and serial data signals.

Some of the features of DPOJET are:

®  Advanced Jitter and Timing Analysis for clocks and data signals, with up to 99 simultaneous
measurements on 12 analog and 16 digital sources.

m  Jitter Guide/Serial Datawizard for easy configuration of popular measurement sets.

®m  One Touch Jitter wizard for quick jitter summaries.

m  Accuratejitter decomposition and TJ (BER) estimation using industry-accepted methods.
®  Comprehensive measurement statistics.

= Flexible measurement/statistic logging and export capabilities.

B Sophisticated graphical analysistools such as Histograms, Time Trends, Eye Diagrams, Spectrums,
Bathtub Plots and Real-Time Eye® diagrams with transition and non-transition bit separation.

m  Tektronix patented Programmable PLL software clock recovery.
B Standards-specific support for clock recovery and jitter separation methods.
m  Capture and storage of worst-case waveforms for subsequent analysis.

= Thorough remote programmability using oscilloscope-like syntax.

Free Trials

Refer to the Optional Applications Software on a Windows-Based Oscilloscope Installation Manual for
details on free trails which are available for all applications. The manual is available on the Optional
Applications Software on Windows-Based Oscilloscopes DV D, in the documents directory.

NOTE. Before evaluating an application, first check that your DSA/DPO/MSO series oscilloscope firmware
version is consistent with the version requirements mentioned in the application’s readme file. You can
check the firmware version number from the oscilloscope Help drop-down list (About TekScope). To check
the application's firmware compatibility, refer to the System Requirements section of the readme.txt file.

If an application is introduced after you receive your oscilloscope, you can download the application
as described in the installation manual (Tektronix part number 071-1888-X X) to obtain the free trial.
Download the manual's from www.tektronix.com/manual s and www.tektronix.com/software.
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Related Documentation

Related Documentation

Tektronix manuals are available at: www.tektronix.com/manuals and www.tektronix.com/software. Use

the following table to determine the document that you need:

Table 1: List of reference documents

For information on:

Refer to:

®  Operating the Oscilloscope

Oscilloscope user manual.
Oscilloscope user online help.

= Software warranty

B List of available applications

®  Compatible oscilloscopes

B Relevant software and firmware version numbers
E  Applying a new option key label

B |nstalling an application

®  Enabling an application

= Downloading updates from the Tektronix Web site

Optional Applications Software on Windows-Based
Oscilloscopes Installation Manual, which is provided on
the Optional Applications Software on Windows-Based
Oscilloscopes CD-ROM, in the Documents directory.
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Conven

Onli

You

to the Application Conventions

tions

ne Help uses the following conventions:

When steps require sequence of selections using the application interface, the “>" delimiter marks
each transition between a menu and an option. For example, Analyze > Wizard > One Touch Jitter.

The terms “DPOJET application” and “application” refer to DPOJET.
The term " oscilloscope” refersto any product on which this application runs.
The term “DUT” is an abbreviation for Device Under Test.

The term “select” is ageneric term that applies to the methods of choosing an option: with a mouse or
with the touch screen.

User interface screen graphics are taken from a DPO7000 series oscilloscope.

can find a PDF (portable document format) file for this document in the Documents directory on the

Optional Applications Software on Windows-Based Oscilloscopes DVD. The DVD booklet only contains
information on installing the application from the DV D and on how to apply anew label. You can also find
the PDF and the Online Help at Start > All Programs > TekApplications > DPOJET.

Tabl

Icon

e 2: Icon descriptions

Meaning

-

This icon identifies important information.

in loss of data.

,.-.. This icon identifies conditions or practices that could result

This icon identifies additional information that will help you
use the application more efficiently.

Technical Support

Tektronix welcomes your comments about products and services. Contact Tektronix through mail,
telephone, or the Web site. Click Contacting Tektronix ) for more information.

Tektronix aso welcomes your feedback. Click Customer feedback (see page 4) for suggestions for
providing feedback to Tektronix.

DPOJET Jit
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Customer Feedback

Tektronix values your feedback on our products. To help us serve you better, please send us your
suggestions, ideas, or other comments you may have regarding the application or oscilloscope.

Direct your feedback via email to
techsupport@tektronix.com
Or FAX at (503) 627-5695, and include the following information:

General Information

®m  QOscilloscope model number (for example, DPO/M SO5000, DPO7000, DSA/DPO/M SO70000 series)
and hardware options, if any.

= Software version number.

B Probes used.

Application-specific Information

m  Description of the problem such that technical support can duplicate the problem.

m |f possible, save the oscilloscope and application setup files as . set and associated . xml files.
® |f possible, save the waveform on which you are performing the measurement asa .wfm file.

Once you have gathered this information, contact technical support by phone or through e-mail. In the
subject field, please indicate “DPOJET Problem” and attach the .set, .xml and .wfm files to your
e-mail. If thereis any query related to the actual measurement results, then you can generate a.mht
report and send it.

The following items are important, but optional:

® Your name

= Your company

B Your mailing address

®  Your phone number

= Your FAX number

Enter your suggestion. Please be as specific as possible.

Pleaseindicate if you would like to be contacted by Tektronix regarding your suggestion or comments.

To include screen shots of the oscilloscope waveform and DPOJET user interface, from your oscilloscope
menu bar, click File > Save As> Screen Capture. To include screenshots of the DPOJET plots, select the
floppy-disk icon from the plots toolbar. In either case, enter afile namein the Save As dialog box, select
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an image file format (For example:.bmp or .png or .jpeg), choose a save location and select Save. You can
then attach the file(s) to your e-mail (depending on the capabilities of your e-mail editor).
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Getting Started Product Description

Product Description

DPOJET isajitter (see page 7), timing (see page 7), and eye diagram analysis (see page 7) tool for
Tektronix Performance Digital Oscilloscopes (DPO7000/C, DSA/DPO70000/B/C, DSA/DPO72504D,
DSA/DPQO73304D, MSO70000/C, DPO5000, and M SO5000 series). DPOJET enables you to achieve
new levels of productivity, efficiency, and measurement reliability on complex clock, digital, and serial
data signals.

The application provides the following features:

®  One Touch Jitter Summary.

®  Measurement Setup Wizard.

m  Auto-detection of signal type (clock or data), bit rate, and pattern length.

B RJDJdecomposition on repeating and arbitrary data patterns.

m Spectra plot with Normal, Averaging, and Peak Hold.

=  Eyediagrams with transition and non-transition bits separation.

®  High pass and low pass measurement filters.

m  Selectable PLL, linear and explicit clock edge detection and clock recovery methods.
B Automatic reference level autoset for eye diagrams, jitter and timing measurements.

B Preferences shortcut to set up options available at the Select panel.

Timing Analysis

Timing analysis is the measurement of period, setup, hold, skew, and other edge-to-edge data
timing relationships.

Eye Diagram Analysis

Eye diagram analysis is the plotting and measurement of eye diagrams and masks.

Jitter Analysis

Jitter Analysisis the measurement of Time Interval Error (TIE), advanced RJDJ decomposition, and
other clock to data edge relationships.
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DPOJET Option Levels

The DPOJET application offers two different levels of features, depending on how it is configured. The
configurations are determined by the following order codes:

m  DJE - Jitter and Eye Diagram Analysis Tools - Essentials
®  DJA - Jitter and Eye Diagram Analysis Tools - Advanced

NOTE. The application name “ Jitter and Eye Diagram Analysis Tools’ isthe same for DJE and DJA.
However, Help > About DPOJET indicates the configured option level. Save/Recall is compatible between
the option levels. If a setup file saved in DJA is recalled in DJE, only the capabilities available in DJE
will be recalled.

Jitter and Eye Diagram Analysis Tools - Essentials

Use Essentials for basic timing and jitter analysis. Essentials offers:

B Period, Frequency and Time Interval Error analysis.

B Timing parametrics such as rise/fall times, pulse width and duty cycle.

= Many graphical tools such as histograms, time trends, and spectrums.

®  Configurable HTML report generation.

= Logging features for recording individual measurements, statistics, or worst-case waveforms.
= Comprehensive remote control using oscilloscope-like GPIB syntax.

B A wizard interface to ease common setup tasks.

NOTE. Summary View and Overall Test Result are not available for DJE.

Jitter and Eye Diagram Analysis Tools-Advanced

The Advanced configuration offers all the features of Essentials, and adds the following:
m Jitter separation (RYDJ analysis).

= Eye measurements.

= Amplitude measurements.

= Measurement filters.

®m  Eyediagrams, bathtub plots or Mask Hits waveform plots.

m  Pasg/Fail limits capability.
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Getting Started Compatibility

NOTE. Option DJA isrequired for PCI Express Genl/Gen2/Gen3 measurements and for DDRA
measurements.

Compatibility

For information on oscilloscope compatibility, refer to the Optional Application Software on Microsoft
Windows Based Oscilloscopes Installation Manual, Tektronix part number 077-0067-XX. The manual is
available as a PDF file.

Requirements and Restrictions

DPOJET requires Matlab MCR (Matlab Compiler Runtime) 7.5 for 32-bit oscilloscopes and Matlab
MCR 8.0 for 64-bit oscilloscopes. The required MCR will automatically be installed, if not present,
by the TekScope firmware deployment package.

DPOJET requires .Net Framework v3.5 or higher for 32-bit oscilloscopes and .Net framework v4 or
higher for 64-bit oscilloscopes.

DPOJET Jitter and Eye Diagram Analysis Tools 9



Getting Started

Supported Probes

10

The application supports the following probes:

TAP1500
TAP2500
TAP3500
P5100
P6015
P6101A
PG139A
P6241
P6243
P6245
P6249
P6150
P6158
P7240
P7260
P7330
P7340A
P7350
P7350SMA
P7360A
P7380A
P7380SMA
P7313A
P7313SMA
All P75XX and P76XX probes

Supported Probes

DPOJET Jitter and Eye Diagram Analysis Tools
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Installing the Application

Refer to the Optional Applications Software on Windows-Based Oscill oscopes I nstallation Manual for the
following information:

m  Software warranty.

B List of available applications, compatible oscilloscopes, and relevant software and firmware version
numbers.

m  Applying a new option installation key label.

®  [nstalling an application.

= Enabling an application.

m  Downloading updates from the Tektronix Web site.

You can find a PDF (portable document format) file for this document in the Documents directory on the
Optional Applications Software on Windows-Based Oscilloscopes DVD. The DVD booklet contains
information on how to install the application from the DVD and on how to apply a new option installation
key label.

DPOJET Jitter and Eye Diagram Analysis Tools 1



Getting Started About DPOJET

About DPOJET

Click Help > About DPOJET to view application details such as the release software version number,
application name, and copyright.

EI Exprezz 3.0 61.1.4  Compatible with DPOJET @ True
PLl Express E1.1.4  Compatible with DPOJET : True

NOTE. The version displayed above isindicative only, the version number displayed will vary depending
upon the exact version of the application installed.
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Starting the Application

Starting the Application

On the oscilloscope menu bar, click Analyze > Jitter and Eye Analysis (DPOJET) > Select to open

the application.

Application Interface Menu Controls

Table 3: Application menu controls descriptions

Item Description

Tab Shortcut to a menu in the menu bar or a category of menu
options; most tabs are short cuts.

Area Visual frame with a set of related options.

Option button

Button that defines a particular command or task.

Field

A box to type in text, or to enter a value with the Keypad or
a Multipurpose knob.

Check Boxes

Use to select or clear preferences.

Scroll bar

Vertical or horizontal bar at the side or bottom of a display
area that can be used for moving around in that area.

Browse

Displays a window where to look through a list of directories
and files.

Command button

Button that initiates an immediate action such as Run
command button in the control panel.

Virtual Keypad icon

Click to use on-screen keypad to enter alphanumeric values.

MP knob references (a or b)

(b)
@

Identifiers that show which Multi Purpose Knob (MPK) may
be used as an alternate means to control a parameter;
turn the knob on the oscilloscope front panel to adjust the
corresponding parameter Also, the value can be entered
directly on the MPK display component.

DPOJET Jitter and Eye Diagram Analysis Tools
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Operating Basics Virtual Keypad

Virtual Keypad

Select the. icon and use the virtual keypad to enter alphanumeric values, such as reference voltage
levels.
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Tips on DPOJET User Interface

Here are some tips to help you with the application user interface:

Use the Serial DatalJitter Guide to rapidly set up and initiate sets of commonly used measurements.
After running the Serial Data/Jitter Guide, you may modify the configuration parameters to meet
specific needs.

Select a measurement to create a measurement and add it to the current measurement table. New
measurements initially use the same source as the earlier measurement, or the most recently used

source. Click b to change the measurement source or adjust other source parameters such as
the reference levels.

Select any measurement multiple times to create multiple copies. This may be useful if you wish to
run the same measurement with different configuration options.

Use the Single button E to obtain a single set of measurements from a single new waveform
acquisition. Pushing the button again before processing has completed will interrupt the processing
cycle.

Use the Run button G to conti nuously acquire and accumulate measurements. Push the button
again to interrupt the current acquisition.

Use the Recalc button ﬁ to perform measurements on the waveform currently displayed on the

oscilloscope, that is without performing a new acquisition. Thisis useful if you wish to modify a
configuration parameter and re-run the measurements on the current waveform.

Application Directories

The installation directory for DPOJET isC:\Program Files\TekApplications\DPOJET. During
installation, the application sets up directories for various functions such as to save setup files. Thefile
name extension is used to identify the file type.

Table 4: Application directories

Tips on DPOJET User Interface

Default directory Used for
C:\%USERPROFILE%\Tektronix\TekApplica- Exported plot files.
tions\DPOJET\Images
C:\Users\Public\Tektronix\TekApplica- Pass/fail limits files.
tions\DPOJET\Limits
C:\Users\Public\Tektronix\TekApplica- Bit patterns

tions\DPOJET\Patterns

DPOJET Jitter and Eye Diagram Analysis Tools
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Table 4: Application directories (cont.)

Default directory

File Name Extensions

Used for

C:\%USERPROFILE%\Tektronix\TekApplica-
tions\DPOJET\Logs'

Log files. Consists of three subfolders:
B Statistics for statistics log files (.csv)
= Measurements for measurement log files (.csv) and

m  Waveforms for worst case waveforms (.wfm)

C:\Users\Public\Tektronix\TekApplica-
tions\DPOJET\Masks

Mask files for various serial data standards. For Example -
PCIE, FBDIMM, SATA.

C:\%USERPROFILE%\Tektronix\TekApplica-
tions\DPOJET\Reports'

Report files (.mht ).

C:\%USERPROFILE%\Tektronix\TekApplica-
tions\DPOJET\Data'

Error log file, DPOJETErrors. log.

C:\Users\Public\Tektronix\TekApplica-
tions\DPOJET\Examples

Various tutorial and support files.

1 %USERPROFILE% represents your user location.

File Name Extensions

Table 5: File name extensions

File Extension Description

.Csv Ascii file containing Comma Separated Values. This file
format may be read by any ascii text editor (such as
Notepad) or may be imported into spreadsheets such as
Excel.

-xml Ascii file containing measurement setup information, limits
or other data in Extensible Markup Language.

-set Binary file containing oscilloscope setup information in a
proprietary format.

.mht An HTML archive file, compatible with common Windows
applications; and contain the full report, including text and
graphics.

-msk A user mask file.

-wfm Binary file containing an oscilloscope waveform record in a

recallable, proprietary format.

16
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Application Menu Shortcuts

Application Menu Shortcuts

The DPOJET application provides shortcuts for navigating the user interface. Use Alt+ A for the Analyze
menu and Alt+A+J for Jitter and Eye Analysis (DPOJET). Use Alt+A+E for PCl Express and Alt+A+U

for USB 3.0 Essentials.

NOTE. Alt+A+J is common for all submenus except the Help menu.

Table 6: Application shortcuts

Menu Items SubMenu Shortcut
Wizard One Touch Jitter Alt +A+J+]
Serial Data/Jitter Wizard Alt +A+J+W
Select Alt +A+J+S
Configure Alt +A+J+C
Results Alt +A+J+R
Plots Alt +A+J+P
Reports Alt +A+J+0
Export Data Snapshot Alt +A+J+E+D
Measurement Summary Alt +A+J+E+S
Data Logging Alt +A+J+L
Preferences Alt +A+J+F
Limits Alt +A+J+|
Global Configuration Alt +A+J+G
Measurement Summary Alt +A+J+M
Deskew Alt +A+J+K
Help
About DPOJET Alt +H+J
Help on Jitter and Eye Analysis Alt +H+T
Help on PCI Express MOI Alt+H+M
Help on USB 3.0 MOI Alt+H+U

DPOJET Jitter and Eye Diagram Analysis Tools
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Returning to the Application

When you access oscilloscope functions, the DPOJET control windows may be replaced by the
oscilloscope control windows or by the oscilloscope graticule. Access oscilloscope functions in the
following ways.

B From the menu bar on the oscilloscope, choose Analyze > Jitter and Eye Analysis (DPOJET) >
Select.

= Alternatively, switch between recently used control panels using the forward or backward arrowsﬂ on
the right corner of the control panel.

Saving a Setup

The DPOJET application state is automatically saved with the oscilloscope state. To save the oscilloscope
settings and application state, follow these steps:

1. Click File > Save As > Setup.
2. Inthefile browser, select the directory to save the setup file.

3. Select or enter afile name. The application appends *_DPOJET .xml to store DPOJET setup, and
*_set to store oscill oscope settings.

4, Click Save.

NOTE. After the oscilloscope application is started, DPOJET needs to be launched at least once before
any saved DPOJET configuration can be recalled.

Recalling a Saved Setup

18

To recall the default application setup and oscilloscope settings, do the following steps:
1. Click File> Recall.

2. Select the directory in the file browser to recall the setup file.

3. Select a -set file and click Recall.

NOTE. Only .set files can be selected for recall; any corresponding _DPOJET.xml file in the same directory
will be recalled as well, if DPOJET has been launched at |east once since the oscilloscope application
was started. If DPOJET has not been launched at least once, the oscilloscope settings will be recalled

but the DPOJET configuration will be ignored.
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Recalling the Default Setup

To recall the default application and oscilloscope settings, click File > Recall Default Setup.

Setting Up the Application for Analysis

In general, setting up the application for analysis consists of these steps.

1
2.
3.
4,

Selecting one or more measurements
Configuring parameters for the selected measurements
Configuring any global parameters

Adding plots to visual measurement results

Steps 2-4 are optional, and step 4 can be done either before or after measurement results have been
calculated. In addition to thismanual process, several wizard interfaces (One Touch Jitter, Serial DatalJitter
Guide) are available that can streamline the process.

Selecting measurements is accomplished by first selecting a measurement category (Period and
Frequency, Jitter, Time, Eye, Amplitude, or Standard-Specific Measurements) and then choosing specific
measurements. A measurement may be selected multiple times, for example to run on different waveform
sources or to run on the same waveform source with different parameters.

Refer to the following sections for more details on various measurements.

Period and Frequency measurements (see page 19)

Jitter measurements (see page 21)

Time measurements (see page 23)

Eye measurements (see page 25)

Amplitude measurements (see page 26)

Standard-Specific M easurements (see page 27)

Table of Measurements-Period/Freq

Definitions of the period and frequency-related measurements are given in the following table:
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Table 7: Period/Frequency measurements definitions

Measurement

Table of Measurements-Period/Freq

Description

Period

For clock signals, the elapsed time between consecutive
crossings of the mid reference voltage level in the direction
specified; one measurement is recorded per crossing pair.
For data signals, the elapsed time between consecutive
crossings of the mid reference voltage in opposite directions
divided by the estimated number of unit intervals for that
pair of crossings; one measurement is recorded per unit
interval so N consecutive bits of the same polarity result in
N identical period measurements.

Frequency

The inverse of the period for each cycle or unit interval.

CC-Period

The cycle-to-cycle period; the difference in period
measurements from one cycle to the next, that is the first
difference of the Period measurement.

N-Period

The duration of N periods.

Pos Width

Amount of time the waveform remains above the mid
reference voltage level.

Neg Width

Amount of time the waveform remains below the mid
reference voltage level.

+Duty Cycle

The ratio of positive width to period, expressed in %.

-Duty Cycle

The ratio of negative width to period, expressed in %.

+CC-Duty

The difference between two consecutive positive widths.

—CC-Duty

The difference between two consecutive negative widths.
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Table of Measurements-Jitter

By default, the application enables analysis of al jitter components except Non-Periodic Jitter (NPJ).
Thisis because NPJ (aform of Bounded Uncorrelated Jitter (BUJ) that isn't periodic) is less frequently
encountered and its analysis typically requireslonger waveforms, multiple waveforms, or both. The default
processing modeis called Spectral Only. To enable analysis of NPJ, you must set the processing mode to
Spectral + BUJ. Thisis done either from the Preferences-Jitter Decomp panel or from the Jitter Map.

Related Topics
m  Breakdown of Jitter (Jitter Map (see page 32)

m  Preferences Jitter Decomp (see page 73)

Definitions of the jitter-related measurements are given in the following table.

NOTE. Alljitter measurements except TIE are statistical measurements that require sufficient record length
so that all deterministic effects can be observed and the random jitter can be modeled.

Table 8: Jitter measurements definitions

Measurement Description

TIE Time Interval Error is the difference in time between an
edge in the source waveform and the corresponding edge in
a reference clock or explicitly by another source signal. The
reference clock is determined by a clock recovery process.

RJ Random Jitter is the statistics for all timing errors not
exhibiting deterministic behavior, based on the assumption
that they follow a Gaussian distribution. If the Jitter
Separation Model is set to Spectral + BUJ, the Gaussian
assumption is further validated and jitter appearing to be
non-Gaussian is excluded. Random Jitter is characterized
by its standard deviation.

RJ-36 Dual-Dirac Random Jitter is Random Jitter as defined
above, but calculated based on a simplified assumption that
the histogram of all deterministic jitter can modeled as a
pair of equal-magnitude Dirac functions (impulses known as
delta-functions).

DJ Deterministic Jitter is the statistics for all timing errors
that follow deterministic behavior. Deterministic Jitter is
characterized by its peak-to-peak value.

DJ-3d Dual-Dirac Random Jitter is Random Jitter as defined
above, but calculated on the same simplified model as
described under RJ-39.
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Table 8: Jitter measurements definitions (cont.)

Measurement

Table of Measurements-Jitter

Description

PJ

Periodic Jitter is the statistics for that portion of the
deterministic jitter which is periodic, but for which the period
is not correlated with any data in the waveform.

DDJ

Data-Dependent Jitter is the statistics for that portion of the
deterministic jitter directly correlated with the data pattern
in the waveform.

DCD

Duty Cycle Distortion is the statistics for that portion of the
deterministic jitter directly correlated with signal polarity, that
is the difference in the mean timing error on positive edges
versus that on negative edges.

TI@BER

Total Jitter at a specified Bit Error Rate (BER). This
combines the Random and Deterministic effects, and
predicts a peak-to-peak jitter that will only be exceeded with
a probability equal to the BER.

Jitter Summary

This is not an individual measurement but a convenience
function. Pressing this button automatically adds a set of
eleven jitter-related measurements with a single action. The
measurements are: TIE, RJ, RJ-60, DJ, DJ-00, PJ, SRJ,
DDJ, DCD, TI@BER, and Width@BER.

Phase Noise

The RMS magnitude for all integrated timing jitter falling
between two specified frequency limits. This measurement
is only applicable for clock signals.

NPJ#

Non-Period Jitter is the statistics for that portion of the
non-deterministic jitter that has a bounded distribution. It is
characterized by its dual-dirac amplitude (that is, the amount
by which its presence causes an additional separation of
the two Gaussian distributions in the dual-dirac model).

J2

Total Jitter at a Bit Error Rate (BER) value of 2.5E-3. This
statistical value predicts a peak-to-peak jitter that will only
be exceeded with a probability equal to the BER.

J9

Total Jitter at a Bit Error Rate (BER) value of 2.5E-10. This
statistical value predicts a peak-to-peak jitter that will only
be exceeded with a probability equal to the BER.

FIN

The peak-to-peak amplitude of periodic jitter occurring at

a rate that divides the data rate by an integer. (When a
deterministic jitter component could be interpreted either as
FIN or DDJ, it is treated as DDJ by convention.)

SRJ

Sub-Rate jitter is jitter at rates that integrally divide the data
rate. SRJ typically results when a data stream has been
created by multiplexing multiple lower-rate streams. SRJ
is a subcomponent of PJ, and can be further isolated into
FIN components.

¥ The NPJ measurement is only available when the Jitter Separation Model is set to Spectral + BUJ under DPOJET Preferences Setup.
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Table of Measurements-Time

Table of Measurements-Time

Definitions of the time-related measurements are given in the following table:

Table 9: Time measurements definitions

Measurement Description

Rise Time Elapsed time between the Low reference level crossing and
the High reference level crossing on the rising edge of the
waveform

Fall Time Elapsed time between the High reference level crossing
and the Low reference level crossing on the falling edge
of the waveform

High Time Amount of time the waveform remains above the high
reference voltage level

Low Time Amount of time the waveform remains below the low
reference voltage level

Setup Elapsed time between the designated edge of a data
waveform and that of a clock waveform, based on the
respective mid reference level crossings

Hold Elapsed time between the designated edge of a clock

waveform and that of a data waveform, based on the
respective mid reference level crossings

Rise Slew Rate

Rate of change of voltage between the two chosen
reference level crossings on the rising edges of the
waveform

Fall Slew Rate

Rate of change of voltage between the two chosen
reference level crossings on the falling edges of the
waveform

Skew

Time difference between two similar edges on two
waveforms assuming that every edge in one waveform has
a corresponding edge (either the same or opposite polarity)
in the other waveform; edge locations are determined by
the mid reference voltage level.

SSC Profile

SSC Profile is not intended to serve as a measurement. It
is a vehicle for showing the SSC modulation profile versus
time, using a time trend plot.

SSC Mod Rate

SSC Mod Rate computes the SSC modulating frequency.

SSC Freq Dev

SSC frequency deviation in ppm (parts per million),
measured at each inflection point in the modulation profile

SSC Freq Dev Min

The minimum frequency shift as a function of time

SSC Freq Dev Max

The maximum frequency shift as a function of time

DPOJET Jitter and Eye Diagram Analysis Tools
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Table 9: Time measurements definitions (cont.)

Measurement

Table of Measurements-Time

Description

Time Outside Level.

Time Outside Level Ring Back is defined as the time interval
of overshoot or undershoot.

tCMD-CMD #

tCMD-CMD iis a timing measurement and it measures the
elapsed time between two logic states on a specified digital
bus.

¥ This measurement is available only on 64-bit MSO instruments.
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Table of Measurements-Eye

Table of Measurements-Eye

Definitions of the eye-related measurements are given in the following table:

Table 10: Eye measurements definitions

Measurement

Description

Autofit Mask Hits

The number of unit intervals for which mask violations
occurred. A mask violation occurs when, during a unit
interval, the waveform passes through a segment of the
defined mask. Autofit mask hits are separately tailed for
Segment 1 (upper), Segment 2 (Center) and Segment 3
(lower) and the total for all three segments is also reported.
Autofit Mask Hits reports mask hits in terms of Pixel (not Ul)
and only the Segment 2 (Middle) is considered as criteria
for mask hits calculation and it will move the mask a location
where the minimum or zero hits are happening.

Height

The measured clear vertical eye opening at the center of
the unit interval. Height = High(min) — Low(max)

Height@BER

The eye height at a specified Bit Error Rate

Width

Measured clear horizontal eye opening at the middle
reference level.

Width = Ul(mean) — TIE(max) — TIE(min)

Width@BER

The horizontal eye opening projected to correspond to

a specified Bit Error Rate. This number is obtained by
measuring the jitter on the waveform, performing RJ/DJ
separation analysis, creating a bathtub curve, and reporting
the bathtub width at the appropriate error rate. This eye
width may not match the observed eye width because

it is a statistical measure. The measurement requires a
sufficient record length so that all deterministic effects can
be observed and the random jitter can be modeled.

Width(BER) = Ul(mean) — TJ(BER)

Mask Hits

The number of unit intervals for which mask violations
occurred. A mask violation occurs when, during a unit
interval, the waveform passes through a segment of the
defined mask. Mask hits are separately tallied for Segment
1 (upper), Segment 2 (center-of-eye mask) and Segment 3
(lower), and the total for all three segments is also reported.
Thus, as many as three hits can be added to the total count
for each unit interval. The population for this measurement
gives the total number of unit intervals observed.

Eye High

The voltage at a selected horizontal position across the unit
interval, for all High bits in the waveform.

DPOJET Jitter and Eye Diagram Analysis Tools
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Table 10: Eye measurements definitions (cont.)

Table of Measurements-Amplitude

Measurement Description

Eye Low The voltage at the selected horizontal position across the
unit interval, for all Low bits in the waveform.

Q-Factor Quality Factor is the ratio of vertical eye opening to rms

vertical noise.

Table of Measurements-Amplitude

Definitions of the amplitude-related measurements are given in the following table:

Table 11: Amplitude measurements definitions

Measurement

Description

High

Vertical value in the central portion of the unit interval (Ul)
for high data bits. The percent of the Ul over which the
waveform is evaluated is adjustable, as is the method

by which a single value is derived from this span. The
measurement may optionally be limited to transition or
non-transition bits only.

Low

Vertical value in the central portion of the unit interval (UI)
for low data bits, with configuration options matching those
of the High measurement.

High-Low

Difference between the mean value of the High
measurement and the mean value of the Low measurement.

DC Common Mode

Common-mode voltage for the two sources.

+
Memﬂ[ Sourcel d Source? ]

AC Common Mode

The common mode voltage between two single-ended
signals. AC is defined as all the frequency components
above the cutoff frequency (30 KHz).

T/nT-Ratio Ratio of the transition eye-voltage to the nearest subsequent
non-transition eye voltage, expressed in decibels.

V-Diff —Xovr Voltage level at the crossover voltage of a differential signal
pair.

Overshoot Difference between the positive-going peak amplitude and
the reference voltage level, for each waveform event that
exceeds the reference level.

Undershoot Difference between the negative-going peak amplitude

and the reference voltage level (expressed as a positive
number), for each waveform event that exceeds the
reference level.

26
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Table 11: Amplitude measurements definitions (cont.)

Measurement

Table of Measurements-Standard

Description

Cycle Pk-Pk

Difference between the maximum and minimum voltage for
each cycle, where a cycle is defined as a positive half-cycle
followed by a negative half-cycle or a negative half-cycle
followed by a positive half-cycle. Half-cycles are determined
by the mid reference level crossings.

Cycle Min

Defined as the peak negative voltage for each negative
half-cycle, where half-cycles are determined by the mid
reference level crossings.

Cycle Max

Defined as the peak positive voltage for each positive
half-cycle, where half-cycles are determined by the mid
reference level crossings.

Table of Measurements-Standard

Standard-specific measurements in the this category may include timing, jitter, amplitude or eye
measurements. Generally, they are measurements that have been modified to support a specific standard or
otherwise deviate from the generic measurements. Use the Standard drop-down list to view the DDR, PCI
Express and USB measurements. Use the Test Point Selection (see page 31) when available, to select the
setup file specific to the standard. Their measurement definitions are given in the following table:

Table 12: Standard-specific measurements definitions

Measurement

Description

DDR

DDR Setup-SE

Elapsed time between the designated edge of a data
waveform and that of a single-ended DQS waveform, based
on their respective DDR-specific reference level crossings.

DDR Setup-Diff

Elapsed time between the designated edge of a data
waveform and that of a differential DQS waveform, based
on their respective DDR-specific reference level crossings.

DDR Hold-SE

Elapsed time between the designated edge of a
single-ended DQS waveform and that of a data waveform,
based on their respective DDR-specific reference level
Crossings.

DDR Hold-Diff

Elapsed time between the designated edge of a differential
DQS waveform and that of a data waveform, based on their
respective DDR-specific reference level crossings.

DDR tCK(avg)

Calculated as the average clock period across a sliding
N-cycle window.

DDR tCL(avg)

Defined as the average low pulse width calculated across a
sliding N-cycle window.

DDR tCH(avg)

Defined as the average high pulse width and is calculated
across a sliding N-cycle window.

DPOJET Jitter and Eye Diagram Analysis Tools
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Measurement

Table of Measurements-Standard

Description

DDR tERR(n)

Defined as the cumulative error across multiple consecutive
cycles from tCK(avg).

DDR tERR(m-n)

Defined as the cumulative error across multiple consecutive
predefined cycles from tCK(avg).

DDR tJIT(duty) Defined as the cumulative set of the largest deviation of
any single tCH from tCH(avg) and the largest deviation of
any single tCL from tCL(avg).

DDR tJIT(per) Defined as the largest deviation of any single tCK from
tCK(avg).

DDR tRPRE Defined as the width of the READ preamble, from the exit of
tristate to the first rising edge on DQS.

DDR tWPRE Defined as the width of WRITE preamble, from the exit of
tristate to the first rising edge on DQS.

DDR tPST Defined as the width of the postamble, from the last falling

mid reference level crossing to the start of an undriven state
(as judged by a rising trend per JEDEC specs), for either a
Read or Write burst.

DDR Over Area

Defined as the area of a triangle for which the base is
defined by the crossings of the configured reference level
and the peak is the maximum voltage level attained between
those crossings.

DDR Under Area

Defined as the area of an inverted triangle for which the
base is defined by the crossings of the configured reference
level and the (downward pointing) peak is the minimum
voltage level attained between those crossings.

DDR VID(ac) Defined as the AC differential input voltage.

DDR tDQSS WRITE command to 1st DQS latching transition.

DDR3 Vix(ac) Defined as the differential input cross-point voltage relative
to VDD/2 for (CK/CK) or (DQS/DQS).

GDDRS5 tBurst-CMD # Defined as the elapsed time from the last data element of a
READ or WRITE burst to the Command.

GDDR5 tCKSRE # Defined as the time elapsed from the SRE command to
valid clock cycles.

GDDR5 tCKSRX ¥ Defined as the valid clock (CK) required before Self Refresh
exit (SRX).

DDR2 tDQSCK Defined as the elapsed time from the first rising DQS in a
burst to the nearest rising CK or CK#.

PCI Express

PCle T-Tx-Diff-PP

Defined as the change in voltage level across a transition
in the waveform. It is the peak-to-peak differential voltage
swing.

PCle T-TX

Defined as the measured clear horizontal eye opening at
the middle reference level.
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Measurement

Table of Measurements-Standard

Description

PCle T-Tx-Fall

Defined as the time difference between the VRefLo(20%)
reference level crossing and the VRefHi(80%) reference
level crossing on the falling edge of the waveform.

PCle Tmin-Pulse

Defined as the single pulse width measured from one
transition center to the next.

PCle DeEmph

Defined as the ratio of the transition eye-voltage to the
nearest subsequent non-transition eye voltage, expressed
in decibels.

PCle T-Tx-Rise

Defined as the time difference between the VRefHi(80%)
reference level crossing and the VRefLo(20%) reference
level crossing on the rising edge of the waveform.

PCle Ul

For clock signals, the elapsed time between consecutive
crossings of the mid reference voltage level in the direction
specified; one measurement is recorded per crossing pair.
For data signals, the elapsed time between consecutive
crossings of the mid reference voltage in opposite directions
divided by the estimated number of unit intervals for that
pair of crossings; one measurement is recorded per unit
interval so N consecutive bits of the same polarity result in
N identical period measurements.

PCle Med-Mx-Jitter

Defined as the maximum time between the jitter median and
the maximum deviation from the median.

PCle T-RF-Mismch

Defined as the mismatch between Rise time (TRise) and
Fall time (TFall).

PCle MAX-MIN Ratio t

Defined as the voltage range ratio over which a particular
receiver must operate for consecutive Ul.

PCle SSC FREQ DEV

Defined as the SSC frequency deviation in ppm (parts per
million).

PCle SSC PROFILE

Shows the modulation profile of the SSC.

PCle AC Common Mode

The common mode voltage between two single-ended
signals. AC is defined as all the frequency components
above the cutoff frequency (30 KHz).

T-TX-DDJ

Defined as the time delta between the PDF's mean for each
zero crossing point and the corresponding recovered clock
edge.

T-TX-UTJ

Referenced to a recovered data clock generated by means
of a CDR tracking function. Uncorrelated total jitter may be
derived after removing the DDJ component from each PDF
and combining the PDFs for all edges in the pattern.

T-TX-UDJDD

Defined as uncorrelated jitter at the zero crossing point and
the corresponding recovered clock edge.

T-TX-UPW-TJ

Defined as an edge-to-edge phenomenon on consecutive
edges.

T-TX-UPW-DJDD

Defined as uncorrelated PWJ at the zero crossing.
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Measurement Description

V-TX-NO-EQ Defined by setting c.; and c.; to zero and measuring the
p-p voltage on the 64-ones/64-zeroes segment of the
compliance pattern.

V-TX- EIEOS Defined by setting c., coefficient value of -0.33 and a ¢4
coefficient of 0.0 and measuring the p-p voltage on the
8-ones/8-zeroes segment of the compliance pattern, where
the pattern is repeated for a total of 128 UI.

ps21TX Measured by comparing the 64-zeroes/64- ones p-p voltage
(V111) against a 1010 pattern (V101).
V-TX-BOOST When ¢-1 and c+1 are non-zero, measure the PP voltage on

the 64-ones/64-zeroes segment of the compliance pattern
and with immediate single transition bit voltage.

USB 3.0 Essentials

USB VTx-Diff-PP Defined as the change in voltage level across a transition
in the waveform. It is the peak-to-peak differential voltage
swing.

USB TCdr-Slew-Max This measurement finds the peak-to-peak period jitter.

Period jitter can be obtained by taking the first difference of
the filtered phase jitter.

USB Tmin-Pulse-Tj Defined as the single pulse width measured from one
transition center to the next including all jitter sources.

USB Tmin-Pulse-Dj Defined as the minimum pulse width with only deterministic
jitter components.

USB SSC MOD RATE Defined as the SSC modulation rate in terms of Hz.

USB SSC FREQ DEV MAX Defined as the maximum frequency shift as a function of
time.

USB SSC FREQ DEV MIN Defined as the minimum frequency shift as a function of
time.

USB SSC PROFILE Shows the modulation profile of the SSC.

USB Ul For clock signals, defined as he elapsed time between

consecutive crossings of the mid reference voltage level in
the direction specified; one measurement is recorded per
crossing pair. For data signals, defined as the elapsed time
between consecutive crossings of the mid reference voltage
in opposite directions divided by the estimated number of
unit intervals for that pair of crossings; one measurement is
recorded per unit interval so that N consecutive bits of the
same polarity result in N identical period measurements.

USB AC Common Mode The common mode voltage between two single-ended
signals. AC is defined as all the frequency components
above the cutoff frequency (30 KHz).

T Custom name for PCle MAX-MIN Ratio is PCle VRX-MAX-MIN Ratio.
¥ This measurement is available only on 64-bit MSO instruments.
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Test Point Selection in the Standard Tab

Test Point Selection is available only for PCl Express, USB, and MIPI standards. You can either use the
Test Point “ Setup” button or File > Recall option to select the setup file for the selected standard.

The Test Point shows “None Selected” if no test point is specified. Click Setup to navigate to the directory,
which contains the setup files specific to the standard.

The setup file with oscilloscope settings and test measurements replaces any selected measurements and
oscilloscope settings before specifying the test point. A warning message is displayed as shown:

p

Do pou want bo conbitiue?

Once the test point is selected, the measurements associated with the test point are displayed in the
measurement table and the configuration specific to the standard is recalled. However, you can still add the
measurements specific to the standard. At any time, you can save the setup file to recall. The Test Point
field displays only the Test point name. A tool tip displays the entire file name as shown:

Jitter and Eye Diagram Analysis Tools Preferences ¥

“‘ Measurement | Source(s)
| PCle VT Diff PP i

Test Point R3I]7V-T)(-EIEOS-RS  Setup [ 4

Clear Selected

|C:‘\TEkADpl\EatiUﬂS\DPOJET‘\SEtUDS\PCIE\REV3.U\BGSE‘\R3U_\I'-T><-EIEOS-RS Jsek
T-TA-ODJ00 DI 3 &

aw @

Standard ;_F_E:I Express 3.0 d

V-TX-NO-EQ ps21TX

T-TX-UPW- Sl
VIXEEOS  TIXDDJ  TTXUTJ T4 ]
w Qo @ -

When you select PCl Express from the Standards list, a hint saying “This standard contains Genl and
Gen2 measurements’ as shown:
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Jitter and Eye Diagram Analysis Tools Preferences 7

Period | Standard: 'W ¥ I Measurement Source(s)
Froa EETT. | |
Test Point R30_BaseMeas RS @

oo i
Clear Selected

figuri
T-Tx-Diff-PP T-TX T-Tz-Fall  Tmin-Pulse Q Tl

“w @ W @B o

. DeEmph T-Tx-Rise =8
ampl ! -—

Breakdown of Jitter (Jitter Map)

The breakdown of jitter into components such as RJ, PJ and DDJ is model-based. This means that a
suitable mathematical model is proposed for the overall jitter, consisting of various jitter components.
The components are separable from each other based on observable characteristics, and the rules by
which these components combine to form an overall jitter distribution are based on well-understood
mathematical principles.

The jitter model used by DPOJET is hierarchical, and is represented by ajitter map. This map may

be displayed by clicking Select > Jitter, and then clicking the information icon (%) in the upper right
corner of the panel.

DPOJET actually offers two different jitter maps:

= When the Jitter Separation Method is set to * Spectral Only’ (which is the default), a simpler map that
doesn’t include NPJ and BUJ categoriesis used. This offers simpler and faster processing and gives
accurate results when crosstalk is not present (and often even when it is present).

= When the Jitter Separation Method is set to ‘ Spectral + BUJ' , the map shown below is used. This map
offers an additional model component, Non-Periodic Jitter or NPJ. Thisjitter model is more accurate
when certain types of crosstalk are present. The disadvantage of using this map is that more statistics
(that is, a higher population of unit intervals) must be acquired before results can be produced. This
may require longer record length, multiple acquisitions, or both.

By clicking the radio buttons in the upper left corner of the map window, you can switch between the
two jitter models. Once amodel has been selected, you can add jitter measurements by clicking directly
on the buttons embedded in the map, or dismiss the map and click on the conventional buttons in the
main control window.
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Random

MPJ is currently
supported only for
clock-like signals

Related Topics

B Separation of Non-Periodic Jitter (NPJ) (see page 327)

BuUJ

jounded
Uncomelated

One Touch Jitter

One Touch Jitter

of (F/2. Fl4

One Touch Jitter is a process for automatically performing complex jitter analysis with a single menu
selection. The process selects a waveform source, sets the horizontal and vertical scales, chooses
measurements, generates statistical results and creates plot summary (Histogram, Spectrum, Bathtub
and Eye Diagram). To run this process, select Analyze > Jitter and Eye Analysis (DPOJET) > One

Touch Jitter.

By default, the DPOJET application chooses an appropriate source for the jitter measurements from the
available active source(s) (amplitude >50 mV) before generating the jitter summary.

Jitter and Eye Diagram Analysis Tools

Measurements
Period/
Freq Period PasWidth  Neg Width

Time N-Period  +Duty Cycle —Duty Cycle

CC—Period  +CC-Duty
Ampl FrreaTn. Y e

= B Standard
|

DPOJET Jitter and Eye Diagram Analysis Tools

Freg

TIE1
Height1 e
TJ@BER1 ajcm
RJ-861 gen
DJ-6d1 Lajcnt

Width@BER1 ¥ chi
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34

NOTE. If the source amplitude is not greater than 50 mV, the application displays a message “ Signal
amplitude is extremely low for the selected source” .

The following logic is used if none or many sources are active:

®  None of the sources are active (see page 34)

m  Only one source is active (see page 34)

B Two sources are active (see page 34)

B Three sources are active (see page 35)

®  Four or more sources are active (see page 35)

Case 1: None of the sources are active

If none of the sources are active, you are prompted to select any one of the Ch, Ref or Math sources.
The selected source is vaidated to have amplitude >50 mV. When the amplitude of the selected source
is>50 mV, then autoset is performed to increase vertical and horizontal resolution of the signal. The
selected source is assigned for all single source jitter measurements. The results and plots are generated
for a single sequence.

Case 2: Only one source is active

The application checks if the active source has amplitude >50 mV. The selected source is assigned for al
single jitter measurements. The results and plots are generated for a single sequence.

Case 3: Two sources are active

The application checks whether the active sources are a differential pair. If so, it creates a Math waveform
by taking the difference of the two (Example: Math1=Ref1-Ref2). The lowest numbered Math waveform
is considered as the source for al single jitter measurements. The results and plots are generated for a
single sequence.

If the active sources are not a differential pair, the application checksif one of the source isaclock with a
period that divides the other sources. An explicit clock recovery method derives the clock from the clock
source. The application creates explicit-clock measurements TIE, Height, TJ@BER, RJ-66, DJ-66 and
Width@BER for the source. The results and plots are generated for a single sequence.

If one of the active sourcesis not a clock, the application selects a single source from the active sources
using the following priority:

= 1s- Lowest numbered Math
= 2nd- | owest numbered Channel
m  3rd- | owest numbered Ref

The results and plots are generated for a single sequence.

DPOJET Jitter and Eye Diagram Analysis Tools



Operating Basics One Touch Jitter

Case 4: Three sources are active

The application checks whether one of the active sources is a Math, which is defined as difference of two
sources (Example: Math1=Ref1-Ref2 ). The application selects the Math waveform as the source for all
single source jitter measurements. The results and plots are generated for a single sequence.

If one of the active sourcesis not a Math, the application selects a single source from the active sources
using the following priority:

m  1st-L owest numbered Math
m  2nd-| owest numbered Channel
m  3rd-| owest numbered Ref

The application creates single source jitter measurements. The results and plots are generated for asingle
sequence.

Case 5: Four or more sources are active

If four or more sources are active, the application selects a single source from the active sources using
the following priority:

m  1st-L owest numbered Math
= 2nd-| owest numbered Channel
m  3rd-L owest numbered Ref

The application creates single source jitter measurements for the selected source. The results and plots
are generated for a single sequence. The following figure shows the summary plot after One Touch
Jitter is performed.

! DPOUET Plats

EGHT
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About Serial DatalJitter Guide

36

About Serial Data/Jitter Guide

The Serial DatalJitter Guide allows you to set up, configure and run a measurement without intimate
knowledge about the control menus.

Select Analyze > Jitter and Eye Analysis (DPOJET) > Serial Data/Jitter Wizard to launch the Seria
Data/ Jitter Wizard.

The Serial Datal Jitter Wizard includes the following steps:

Select Measurement (see page 37)

Configure Measurement (see page 38)

Select Source(s) (see page 40)

Configure Autoset Options (see page 42)

Select Plots (see page 42)

NOTE. You can exit the Serial Data/Jitter Wizard without affecting any settings in the DPOJET application
by clicking Cancel anytime before clicking the Finish button.
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Select Measurement

In this step, you can select any of the listed measurements:

Which measurement would you like to make 7
{+ Period and Frequency

) Skew

{_ Time Interval Error (TIE)

@ Select Measurement

. ditter Summary
_ Total (TJ@BER)
- RJ, DJ, P, DD, TIE, DCD

o Eve Summary
- Height
- Width, Width@BER
- Unit Interval

= Period and Frequency
m  Skew
®  Time Interval Error (TIE)

m Jitter Summary includes Total Jitter (TJ@BER), RJ, DJ, PJ, DDJ, TIE, and DCD measurements and
plots

®  Eye Summary (see page 44) includes Height, Height@BER, Width, Width@BER, and Unit Interval
measurements and plots

By default, the Period and Frequency measurement is selected. Click Next to accept the measurement

and proceed to Configure Measurement. The transition to next step is represented by on the left
along with selections or default values.

DPOJET Jitter and Eye Diagram Analysis Tools 37



Operating Basics About Configuring M easurement

About Configuring Measurement

By default, the configuration parameters are displayed for Period and Frequency, TIE and Eye
measurements. The Configure Measurement option is available only for Skew and Jitter Summary. The

selection in the previous step is displayed on the left.

B Configure Skew Measurement (see page 38)

. Configure Jitter Summary Measurement (see page 39)

Configure Measurement-Skew

If you select Skew in the previous step, you can configure edges by selecting the From and To edges and
set the measurement limits.

Click Next to select the measurement sources.

‘Select Edges
From Edge: To Edge:

i @ Configure Measurement [+ Rise () Same as From
(| Fall {_ Opposite as From

_Both

Meas Range Limits

Max Value Min Value
10ns | -10ns

Related Topics
B Configure Edges for Skew Measurement (see page 157)
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Configure Measurement-Jitter Summary

If you select Jitter Summary measurement in the previous step, the bit rate and pattern length will
automatically be determined by DPOJET, thus the Configure Measurement section is not required.

NOTE. The measurements that you select also determine the plot types.

Click Next to select the measurement sources.

() Time Interval Error (TIE)

~Total (TJ@BER)
~RJ, DJ, PJ,DDJ, TIE, DCD

Related Topics
B RJDJAnaysis Parameters (see page 229)

B RJDJ (see page 149)

DPOJET Jitter and Eye Diagram Analysis Tools
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Select Sources

In this step, you can select the measurement source(s). The source selection depends on the measurement
type. By default, Sourcel is displayed automatically for all the measurements depending on the waveform
last used. If Chl/Refl/Mathl is displayed for Sourcel, Source2 is Ch2/Ref2/Math2 else Chl/Mathl/Refl

will be selected as Source2.

Serial Dataitter Wizare—~_
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The Source2 option is displayed only for two source measurements such as Skew.

Serial Dataitter Wi;__ax L~

\

Click Next to configure autoset.
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Configure Autoset Options

In this step, you can choose to automatically adjust the oscilloscope settings or the reference levels before
the measurement. The default of Yesis recommended. By selecting No, you will retain the current
oscilloscope settings and/or ref levels.

Click Next to select plots.

Would you like the horizontal and vertical
settings optimized based on the signal?

[+ Yes (Recommended)

| ) No, please retain the current settings

Would you like the reference levels
automatically chosen hased on the signal?

9:-¥ésifﬁecummndedi<

O N!_J',-‘plBaSB ret.ain the current ref levels

Select Plots

42

In this step, you can select the plots that you want to display. The measurements that you selected earlier
also determine which plot types will be available in this step. The following table lists the available
plots for measurements:

Table 13: Measurements and available plots

Measurement Plots

Period and Frequency Period Trend, Period Spectrum, Period Histogram.
Skew Skew Trend, Skew Spectrum.

TIE TIE Trend, TIE Spectrum, TIE Histogram.
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Table 13: Measurements and available plots (cont.)

Measurement Plots

Jitter Summary TIE Trend, TIE Spectrum, TIE Histogram, and Bathtub
Curve.

Eye Summary (see page 44) Eye Diagram (Transition Bit), Eye Diagram (Non Transition

Bit) Unit Interval Histogram, and Eye Width@BER.

In this example, the selections shown are for a Period and Frequency measurement.

Serial Dataitter Wizaret—~

What plots would you like to see 7
|+ Time Trend [Period]

|+ Histogram [Perioa)
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Click Finish to start the acquisition sequence using the selected settings. The Serial DatalJitter Guide
window closes and the results screen is displayed.

-} [DPOJET Plots Q@@
CEIEEEY LYl = - N ek

Period1: Time Trend Y. Time Period1: Spectrum v Hif Period1: Histogram ¥ Time

Ak X =k
[+ Freq1, Ch1 20.831MHz  30.101kHz  20921MHz 20.758MHz 162.85kHz 260 130.48kHz  -140.99kHz

NOTE. None of the user specified settings are retained if you click Cancel before clicking Finish.

Configuring for SSC (Spread Spectrum Clocking). Spread Spectrum Clocking involves modulating the
clock frequency of a device and high-speed serial signalsin a controlled manner. The purpose of using

SSC modulation is to spread the spectral energy to mitigate interference due to unintentional RF radiation.
The typica modulating frequency is 33.3 KHz.

The Seria Datawizard will configure DPOJET appropriately to see an open eye diagram for asignal with
SSC, by using PLL clock recovery to track the modulation. If your goal isto analyze the SSC modulation
profile versus time, a different configuration isrequired. You can use the SSC-related measurements (SSC
Profile, SSC Mod Rate, SSC Freq Dev, etc) to configure DPOJET appropriately for those purposes.

About Jitter and Eye Diagram Analysis Options

Click Analyze > Jitter and Eye Analysis (DPOJET) to view the following options:
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m  Export Data Snapshot (see page 48)

m  Export Measurement Summary (see page 52)

m DataLogging (see page 52)

m_ Preferences (see page 68)

= Limits (see page 76)

B Globa Configuration (see page 112)

B Measurement Summary (see page 64)

B Deskew (see page 45)

Deskew

To ensure accurate results for two-channel measurements and differential signals acquired on two channels,
it isimportant to first deskew the probes and oscilloscope channels before you take measurements
of your DUT (see page 45).

The application includes an automated deskew utility that you can use to deskew any pair of oscilloscope
channels.

NOTE. To produce the best deskew results, you should connect the probes to the fastest slew rate signals
from your DUT.

Connecting to a Device Under Test (DUT)

You can use any compatible probes or cable interface to connect between your DUT and oscill oscope.

c WARNING. To avoid electric shock, remove power from the DUT before attaching probes. Do not touch
exposed conductors except with the properly rated probe tips. Refer to the probe manual for proper
use. Failure to do so may cause injury or death.

Refer to the General Safety Summary in your oscilloscope manual.

Deskewing on Oscilloscopes with Bandwidth Extension

Some Tektronix oscilloscopes feature software-based bandwidth extension. The bandwidth extension
may be enabled on a per-channel basis.

Enabling or disabling bandwidth extension on any channel affects the skew on that channel. Thus, you
should deskew probes and channels after you make such configuration changes. Bandwidth Extension
provides improved timing accuracy, phase matching, and amplitude accuracy. It also will provide noise
reduction. Bandwidth extension should be used at all times.
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Steps to Deskew Probes and Channels

To deskew praobes and oscill oscope channels, follow these steps:

1. Refer to Connecting to a Device Under Test before starting the procedure.
2. Connect both probes to the fastest signal in your DUT.

Set up the oscilloscope as follows:

1. UsetheHorizontal Scale knob to set the oscilloscope to an acquisition rate so that thereis at least two,
preferably five, samples per edge or more samples on the deskew edge.

2. Usethe Vertical Scale and Position knobs to adjust the signals to fill the display without missing
any part of the signals.

3. Set the Record Length so that there are more than 100 edges in the acquisition.
4. Launch the DPOJET application.
5. Click Analyze > Jitter and Eye Analysis (DPOJET) > Deskew.

6. Set the Reference channel source to Chl. The source waveform is the reference point used to deskew
the remaining channels.

7. Set the Channel to be Deskewed source as Ch2.

8. To start the process, click Perform Deskew.

9. Repeat steps 7 and 8 for other Ch waveforms.

10. Select Summary (see page 47) to view the deskew values.
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Deskew Summary

The Deskew Summary dialog lists the channel source and its deskew values.
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Export Data Snapshot-Statistics
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Export Data Snapshot-Statistics

You can save a snapshot of the current statistics in .csv format. The default location is
C:\%USERPROFILE%\Tektronix\TekApplications\DPOJET\Logs\Statistics, where
%USERPROFILE% represents your user location.

Click Analyze > Jitter and Eye Analysis (DPOJET) > Export > Data Snapshot > Statisticsto view the

following:

Statistics
Measurement

1 [ TIE1

|v] Height1

|¥|] TJ@BER1
v RJ-G61

|v] DJ-681

[¥] Width@BER1

File Mame

IC:\Users\johnh\Teldmnn(\Tekﬂpplications\D POJETLogs"Stat i
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Table 14: Data Snapshot- Statistics options

Item

Export Data Snapshot-M easurement

Description

Select Target Measurements

Displays the measurement list. Click a row to select the
measurement. By default, all measurements are selected.

Select All

Selects all the measurements in the list for saving statistics.

Clear All

Deselects all the measurements from the list.

Save Statistics

Save

Saves the current statistics of selected target measurements
to a log file.

File Name

Browse

Allows you to choose the name and location where

the .csv file will be saved. The default name is
YYMMDD_HHMMSS_Stats.csv. The default directory
is C:\%USERPROFILE%\Tektronix\TekAppli-
cations\DPOJET\Logs, where %USERPROFILE%
represents your user location.

Close

Accepts the changes and closes the window.

NOTE. The default location for saving log files can be changed in the Preferences dialog box.

Related Topics

m  Export Data Snapshot-M easurement (see page 49)

Export Data Snapshot-Measurement

You can save a snapshot of the data points in .csv format. The default location is
C:\%USERPROFILE%\Tektronix\TekApplications\DPOJET\Logs\Measurements, where

%USERPROFILE% represents your user |ocation.

DPOJET Jitter and Eye Diagram Analysis Tools
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Export Data Snapshot-M easurement

Click Analyze > Jitter and Eye Analysis (DPOJET) > Export > Data Snapshot > M easurement

to view the following:

Select Target Measurements

Tl Measurement Source(s)

Measurement
|»] Height1 Ch1
[v] TJ@BER1 ch1
|w] RJ-GE1

|w] DJ-B51

[v] width@BER1

Folder

Table 15: Data Snapshot- Measurement options

Item

IC:\Users\johnh\Teldmnix\Tek:N)plicahons\D POJET Logs'Mez G

Description

Select Target Measurements

Displays the measurement list. Click a row to select the
measurement. By default, all measurements are selected.

Select All

Selects all the measurements in the list for saving statistics.

Clear All

Deselects all the measurements from the list.

Save Measurements

Save Saves the data points for current acquisition of selected
target measurements in a log file.

Folder

Browse Allows you to choose the location where the .csv files
will be saved. The default directory is C:\%USERPRO-
FILE%\Tektronix\TekApplications\DPO-
JET\Logs\Measurements, where %USERPROFILE%
represents your user location.

File Names

View Displays View Log File Names (see page 55)
dialog box which lists the measurements and
their source(s) with corresponding log file
name in YYMMDD_HHMMSS_<Measurement
Name>-<SourceName>. csv format.

Close Accepts the changes and closes the window.
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View Log File Names

The View Log File Names dialog box lists the measurements and their source(s) with corresponding
log file name in YYMMDD_HHMMSS_<Measurement Name>-<SourceName>.csv format. Click Close
to close the dialog box.

070903_130245_Pos Width1-Ch1.csv
070903_130245_Neg Width1-Ch1.csv

Related Topics
m  Export Data Snapshot (see page 48)
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Export Measurement Summary

Export Measurement Summary

Click Analyze > Jitter and Eye Analysis (DPOJET) > Export > Measurement Summary to save
the generated report in C:\%USERPROF ILE%\Tektronix\TekApplications\DPOJET\Reports,
where %USERPROFILE% represents your user location. The exported measurement summary contains
information only about application setup and configuration.

Save As

=

B

iy Recent
Documents

~

Dezktop

7,

My Documents

tdy Computer
“

dy Metwork,
Places

gL |

@3

Save in: | i) Reportz

=l £ BB
File: narne: I-.-1E.3:5:F:E ot b j Save |
Save a3 bype: |Report fles [*.mht) =] Cancel

Data Logging-Statistics

52

The application can continuously log (saveto file) the calculated statistics. You can save the statisticsto a
“comma separated value” (.csv) file to import into a text editor, a spreadsheet, or an analysis tool.

By default, all measurements are selected. You can select individual measurements by selecting the

row in the table on the left.

The steps for logging statistics are:

1. Click Analyze > Jitter and Eye Analysis (DPOJET) > Data L ogging > Statistics to view the
Logging Statistics screen.
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Statistics Log Statistics

Measurement @ G

Worst Case

Data Log File

Data L ogging-Statistics

Select Target Measurements

Measurement Source(s)
TIE1 Ch1
|v] Height1
v TJ@BER1
|v] RJ-GB1
|v] DJ-B51
[¥] width@BER1

IC.\Users\juhnh\Tek‘lmnix\Tek.N)p\icaiions\D POJETLogs"Stat G

2. Select the measurements that you want to log in the Select Target M easurements table on the left.
Click Select All to select all the measurements for logging or click Clear All to deselect the current

measurements list.

3. Click On/Off to enable/disable automatic logging statistics for all selected measurements.

4. Click Browse to select a directory.

The default directory is C:\%USERPROFILE%\Tektronix\TekApplications\DPO-
JET\Logs\Statistics, where %USERPROFILE% represents your user location.

Table 16: Log-Statistics options

Item

Description

Select Target Measurements

Displays the measurement list. Select the check box to
select the measurement. By default, all measurements are
selected.

Select All Selects all the measurements in the list.

Clear All Deselects all the measurements in the list.

Log Statistics

Off Disables automatic logging for all selected measurements.
On Enables automatic logging for all selected measurements.
Data Log File

Browse Allows you to choose the name and location where

the .csv file will be saved. The default name is YYM-
MDD_HHMMSS_Stats.csv. The default directory is
C:\%USERPROFILE%\Tektronix\TekAppli-
cations\DPOJET\Logs\Statistics, where
%USERPROFILE% represents your user location.
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NOTE. Microsoft Excel has a limitation where you cannot increase the number of rows (65,536) or
columns (256) beyond the maximum row and column limits. Opening log files in Wordpad or another
analysis package is recommended. An error message “ File not loaded completely” is displayed, if you try
to open a log file with data exceeding the aforesaid row and column limits.

Related Topics
m Data Logging-Measurement (see page 54)

B Data Logging-Worst Case (see page 59)

Data Logging-Measurement

You can log the actual individual measurement data values as measurement files.

1. Click Analyze > Jitter and Eye Analysis (DPOJET) > Data L ogging > M easurement to view the
Logging screen.

Data Logging

Select Target Measurements

L Log Measurements
Statistics Measurement Source(s)

Measurement e G = chl
|»] Height1 Ch1
Worst Case [v] TJ@BER1 ch1
[v] RJ-661 ch1
|»] DJ-851 Ch1
[»] Width@BER1 Ch1

Folder
IC:\Users\lohnh\Tektronn(\Tekﬁppllcatlons\D POJET Logs"Mez G é

2. Select the measurements that you want to log in the Select Target M easurements table on the left.
Click Select All to select all the measurements for logging or click Clear All to deselect the current
measurements list.

3. Click On/Off to enable/disable logging for all selected measurements.
4. Click Browse to select a directory.

The default directory is C:\%USERPROFILE%\Tektronix\TekApplications\DPO-
JET\Logs\Measurements, where %USERPROFILE% represents your user |ocation.
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Table 17: Log-Measurements options

Item

Data L ogging-M easurement

Description

Select Target Measurements

Displays the measurement list. Select the check box to
select the measurement. By default, all measurements are
selected.

Select Al Selects all the measurements in the list.

Clear All Deselects all the measurements from the list.

Log Measurements

Off Disables automatic logging for all selected measurements.

On Enables automatic logging for all selected measurements.

Folder

Browse Allows you to choose the name and location where
the .csv file will be saved. The default directory is
C:\%USERPROFILE%\Tektronix\TekAppli-
cations\DPOJET\Logs\Measurements, where
%USERPROFILE% represents your user location.

File Names

View Displays View Log File Names (see page 55) dialog box

which lists the selected measurements with source(s)
and their corresponding log file names in <Measurement-
Name>_<SourceName>_ YYMMDD_HHMMSS.csv format.

View Log File Names

The View Log File Names dialog box lists the selected measurements with source(s) and their
corresponding log file names in <M easurementName>_<SourceName> YYMMDD_HHMMSS.csv
format. A tool tip is displayed as shown on hovering the mouse over the text. Click Close to close the

dialog box.
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View Log File Names

Widthi@BER1 ) Width@BER1_DQ_100601_170718.csv

[width@BER1_DG_100601_170718.c5v]

The application displays a hint at the bottom of the screen under the following conditions:

= Qualifier turned on for measurementsin Global > Qualify with searches specified.
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®BER1_DQS,DQ_100506_141031.csv
Setup1_DOS,DO_100506_141031.csv

B Any sources other than search types are specified. Example Math instead of Searchl.

fBER1_Min_Ch2{DQ).wfm
Width@BER1 Da,Mathd Width@BER1_Min_Math4.wfm
WidthifBER1 DQ,Math4 Widthd@BER1_Max_Ch2{DQ).wim
Width@BER1 Da,Mathd Width@BER1_Max_Math4.wim
Setup1 DQS,DAMa... Setup1_Min_Ch1{DAOS).wfm
Setup1 DAS,DOMa... Setup1_Min_ChZ2{DQ).wfm

Setup1 DAS,DO,Ma... Setup1_Min_Mathd.wifm
Setup1 DQS,DOMa... Setup1_Max_Ch1{DAOS).wfm
Setup1 DAS,DO,Ma... Setup1_Max_Ch2({D3).wfm
Setup1 DQS,DAMa... Setup1_Max_Mathd. wfm
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Related Topics
B Data Logging-Statistics (see page 52)

m Data Logging-Worst Case (see page 59)
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Data Logging-Worst Case

Data L ogging-Worst Case

1. Click Analyze > Jitter and Eye Analysis (DPOJET) > Data L ogging > Wor st Case to view the

Worst Case Logging screen.

Select Target Measurements

Log Waorst Case Waveforms

SRR Measurement

Measurement E G TIE1

|¥] Height1
Worst Case [v] TJ@BER1
[v] RI-G51

[v] DJ-551

[v] Width@BER1

Source(s)
Ch1
Ch1
Ch1
Ch1
Ch1
Ch1

Folder

2. Select the measurements which you want to log

IC:\Users\johnh\Tek‘tmnix\Tek:N)pIications\DF‘OJI:—I'\Logs\Wa' G é

in the Select Target Measurements table on the

left. Click Select All to select all the measurements for logging or click Clear All to deselect the

current measurements list.

3. Click On/Off to enable/disable worst case logging for all selected measurements.

4. Click Browse to select a directory.

The default directory is C:\%USERPROFILE%\Tektronix\TekApplications\DPO-
JET\Logs\Waveforms, where %USERPROFILE% represents your user location.

Table 18: Log-Worst case options

Item

Description

Select Target Measurements

Displays the measurement list. Select the check box to
select the measurement. By default, all measurements are
selected.

Select All Selects all the measurements in the list.

Clear All Deselects all the measurements in the list.

Log Worst Case Waveforms

Off Disables the application to save worst case waveforms for
all selected measurements.

On Enables the application to save worst case waveforms for

all selected measurements.
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Data L ogging-Worst Case

Table 18: Log-Worst case options (cont.)

Item Description

Folder

Browse Allows you to choose the name and location where
the .csv file will be saved. The default directory is
C:\%USERPROFILE%\Tektronix\TekAppli-
cations\DPOJET\Logs\Waveforms, where
%USERPROFILE% represents your user location.

File Names

View Displays View Log File Names (see page 60) dialog

box which lists the selected measurements with source
(labels) and their corresponding log file names in <Mea-
surementName>_Min_<Source(label)>_wfm
and <MeasurementName>_Max_<Source(la-
bel)>_wfmT format.

T For example, if the selected measurement is Skewl with Ch1 and Ch2 as sources, then the file names will be Skew1_Min_Ch1(DQS).wfm,
Skew1_Min_Ch2(DQ).wfm, Skewl Max_Ch1(DQS).wfm, and Skewl_Max_Ch2(DQ).wfm.

View Log File Names

The View Log File Names dialog box lists the selected measurements with source(s) and their
corresponding log file names in <MeasurementName>_Min_<Source(label)>.wfm and
<MeasurementName>_Max_<Source(label)>.wfm format. Click Close to close the dialog box.

View Log File Names

| Measurement
WidthiftBER1

.' Width@BER1

| Setupt

Setup1

| Setup1

Setupi

60

Sources '

DAS,DO
DAS,DO
DAS,DO
DAS,DO

WidthfBER1_Min_Ch2{DO).wfm
Width@BER1_Max_Ch2({DQ).wfm
Setup1_Min_Ch1{DAS).wfm
Setup1_Min_Ch2{DQ).wfm
Setup1_Max_Ch1{DOS).wim
Setup1_Max_Chz{DQ).wfim
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Data L ogging-Worst Case

The application displays a hint at the bottom of the screen under the following conditions:

B Quadlifier turned on for measurements in Global > Qualify with searches specified.

View Log File Names

Width@BER1
l Widthi@BER1
Setup1
Setup1
Setup1
Setup1

DQS.DO
DQS.DO
DQS.DO
DQS.DO

il
Width@BER1_Min_Ch2{DQ).wim
Width@BER1_Max_Ch2({DQ).wfm
Setup1_Min_Ch1{DOS).wim
Setup1_Min_Ch2{DQ).wfm
Setup1_Max_Ch1{DOS).wim
Setup1_Max_Ch2{DQ).wim

B Any sources other than search types are specified. Example Math instead of Searchl.
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i
Measurement
Width@BER1
Width@BER1

. Width@BER1

| Width@BER1
Setup1

.- Setup1

Setup1
Setup1
] Setup1
Setup1

View Log File Names

' Sources *

DG, Math4
DQ,Mathd
DQ,Math4
DQ,Math4

DQS,DO,Ma...
DQS.DO.Ma...
DQS,DO,Ma...
DQS.DO.Ma...
DQS,DO,Ma...
DQS.DO.Ma...

Data L ogging-Worst Case

Widthi@BER1_Min_Ch2{DQ).wim
Width@BER1_Min_Mathd.wfm
Width@BER1_Max_Ch2{DQ).wfm
Width@BER1_Max_Mathd.wim
Setup1_Min_Ch1{DOS).wfm
Setup1_Min_Ch2{DO).wfm
Setup1_Min_Mathd.wim
Setup1_Max_Ch1(DOS).wfm
Setup1_Max_Ch2{DQ).wim
Setup1_Max_Mathd.wifm

Logging Worst Case for Mask Hits Measurement

The DPOJET application supports worst case logging for the Mask Hits measurement. Whenever Mask
Hitsis selected, there are two waveforms corresponding to maximum and minimum values for each
of the segment as shown in the following figure:
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View Log File Names

Mask Hits1
Mask Hits1
Mask Hits1
Mask Hits1
Mask Hits1
Mask Hits1

Mask Hits1_Seg1_Min_RefJ.wim
Mask Hits1_Seg1_Max_Ref3.wim
Mask Hits1_Seg?_Min_RefJ.wfm
Mask Hits1_Seg2_Max_Ref3.wim
Mask Hits1_Seqg3_Min_Ref3.wfim
Mask Hits1_Segd_Max_Ref3.wfm

Data L ogging-Worst Case

When an additional clock source (Clock Recovery > Explicit Clock Edge) isincluded for the Mask Hits
measurement, there are two waveforms corresponding to maximum and minimum values for each of

the source as shown:
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View Log File Names

Measurement

Mask Hits1
Mask Hits1
Mask Hits1
Mask Hits1
Mask Hits1
Mask Hits1
Mask Hits1
Mask Hits1
Mask Hits1
Mask Hits1
Mask Hits1

Sources *

Ref2,Ref3

Measurement Configuration Summary-M easurement

Mask Hits1_Seq1_Min_RefZ wim
Mask Hits1_Seg1_Min_Ref3.wim
Mask Hits1_Seq1_Max_Refz.wim
Mask Hits1_Seg1_Max_Ref3.wfm
Mask Hits1_Seg2_Min_Ref2 wfm
Mask Hits1_Seq?_Min_RefJ wim
Mask Hits1_Seg2_Max_RefZ2.wfm
Mask Hits1_Seq?_ Max_Refi.wim
Mask Hits1_Seg3_Min_RefZ2.wim
Mask Hits1_Seq3d_Min_RefJ wim
Mask Hits1_Seq3_Max_Ref2.wim
Mask Hits1_Seg3_Max_Ref3.wfm

NOTE. All waveforms are displayed in the reports when worst case logging is enabled. Worst case
waveform logging is now supported for all search types. For more details on the search types, refer to

your oscilloscope online help.

Related Topics

m Data Logging-Statistics (see page 52)

= Data Logging-Measurement (see page 54)

Measurement Configuration Summary-Measurement

Click Analyze > Jitter and Eye Analysis (DPOJET) > M easurement Configuration Summary >
M easurement to view measurement, source and the configuration parameters of each measurement.

64
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_Measurement Configuration Summary

Measurement

Ref Levels

ementRanqe Limits: Oﬁ Max: 1ns, Min: -1ns, Custom Source
Name: —

Bit Config == Bit Type: All Bits | Clock Recovery == Method: Constant
Clock —Mean, Auto Calc: Every Acg, Mominal Data Rate: Auto, Bit Rate:
2.5Gb!s, Known Data Pattern: Off, Pattern Filename:
CiUsers\PubliciTektronix\Tekapplications\DPOJET\Patterns\PRBS 127 bt
| General == Measurement Range Limits: Off, Max: 500mV, Min: 50mV,
Custom Source Name: —

Height1

Edges == Signal Type: AUTO, Clock Edge: Rising | Clock Recovery ==
Method: Constant Clock — Mean, Auto Calc: Every Acq, Mominal Data
Rate: Auto, Bit Rate: 2.5Gb/s, Known Data Pattern: Off, Pattern Filename:

C\Users\F‘ubIlc\TemronuﬂTeka I|cat|0ns\DF'0JET\F'atlems\F‘RElS127b(l
TJ@BER1 e e et et V]

Table 19: Measurement configuration information

Item Description

Measurement Displays the measurement name.

Source Displays the selected source.

Others Displays the other configuration information related to the
selected measurement.

OK Closes the window.

Related Topics

m  Measurement Summary-Ref Levels (see page 65)

m Measurement Summary-Misc (see page 67)

Measurement Summary-Ref Levels

Click Analyze > Jitter and Eye Analysis (DPOJET) > M easurement Configuration Summary > Ref
Levelsto view the ref level tab. Thistab providesinformation about ref level configuration per source.
Displays the reference voltage levels for the high, mid, and low thresholds for the rising edge and for the
falling edge of each active source, and the hysteresis.

DPOJET Jitter and Eye Diagram Analysis Tools 65



Operating Basics

66

Measurement Configuration Summary

Measurement Summary-Ref Levels

Measurement .
Auto((Min-Max))

Ref Levels

Fall High  Fall Mid Fall Low
233.61mv

Table 20: Ref level configuration information

Item Description

Source Displays the selected source.

Rise High Displays the high threshold level for the rising edge of the
source.

Rise Mid Displays the middle threshold level for the rising edge of
the source.

Rise Low Displays the low threshold level for the rising edge of the
source.

Hysteresis Displays the threshold margin to the reference level which
the voltage must cross to be recognized as changing; the
margin is the relative reference level plus or minus the
hysteresis; use to filter out spurious events.

Fall High Displays the high threshold level for the falling edge of the
source.

Fall Mid Displays the middle threshold level for the falling edge of
the source.

Fall Low Displays the low threshold level for the falling edge of the
source.

OK Closes the window.

Related Topics

= Measurement Configuration Summary-M easurement (see page 64)

m  Measurement Summary-Misc (see page 67)
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Measurement Summary-Misc

Click Analyze > Jitter and Eye Analysis (DPOJET) > M easurement Configuration Summary > Misc
tab to view various configuration parameters. The Miscellaneous tab shows whether the Gating, Qualify,
and Stat Pop Limit functions are enabled; if enabled, it also shows the source for qualification, the size for
population, and various other configuration choices.

'Measurement Configuration Summary

Me t
ot OFf, Limit By: Acquistions, Stop Condition: Each
Measurement
Ref Levels
Source

Size

Table 21: Miscellaneous configuration information

Item Description

State Displays On when Gating, Qualify and Population are
enabled and Off when they are disabled.

Source Displays the selected source for qualify.

Size Specifies the maximum population that can be obtained for
each active measurement.

OK Closes the window.

Related Topics

B Measurement Configuration Summary-M easurement (see page 64)

B Measurement Summary-Ref Levels (see page 65)
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About Preferences Setup

The application provides Preferences Setup, where you can set options that apply globally within DPOJET.
These options remain unchanged until you reset them. Click Analyze > Jitter and Eye Analysis
(DPOJET) > Preferencesto view the Preferences screen. Optionally, click the preferences shortcut that
is available in the select panel of DPOJET and its modules such as DDR, PCIE, and USB. To use the
application more efficiently, you can set the options in the following tabs:

m Preferences-General (see page 69)

®  Preferences-Measurement (see page 70)

m Preferences-Path Defaults (see page 75)
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Preferences-General

Click Analyze > Jitter and Eye Analysis (DPOJET) > Preferences > General to view the following:

General Display Units n

Measurement

Default Image Type n

Jitter Decomp

Path Defaults
Motifier Duration

Table 22: Preferences-General options

Item Description

View Log Displays the error/warning log file in a Notepad window
when the button is pushed.

Clear Log Clears the error/warning log file when the button is pushed.

Display Units Selects the display units for time measurements, between
seconds or Unit Intervals.

Default Image Type Selects the default image format (JPEG, PNG or BMP) that

will be used by those functions that save images.

Notifier Duration Determines how long the warning notifier will remain on
the screen before disappearing. (The notifier may also be
dismissed manually).

Cancel Discards all changes and closes the Preferences window.
OK Accepts all changes and closes Preferences window.
Related Topics

B Preferences-Measurement (see page 70)

m  Preferences-Path Defaults (see page 75)
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Preferences-Measurement

Click Analyze > Jitter and Eye Analysis (DPOJET) > Preferences > Measurement to view the
following:

General
= |_ Limit Rise/Fall measurements to transition bits only

Measurement Enable high-performance eye rendering

Jitter Decomp |_ Halt free-run on a limit failure for any measurement

Path Defaults ‘Waveform Interpolation Type

The Measurement tab allows you to limit Rise and Fall measurements to transition bits only, or allow these
measurements for all bits. Here, the transition bits refer to edge transitions for which the preceding
transition was only one unit interval away. This may be important for signals with pre-emphasis, since
the transition following a string of two or more like bits has an intentionally low swing that you may

not want to measure.
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Preferences-M easurement

Use thistab to enable or disable high-performance eye rendering. This provides atrade-off between greater
fidelity or greater rendering speed. You can aso select the waveform interpolation type.

Table 23: Preferences-Measurement options

Item Description
Limit Rise/Fall measurements to transition bits When selected, determines whether Rise Time and Fall Time
only measurements are performed on all bits or only on transition bits.

Enable high-performance eye rendering

Determines whether eye diagrams are optimized for speed or fidelity.
When disabled, all unit intervals (Ul) in the waveform(s) are included in
the rendered eye. This gives the highest fidelity eye rendering, but can
take a considerable amount of time for long records. When this option
is enabled, a statistically representative subset of the Ul is rendered,
so that eye diagrams for long waveforms can be displayed in a shorter
time. The rules for high-performance rendering are as follows:

m [f the waveform contains 15,000 or fewer Ul, all the Uls in the
waveform are rendered.

m  |f the waveform includes more than 15,000 Ul it is subdivided into
segments of 2000 Ul each. The entire waveform is scanned to find
the specific Ul, that are the worst-case violators for six different
points around the eye. For each of these worst case violators, the
entire segment of 2000 Ul in which it lies is rendered. Depending
on whether multiple worst-case violators lie in the same segment or
not, as few as 2000 Ul but typically from 8000 to 12,000 Ul will be
rendered in the final eye.

Uls: Current number of Uls used to render eye diagram: Total number
of Uls in the current acquisition

Total: Total number of Uls used to render the eye diagram (when doing
multiple acquisitions): Total number of Uls in the total population (when
doing multiple acquisitions.

If high performance rendering is off:

UlsX=UlsY

Population X = Population Y

If high performance rendering is on:

UlsX<UlsY
Population X < Population Y

Halt free-run on a limit failure for any
measurement

If any of the selected measurement fails a limit test in free run,
sequencing is stopped.

Waveform Interpolation Type

Select the type of interpolation that is used between sample points,

to determine the exact time when a waveform crosses a reference
voltage level. Linear interpolation is faster but introduces distortion that
raises the jitter noise floor slightly. Sin(x)/x Interpolation, also known
as Sinc Interpolation, approaches theoretically perfect waveform
reconstruction but is computationally expensive.

NOTE. For Eye-High, Eye-Low, and Eye-Height measurements,
Sin(x)/x interpolation is always used for eye measurements
independent of the chosen interpolation type.

Cancel

Discards the changes and closes the window.

OK

Accepts the changes and closes the window.
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Related Topics

B Preferences-General (see page 69)

m Preferences-Jitter Decomp (see page 73)

m Preferences-Path Defaults (see page 75)
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Preferences-Jitter Decomp

Click Analyze > Jitter and Eye Analysis (DPOJET) > Preferences > Jitter Decomp to view the
following:

General Dual Dirac Model |PCI/FB-DIMM n
Measurement Jitter Separation Model |Spectral + BUJ n

Jitter Decomnp Minimum # of Ul for BUJ Analysis 1M

Path Defaults

The Jitter Decomp tab allows you to select the Dual Dirac model and the Jitter Separation model, and to
select the minimum number of unit intervals required for BUJ analysis.
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Table 24: Preferences-Jitter Decomp options

Item Description

Dual Dirac Model Determines which parameter-extraction method is used when RJ/DJ
separation is done under the Dual-Dirac model. This affects results for
the RJ-30 and DJ-0d measurements only. When Fibre Channel is
selected, RJ and DJ parameters are extracted according to guidelines
given in ANSI/INCITS Technical Report TR-35-2004 “Methodologies
for Jitter and Signal Quality Specification”. RJ and DJ values are
selected that cause an exact match between the bathtub curves from
the dual-dirac and the full analytical models at two prescribed BER
levels. When PCI/FB-DIMM is selected, RJ and DJ parameters are
determined using the methodology defined in the PCI Express Gen 2
and Fully-Buffered DIMM specifications. In this technique, the bathtub
curves are plotted on a Q-scale that linearizes the tails of the bathtub,
and the RJ and DJ values are derived from where the asymptotes to
the curves intersect the BER=0 line.

Jitter Separation Model Selects the type of jitter separation, Spectral Only or Spectral + BUJ.
Spectral Only identifies almost all categories of jitter, including Bounded
Uncorrelated Jitter (BUJ) that is periodic (PJ). However, it cannot
separate bounded random jitter from Gaussian random jitter. Spectral+
BUJ includes additional processing to identify bounded random jitter
(also called Non-Periodic Jitter or NPJ). NPJ is typically caused by
crosstalk from a signal on a different clock domain, and generally
requires a higher population of measurements for proper detection.

Minimum # of Ul for BUJ Analysis Determines the number of unit intervals (Ul) that must be processed
before jitter separation is performed. This item is only used for Spectral
+ BUJ processing, and is not shown if the Jitter Separation Model is
Spectral Only. A higher number of Ul will allow the separation algorithm
to detect lower levels of NPJ, but will typically require longer record
length, more acquisitions, or both. A lower number of Ul will allow
processing to occur on smaller populations of Ul, but may only identify
stronger forms of NPJ. Also, note that the number of Ul processed
for BUJ analysis is only 17% to 33% of the total Ul acquired in each

waveform.
Cancel Discards the changes and closes the window.
oK Accepts the changes and closes the window.

Related Topics

m  Preferences-General (see page 69)

m Preferences-Measurement (see page 70)

m Preferences-Path Defaults (see page 75)
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Preferences-Path defaults

Click Analyze > Jitter and Eye Analysis (DPOJET) > Preferences > Path Defaultsto view the
following:

Defaultimage export directory
IC:\Users\johnh\Teldmnix\Tekﬁpplications\DF‘OJ!:—I'\Images G

General

Measurement
Default logging export directory

Jitter Decomp IC:\Users\johnh\Teldmnix\Tek:N)plications\DF‘OJI:—I'\Logs G

Path Defaults Default report output directory
IC.\Users\johnh\Tek‘Imnix\Tek.N)plicaﬁons\DF‘OJI:—I'\Heporls G

The Path Defaults allows you to set the path for images, reports and log files. Click Browse to modify the
default directory path.

Table 25: Preferences-Path defaults options

Item Description

Default image export directory Selects the directory to which images will be saved, unless
overridden at the time of the export.

Default logging export directory Selects the directory to which logs will be saved, unless
overridden at the time of the export.

Default report export directory Selects the directory to which reports will be saved, unless
overridden at the time of the export.

Cancel Discards the changes and closes the window.

OK Accepts the changes and closes the window.

Related Topics

m  Preferences-Genera (see page 69)

m  Preferences-Measurement (see page 70)

®  Preferences-Jitter Decomp (see page 73)
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Limits

76

A Limitsfile allows you to specify the Pass/Fail threshold for measurements. Each DPOJET-based serial
data application typically provides limits files that include combinations of relevant measurements and
statistical characteristics, and an appropriate range of values for each combination.

The DPOJET application provides an example limitsfile, called Example_Limits.xml, that is annotated to
explain some of the methods of assigning limits. You can create additional limits files by copying the
example and modifying it appropriately. You can specify limits for any of the result parameters such as
Mean, Std Dev, Max, Min, peak-to-peak, population, MaxPosDelta or MinPosDelta. For each of these
result parameters, you can specify Upper Limit (UL), Lower Limit (LL), or Both. The measurement names
in the limits file must be entered as mentioned in

Setting Up the Application for Analysis (see page 19).

To include Pass/Fail statusin the result statistics, you can create a limits file using an XML editor or any
other editor in the following format. If the fileis created in any other editor such as notepad, it should
be saved in Unicode format.

<?xml version="1.0" encoding=""utf-16" ?>
<Main>

<Measurement>
<NAME>Per i od</NAME>

<STATS>
<STATS_NAME>Mean</STATS_NAME>
<LIMIT>UL</LIMIT>

<UL>1</UL>

<LL>0</LL>

</STATS>

<STATS>
<STATS_NAME>StdDev</STATS_NAME>
<LIMIT>LL</LIMIT>

<UL>1121</UL>

<LL>0121</LL>

</STATS>

<STATS>
<STATS_NAME>Max</STATS_NAME>
<LIMIT>BOTH</LIMIT>

<UL>1</UL>

<LL>0</LL>

</STATS>

<STATS>

<STATS_ NAME>Min</STATS_NAME>
<LIMIT>UL</LIMIT>

<UL>0</UL>

<LL>1</LL>

</STATS>

<STATS>
<STATS_NAME>PeakToPeak</STATS_NAME>
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<LIMIT>UL</LIMIT>

<UL>1</UL>

<LL>1</LL>

</STATS>

<STATS>
<STATS_NAME>MaxPosDelta</STATS_NAME>
<LIMIT>UL</LIMIT>

<UL>1121</UL>

<LL>1121</LL>

</STATS>

<STATS>
<STATS_NAME>MinNegDelta</STATS_NAME>
<LIMIT>UL</LIMIT>

<UL>0</UL>

<LL>0</LL>

</STATS>

<STATS>
<STATS_NAME>Population</STATS_NAME>
<LIMIT>UL</LIMIT>

<UL>0</UL>

<LL>0</LL>

</STATS>

</Measurement>

</Main>

)

C:\TekApplications\DPQJET \Limits

Table 26: Limits options

Item Description

Pass/Fail Test

Off/On Enables (On) or Disables (Off) the display of limit information
in results. Select On to choose a limits file for the selected
measurement.

Limits File

Browse To select an existing limits file or locate the directory.

Close Accepts the changes and closes the window.
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Limits for Mask Hits

Limits are available for Mask Hits. The applications displays the following in the results panel when limits
are turned on (Analyze > Jitter and Eye Anaysis (DPOJET) > Limits):

Jitter and Eye Diagram Analysis Tools

ilﬁlsm Segment 2
| Hits In Segment 3

| High Limit
| Hits In Segment 1
ilﬁlsm Segment 2

About Taking a New Measurement

If you want to change the trigger settings or localize the measurements, you should do so before you
take any measurements.

NOTE. When you run any measurement, Sampling mode in the oscilloscope should be set to “ Real Time” .
If it is set to Equivalent Time, DPOJET will force it to Real Time when you sequence measurements.

Interpolated Real Time is not preferred, and will reduce effective record length without providing any
benefit.

Selecting a Measurement

To take a measurement, click Analyze > Jitter And Eye Analysis > Select.

78 DPOJET Jitter and Eye Diagram Analysis Tools



Operating Basics

Selecting a Measurement

Alternatively, click Analyze > [application name] to personalize DPOJET for a specific standard. For
example, to take a PCl Express measurement, click Analyze > PCI Express and for USB 3.0 Essentials
measurement, click Analyze > USB 3.0 Essentials.

Jitter and Eye Diagram Analysis Tools

{ Measurements
Period/

A0 Period PosWidth  Neg Width

Time N-Period  +Duty Cycle —Duty Cycle

i
CC—Period  +CCDuty —CC-Duty

Ampl

Standard |

Freg

Preferences ¥

| Measurement Source(s)

NOTE. A shortcut to Preferencesis provided to set various application settings.

The application provides you different methods to set up the application:

Wizard (see page 80)

M easurement Setup sequence (see page 80)

The measurement categories are Period/Freq, Jitter, Time, Eye, Amplitude, and Standard as shown in the

following table:

Table 27: Measurement selections

Category Measurements

Period/Freq Period Pos Width Neg Width Freq
N-Period +Duty Cycle —Duty Cycle
CC—Period +CC-Duty -CC-Duty

Jitter TIE RJ RJ-00 Jitter Summary
TJ@BER DJ DJ-88
PJ DDJ DCD Phase Noise
J2 J9 SRj FIN

Time Rise Time Fall Time Skew * SSC Profile
High Time Low Time Setup SSC Mod Rate
Rise Slew Rate Fall Slew Rate Hold " SSC Freq Dev
SSC Freq Dev Min SSC Freq Dev Max Time Outside Level tCMD-CMD #§

Eye Width Width@BER Q-Factor Mask Hits
Height Height@BER High Low
AutoFit Mask Hits
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Table 27: Measurement selections (cont.)

Selecting a Measurement

Category Measurements
Ampl High DC Common Mode* Overshoot Cycle Min
Low T/nT-Ratio Undershoot Cycle Max
High-Low V-Diff —Xovr * Cycle Pk-Pk AC Common Mode *
Standard DDR
DDR Setup-SE* DDR Hold-Diff* DDR tCK(avg) DDR tJIT(duty)
DDR Setup-Diff* DDR tCL(avg) DDR tERR(n) DDR tJIT(per)
DDR Hold-SE* DDR t CH(avg) DDR tERR(m-n) DDR tRPRE
DDR tWPRE DDR tPST DDR Over Area DDR Under Area
DDR tDQSS"#§ DDR VID(ac) DDR2 tDQSCK DDR3 Vix(ac)
GDDR5 tCKSRE #§ GDDR5 tCKSRX #§ GDDR5 tBurst-
CMD#8§
PCI Express
PCle T-Tx-Diff-PP PCle T-TX PCle T-Tx-Fall PCle Tmin-Pulse
PCle DeEmph PCle T-Tx-Rise PCle Ul MAX-MIN Ratio
PCle Med-Mx-Jitter PCle T-RF-Mismch PCle SSC FREQ PCle SSC PROFILE
PCle AC Common
Mode *
USB 3.0 Essentials
VTx-Diff-PP Tmin-Pulse-Tj USB Tmin-Pulse-Dj USB SSC MOD
RATE

TCdr-Slew-Max

USB SSC FREQ
DEV-MAX

USB SSC FREQ
DEV MIN

USB SSC PROFILE

USB Ul

USB AC Common
Mode *

Two Source Measurements.

T To run a slew rate measurement, you need a waveform with minimum record length of 5 MB.

¥ Bus source is required.

§  This measurement is available only on 64-bit MSO instruments.

Wizard

The Serial Data/ Jitter Guide allows you to set up, configure, and run the selected set of measurements
without requiring any knowledge of the control menus. However, it does not provide access to
many of the advanced features.

Measurement Setup Sequence

The Measurement Setup Sequence buttons in the left navigation panel shows the logical order you
would follow to set up the application if you do not use the Wizard.
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Warning Log Notifiers

Warning Log Notifiers display error messages or warnings. Warnings ( _'.‘l ) or Error ( 9) messages are
also shown in the results tab. You can click View Log to view the error log information in a text editor.
Click OK to discard the displayed error message.

® Error

You can set the duration for which the warning notification should appear on the screen in the Preferences
(see page 68) dialog box or click OK to discard the warning information.

NOTE. The error or warning log is saved as DPOJETErrors.log in C: \%USERPROFILE%\ Tek-
tronix\TekApplications\DPOJET subfolder, where %USERPROFILEY represents your user
location.
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Navigation Panel

The Navigation Panel appears on the left of the application window. It consists of the following tabs:
Select, Configure, Results, Plots and Reports.

Table 28: Navigation panel functions

Tab Description

Select Displays the various measurements available for selection.
By default, this tab is highlighted. You can click any
measurement categorized with Period/Freq, Jitter, Time,
Eye and Amplitude tabs.

Configure Displays the configuration for the selected measurement.
Results Displays the result for the selected measurement.
Plots Displays the result as a two-dimensional plot for additional

measurement analysis. You can select and configure plots
for selected measurements.

Reports Displays the configuration for generating reports in .mht
format. Allows you to select results, plots and details.

Control Panel

The Control Panel appears on the right of the application window. Using this panel, you can start or stop the
sequence of processes for the application and the oscilloscope to acquire information from the waveform.
The controls are Clear, Recalc, Single and Run. The following table describes each of these controls:
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Table 29: Control panel selections

Control Pandl

Item Description

Clear Clears the current result display and resets any statistical
results and autoset ref levels.

Recalc Runs the selected measurements on the current acquisition.

Single Initiates a new acquisition and runs the selected
measurements.

Run Initiates a new acquisition and runs the selected
measurements repeatedly until Stop is clicked. Used only
for live sources.

Show Plots Displays the plot summary window when clicked. This
button appears in the control panel only when a plot is
selected.

DDR Analysis Shortcut to access the DDRA application from DPOJET.

Appears in the control panel only when DDRA is opened
using Analyze > DDR Analysis.

The control panel with Show Plots is as shown:
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Sources Setup

The application takes measurements from waveforms specified as input sources. You can select an
oscilloscope channel input (live), areference or amath waveform as the source and also view labels of the
selected waveforms. Some measurements require a bus as a source. Bus as a Source (see page 85)

You can configure sources using any of the following options:

m  Click icon in the table which lists the selected measurements.
= Double-click anywhere on arow in the table that lists the selected measurements.

The source selections depend on the selected measurement.

NOTE. Setup, Hold, V-DIff—Xovr, DC Common Mode and Skew are two source measurements. The
Source2 option is displayed only for two source measurements.

When more than one single source measurement is selected, Apply to all single source measurements
option is enabled in the source configuration screen.
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When more than one two source measurement is selected, Apply to all two source measurements
option is enabled in the source configuration screen.

NOTE. Although any DPOJET measurement can be assigned a custom name (Example: tDQSH), the
custom name is not displayed in the DPOJET source configuration screen. Instead, the default name
for the corresponding measurement is displayed.

Related Topics
B Source Autoset (see page 93)

m  Ref Levels (see page 96)

E_Bus as a Source

Bus as a Source

On M SO model oscilloscopes only, some measurements (tCMD-CMD, GDDRS5 tCKSRE, GDDR5
tCKSRX, and GDDRS5 tBurst-CMD ) require abus as a source. Set up the bus using the Bus Setup window
of TekScope, and set up the source using the Source Configurations window of DPOJET. If you try to
select a measurement that requires a bus, but no busis configured, a pop up asks you to set up abus.
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Clicking Bus Setup displays the Bus Setup window where you can configure a bus.

You can select sources using the Source configuration window. The selected busis displayed and you can
apply both the bus and analog source settings to all similar measurements. If the measurement requires one
bus source and one clock source, the following Source Configuration window is displayed.

X
—Soume Configuration

CrET .
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If the measurement has only one bus source, and Source Autoset and Ref Level Autoset are not required,
then the following Source Configuration window is displayed.

X
—Soume Configuration

cwocwpt v

Related Topic
B Sources Setup (see page 84)

Digital as a source

DPOJET supports the following measurement on Digital channels. Digital source measurements are
available only on M SO5000/70000 series of instruments running with 64-bit Windows 7 OS.

Table 30:

Period/Frequency

measurements Time measurements
Period Skew

Positive Width Setup

Negative Width Hold

Frequency

+Duty Cycle

-Duty Cycle

CC-Period
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Table 30: (cont.)

Period/Frequency

measurements Time measurements
+CC-Duty

-CC-Duty

Digital source selection
You can select any of the Digital channels (DO — D15) from the digital tab as shown below.

Digital Channels 3

ey )
@@
- @

=

Left and Right arrows will display the previous and next set of digital channels as shown below:

Digital Channels )| Digital Channels 1

Digital Channels 3

- o)
@
| @

¥

Digital sources do not have Source Autoset available. Also, digital sources are not used for performing
Ref Level Autoset.

Configurations and features

All the configurations and the features that are supported for analog sources are supported for digital
sources as well.
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Related Topic

B Sources Setup (see page 84)

Custom Source Name

Any oscilloscope source (Channel, Math, or Reference) can have a custom label which is created or
changed using the main oscilloscope interface:

B Channels; Vertical > Label
®  Maths: Math > Setup
m References: File > Reference Waveform Controls

If a source has been assigned a custom label, both the native name and custom name are shown on the
Source Config panel. When sources with custom labels appear in the measurement lists (for example, on
the Select or Config panels of DPOJET), only the custom label is shown. To see the native name, move
the mouse over the row in the measurement table; atool tip displays the native name. In these cases, the
custom label is shown, followed by the native name in parenthesis, for example DQS (Chl).

The custom source names (DQ and DQS) appear in the following screens:

®  Measurement table
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Measurements

Period PosWidth  NegWidth

N—Period

*Duty Cycle  —Duty Cycle

CCPeriod  +CCDuty  —CC-Duty

Ampl

Standard

B Source Configuration

tDQSH, DQS
tDQSL, DQS

(DS Diffibase), DQS...
{DS_SE{base), DOS, ...

96.072ps
3.0997ns
143.94ps
83.597ps

50.293ps
1.5644ns
72.524ps
68.5509ps

90

Freqg

782.29ps
204.17ps
7.4255ns
259.29ps
276.37ps

22.500ps
26.667ps
6.0000ps
555.54fs

Custom Source Name

0.0000s

176.17ps
4.8987ns
239.28ps
22.222ps

181.67ps
7.3988ns
253.29ps
275.82ps

-164.00ps
-4.8717ns
-161.67ps
-24.222ps
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= Plots

Jitter and Eye Diagram Analysis Tools

Plots

Skew1 F S,
e iDQ A Time Trend Data Array  Histogram

Er——rT | e
Hold1 DAS,DQ
DC Common Mode1 | 1| DQS,DQ Spectrum  Transfer

High1 _joas

= Data Snapshot

Statistics
Measurement
[~ setup1 DQs,DQ
[v] Hold1 Das,ba
[¥] DC Common Mod.. DQS,DQ
|w] High1 DQs

File Mame

IC:\Users\johnh\Teldmnix\Tekﬁpplications\D POJETLogs"Stat i
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Spectrum Setup1,DAS,...
Transfer Setup1,DQS,..
Data Array Setup1,DQS,..

isaram | seupras-
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Custom Source Name

m  Datalogging

Log Statistics

Statistics

Measurement

Worst Case

Data Log File

[»] Setup1

|w] Autofit Mask Hits1
|v] Height @BER1
|v| TinT Ratio1

¥ DC Common M...
|v] Cycle Max1

|v] AC Common Mo...

IC:\Users\johnh\Teldmnix\Tek}bplications\D POJET"Logs"Stat i

B Measurement Summary

Ref Levels
Data Eye Width

tDHDiff(base)

Clock Recovery => Method: Explicit Clock — Edge,
Clock Source: Ch1, Clock Edge: Both, Clock Multiplier:
1, Clock Offset: 625ps | General == Measurement
Range Limits: Off, Max: 1ms, Min: Os, Custom Hame:
Data Eye Width, Custom Source Name: DQ{CH3),
DAS{CH1)

Edges => Clock Edge: Both, Data Edye: Both | Filters
==> F1: Spec: No Filter, F2: Spec: No Filter | General =>
Measurement Range Limits: On, Max: 800ps, Min: 0s,
Custom Name: tDH-Diff{base}, Custom Source Name:
DOS(CH1), DO{CHI

Filters => F1: Spec: Mo Filter, F2: Spec: Mo Filter |
General => Measurement Range Limits: Off, Max: 1ms,
Min: 1ps, Custom Name: tDQSH, Custom Source
Hame: DQS{CH1)

Filters =» F1: Spec: No Filter, F2: Spec: No Filter |

General => Measurement Range Limits: Off, Max: 1ms, a

92
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= Export Results to Ref

Export Results to Ref Wave

Measurement

tDASH, DOS Mone

Source Autoset

The Source Autoset allows you to automatically adjust the oscilloscope's vertical and/or horizontal settings
for live sources (Ch1-Ch4) to improve measurement accuracy.

The Vertical Scale option automatically checks the peak-to-peak level of live sources. The vertical scale
and offset of all signalswith a peak-to-peak value less than six divisions are adjusted so the peak-to-peak
will be eight divisions. If the maximum or minimum value of asignal is“clipped”, the vertical scale and
offset are adjusted so that the peak-to-peak value will be eight divisions.

The Horizontal Resolution option checks the Rise Time/Resolution and Fall Time/Resolution of all

live channels. The instrument horizontal resolution is set to the largest value that does not cause the
samples-per-edge of the fastest edge to fall below five samples per edge. The option sets the acquisition
sampling mode to Real Time for signals with very high edge speeds. Horizontal Autoset, by default, tries
to set the record length corresponding to 10000 Ul for any given waveform at highest possible sample rate.
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Source Autoset

To automatically define both the vertical and horizontal settings for all channel sources, select the Vert
and Horiz button. The Vert and Horiz option also applies an oscilloscope autoset on each channel before
performing the vertical scale and horizontal resolution autoset.

Follow these steps to automatically define the vertical or horizontal settings for active sources:

1. Ensurethat any channel waveform that you want to autoset is visible on the oscill oscope.

2. Select one of the following options:

- Vert & Horiz to autoset both vertical and horizontal setting.

= Vert Scale button to autoset oscilloscope vertical settings only.

- Horiz Resto autoset oscilloscope horizontal settings only.
3. Select Undo to return the oscilloscope to its state before autoset.

Table 31: Autoset configuration options

Item

Description

Vertical Scale

If a channel waveform is clipped or does not exceed six
vertical divisions, adjust the scale so that the waveform
occupies about eight divisions.

Horiz Res Sets the horizontal resolution so that the number of samples
on the fastest transition (edge) exceeds a specified target.

Vert & Horiz Performs a sequence: Oscilloscope Autoset, Vertical scale
and Horizontal resolution.

Undo Returns to the settings present before an Autoset was
performed; disabled after measurements are taken until you
perform another source autoset.

Ref Levels Setup - Click Ref Levels Setup in the Source Configuration screen

to hide/unhide the Ref Levels Setup.

94
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Ref Levels

Timing measurements are based on state transition times. By definition, edges occur when a waveform
crosses specified reference voltage levels. Reference voltage levels must be set so that the application

can identify state transitions on a waveform. By default, the application automatically chooses reference
voltage levels when necessary.

Ch2 Percentage

The DPOJET application uses three basic reference levels: High, Mid and Low. In addition, a hysteresis
value defines a voltage band that prevents a noisy waveform from producing spurious edges. The reference
levels and hysteresis are independently set for each source waveform, and are specified separately for

rising versus falling transitions. There are two ways to set the reference voltage levels: automatic (see
page 98) and manual (see page 99).
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High, Mid, and Low Reference Voltage Levels
The application uses three reference voltage levels. High, Mid, and Low:

®  For most measurements, the application only uses the Mid reference voltage level. The Mid reference
level defines when the waveform state transition occurs at a given threshold.

B For Rise Time and Fall Time measurements, the High and Low reference voltage levels define when
the waveform is fully high or fully low.

High 7 3E‘m ra
I — T ¥ 11
i
M ] —t= ¥ l: 1
1A}
Low—mtf v T

Rising Versus Falling Thresholds

You can specify thresholds for each of the reference voltage levels: High, Mid, and Low. The application
uses the thresholds to determine the following events:

= A Low/Mid/High rising event, which occurs when the waveform passes through the corresponding
Rise threshold in the positive direction.

= A Low/Mid/High falling event, which occurs when the waveform passes through the corresponding
Fall threshold in the negative direction.

For agiven logical reference level (such as Low, Mid, or High), rising and falling events alternate as
time progresses.

NOTE. In many cases, the rising and falling thresholds for a given reference voltage level are set to the
same value. In those cases, a hysteresis value helps prevent spurious edges produced by small amounts of
noise in a waveform.

Using the Hysteresis Option

The hysteresis option can prevent small amounts of noisein awaveform from producing multiple threshold
crossings. You can use a hysteresis when the rising and falling thresholds for a given reference voltage
level are set to the same value.

The reference voltage level + the hysteresis value defines a voltage range that must be fully crossed by
the waveform for an edge event to occur. If the decision threshold is crossed more than once before the
waveform exits the hysteresis band, the mean value of the first and last crossing are used as the edge
event time.

DPOUJET Jitter and Eye Diagram Analysis Tools 97



Operating Basics Ref Levels

For example, if the waveform rises through the Threshold — Hysteresis, then rises through the Threshold,
then falls through the Threshold, then rises through both the Threshold and the Threshold + Hysteresis, a
single edge event occurs at the mean value of the two rising crossings.

Example of Hysteresis on a Noisy Waveform

Threshold + Hysteresis - — - ————- 7 ——— — -

Threshold — — — — ===c

Threshold - Hysteresis — - — — &£ - — — — — — -
Edoe event time

— -» Hysteresis

High —————
Mid ——— —} Hysteresis
Low — — —F——p Hysteresis

Automatic Versus Manual Reference Voltage Levels

Each measurement source can be configured to automatically choose voltage reference levels (default), or
to use specific absolute reference voltages. 1n the automatic configuration, levels are chosen according to
percentages of the overall signal amplitude.

Inthe Ref Levels Setup panel, atable at the left edge contains all of the current active measurement sources.
If asourceis configured for Percentages, appropriate reference levels will be chosen, when necessary
(typically when you press the Single or Run button). Select Autoset at the right edge of the Source
Configuration menu to force autoset to occur and to learn which absolute voltage will be used. For each
level, the absolute voltage will be shown directly under the corresponding control. If Autoset has not been
selected recently, the values will be shown as TBD; the last-used voltages will be displayed for reference.

Normally, the reference levels used for rising and falling edges are identical for a given threshold (High,
Mid or Low). Some special cases demand different thresholds for rising edges than for falling edges.

In those cases, select the Advanced check box to allow separate configuration based on polarity. The
Advanced view also alows you to adjust the Hysteresis value or choose the Base-Top method.

For more details, refer to Understanding When Ref Level Autoset will Occur (see page 99) and
Understanding How Ref Level Autoset Chooses Voltages (see page 99).
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Table 32: Configure sources ref levels autoset configuration

Item Description

Autoset” Calculates and displays the reference voltage levels for
all sources where the autoset option is set according to
the Autoset Ref Level Setup.

Base top method Specifies the Base-Top method to be used for all reference
voltage levels when autoset occurs.

If you do not perform Autoset using the Autoset button, the application updates the reference levels (if required) when you select Single or Run
to take measurements.

Understanding When Ref Level Autoset will Occur

When Autoset is enabled for a given source, the individual reference levels are displayed but you may
not manually adjust them. Instead, the reference levels are automatically recalculated whenever one of
the following events occur:

B A measurement sequence is initiated for the first time after a source has become active.
= A measurement sequence isinitiated for the first time after al results have been cleared.
=  The Autoset button at the right edge of the panel is pressed.

The Autoset button is provided as a convenience, but it is never required. Autoset will always be run (if
enabled) before an uninitialized source is used for a measurement.

Understanding How Ref Level Autoset Chooses Voltages

Once triggered, the Reference Level Autoset function uses the following logic to determine actual voltage
levels.

For each applicable source, the Top (high logic level) and Base (low logic level) arefirst determined. Then,
the High, Mid and Low levels are calculated as percentages of the Top-Base difference. For example,

if the Top and Base are 2.8 volts and 0.4 volts respectively and the High percentage level is 90%, this
threshold would be calculated as:

HighThres= Base+ High Percent (Top-Base)= 0.4+0.9 (2.8-0.4)= 2.56

Manually Adjusting the Reference Voltage Levels

Whether or not you use the application to automatically calculate the initial reference voltage levels, you
may need to manually change the values. To set the reference levels manually, follow these steps:

1. Click ks icon in the table which lists the selected measurements to view the source configuration
screen.

2. Select the desired source from the Source list.

NOTE. You cannot select inactive sources.
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3. Sedlect the Absolute button.

4. Select the reference levels or hysteresis options and manually adjust the values. The values will not
change when you select Autoset or take measurements.

NOTE. A source will become inactive if all measurements on that source are removed. If a new
measurement is then added on that source, the source once again becomes active, and defaults to Autoset.
If you clear all measurement on a source that was set to Manual, you must reselect the Manual state (if
desired) when the source is again added.

Click Percentage to set the reference levelsin percentages.

Click Percentage to set the reference levels in percentages with advanced not checked.
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Percentage

Percentage High Ref
90%

TED{Last 1Y)

Mid Ref
50%

TED{LastOV)

Low Ref

%

TED(Last-1V)

Click Absolute to set the reference levels manually to specific voltages with advanced not checked.

Absolute
Peroentage High Ref

Table 33: Configure sources ref levels configuration

Item Description

Autoset Calculates and displays the reference voltage levels for all
sources where the autoset option is set according to the
Autoset Ref Level Setup.

Base top method Specifies the Base-Top method to be used for all reference
voltage levels when autoset occurs.

Advanced Allows you to set the Rise and Fall reference levels
independently.

Absolute Allows manually setting the reference levels.

Percentage Allows setting the reference levels as a percentage.

20% — 80% Sets the low threshold level to 20%, the mid threshold level

to 50%, and the high threshold level to 80%.
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Base Top Method

Table 33: Configure sources ref levels configuration (cont.)

Item

Description

10% - 90%

Sets the low threshold level to 10%, the mid threshold level
to 50%, and the high threshold level to 90%.

Ref Levels Setup (one level per source) t

Rise High Sets the high threshold level for the rising edge of the
source.

Rise Mid Sets the middle threshold level for the rising edge of the
source.

Rise Low Sets the low threshold level for the rising edge of the source.

Fall High Sets the high threshold level for the falling edge of the
source.

Fall Mid Sets the middle threshold level for the falling edge of the
source.

Fall Low Sets the low threshold level for the falling edge of the
source.

Hysteresis Sets the threshold margin to the reference level which
the voltage must cross to be recognized as changing; the
margin is the relative reference level plus or minus half the
hysteresis; use to filter out spurious events.

Close Accepts the changes and closes the window.

*

to take measurements.

If you do not update ref levels by clicking Autoset, the application updates the reference levels (if required) when you select the Single or Run

T Default settings are 90% (High), 50% (Mid), 10% (Low), and 3% (Hysteresis).

Base Top Method

Click Base top method in the Ref Level Setup screen to select a method used for calculating Top and

Base of the waveform.

When the reference levels are set to Autoset, which is the default, the following steps are used during

an autoset:

®  Base and Top of the waveform are calculated

= High, Mid and Low reference voltages are determined as percentages of the (Top - Base) difference

There are four methods to cal culate the Base and Top of the waveform:

B Min - Max
®m  Low - High Histogram (Full Waveform)
= Low - High Histogram (Center of Eye)

= Auto
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Table 34: Autoset ref level configuration

Item Description
Base Top Method
Min-Max Uses the minimum and maximum values in the waveform

to determine the base and top amplitude. Useful on a
waveform with low noise and free from excessive overshoot.

Low-High Histogram (Full Waveform) Uses a histogram approach to determine the base top
amplitude. Creates a histogram of the amplitudes of the
entire waveform; the histogram should have a peak at the
nominal high level, and another peak at the nominal low
level.

Low-High Histogram (Center of Eye) Uses a histogram approach to determine the base top
amplitude. Creates a histogram of the amplitudes in the
center of each bit (unit interval) while ignoring the waveform
during bit transitions. The histogram should have a peak
at the nominal high level and another peak at the nominal

low level.
Auto Automatically determines the best Base Top method to use.
OK Accepts the changes and closes the window.

Default settings are 90% (High), 50% (Mid), 10% (Low), and 3% (Hysteresis).
Min - Max

The figure shows a typical data waveform with avertical histogram turned on. If base-top method
Min-Max is selected, the voltages indicated by the red linesis used for the base and top since these are
the absolute min and max points in the entire waveform. If there isn't too much overshoot in awaveform
thisis a good base top method.
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Low - High Histogram (Full Waveform)

If base-top method Low - High Histogram (Full Waveform) is selected, the oscilloscope performs two
histogram measurements. one on the top half of the waveform and another on the lower half of the
waveform. The upper and lower blue lines in the figure show the modes of the upper and lower histogram,
respectively. The mode of a histogram is the value that appears most frequently; visualy, it is the peak of
the histogram. It doesagood job of picking out the high and low logic levelsto which the waveform settles.

Low - High Histogram (Center of Eye)

If base-top method Low - High Histogram (Center of Eye) is selected, the waveform is assumed to be a
serial data signal and DPOJET performs clock recovery on the waveform. Then, the point at the center of
each unit interval istaken. These samples are sorted into low bits and high bits. One histogram is formed
on the low samples, and another on the high samples. The Base and Top are the modes of these histograms.
Thisis similar to the Histogram Mode method Low - High Histogram (Full Waveform), except it is less
influenced by the shape of the waveform during transitions between hits.

Auto

Base-top method Auto is the default. In Auto, method Low - High Histogram (Full Waveform) is tried
first. But sometimes that method gives ambiguous results because there's no clear point to choose on the
histogram. If that occurs, DPOJET switches to method Min-Max.
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Bit Rate and Pattern Length Detection

Beginning with version 6.1.0, DPOJET performs automatic detection of bit rate and pattern length
whenever a new processing cycle occurs (for example, after aconfiguration change or a“Clear” operation).
The detected values are displayed at the top of the results panel, to allow quick verification of overall test
setup and device configuration

Jitter and Eye Diagram Analysis Tools

m |f there are simultaneous measurements on severa different sources, the results for the source
associated with the first measurement will be shown initially. The drop-down selector can be used to
see the bit rate and pattern length for other sources.

= Thereported bit rate can be influenced by the clock recovery settings, and in particular by the Nominal
Data Rate (if present) in the Advanced panel of the clock recovery configuration tab.

= |f no repeating pattern is detected, or if jitter measurements are explicitly configured to use
arbitrary-pattern analysis, the second line will say Pattern: Arbitrary.

m By default, the detected pattern length also automatically configures any jitter measurements that
require pattern length as a configuration parameter. These parameters appear on the RjDj tab of the
jitter measurements. If ajitter measurement is configured to use a specific pattern length (instead of
using the detected length), the user-specified length will be shown at the top of the results panel and
will be used by the measurement even if it does not appear to match the actual signal. To manually
configure the pattern length, select the configure tab and then the measurement. Select the RjDj tab
and select the Manual button.

Related Topics
m  About RIDJ (see page 149)

m  Clock Recovery Advanced Setup (see page 129)

About Configuring a Measurement

You can configure the measurements listed under the following categories:
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m  Period/Freq
= Jitter

= Time

® Eye

= Amplitude
. Standard

About Configuring a Measurement

NOTE. Configure tabs are displayed only when you select a measurement.

The following tables list the configure tabs displayed for each measurement.

Table 35: Period/Freq measurements

Clock
Bit Recov- Gen-

Ul Name Measurements Edges Config ery RJDJ Filters eral Global
Period Clock Period P [ [ [

Data Period L L P
Freq Clock P~ [ P~ [

Frequency

Data Frequency e [ e
Pos Pos Width [ I I
Width
Neg Neg Width e [ e
Width
N-Pe- N-Period P [ [
riod
+Duty +Duty Cycle I % e [
Cycle
-Duty -Duty Cycle
Cycle
CC-Pe- CC-Period I L L [
riod
+CC- +CC-Duty [ - [
Duty
-CC- -CC-Duty - L -
Duty

106
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Table 36: Jitter measurements

Clock
Bit Recov-
Ul Name Measurements Config Edges ery RJDJ Filters General Global
TIE Clock TIE -~ -~ V’ V’ V’
Data TIE % [ [ [
@ Clock TJ V’ - - V’ P~ P~
BER Data TJ - - - P P
DCD Clock DCD s s s s s s
Data DCD [ - [ [ [
RJ Clock RJ P~ P~ P~ P P P~
Data RJ I I I 4 %
DJ Clock DJ I I I s s s
Data DJ 7 % % P [
DDJ DDJ s - 4 P~ [
RJ-36 Clock RJ-306 V- V- V- V- V- V-
Data RJ-00 [ [ [ [ P
DJ-60 Clock DJ-36 - - V’ V’ -~ -~
Data DJ-0d - - - - -
PJ Clock PJ - -~ - - - 1~
Data PJ % P~ % e P
SRj SR| = 2 2 P2 e =
FIN FIN - V” P~ - - -
Jitter
Sum-
mary !
Phase - - - -
Noise
J2 Clock TJ - - - s - -
Data TJ s - 4 I -
J9 Clock TJ P P P P P P
Data TJ P [ [ [ [

1 Jitter Summary is not an individual measurement but a convenience function. Pressing this button automatically adds a set of eleven
jitter-related measurements with a single action. The measurements are: TIE, RJ, RJ-33, DJ, DJ-65, PJ, DDJ, DCD, TU@BER, and
Width@BER.
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Table 37: Timing measurements

About Configuring a Measurement

Clock

Measure- Bus Recov-
ments SSC State Edges ery RJDJ Filters General Global
Rise Time I I I
Fall Time I - I I
Skew - - P~ P~
High Time I I 4
Low Time - - -
Setup I I I I
Rise Slew s I - -
Rate
Fall Slew Rate I I - -
Hold P P P P
SSC Profile I I I
SSC Mod Rate I I -
SSC Freq Dev I I I I I
SSC Freq Dev P P P s s
Min
SSC Freq Dev s I I I I
Max
Time Outside I I - I
Level
tCMD-CMD - - -
Table 38: Eye measurements

Clock
Measure- Bit Recov-
ments Config Edges ery BER RJDJ Filters General Global
Width - - -
Width@BER P P P P P P
Height - -~ - 1~
Height@BER P~ - - P~ P~
Mask Hits - - - -
Eye High - - - s s
Eye Low s s s I I
Q-Factor P~ P~ P~ P~ P~
AutoFit Mask I I % %

Hits
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Table 39: Amplitude measurements

Clock
Bit Recov-
Measurements Config Edges ery RJDJ Filters General Global
High . P P 4 4
DC Common [ [ [
Mode
AC Common I I s
Mode
Low I I I P~ P~
T/nT Ratio - - - -
High-Low L L L - -
V-Diff-Xovr s I - -
Overshoot - 1 - -
Undershoot - - - -
Cycle Pk-Pk L P .
Cycle Min I I 4
Cycle Max - - P
Table 40: Standard-specific measurements
Clock
Measure- Bus Bit Recov-
ments State Config Edges ery BER Filters General Global
DDR
DDR - - v -
Setup-SE
DDR Setup- - - s s
Diff
DDR Hold-SE - P~ P~ P~
DDR Hold-Diff -~ -~ -~ -~
DDR tCK(avg) - - s s
DDR tCH(avg) I I I I
DDR tCL(avg) - - - -
DDR tERR(n) - - -
DDR - -~ -
tERR(m-n)
DDR tJIT(duty) - - - -
DDR tJIT(per) -~ -~ -~ -~
DDR tRPRE P~ P~ P
DDR tWPRE s P~ P~
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Table 40: Standard-specific measurements (cont.)

Clock
Measure- Bus Bit Recov-
ments State Config Edges ery BER Filters General Global
DDR tPST I P I
DDR Over 4 [ L L
Area
DDR Under P P P~ P~
Area
DDR tDQSS 4 I
DDR VID(ac) I P I
GDDR5 P [ [
tBurst-CMD
GDDR5 1~ [ [
tCKSRE
GDDR5 P~ P I
tCKSRX
DDR2 I P I
tDQSCK
PCI Express
PCle Med-Mx- P~ P~ 7 P P
Jitter
PCle T-RF- P P P P
Mismch
PCle MAX- P P P
MIN Ratio *
PCle SSC 1~ [ [ [
FREQ DEV
PCle SSC I I I I
PROFILE
PCle T-Tx- 4 P I
Diff-PP
PCle T-TX P P P
PCle T-Tx-Fall I 4 - - P
PCle Tmin- P~ P P
Pulse
PCle DeEmph I I I I
PCle T-Tx- - - - - -
Rise
PCle UI I P 4
PCle AC L 1~ 1~
Common
Mode
T-TX-DJ I P 4
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Table 40: Standard-specific measurements (cont.)

About Configuring a Measurement

Clock
Measure- Recov-
ments ery BER Filters General Global
T-TX-UTJ I I I I
T-TX-UDJDD I I 4 4
T-TX-UPW-TJ 1~ 1~ 1~ L
T-TX- 4 4 I I
UPWDJDD
V-TX-NO-EQ P o .
V-TX- EIEOS I I I
ps21TX 4 I I
USB 3.0 Essentials
USB VTx- 4 I I
Diff-PP
USB TCdr- [ [ P P
Slew-Max
USB Tmin- - - -
Pulse-Tj
USB Tmin- I I I I
Pulse-Dj
USB SSC [ [ [ [
MOD RATE
USB SSC I I I I
FREQ-DEV
MAX
USB SSC [ [ [ [
FREQ DEV-
MIN
USB SSC [ [ [
PROFILE
USB UI 1~ 1~ 1~
USB AC [ P P
Common
Mode

¥ Custom name for PCle MAX-MIN Ratio is PCle VRX-MAX-MIN Ratio.

Related Topics
B Globa (see page 112)

= Genera (see page 119)

m_ Filters (see page 120)

B Clock Recovery (see page 125)
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m_ Bit Config (see page 141)
B RJDJ (see page 149)

= Configuring Bus States (see page 153)

m  Edges (see page 155)
B Spread Spectrum Clocking (SSC) (see page 171)

About Global

This configuration tab is common for all measurements. You can limit the waveform data analysis by
Gating, by applying a Qualifier, or by setting the measurement population limits. Access the Global
configuration directly from the oscilloscope menu under Analyze > Jitter and Eye Analysis (DPOJET) >
Global Configuration..

Jitler and Eve Diagram Analysis Toals

Gating

Gating alows you to focus the analysis on a specific area of the waveform bounded by a gated region,
which is away to filter unnecessary information.
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You can set up a gated region in one of the following ways:
®  Zoom

= Cursors

Jitter and Eye Diagram Analysis Tools

| Measurement | Source(s) |
TIE1 Elcm
Height1 Elcm
/| TI@BER1 cm
RJ-551 Wlicm

o T @D @

Width@BER1 Lacm |
-
Population @

Table 41: Global-Gating options

Item Description

Off No gating occurs; application takes measurements over
the entire waveform.

Zoom Zooms the specified region of the source waveform to take
measurements within the selected area. The region of
waveform within the zoom is analyzed.

Cursors Gates the waveform with Vertical cursors. The region of
waveform within the cursors is analyzed.
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Qualify

Quadlifiers allows you to limit the application to more narrowly defined conditions before taking
measurements. All sources for the measurements and Qualify input must have the same Horizontal Sample
Rate, Record Length, and Position to ensure that measurements function properly. For measurements
which require clock recovery such as TIE or eye measurements, only the first qualified region will be
measured even if multiple qualified regions are present. For all other measurements, the entire waveform
is processed.

Jitter and Eye Diagram Analysis Tools

\| |Measurement | Source(s) | ;
TIE1 L Ch1

Height1

| TI@BER1

RJ-551

o o @D
Width@BER1 L
repi ()

Table 42: Global-Qualify options

Item Description

Off Disables the application from using the defined conditions
while taking measurements.

On Enables the application to use the defined conditions while
taking measurements.

Configure Displays the Qualify with Logic (see page 115) dialog box.
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Configuring Qualify with Logic

Table 43: Qualify-Configure options

Configuring Qualify with Logic

Source Ch1-Ch4, Ref1-Ref4, Math1-Math4 Search0-Search8
Qualify With Logic Qualify With Logic
|Search1 | ¥ |
Configura-
tion Panel
Configure [tem Description
options Source* Selects a waveform to qualify the signal or ~ Selects a waveform to qualify the signal or
clock source used for the measurement. clock source used for the measurement.
The input source waveforms or files are The input source waveforms or files are
Ch1-Ch4, Refl-Ref4, and Math1-Math4. Search0-Search8 (see page 116). Displays
the burst control type selected in DDRA
when you turn on the qualifier. Also
indicates that ASM is turned on.
Mid Shows the vertical reference level of the
qualifier waveform. ¥
Hysteresis Shows the amount of hysteresis applied to
the vertical reference level of the qualifier
waveform. Hysteresis prevents small
amounts of noise in a waveform from
producing multiple threshold crossings.
Active
Hight Enables measurements in regions t where
the qualifier waveform exceeds the mid
reference level.
Lowt Enables measurements in regions f where
the qualifier waveform falls below the mid
reference level.
(0] ¢ Accepts the changes and closes the

window.

* Measurement and Qualify sources must have the same Horizontal Sample Rate, Record Length, and Position to ensure that measurements

function properly.

T For measurements that require clock recovery, only the first qualified region will be measured even if multiple qualified regions are present.

¥ The default behavior for all reference levels is to automatically adjust based on the signal amplitude after a Clear operation, unless you disable

the autoset check box in the source configuration panel. Whether you use the Qualify with Logic dialog box to adjust the levels or not, be

DPOJET Jitter and Eye Diagram Analysis Tools
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aware that the levels may change if automatic adjustment is still enabled. For more information, refer to Automatic Versus Manual Reference
Voltage Levels (see page 98).

Search Behavior in DPOJET

When search is configured, the application analyzes the identified marks on the source waveform. Read
and Write bursts are selected in ASM when search is selected as the qualify source. Each Mark indicates
the start and stop of aburst. These marks are used by the DPOJET measurement when the qualify sourceis
configured to Search. You can configure up to eight searches (Searchl — Search8) in ASM (Advanced
Search and Mark)and SearchO for visual search. The same search number gets reflected in DPOJET.
Search is used for Multiple burst analysis. For more details, refer to your oscilloscope online help.
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Population

The Population control allows you to limit the amount of waveform data that is analyzed. Thisis often
donein industry standards to make sure that there is consistency between measurement techniques.

Jitter and Eye Diagram Analysis Tools

|Measurement | Source(s) | =
TIE1 Elcm Cating @ G G
Height1 Elcm i

TJ@BER1 Ecm
RJ-551

Qualify @ @
Population @

Width@BER1

Table 44: Global-Population options

Item Description

Off Disables the application from using a Population limit while
taking measurements.

On Enables the application to use a Population limit while
taking measurements.

Configure Displays the Population Limit (see page 118) dialog box

wherein you can set a limit on a maximum population to
obtain, for selected measurements.
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Configuring Population Limit
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Population Limit

noauisitons v

Limit
1k Each Measurement n

Table 45: Population-Configure options

Configuring Population Limit

Item Description

Limit By

Population The limit determines the population of measurement
observations that will be accumulated. Some measurements
may accumulate observations more quickly than others.

Acquisitions The limit determines the number of acquisition cycles that
will be performed.

Stop Conditions

Each Measurement

Each measurement stops accumulating as soon as it
reaches the specified limit. Sequencing does not stop until
all measurements have reached the limit, at which time
every measurement will have exactly the limit.

Last Measurement

Sequencing continues and all measurements continue
accumulating until the last (slowest accumulating)
measurement reaches the limit, at which time they all stop.
When sequencing stops, all measurements except one may
have higher population than the limit.

Limit Specifies the number of acquisitions or measurements the
application takes before sequencing stops. Population limit
is not applicable for Mask Hits.

OK Accepts the changes and closes the window.
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General

This configuration tab allows you to customize the measurement name and qualify the measurement within
a selected result range. The General tab looks the same for all the measurements but is not common. The
values are different for different measurements. You can set the custom name per measurement here. Use
the virtual keyboard to enter the measurement name of your choice. Measurements selected in DDRA are
the custom names for the measurements defined in DPOJET. A toal tip displays the custom name and the
DPOJET-based measurement name (in brackets) on moving the mouse over the row in the measurement
table, results, data snapshot, and measurement configuration summary.

NOTE. Custom measurement names revert to their DPOJET-based measurement names on being cleared
in the General configuration screen.

Jitter and Eye Diagram Analysis Tools
G
Height1

Measurement Range Limits

Max Value Min Value

TJ@BER1 = |
o G M @G - e

DJ-551

Custom Measurement Name

Table 46: General options

Item Description

Off Disables the application from using the specified
measurement limits.

On Enables the application to use the specified measurement
limits.

Max or Min value Specify the maximum and minimum range of valid

measurement values measurements. The default values
for the Measurement Range Limits options vary by
measurement.

Custom Measurement Name Option to modify the measurement name. Allows adding a
user-specified name to any measurement. This is useful for
aligning DPOJET measurements with a user measurement
list or standard.
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NOTE. If amax value smaller than the min valueis entered, it is accepted and the min value is also silently
reduced to the samevalue. Likewise, if amin value larger than the max is entered, both are set to that value.

Filters

This configuration tab allows you to modify the measurement data by applying a High Pass filter to block
low frequency band components or a Low Pass filter to block high frequency band components. For
Example, Selecting a1 MHz high pass filter can reduce the effect of SSC on results.

For some measurements (Period, Frequency, TIE, +Duty Cycle, —Duty Cycle, +CC Duty, — CC Duty,
CC—Period, Positive Width, Negative Width, N-Period, Rise Time, Fall Time, Low Time, High Time,
DC Common Mode, High-Low, High, Low, T/nT Ratio, PCle T-Tx-Rise, PCle T-Tx-Fall, PCle
T-RF-Mismch, PCle Ul, USB Ul, PCle SSC FREQ DEV, USB TCdr-Slew-Max, USB SSC FREQ DEV,
USB SSC MOD RATE and USB SSC PROFILE), the measurements versus time waveform (time trend)
that is derived from the original oscilloscope waveform can be filtered before it is passed to the statistics
and plotting subsystems.

F1 cutoff fregm——y~ | }3 dB
[
I =——High Pass
Magnitude |
Freguency
3 dE-{— _ _________ | -—___—FE cutoff freq.
|
Low Pass —fa :
MagnitLde |
3dBq
17 Order
E"ddOrder
Magnitude 3 Order
Freguency

Band Pass Filtering

You can create a band pass filter by enabling both the High Pass and the L ow Passfilters on a measurement.
The cut-off frequency for the Low Pass filter must be greater than or equal to the cut-off frequency for the
High Pass filter.

You should be aware that setting the cut-off frequencies close to each other may effectively filter out al
of the measurement data, or all but a small amount of timing noise. This diagram shows the spectrum
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of the measurement data passed to the statistics and plotting subsystems when you use both the High
Pass and the Low Pass filters.

E-and| Pass
3de [ l [
F1 High Pass_| K/ X F2 Low Pass
cutoff freq. _/ I I | cukoff freg.
Maghitude
Frequency

High Pass filters attenuate low frequencies, and filter out DC values entirely. When a high passfilter is
added to a period or frequency measurement, the mean value of the filtered measurement goes to zero.
This can be seen by creating a Time Trend plot of a high-pass-filtered period or frequency measurement.
Although thisis the correct theoretical behavior for the filtered measurement, it is not very useful if the
Results panel reports that the mean period or frequency is zero. For this reason, the mean values that
appear in the results panels for Period and Frequency measurements are the values before the filter.
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M easurements such as AC Common Mode, PCle AC Common Mode, and USB AC Common Mode use a
high-pass sliding window filter. Thisfilter is applied to remove low frequency common mode noise. It
has a 30 kHz cutoff frequency.

Jitter and Eye Diagram Analysis Tools

i Width@BER1
/ | Period1

2 common iodet | cricha |

121



Operating Basics Brick Wall Filter Configuration

Table 47: Filter options

Item Description
High Pass
Filter Spec When enabled, blocks the low frequency band and passes

only the high frequency band of the waveform; defined as
1st order, 2nd order, 31 order Butterworth and No filter, being

the default.

Freq (F1)" High Pass filter cut-off frequency at which the filter
magnitude falls by 3 dB.

Low Pass

Filter Spec When enabled, blocks the high frequency band and passes
only the low frequency band of the waveform; defined as 1st
order, 2nd order, 3rd order Butterworth, and No filter, being
the default.

Freq (F2)* Low Pass filter cut-off frequency at which the filter
magnitude falls by 3 dB.

Advanced Displays the Advanced Filter Configuration (see page 123)
dialog box.

Apply to All Settings of the measurement are applied to all

measurements with those settings.

Includes a 3 dB cut-off frequency.

Brick Wall Filter Configuration

M easurements such as PCle DeEmph and PCle Med-Mx Jitter use the Brick Wall filter. A brick wall filter
is applied to the PCle signal to remove the low frequency jitter components. The PCI Express application
applies thefilter as per the PCle specification. A Brick Wall filter has a very sharp cut-off frequency.

Jitter and Eye Diagram Analysis Tools

T, Measurement Source(s)
~— PCle DeEmph jont

mwe (LR . Brick Wall Fitter
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Advanced Filter Configuration

The measurement filters are implemented using infinite impulse response (I1R) designs. Aswith any
causal filter, atransient may occur at the filter’s output in response to the arrival of theinput signal. Itis
usually desirable to exclude this transient from the measurement results.

In the DPOJET application, the filter transient is managed in two ways. First, the input to thefilter is
gently “ramped up” from zero to its full value over some ramp timet,. Second, the output of the ramp
is“blanked” over some duration ty, so that the remaining effects of any transient are omitted from
measurement results, statistics and plots. The sequence of operations is depicted here:

Unfiltered Ramp o Blanking Filtered
Measurement_’ it,) —p Filter — {tp) _’Measurement

The ramp function has a raised-cosine profile and is defined in the time domain as:

1 £
— [1 - cos(}?*—j] 0<t Lk,
2 ¢

¥

1 £t

¥

T

LY
tr r

Raised Cosine Ramp Function

You may adjust the ramp time t, by means of the Advanced control panel. If you wish to turn off the
ramp function, set the ramp time to 0.

Similarly, you may adjust the blanking duration t, by means of the Advanced control panel. Setting the
blanking duration to O will allow you to see the entire filtered measurement, including any transients.
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Both, the ramp time t; and the blanking duration t,, are set relative to the reciprocal of the lowest filter
frequency F.. By default, both of these parameters are set to 1/F.. Since they are normalized to the filter
frequency, they will automatically adjust if you change the filter cut-off frequency.

The complete set of signal processing options, together with representative waveforms that suggest how
the options affect the measurement vector, are shown here;

Unfiltered
Measurement t

l__.—-—"

Ramp (t,)

AT

Filter

gt A,
o U“U U“U“L“U“

l\ S rm mr

Measurement J U UVU‘ILHUH ?

A
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Table 48: Advanced filter configuration options

Item Description

Ramp Time Duration of the raised-cosine smoothing function applied to

the measurement vector before the vector is filtered.

Blanking Time Duration of the filter's output that is suppressed. The

blanked portion of the output is not included in the
measurement statistics, or in any plots.

OK

Accepts changes and closes.

About Clock Recovery

Clock recovery refers to the process of establishing a reference clock, the edges of which can be used
as a basis for timing comparisons. The Clock Recovery configuration tab allows you to select one of
the following clock recovery methods:

Constant Clock - Mean (see page 127)

Constant Clock - Median (see page 128)

Constant Clock - Fixed (see page 129)

Phase Locked Loop Standard BandWidth (see page 132)

Phase Locked Loop Custom BandWidth (see page 134)

Explicit Clock - Edge (see page 136)

Explicit Clock - PLL (see page 138)

The firgt five methods derive the reference clock from the same channel upon which the measurement
isdefined. Thisisthe conventional method of clock recovery for serial data communications, where no
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separate clock is available. The last two methods (Explicit Clock) derive the reference clock from a
channel other than the one upon which the measurement is defined.

About Constant Clock Recovery

In Constant Clock Recovery, the clock is assumed to be of the form A*sin (211 ft +®), where the frequency
(f) and phase (@) are treated as unknown constants. Once a source waveform has been acquired and the
edges extracted, one or both of these constants are determined using linear regression, so that the recovered
clock minimizes the mean squared sum of the Time Interval Error (TIE) for that waveform.

If Constant Clock - Mean is selected as the clock recovery method, both the frequency and the phase
are chosen to minimize the mean sguared error.

If Constant Clock - Fixed is selected as the clock recovery method, the precise frequency specified is
used but the phase is chosen so that the median error between the recovered and measured edgesiis zero.

If Constant Clock - Median is selected as the clock recovery method, the phase is chosen so that the
median error between the recovered and measured edges is zero.

CC (linear regrassion) )
t Gl
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Constant Clock - Mean

This method provides the following options that control how the clock recovery is performed:
= Auto Calc First Acq
= Auto Calc Every Acq

Selecting Autocalc First Acq will alow the clock-recovery agorithm to choose a new best-fit clock
frequency and phase only on the first acquisition. Subsequent acquisitions will choose a best fit on clock
phase but retain the clock frequency found on the first acquisition.

Selecting Autocalc Every Acq will allow the clock-recovery algorithm to choose a new best-fit clock
frequency and phase for each new oscill oscope acquisition.

Clearing the measurement results by choosing Clear on the sequencing panel will reset the clock recovery
so that both frequency and phase are optimized on the subsegquent acquisition.

Jitter and Eye Diagram Analysis Tools

m | Measurement Snurcefé) | . S -
' Method Appiy to Al

TIE1
: !Conslﬂnl Clock — Mean ‘ ¥ |

Auto Calc

. * Copies these clock recavery settings to other measurements
R i

Table 49: Constant clock - mean options

Item Description

Auto Calc First Acqg Calculates the best fit of the initial acquisition or the first
acquisition after clearing results, and then uses the value
until you clear the results.

Auto Calc Every Acq Calculates the best fit for each acquisition (default).
Apply to All
Apply Applies the current clock recovery configuration to all

selected measurement(s), PLL-Standard clock recovery
options that have Clock Recovery as configuration tab.

Advanced Displays the Clock Recovery Advanced Setup (see

page 129) dialog box.
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Constant Clock - Median

This method provides the following options that control how the clock recovery is performed:
= Auto Calc First Acq
= Auto Calc Every Acq

Selecting Autocalc First Acq will allow the clock-recovery algorithm to choose a new best-fit clock
frequency and phase only on the first acquisition. Subsequent acquisitions will choose a best fit on clock
phase but retain the clock frequency found on the first acquisition.

Selecting Autocalc Every Acq will allow the clock-recovery algorithm to choose a new best-fit clock
frequency and phase for each new oscilloscope acquisition.

Clearing the measurement results by choosing Clear on the sequencing panel will reset the clock recovery
so that both frequency and phase are optimized on the subsequent acquisition.

Jitter and Eye Diagram Analysis Teols

Measurement Source(s) | S
Apply to All
Constant Clock — Median | v ‘ @

Auto Calc
-
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. * Copies these clock recovery settings to ather measurements

Table 50: Constant clock - median options

Item Description

Auto Calc First Acq Calculates the best fit of the initial acquisition or the first
acquisition after clearing results, and then uses the value
until you clear the results.

Auto Calc Every Acq Calculates the best fit for each acquisition (default).
Apply to All
Apply Applies the current clock recovery configuration to all

selected measurement(s) that have Clock Recovery as the
configuration tab.

Advanced Displays the Clock Recovery Advanced Setup (see

page 129) dialog box.
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Constant Clock - Fixed

This method provides a single option that controls how the clock recovery is performed. With Fixed
Constant Clock recovery, no attempt is made to derive information about the actual data rate from the
signal under test. Instead, the precise frequency that you specify will be used. (However, the clock phase
will be chosen so that the median difference between the recovered and measured edges is zero.)

Jitter and Eye Diagram Analysis Tools

Method Applyto A+
‘Constant Clock — Fixed (| ¥ |

Clock Frequency

2.5GHz

This exact clock frequency will be used.
The clock phase will be determined by hest-fit.

- * Copies these clock recovery settings to other measurements

NOTE. Click Apply to All to apply the clock recovery configuration to all selected measurement(s) that
have Clock Recovery as configuration tab.

Clock Recovery Advanced Setup

The Advanced Clock Recovery methods can be used when unusually high noise or ambiguous data
patterns defeats normal clock recovery methods. Under most normal operating conditions, these methods
are not required nor recommended.

Nominal Data Rate and Known Data Pattern are the two advanced clock recovery methods.

In Nominal Data Rate, you can provide the nominal data rate to the clock recovery algorithm. Normally,
the application analyzes your data and determines the data rate automatically. Setting this parameter to
Manual allows you to provide a starting point or hint to the clock recovery algorithm. Thisis useful when
the data pattern makes data rate detection ambiguous. Asan example,a“11001 100" pattern at 8 Gh/s
would otherwise be detected asa“1 0 1 0” pattern at 4 Gh/s. Setting the bit rate to 8 Gh/s will cause the
proper unit interval and pattern length to be identified.

In Known Data Pattern, the pattern is specified by using an ASCI|I text file containing the characters 1

and 0. The file may contain other characters, spaces and tabs for formatting purposes, but they will be
ignored. Several filesfor commonly used patterns are included with the application, and you may use these
as examples if you wish to create your own pattern files. Click Browse to modify the default location

for pattern files.
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Clock Recovery Advanced Setup

NOTE. The last line of the pattern file must end with a CR/LF. Without the CR/LF, you will receive a

too many bits error message.

X

_Clock Recovery Advanced Se :

=y=r

Table 51: Advanced clock recovery options

“Users' Publich Tektroni Tekapplications D POJET \Pattems".

S

Item Description

Nominal Data Rate

Auto Enables automatic detection of the data rate on the first
acquisition following a Clear or configuration change.

Manual Allows you to manually specify the nominal data rate. This
is useful when the data pattern makes data rate detection
ambiguous. As an example,a“11001 100" pattern at
8 Gh/s would otherwise be detected as a “1 0 1 0” pattern
at 4 Gbls.

Bit Rate In Manual configuration, allows you to specify the

approximate data rate in bits per second (b/s). In Auto
configuration, displays the detected data rate.

Known Data Pattern

Off, On

Enables (On) or disables (Off) advanced clock recovery
through a known data pattern.

Pattern File Name

Browse

Selects a file to use for the data pattern.

OK

Accepts changes and closes.
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About PLL Clock Recovery Setup

When PLL-based clock recovery is selected, the application simulates the behavior of the hardware Phase
Locked Loop clock recovery circuit. Thisis afeedback loop in which the Voltage-Controlled Oscillator
(VCO) is used to track or follow slow variations in the bit rate of the input waveform. Such loops are
frequently used to recover the clock in communication links that do not transmit the clock as a separate
signal. The PLL parametersin the application may be adjusted to simulate with the behavior of areceiver
in such alink, within certain guidelines.

NOTE. The effective transfer function of a PLL loop is not equal to the PLL Loop BW setting. The Transfer
function depends on the factors such as damping, transition density and type.

||
EDGE —-=

L J""tl:l_k:

NOTE. PLL response is not instantaneous. This causes some signals to have a ramped trend at the
beginning of a waveform as the PLL locks to the applied signal. To avoid a PLL start-up transient, part of
the output is blanked out. Thisis applicable only when you select PLL Custom BW, PLL Standard BW or
Explicit Clock-PLL asthe clock recovery method. PLL blanking is used by measurements such as TIE,
RJ, RJ-64, DJ, DJ-6¢, PJ, TI@BER, High Voltage, Low \oltage, High-Low, T n/t Ratio, Eye Wdth, Eye
Height, Wdth@BER, Height@BER, Rise Time and Fall Time.
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About PLL Loop BW versus JTF BW

Phase locked |oops are characterized according to their bandwidth (BW), and severa different bandwidths
are commonly used. The terminology used for these bandwidths is described here, since it varies
somewhat across different industries.

®  Loop BW (or Closed Loop BW) is the frequency at which the closed-loop gain has fallento -3 dB
(half power) relative to unity-gain. The closed-loop gain function has the character of alow-passfilter.

= JTF BW (Jitter Transfer Function BW or Error Function BW) is the frequency below which input jitter
to atracking loop is removed. The JTF BW has a high-pass filter characteristic.

For Type | loops, the Loop BW and the JTF BW are always equal. For Type Il loops, these two bandwidths
are different, and their ratio depends on the PLL damping factor. You can choose to specify either
bandwidth, and the other is displayed for reference.

PLL Standard BW

The PLL control area provides control over the phase-locked |oop used for clock recovery. You can choose
the loop bandwidth and the loop order, and if a Type Il loop is chosen, you can specify the damping factor.

To set the loop bandwidth automatically, based on a serial standard, select PLL: Standard BW as the clock
recovery method. From the Standard: b/slist box, select the standard that matches your data link. For
example, choose “PCI-E: 2.5” to test a 2.5 Ghit/second PCI Express link. In this case, the PLL bandwidth
will be set to 1.5 MHz, which is 1/1667 of the baud rate as specified in PCl Express standard.

You can use the PLL Model list box to choose between Type | and Type Il loop. A Typel loop hasa
transfer function that approaches zero frequency with a slope of 1/s and a Type Il loop approaches zero
frequency with a 1/s?2 slope (In much of the PLL literature, these terms are used interchangeably with
First-Order and Second-Order loops. For athorough discussion of 1oop type versus order, see Frequency
Synthesis by Phase Lock, by William Egan).

NOTE. Although it is possible to configure a Type Il PLL with a bandwidth up to 1/10 of the baud rate,
such a loop will have poor dynamic performance. This is because Type Il loops have less phase margin
than Type | loops. A preferred alternative to using a Type Il PLL with a bandwidth close to its baud rateis
to use a second order high-pass measurement filter to emulate the effects of the PLL.
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PLL Standard BW

—’

to Al
Edges Method Apply
[PLL — Standard BW v
Clock
Recovery
PLL Model Damping
Standard: bis Loop BW
LI PCIE :2.5G v ) )
JTF Bl =1.4517M i
* Copies these clock recovery settings to other measurements J
Related Topics

® About PLL Loop BW versus JTF BW (see page 132)

Table 52: PLL-Standard clock recovery options

Item Description

PLL Model Selects between a Type | or Type Il phase-locked loop.

Damping Use the keypad to specify the damping ratio of the PLL. It is
enabled only for Type Il phase-locked loop.

Loop BW Displays the Closed Loop bandwidth that has been
configured based on the current standard.

JTF BW Displays the Jitter Transfer Function bandwidth that has

been configured based on the current standard.

Standard: b/s

Implicitly sets the loop bandwidth of the clock recovery PLL,
based on selection of the industry standard and data rate in
bits/second.

Apply to All

Applies the current clock recovery configuration to all
selected measurements that have user-configurable clock
recovery.

Apply

Applies the current clock recovery configuration to all
selected measurement(s) that have Clock Recovery as the
configuration tab.

Advanced

Displays the Clock Recovery Advanced Setup. For more
details, refer to the Clock Recovery Advanced Setup (see

page 129).
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PLL Custom BW

134

The PLL control area provides control over the phase-locked loop used for clock recovery. You can choose
the loop bandwidth and the loop order, and if a Type Il loop is chosen, you can specify the damping factor.

To manually control the loop bandwidth, select PLL: Custom BW as the clock recovery method and use
the BW control to choose the -3 dB bandwidth, in Hz.

You can use the PLL Model list box to choose between a Type | and Type Il loop. A Typel loop has a
transfer function that approaches zero frequency with a slope of 1/s and a Type Il loop approaches zero
frequency with a 1/s?2 slope. (In much of the PLL literature, these terms are used interchangeably with
First-Order and Second-Order loops. For athorough discussion of loop type versus order, see Frequency
Synthesis by Phase Lock, by William Egan).

If you choose a Type |1 loop, you can use the radio buttons to select whether you will directly control the
Loop BW (low-pass function) or the JTF BW (high-pass function). You must aso select the Damping
Factor for a Type 11 loop.

NOTE. Although it is possible to configure a Type || PLL with a bandwidth up to 1/10 of the baud rate,
such a loop will have poor dynamic performance. Thisis because Type Il loops have |ess phase margin
than Type | loops. A preferred alternative to using a Type |l PLL with a high bandwidth is to use a 2nd
order high-pass measurement filter to emulate the effects of the PLL.

Related Topics
® About PLL Loop BW versus JTF BW (see page 132)

Method sebi b E
PLL — Custom BW v
PLL Model 1 — Damping
00|
Type Il \J . T00m
« JTF BW
JTF BW

3MHz
Leop Bla/ = 6.1997M w

* Copies these clock recovery settings to other measurements |
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Loop BW
« JTF BW

JTF BW

3MHz

Leop B = 6.1957M

Table 53: PLL-Custom clock recovery options

About Explicit Clock Recovery

Item Description

PLL Model Selects between Type | or Type Il phase-locked loop.

Damping Use the keypad to specify the damping ratio of the PLL. Itis
enabled only for Type Il phase-locked loop.

JTF BW Explicitly sets the JTF bandwidth of the clock recovery PLL
when the PLL Model is Type Il and the JTF BW radio button
is selected.

Loop BW Explicitly sets the Loop bandwidth of the clock recovery
PLL when the PLL Model is Type Il and the Loop BW radio
button is selected.

Apply to Al Applies the current clock recovery configuration to all
selected measurements that have user-configurable clock
recovery.

Apply Applies the current clock recovery configuration to all
selected measurement(s) that have Clock Recovery as the
configuration tab.

Advanced Displays the Clock Recovery Advanced Setup. For more

details, refer to the Clock Recovery Advanced Setup (see

page 129).

About Explicit Clock Recovery

In Explicit Clock Recovery, the reference clock is not derived from the measurement’s target source at all,
but isinstead taken from a separately-identified source. Since the source used for the measurement now
differs from the source used to derive the reference clock, selecting this type of clock recovery converts
the measurement from a single-source measurement to a dual-source measurement. The reference clock
source is always shown on the right when the two sources appear in a measurement table. Changing the
clock-recovery method back to a non-explicit clock method will change the measurement back to a

single-source measurement.
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Explicit Clock-Edge

136

Select Explicit Clock-Edge method if you want to use the edges found in the selected clock source
(possibly multiplied up by an integral number). If the Clock Multiplier is set to 1 (the default), only these
edges will be used. If the Clock Multiplier is set to anumber N other than 1, linear interpolation will be
used between each pair of actual edges to create N-1 additional reference edges. The interpolated edge
times, combined with the actual edges, give atotal of N reference edge times per actual edge.

Jitter and Eye Diagram Analysis Tools

| Measuremem Source(s)

4 _
Apphy to All*
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— |Explicit Clock — Edge | ¥ |

Clock Source Clock Edge

Channels ) o
Clock Multiplier

. * Copiezthese clock recovery settings to other measurements

Table 54: Explicit-Clock edge options

Item Description

Clock Source Select Chl to Ch4, Refl to Ref4, or Math1 to Math4 as
reference source for clock recovery.

Clock Edge Specify whether the rising, falling or both edges of selected
source should be considered.

Clock Multiplier Specify the number of edges to be used.

Apply to All

Apply Applies the current clock recovery configuration to all

selected measurement(s) that have Clock Recovery as the
configuration tab.

Advanced Displays the Advanced Explicit Clock-Edge (see page 137)
dialog wherein you can adjust the timing relation between
reference clock source and data source.
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Advanced Explicit Clock-Edge

Advanced Explicit Clock-Edge

To compare the reference clock times to the edge times from the data source, some assumptions must be
made about how they align. The default assumption is that each data source edge is associated with the
reference clock edge to which it is nearest in time. This assumption may not be optimum, for example if
the probes for the reference clock and data signal have different cable lengths.

To change the way the reference clock edges and data edges are associated, you can control the Nominal

clock Offset Relative to Data

o

Explicit Clock: Edge

o

Table 55: Advanced Explicit-Clock edge options

Every acquisition n

Item Description

Nominal Clock Offset Relative to Data

Auto Automatically calculates the clock data skew and shifts the
reference clock edges before the application associates
each data edge with the closest clock edge.

Manual Specify a time delay (positive or negative) to shift the
reference clock edge before the application associates each
data edge with the closet data edge.

Recalculate

When required

Recalculates the nominal clock offset value whenever a
new measurement is added or results are cleared or there
are any measurement configuration changes.

Every acquisition

Recalculates the nominal clock offset value for every
acquisition.

Related Topics

m  Effect of Nominal Clock Offset on Eye Diagrams (see page 140)
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Explicit Clock-PLL

Select Explicit Clock-PLL asthe clock recovery method if you want to feed the edges from the selected
clock source through a PLL rather than using them directly. The actual edges from the clock source will
be used to drive a software PLL model, and the edge times coming out of the PLL will be used as the
reference edges for the target measurement. If the Clock Multiplier is set to anumber N other than 1, the
output of the PLL will have N edges per actual edge.

Jitter and Eye Diagram Analysis Tools

= Measurement Source(s) 4 7
o |Explicii Clock —BLL " v | @

Clock Source Clock Edge

Filters o
Channels
Clock Multiplier

(mse)
(Bam) avances

. * Copies these clock recovery settings to other measurements

Table 56: Explicit-Clock PLL options

Item Description

Clock Source Select Ch1 to Ch4, Refl to Ref4 or Mathl to Math4 as
reference source for clock recovery.

Clock Edge Specify whether the rising, falling or both edges of selected
source should be considered.

Clock Multiplier Specify the number of edges to be used.

Apply to All

Apply Applies the current clock recovery configuration to all

selected measurement(s) that have Clock Recovery as
configuration tab.

Advanced Displays the Advanced Explicit Clock-PLL (see page 138)
dialog wherein you can adjust the timing relation between
reference clock source and data source.

Advanced Explicit Clock-PLL

In the Advanced Explicit Clock- PLL, you can specify the PLL type, bandwidth, damping factor and
nominal clock offset relative to data. Damping numeric input is enabled only for Type Il phase-locked loop.

138 DPOJET Jitter and Eye Diagram Analysis Tools



Operating Basics Advanced Explicit Clock-PLL

Nominal Clock Offset Relative to Data

To compare the reference clock times to the edge times from the data source, some assumptions must be
made about how they align. The default assumption is that each data source edge is associated with the
reference clock edge to which it is nearest in time. This assumption may not be optimum, for example if
the probes for the reference clock and data signal have different cable lengths.

To change the way the reference clock edges and data edges are associated, you can control the Nominal
clock Offset Relative to Data.

When roquired
-
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Table 57: Advanced Explicit-Clock PLL options

Item

Effect of Nominal Clock Offset on Eye Diagrams

Description

PLL Settings for Explicit Clock

JTF BW

Explicitly sets the JTF bandwidth of the clock recovery PLL
when the PLL Model is Type Il and the JTF BW radio button
is selected.

Loop BW Explicitly sets the Loop bandwidth of the clock recovery
PLL when the PLL Model is Type Il and the Loop BW radio
button is selected.

PLL Model Selects between Type | or Type Il phase-locked loop.

Damping Use the keypad to specify the damping ratio of the PLL. It is

enabled only for Type Il phase-locked loop.

Nominal Clock Offset Relative to Data

Auto

Automatically calculates the clock data skew and shifts the
reference clock edges before the application associates
each data edge with the closest clock edge.

Manual Specify a time delay (positive or negative) to shift the
reference clock edge before the application associates each
data edge with the closet data edge.

Recalculate

When required

Recalculates the nominal clock offset value whenever a
new measurement is added or results are cleared or there
are any measurement configuration changes.

Every acquisition

Calculates the nominal clock offset value for every
acquisition.

Related Topics

m Effect of Nominal Clock Offset on Eye Diagrams (see page 140)

Effect of Nominal Clock Offset on Eye Diagrams

Nominal Clock Offset does not affect the eye diagrams directly. Data and clock timing relationship is
maintained ignoring the clock offset value. The clock offset till affects the eye diagram shape indirectly
through edge labeling and TIE measurement but not with alignment.

When Explicit Clock Recovery is used, the Nominal Clock Offset does not affect eye diagram alignment.
The relative alignment between data and clock is maintained as acquired. An absolute aignment is
controlled by Ref Clock Alignment setting in Eye Diagram plot configuration panel. To ensure proper
alignment between data and clock it isimportant to properly deskew oscilloscope channels.
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Bit Config for Eye Height Measurements

This configuration tab alows you to select which waveform bit types (Transition bits, Non-Transition or
All Bits) are included when taking Eye Height.

Table 58: Bit Config for eye height

Item Description

Bit Type

All Bits Eye analysis includes both transition and non-transition bits.
Transition Eye analysis only on transition bits.

Non-Transition Eye analysis only on non-transition bits.
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Bit Config for Eye High, Eye Low, and Q-Factor Measurements

This configuration tab alows you to select which waveform bit types (Transition bits, Non-Transition or
All Bits) are included when taking Eye Height. This configuration tab also allows you to set the percent
of unit interval where the measurement is taken.

Jitter and Eye Diagram Analysis Tools
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Table 59: Bit Config for eye high, low, and Q-Factor

Item Description

Bit Type

All Bits Eye analysis includes both transition and non-transition bits.
Transition Eye analysis only on transition bits.

Non-Transition Eye analysis only on non-transition hits.

Measure at X% Sets the X% where the measurement is taken
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Bit Config for Height@BER Measurements

This configuration tab allows you to select which waveform bit types (Transition bits, Non-Transition,
or All Bits) are included when taking Height@BER measurements. This configuration tab also allows
you to select the measurement range in terms of percentage Ul and the number of binsto be considered
within the given range.

Jitter and Eye Diagram Analysis Tools
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Table 60: Bit Config for height@BER

Item Description

Bit Type

All Bits Eye analysis includes both transition and non-transition bits.
Transition Eye analysis only on transition bits.

Non-Transition Eye analysis only on non-transition bits.

Measurement Range (Ul%)

Start Defines the starting point of the analysis.

End Defines the ending point of the analysis.

# of Bins Defines the number of bits to be considered within the

specified interval.
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Bit Config for Mask Hits Measurements

This configuration tab allows you to select the waveform bit type (All Bits, Transition, or Non-Transition)
and the mask to be used for Mask Hits measurements.

Jitter and Eye Diagram Analysis Tools

" calecy )  Measurement  Source(s) Il
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Non-Transition
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Mask
C:\Users'Public’ Tektronic Tekapplications \DPOJET\Masks\P! | Browse)

Table 61: Bit Config for mask hits

Item Description

Bit Type

All Bits Eye analysis includes both transition and non-transition bits.
Transition Eye analysis only on transition bits.

Non-Transition Eye analysis only on non-transition hits.

Mask

Browse Allows selection of the mask file. (If none of the supplied

mask files meets your need, you may create a custom mask
file with a text editor by using one of the existing mask
specification files as a template.)

Advanced Advanced is only available for the AutoFit Mask Hits
measurement. Autofit determines the best mask offset.
With Manual you select the mask offset.
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Bit Config for Autofit Mask Hits Measurement

This configuration tab allows you to select the waveform bit type (All Bits, Transition, or Non-Transition)
and the mask to be used for Autofit Mask Hits measurements and Advance options.

Bit Type

Clock Transition Non-Transition

= @ @ @

Mask
C:%Users' Public’ Tektroni, Tekapplications \DPOJE T Masks"Fi ;

Table 62:

Bit Config for mask

hits Description

Bit Type

All Bits Eye analysis includes both transition and non-transition bits.
Transition Eye analysis only on transition bits.

Non-Transition Eye analysis only on non-transition bits.

Mask
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Table 62: (cont.)

Bit Config for mask

hits Description

Browse Allows selection of the mask file. (If none of the supplied mask files meets your need, you may
create a custom mask file with a text editor by using one of the existing mask specification files
as a template.)

Advance Displays the Mask Offset dialog box.

Autofit configuration: When Autofit is clicked, If “Autofit” configuration is selected, the backend
algorithm automatically identifies the best location where the pixel hits are either minimum or zero
in an eye diagram. The “Horizontal Mask Offset” value will get updated in Autofit text box.

Manual configuration: If Manual configuration is selected, the positive offset value will move the
mask to the right side and negative offset value will move the mask to left side of eye diagram.
We should add a short line of text at the bottom of the Horizontal section: “A positive value
moves the mask to the right”. There will be no mask movement for this particular configuration
(Manual = 0 seconds).
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Bit Config for Amplitude Measurements

Bit Config for Amplitude Measurements

This configuration tab is present only for High, L ow and High—L ow measurements. You can select the
waveform bit type (All Bits, Transition, Non-Transition) and method.

Jitter and Eye Diagram Analysis Tools

Table 63: Bit Config for amplitude measurements

Item Description

Bit Type

All Bits Eye analysis includes both transition and non-transition bits.
Transition Eye analysis only on transition bits.

Non-Transition

Eye analysis only on non-transition bits.

Measure the Center X% of the Bit

Determines what percentage (1 to 100) of a unit interval,
centered in the middle of the bit, shall be included in each
measurement. The waveform points selected by the
percentage form a distribution (vertical histogram) from
which a single value is extracted, based on the Method
control.

Method

Determines whether the Mean value or the Median of the
selected distribution is used for the measurement value for
each unit interval.
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Bit Config for PCI Express Measurements

148

This configuration tab alows you to select which waveform bit types (Transition, Non-Transition or All
Bits) are included when taking PCI Express measurements, PCle T-Tx-Rise and PCle T-Tx-Fall.

Jitter and Eye Diagram Analysis Tools

Measurement

PCle T-Tx-Fall1 Bit Type

All Bits: Transition Non-Transition

Table 64: Bit Config for PCI Express measurements

Item Description

Bit Type

All Bits Analysis includes both transition and non-transition bits.
Transition Analysis only on transition bits.

Non-Transition Analysis only on non-transition bits.
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BER for PCI Express Measurements

The BER configure panel is available for T-TX-UTJ, T-TX-UDJDD, T-TX-UPW-TJ,and
T-TX-UPW-DJDD measurements.

Jitter and Eye Diagram Analysis Tools
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Item Description

Target BER

BER= 1E-? Sets the Bit Error Rate exponent, thereby setting the
statistical level at which Total Jitter and Eye Opening are
reported.

Apply To All

Apply Applies the Target BER value to both Jitter Target BER and

Target BER for all the measurements that have the BER as
the configuration tab.

About RJ/DJ

This configuration tab allows you to select an appropriate decomposition method for jitter analysis. R¥DJ
decomposition analysis divides the timing jitter into various categories and uses the results to predict
the total jitter at a selected bit error rate (BER).

The DPOJET application offers two methods of R¥YDJ analysis:
B A method based on spectral analysisthat is appropriate for cyclically repeating data patterns.
B A method that works for arbitrary data sequences.
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This configuration tab allows you to guide the decomposition method based on the data pattern. By
default, the decomposition method is selected automatically based on the detected bit pattern. Thisisthe
recommended configuration.

Jitter and Eye Diagram Analysis Tools

Pattern Detection/Control Apply to All

Pattern Type Pattern Length
| [  TBD
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Table 65: RJ/DJ analysis of repeating options

Item Description

Pattern Detection/Control

Auto [Preferred] Causes the data pattern to be detected automatically on the
first acquisition following a “Clear” or configuration change.
Based on this detection, the Pattern Type and associated
controls are then configured optimally for the given record

length.

Manual Allows (and requires) that the Pattern Type and associated
controls be set manually.

Pattern Type When Pattern Detection is Auto, this field displays the

detected pattern type. When Pattern Detection is Manual, it
determines the method used to separate deterministic jitter
from random jitter. Repeating is the preferred method, but it
can only be used if the pattern is repeating and the repeat
length is known. Arbitrary can be used on a repeating

or non-repeating pattern, but it is more computationally
intensive and can be less accurate than the repeating
pattern method on repeating patterns.

Pattern Length (Only present when the Pattern Type is Repeating.) When
Pattern Detection is Auto, this field shows the detected
pattern length. When Pattern Detection is Manual, this
control must be set to match the actual pattern length. If the
manually-set pattern length is inconsistent with the detected
pattern length, processing will continue but a warning will
be logged.

Window Length (Only present when the Pattern Type is Arbitrary.)
Determines the number of unit intervals over which pattern
correlation effects are analyzed. The window should be set
to a large enough value that the impulse response of the
serial data transmitter and channel have settled.

Target BER *

BER= 1E-? Sets the Bit Error Rate exponent, thereby setting the
statistical level at which Total Jitter, Total Noise and Eye
Opening are reported.

Apply To All

Apply Applies all settings on this configuration tab to all other

measurements that have an RJDJ tab.

t  Only applicable to jitter measurements that perform extrapolation to a BER.

Related Topics
B RJDJAnalysis of Arbitrary Pattern (see page 152)
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m RJIDJAnaysis of Repeating Patterns (see page 152)

RJ/DJ Analysis of Repeating Patterns

This method of RJYDJ analysis uses a Fourier transform of the time-interval error signal to identify and
Separate jitter components. It is described in the Fibre Channel - Methodologies for Jitter and Signal
Quality Specification (MJSQ) and has wide industry acceptance.

This method requires that the data signal be composed of a pattern of N bits that are repeated over and
over. A minimum of 50 repeats of the pattern must be present. If you select Manual configuration, you
must enter the pattern length (N), although it is not necessary to know the specific bits that make up the
pattern. If you use the default “ Auto” configuration, this method will be selected if possible and configured
based on the detected bit pattern.

RJ/DJ Analysis of Arbitrary Pattern

When the data pattern is not repeating, or is unknown, a second method of RJDJ analysis may be used. (It
may also be used if the pattern is repeating, and correlates well with the Spectral method in this case.) This
method assumes that the Inter Symbol Interference (1S1) from a given edge only affects arelatively small
number of subsequent bits. For example, in aband-limited link where a string of ones follows a string of
zeros, the signal may require three or four bit periods to fully settle to the “high” state.

In this method, an analysis window with awidth of K+1 bitsis slid along the waveform. For each position
of the window, the time interval error of the rightmost bit in the window is stored, along with the K-bit
pattern that preceded it. After the window has been dlid across al positions, it is possible to calculate the
component of the jitter that is correlated with each observed K-bit pattern, by averaging together al the
observed errors associated with that specific pattern.

In the configuration menu for the arbitrary-pattern method, the Window Length field allows you to select
how many bits are included in the diding window. The window should include enough bits to allow the
impulse response of the system under test to settle, usually 5 to 10 bits. The disadvantage of increasing
the window length is that it uses more memory and requires additional processing time and greater
measurement population to form an answer. If the measurement population is not sufficient at the end of a
processing cycle to calculate an answer, the results table displays <Min# of UI.

Prior versions of DPOJET alowed direct control of the minimum number of observations required for
each data pattern, before aresult would be produced. This minimum is now set internally to 10. DPOJET
always uses all available observations; this control only set the minimum allowable.
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The arbitrary pattern approach for measuring jitter may not be appropriate if there are very-long-duration
memory effectsin your datalink. An example would be if there are impedance mismatch reflections that
arrive long enough after the initial edge to fall outside the analysis window.

Jitter and Eye Diagram Analysis Tools
[measurement | Source(s)
Bl oco P Refa
TJ@BER1

Pattern Detection/Control Apply to All

Pattern Type  Window Length

| @ Arbitrary_m | 10U1

Table 66: RJ/DJ analysis of arbitrary options

Item Description

Pattern Detection/Control

Pattern Type Selects between repeating or arbitrary pattern analysis.

Window Length When the Pattern Type is set to Arbitrary, sets the pattern window
length in terms of Unit Interval (Ul) used for arbitrary pattern RJ/DJ
separation.

Jitter Target BER f

BER= 1E-? Set the Bit Error Rate exponent, thereby setting the statistical level at
which Total Jitter and Eye Opening are reported.

Apply to All

Apply Applies the current RJ/DJ configuration settings to all the selected
measurement(s) that have the RJ/DJ as the configuration tab.

T Available only for TI@BER and Width@BER measurements.

Configuring Bus States

The following topic applies only to MSO series oscilloscopes, since it depends on the ability to define a
digital bus using the oscilloscope logic channels.

Use this configuration tab to select the bus states, clock source, edge and polarity used in measurements
that require a bus source. The configuration changes based on the selected measurement. Measurement
tCMD-CMD requires two different bus states to calculate the time between them. Select the bus states
using a bus symbol file or a bus pattern setup. Select between the options using the radio buttons.

If asymbol fileis not loaded, Enter pattern is selected. If a symbol fileisloaded, Use symbol fileis
selected. The symbol file loads commands into the drop down lists. The Bus State user interface staysin
sync with the Bus Setup window of the oscilloscope. Any change in Bus state configuration tab will reflect
in Bus setup window and vice versa.
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Configuring Bus States

When a symboal file is loaded, the From Symbol and To Symbol drop downs are displayed, with the
commands loaded from the symbol file. You can select the required Measure at bus states. Changing
Measure at to Clock Edge lets you set the clock source and polarity. Clock Edge considers the time at
which commands are registered, that is, at the Rising or Falling edge of the clock, depending on the

Clock Polarity configuration.

Jitter and Eye Diagram Analysis Tools

the timing bety

. () Use symbol file

. [ Enter pattern

the ing bus states

From Symbol

To Symbol

|MODE_REG | ¥ |

|MODE_REG | ¥ |

M at

Measure at

F Edge
w\m"\___'/CT_\'

Bus T )(Symbo)

Symbol File

|Clock Edge | v |

|Clock Edge | v |

Clock Edge Settings
Clock Source

Clock Polarity

|ch3 [v]

|Rising | v |

Measurements like tCK SRE reguire one waveform source and one bus state. Select the waveform source
from the Clock Source drop down or the Source Configuration window. Your selected source is the first
choice in the Clock Source drop down. Select the bus state using the Symbol drop down.

Jitter and Eye Diagram Analysis Tools

|GDDRStCKSRE1 | ™% Bi,ch3 || Bus State

M the timing bety

the wa

| (+) Use symbol file
. () Enter pattern

From Symbol
SRE v
M at

Edge

Bus e

Symbol File

Clock Edge | ¥

source and this bus state

Clock Edge Settings
Clock Source

Clock Polarity

|Ch3 [*]

|Rising | v ‘

The tBurst-CMD measurement is a single-source measurement by default. The Measure at selection does
not have a Clock Edge selection, only Start and Stop.

Jitter and Eye Diagram Analysis Tools
| AC Common Mode1 | jch1,Ch2
| Period1 e

| GDDRS tBurstchD1 |75 B1 |

™ the timing bety

the wa

() Use symbol file

To Symbol

{+) Enter pattern

Start

SIMD

o Yoo

source and this bus state
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Select Enter pattern to directly enter the required symbol bit patterns.

Jitter and Eye Diagram Analysis Tools

Sours} Measure the timing between the following bus states

™ B1.ch3
From Symbol To Symbol

. Use symbol file
ooooo. |

1 ."..= Enter pattern
M at Measure at
|start |v| |clock Edge

Relevant Edge

Clock Edge Settings

Clock Source Clock Polarity
cns  [v]  [rsng|¥]

Table 67: Bus state options

Item Description

Use symbol file Use the bus state in the symbol file.

Enter pattern Specify a bus state pattern.

Symbol File Browse for the symbol file to use.

Between source and bus state

Symbol The bus state symbol to use in measurements.
Measure at Specify where to take the measurement.

Clock Edge Settings

Clock Source Specify the clock source for the measurement.
Clock Polarity Specify the clock polarity for the measurement.
Between bus states

From Symbol Specify where the measurement is take from.

To Symbol The symbol file specifies where to measurement to.
Measure at The symbol file specifies where to take the measurement.

Start - Considers Start time of the command.

Stop - Considers Stop time of the command.

Clock Edge - Considers the time at which Commands are registered,
that is, at the Rising edge of the clock.

Configuring Edges

This configuration tab allows you to select which waveform edge or edges the application will use to take
each measurement. Depending on the particular measurement, the tab will offer access to other options
and constraints that help guide the analysis. The application is able to automatically detect whether
asignal is clock or data, and will do so by default. This can be overridden by configuring the signal

type as Clock or Data.
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Configuring Edges

The following configuration options apply to most measurements. See the subsequent sections for Edge

tabs corresponding to particular measurements.

Jitter and Eye Diagram Analysis Tools

Item Description

Signal Type

Clock Forces the signal type to be interpreted as a Clock.
Measurements will take place on the edges specified by
the Clock Edge control.

Data Forces the signal to be interpreted as a Data. Both rising
and falling edges are used.

Auto Allows the application to automatically detect whether
the signal is clock or data. If the signal is a clock, the
Clock Edge control will determine which edges are used;
otherwise the Clock Edge control will have no effect.

Clock Edge

Rise Uses only the rising edges of the signal.

Fall Uses only the falling edges of the signal.

Both Uses both the rising and falling edges of the signal.
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Configuring Edges for Skew Measurements
This configuration tab is displayed for Skew measurements.

Jitter and Eye Diagram Analysis Tools

| Measurement Sourcefs) |,

|
| Skew1 5" chi,ch2 ‘

Item Description

From Edge - Defines which edge of the first waveform is used to take measurements.

Rise Uses only the rising edges of the signal.

Fall Uses only the falling edges of the signal.

Both Uses hoth the rising and falling edges of the signal.

To Edge - Defines which edge on the second waveform is used to take measurements.

Same as From Each measurement is defined by a pair of like edges (Rise
to Rise or Fall to Fall).

Opposite as From Each measurement is defined by a pair of opposing edges

(Rise to Fall or Fall to Rise).
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Configuring Edges for Differential CrossOver Voltage Measurements

This configuration tab is displayed for Differential CrossOver Voltage measurements.

Jitter and Eye Diagram Analysis Tools

|Measurement | Source(s) ||
| Skew jcn1,ch2

V-Diff-Xovr1 T cnicnz |
Filters

Item Description

Main Edge - Defines which edges on the Source1 waveform are used to take the measurement.

Rise Uses only the rising edges of the signal.

Fall Uses only the falling edges of the signal.

Both Uses Both the rising and falling edges of the signal.
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Configuring Edges for Phase Noise Measurements

This configuration tab is displayed for Phase Noise measurements. Phase noise measurements are
undefined for data signals, so the signal is assumed to be a clock.

The Noise Integration Limits determine the portion of the phase noise spectrum that is integrated to
produce a single measurement per waveform acquisition.

Jitter and Eye Diagram Analy5|s Tools

Sourcn[s} ’
| Skew1 - lomenz  |RELE
| V-Diff—Xovr1 ﬂcm Ch2

Moise Integration Limits

1MHz

Lower Frequency
OHz

Item Description

Active Edge-Defines which edge of the source waveform is used to take measurements.

Rise Uses only the rising edges of the signal.

Fall Uses only the falling edges of the signal.

Both Uses both the rising and falling edges of the signal.

Noise Integration Limits

Upper Frequency Sets the upper end of the noise integration frequency range.
Lower Frequency Sets the lower end of the noise integration frequency range.
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Configuring Edges for N-Period Measurements

Configuring Edges for N-Period Measurements

160

This configuration tab is displayed for N—Period measurements.

Jitter and Eye Diagram Analy5|s Tools

Item Description

Signal Type

Clock Forces the signal to be interpreted as a Clock.
Measurements will take place on the edges specified by
the Clock Edge control.

Data Forces the signal to be interpreted as a Data. Both rising
and falling edges are used.

Auto Allows the application to automatically detect whether
the signal is clock or data. If the signal is a clock, the
Clock Edge control will determine which edges are used;
otherwise the Clock Edge control will have no effect.

Clock Edge

Rise Uses only the rising edges of the signal.

Fall Uses only the falling edges of the signal.

Both Uses both the rising and falling edges of the signal.

N= Specifies number of cycles or unit interval in each N-period

group.

Edge Increment

Specifies the temporal displacement in edges between
consecutive measurements.
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Configuring Edges for Two Source Measurements

This configuration tab is displayed for two source measurements: Setup and Hold.

Jitter and Eye Diagram Analysis Tools

Skew1 jcmch2
V-Diff-Xovr1 jcnicn2
Phase Noise1 Elcm
N-Period1 licm

Clock Edge {Source1) Data Edge (Source2)

&=
; 'F' Ch1,Ch2 i @
-~

Hold1 Ljcnicn2

&

Item Description

Clock Edge(Source 1)

Rise Uses only the rising edges of the signal.

Fall Uses only the falling edges of the signal.

Both Uses hoth the rising and falling edges of the signal.
Data Edge(Source 2)

Rise Uses only the rising edges of the signal.

Fall Uses only the falling edges of the signal.

Both Uses hoth the rising and falling edges of the signal.
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Configuring Edges for CC-Period/Duty Cycle Measurements

Configuring Edges for CC-Period/Duty Cycle Measurements

162

This configuration tab is displayed for the CC—Period, +Duty Cycle and —Duty Cycle measurements.
These measurements are only defined for clock signals, and each measurement value is evaluated over one

full clock cycle.

Jitter and Eye Diagram Analysis Tools

|
|

Item Description

Clock Edge

Rise Measurements are only initiated on the Rising edges of the
clock signal.

Fall Measurements are only initiated on the Falling edges of
the clock signal.

Both Measurements are initiated on both the Rising and falling

edges of the clock signal.
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Configuring Edges for DCD M easurement

Configuring Edges for DCD Measurement

This configuration tab is displayed for DCD measurement.

Jitter and Eye Diagram Analysis Tools

Item Description

Signal Type

Clock Forces the signal type to Clock. Edges are selectable.

Data Forces the signal type to Data. Both rising and falling edges
are used.

Auto Automatically detects whether the signal is clock or data.
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Configuring Edges for Overshoot/Undershoot Measurements

This configuration is displayed for both Overshoot and Undershoot measurements. The algorithm
calculates the maximum peak amplitude above/below the specified edge configuration reference level
voltage (see page 97) for Overshoot/Undershoot measurements.

An Overshoot event is defined by arising crossing followed by afaling crossing of the reference level.
Undershoot is defined by afalling crossing followed by arising crossing of the reference level.

The difference between the peak amplitude and the reference level voltage is shown in the measurement
results, expressed as a positive value in al cases. The results are stored zero for the cycles which do not
have Overshoot/Undershoot.

Ref Voltage

o
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Configuring Edges for Rise Slew Rate
This configuration is displayed for Rise Slew Rate measurement:

Jitter and Eye Diagram Analysis Tools

~ Source(s)
™ cm

From Level To Level Slew Rate Technique

w @
@& @

|Nominal Method

Item Description

From Level

Mid Uses the source configuration mid reference voltage level
for the Rise slew rate.

Low Uses the source configuration low reference voltage level
for the Rise slew rate. Default is low.

To Level

High Uses the source configuration high reference voltage level
for the Rise slew rate.

Mid Uses the source configuration mid reference voltage level

for the Rise slew rate.

Slew Rate Technique

Nominal Method Determines the slew rate between From->Low level to
To->High level.
DDR Method Determines the slew rate between low to high reference

level. If the actual signal is earlier than the nominal slew
rate line, then the slew rate is calculated using the tangent
method From->Low level to To->High to the sample, which
occurred earlier.

Reference

®  High Mid and Low Reference Voltage Levels (see page 97)
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Configuring Edges for Fall Slew Rate

This configuration is displayed for Fall Slew Rate measurement:

Jitter and Eye Diagram Analysis Tools

~ Source(s)
7 cm

Slew Rate Technique
|Nominal Method [*]

Item Description

From Level

High Uses the source configuration high reference voltage level
for the Fall slew rate.

Mid Uses the source configuration mid reference voltage level
for the Fall slew rate. Default is low.

To Level

Mid Uses the source configuration mid reference voltage level
for the Fall slew rate.

Low Uses the source configuration low reference voltage level

for the Fall slew rate.

Slew Rate Technique

Nominal Method

Defines the slew rate between From->Low level to To->High
level.

DDR Method Determines the slew rate between high to low reference
level. If the actual signal is earlier than the nominal slew
rate line, then the slew rate is calculated using the tangent
method From->High level to To->Low to the sample, which
occurred earlier.

Reference

m High Mid and Low Reference Voltage Levels (see page 97)
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Configuring Edges for DDR tCH(avg) and DDR tCL(avg)

This configuration tab is displayed for both DDR tCH(avg) and DDR tCL (avg). Set the window size for
clock measurements. The measurement analysisis done on a dliding window of size 200 cycles with astep
increment of 1 cycle. You can set window size up to 1M, with at least 200.

Jitter and Eye Diagram Analysis Tools

| DDR tCH(avat LJReft

oo o e |

DDR tCL{ava)1
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Configuring Edges for DDR tERR(m-n)

Configuring Edges for DDR tERR(m-n)

168

This configuration tab is displayed for DDR tERR(m-n) measurement.

Jitter and Eye Diagram Analysis Tools

| Measurement
DDRAERR{M n)1

Number of Periods

Minimum Maximum
6 10

Window Size

w0

Item Description

Clock Edge

Rise Measurements are only initiated on the Rising edges of the
clock signal.

Fall Measurements are only initiated on the Falling edges of the

clock signal.

Number of Periods

Minimum Specify the minimum number of periods required to calculate
error across multiple consecutive cycles from tCK(avg).

Maximum Specify the maximum number of periods required to
calculate error across multiple consecutive cycles from
tCK(avg).

Window Size Measurement analysis is done on a window of size 200

cycles with a step increment of 1 cycle. As per the standard,
the default window size is 200. You can set window size
up to 1M.
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Configuring Edges for DDR tERR(n)

Configuring Edges for DDR tERR(N)

This configuration tab is displayed for DDR tERR(n) measurement.

Jitter and Eye Diagram Analysis Tools
TSR amBHE éu’uice[s'] =
Data Eye Width Jrapos i
tAC-DIff jckna .
tDQSCK-Diff LJpascK |2

tDQSQ-DIff .Jpas,pa

ooREr o0

Number of Periods

HN=

7

Window Size

T

Item Description

Clock Edge

Rise Measurements are initiated only on the Rising edges of the
clock signal.

Fall Measurements are initiated only on the Falling edges of the

clock signal.

Number of Periods

Timing error (tERR) requires number of periods (n(per))
to calculate error across multiple consecutive cycles
from tCK(avg). You can configure n(per) up to 50, with a
resolution of 1.

Window Size

Measurement analysis is done on a window of size 200
cycles with a step increment of 1 cycle. As per the standard,
the default window size is 200. You can set window size
up to 1M.
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Configuring Edges for DDR tHZDQ and DDR tLZDQ

This configuration tab is displayed for both DDR tHZDQ and DDR tLZDQ.

Jitter and Eye Diagram Analysis Tools

AT, I| Measurement | Smme{s]

|| coues

| DDR tLZDA1 lajcnen2 High Ref Voltage
v

Low Ref Voltage
B800mV

Extrapolation

T00mV

Configuring Edges for DDRtJIT(per), DDRtCK(avg) and DDRtJIT(duty)

This configuration tab is displayed for DDRtJIt(per), DDRtCK (avg) and DDRtJI T (duty).

Jitter and Eye Diagram Analysis Tools

\ | Measurement | Source(s) |
DDR tIT(per)1 |LJRen
DDR tCH{ava)1 |LJRef1

T

Item Description

Clock Edge

Rise Measurements are only initiated on the Rising edges of the
clock signal.

Fall Measurements are only initiated on the Falling edges of the
clock signal.

Window Size Measurement analysis is done on a window of size 200

cycles with a step increment of 1 cycle. As per the standard,
the default window size is 200. You can set window size
up to IM.
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Configuring Edges for Time Outside Level
This configuration is displayed for the Time Outside Level measurement:

Jitter and Eye Diagram Analy5|s Tools

5 [ “eawmmmt Souroe[s}

| SSC Profile1 ajcnt

@ SSC Mod Rate1 Elcm
| SSC Freq Devi Ecm
SSCFreqDevMin1 | jch1

/ | SSCFreqDevMax1 [ ]
| Time Outside Levelt |MF® ch1

/ | tCMD-CME Time Outside Levell
|

High Ref Voltage
o

Item Description

Level

High Time Outside Level measurement is computed only in
overshoot using High Ref Level.

Low Time Outside Level measurement is computed only in
undershoot using Low Ref Level.

Both Time Outside Level measurement is computed in both
overshoot and undershoot using High and Low Ref Levels.

High Ref Voltage Displays or allows you to define the high reference voltage
level.

Low Ref Voltage Displays or allows you to define the low reference voltage
level.

Reference

m High Mid and Low Reference Voltage Levels (see page 97)

Spread Spectrum Clocking (SSC)

This configuration tab allows you to set the nominal frequency of the Spread Spectrum Clocking (SSC).
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Jitter and Eye Diagram Analysis Tools

MNominal frequency

| SSC Mod Ratet e

| ssC Freq Dev B ch : _ (+) Auto TBD

SSC Freq Dev Min1 chi

¢ | SSCFreqDevMax1 [ Zjch1

ITimeOutsEdeLeveH @CM | - ! { Manual 2.5GHz
(_Piots ) |tCMD-CMD1 s

Table 68: Spread spectrum clock

Item Description
Nominal frequency
Auto Allows the application to determine the frequency.
Manual You enter the nominal frequency of the spread spectrum
clock.
Sequencing

Use the Control Panel (see page 82) to start or stop the sequence of processes the application and
oscilloscope use to acquire information from awaveform. The application then determinesif the algorithm
for the selected measurement can be applied to the waveform information. Sequencing is the steps to
acquire waveform information, determine if the information is usable for the measurement, take the
measurement, and display the results (and plots if selected).

When you click Recalc, Single or Run, the corresponding button is changed to Stop and the Progress
indicator is displayed. For more details, refer to the Control Panel (see page 82).

Eye Diagram...
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The Progress Indicator displays the sequencer state. Select Stop, if you want to interrupt the sequence
before its completion.

For more details on progress bar status messages, refer to Progress Bar Status M essages (see page 237).
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Viewing Statistical Results

Viewing Statistical Results

The application displays results for the measurements for all acquisitions or for the current acquisition. By
default in the detail view, the limits will not be shown unless the limits are turned on.

Jitter and Eye Diagram Analysis Tools
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Result statistics for most of the measurements show Population in terms of Ul or transitions. According to
the JEDEC specification, the analysis for most of the clock measurements is done for a 200-cycle moving
window. However, for clock measurements such as DDRtCL (avg) and DDRtCH(avg), the population is
shown as tCK (avg) units. For Data Eye Width, the population number is shown as per acquisition.

Table 69: Results menu options

Item Description
e Displays an error message. You can click e to view the
error log information in a text editor.
N - - ",/ P
. Displays a warning. You can click "-=&" to view the error
log information in a text editor.
Description Lists the measurement name and the source.
Mean Lists a statistical mean value for the measurement data.
Std Dev Lists a statistical standard deviation value for the

measurement data.

Max Lists a statistical maximum value for the measurement data.
Shows Pass if the statistics is within the specified Upper
Limit Equality (ULE).

Min Lists a statistical minimum value for the measurement data.
Shows Fail if the statistics has crossed the specified Lower
Limit Equality (LLE).

p-p Lists a statistical peak-to-peak value for the measurement
data.

Population Lists the total number of measurement data points used
for displaying the statistics.

Max-cc Lists the maximum cycle-to-cycle differences per acquisition.
Min-cc Lists the minimum cycle-to-cycle differences per acquisition.
=] Click to view Save Current Stats, Export to Ref Waveform,

o and Display Units-Absolute options.

Options

Save Current Stats... Saves the current statistics as log information.

Export to Ref Waveform Exports time trend data of the selected measurement to
the reference memory.

Display Units- Absolute Default display unit is Absolute.

= Click to view the result details.

T Jitter measurements such as RJ, DJ show population in terms of acquisitions.

NOTE. For Mask Hits measurement, only Mean, Max, Min and Population values are displayed in the
resultstable. On clicking #/, Hitsin Segment 1, Segment 2 and Segment 3 are displayed. For Mask Hits
measurements, mean indicates the total number of hits for all acquisitions.
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The results tab with limits turned on is as shown. You can click the zoom icon, available for Max and
Min values irrespective of the limits being turned on/off in the current acquisition. A tool tip displays the
message “ Click to view the event on the waveform” and appends the result statistics in full resolution
(without any truncation) on hovering the mouse.

NOTE. The zoom feature is available only for vector measurements.

Jitter and Eye Diagram Analysis Tools

T Overall Test Result: s Pass

| Pass/Fail | Mean

e e e
| High Limit uWPnss 56.500ps |
| Low Limit J Pass -56.500ps

| High Margin J Pass 0.043821ns

| Low Margin & Pass 0.024071ns

| Current Acquisition 0.0000s 8.9608ps 12.679ps (R -32.429ps | 45.108ps

Width1, Ref1 Pass  354.89ps 0.0000s 354.89ps 354.89ps 0.0000s

i |[#] Height1, Ref1 532.42mV 0.0000V 532.42mV  Click to view the event on the waveform
LBRORES !‘ ' 1.26789884011958E-115

Results with Error/Warning Notification

The results tab with error 8 icon isas shown. Click View Log to view the error log information in a
text editor.

Jitter and Eye Diagram Analysis Tools
Overall Test Result: &3 Fail

| PassiFail  Mean | Std Dev | Min
P pass | 400.00ps 7.4478ps 42365ps 381.33ps 42.320ps
+ Pos Width1, Ref1 528.98ps 404.42ps 2.0173ns 386.22ps 1.6311ns
+Duty Cycle1, Ref1 49.257% 11.014% 82.961% 27.519% 55.441%
[+ —Duty Cycle1, Ref1 50.743% 11.014% 72.481% 17.039% 55.441%
| —CC—-Duty1, Ref1 190.42fs 597.89ps 1.6074ns -1.6021ns 3.2095ns
\ ‘._ [ +CC—Duty1, Refl 4.1636fs 600.51ps 1.6277ns 1.6184ns 3.2460ns
@ DJ1, ReM 35.020ps 0.0000s 35.020ps 35.020ps 0.0000s
30.708ps 0.0000s 30.708ps 30.708ps 0.0000s
|# RJ1, Ref1 1.5263ps 0.0000s 1.5263ps 1.5263ps 0.0000s

The results tab with warning _!l icon is as shown. You can click View Log to view the error log
information in atext editor.
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Viewing Statistical Results

Jitter and Eye Diagram Analysis Tools

TIE1, Reft . ! 12.67%ps 32.420ps
[® RJ1, Reft 1.5263ps 0. 1.5263ps 1.5263ps
[® RJ-561, Ref1 1.5263ps 0. 1.5263ps 1.5263ps
() TJ@BER1, Ref1 53.457ps 0. 53.457ps 53.457ps
[ DJ1, Reft 35.020ps 0. 35.020ps 35.020ps
[+ DJ-551, Refl 32.000ps 0. 32.090ps 32.090ps
[# PJ1, Reft 821.94fs O 821.04fs 821.94fs
[ DDJ1, Reft 30.708ps 0. 30.708ps 30.708ps
[+ DCD1, Reft 3.4905ps 0. 3.4905ps 3.4905ps

Overall Test Result
There are two ways to view the statistical results of measurements:

® Summary (see page 178)

®  Details (see page 179)

NOTE. Alternatively, you can toggle between Summary and Details using the Expand/Collapse button.

On clicking Single/Run, the Overall Test Result shows Pass/Fail icons depending on the result of the
measurement(s).

Jitter and Eye Diagram Analysis Tools
Overall Test Result: Pa,sg
| | PassfFail | Mean

W_ 1?-679»5 |-52.4290

0.024071ns

| Current Acquisition 8.9608ps 12.679ps B -32.420ps &) 45.108ps
j&] Width1, Refl (#Pass  354.89ps 0.0000s 354.89ps 354.89ps 0.0000s
s, || | Height1, Ref1 532.42mV 0.0000V 532.42mV  Click to view the event on the waveform

1.26739684011958E-115

For example, the Overall test result isfail if any measurement has limit failure. The result statistic which
has failed is highlighted in red as shown:
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Jitter and Eye Diagram Analysis Tools

[l = Perioat, Rert
| High Limit € Fall  400.12ps
| Low Limit (sPass  399.88ps

| High Margin @Fal  0.03346ns
| Low Margin (4Pass  0.03370ns
io:menmmisiﬁon 33.984ns 5.4968ns 40.075ns & 29.901ns & 10.474ns

NOTE. When limits are turned off, Summary and Overall Test Result options are not available.

Summary

Displays the summary of the results for all acquisitions. Pass/Fail information is included whereas
Max-cc and Min-cc information is excluded. Click the Expand button for the summary view as shown:

Jitter and Eye Diagram Analysis Tools
Overall Test Result: 4 Pass
Erer [Pascad ] W
_‘_ (=) TIE1, Ref1 # Pass 0.0000s 8.9608ps 12.679%ps -32.42%s 45108ps
High Limit s Pass 56.500ps
Low Limit J Pass -56.500ps
High Margin \J Pass 0.043821ns
Low Margin \J Pass 0.024071ns
Current Acquisition 2.9608ps 12.679ps & -32.429ps & 45.108ps 3750

sonps | ssamses ooooes |1 |

irligll Limit

1 | imit ik Dace 07 e
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Details

Displays the detailed results specifying values for High Limit, Low Limit, High Margin, Low Margin,
Pasg/Fail, and current acquisition. Click the Expand button for the details view as shown:

Jitter and Eye Diagram Analysis Tools

| Description Mean | StDev | Max ‘ pD
|| TIEA, Reft | 0.0000s  89608ps  12679ps  32429ps  45.108ps 3750 23.649ps  -37.343pe
High Limit 56.500ps
Low Limit -56.500ps
High Margin 0.043821ns
Low Margin 0.024071ns
‘ Pass Fail s Pass s Pass |
| Current Acquisition 0.0000s  8.9608ps  12.679ps & -32.429ps & 45.108ps 3750 23.649ps  -37.343p;

I T 7 Y R (YT

| Hiah §imit

Export Results to Ref Waveform

Using this option, you can export the time trend plot of a measurement to any of the available reference
memory, Ref1-Ref4. Click “® on the right corner of the results panel to select the “ Export Results to
Ref” option.

The Export Results to Ref waveform dialog box appears. It lists al the possible measurements that have
time trend result data (that is measurements for which time trend plot is enabled in the plot panel).

From the list of measurements, results of any one measurement can be exported to any one of the reference
memory (Ref1-Ref4) which is not used as the source of any measurement.

Export Results to Ref Wa
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Before exporting results to a reference memory, the application checks for the following:

If any of the ref waveforms are already used as source for one of the measurement(s), then you cannot
export the results on those ref destinations. The application prevents exporting by displaying an
error message 2003 (see page 238).

If al the reference waveforms (Ref1-Ref4) are already used as sources for various measurements, the
“Export Results to Ref Waveform” is not displayed. Instead, an error message 2002 (see page 238) is

displayed.

If aref destination is assigned to a measurement from the list which is not empty (that is, if theref is
already defined and holds any other recalled waveform), awarning prompts you from overwriting the
existing definition of the selected destination ref.

In case of any error (2002 or 2004) or warning (Overwriting the existing definition) and you select
the response as “N0”, the destination ref reverts to its previous value. For example, if the selected
measurement is Period-Ref1, and the destination ref assigned to the measurement is Ref3, and if you
try to change the destination from Ref3 to Ref1, an error message 2003 (see page 238) is displayed.
Ref3 is retained as the destination ref.

Time trend result export to the reference waveform for a measurement is independent of time trend
plot. Time trend result can be exported to ref without selecting/defining plots in the plots panel.

If “Export Results to Ref” is selected without any measurement selection, an error message 2005

(see page 238) is displayed.

If none of the selected measurements have time trend data, an error message 2007 (see page 238) is
displayed and “Export Results to Ref” dialog is not displayed.

If the selected measurements have no results (results are cleared or measurements are not run to
produce results), an error message 2006 (see page 238) is displayed and “ Export Results to Ref”
dialog box is not displayed.

If the destination is none for all measurements, the results are not exported to ref on clicking OK. An
information/warning 2008 (see page 238) is displayed.

Results as Plots

180

The application can display the results as two-dimensional plots for easier analysis. Before or after you
take measurements, you can set up the Select Plots and Plots Configure menus to define up to four plots.
The last plot selected is displayed when the application completes sequencing (see page 172).

NOTE. Plots are not available for DDR tJI T(duty), DDR tJI T(per), DDR tERR(n), DDR tERR(m-n), PCle
Tmin-Pulse, PCle Med-Mx Jitter, PCle Tmin-Pulse-Tj, PCle Tmin-Pulse-Dj, USB UI,DDR VID(ac), USB
SSC FREQ DEV MAX and USB SSC FREQ DEV MIN, ps21TXand T-TX-DDJ measurements.

If you set up plots after sequencing, the application displays the plot based on the current measurement
and result.
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Results as Plots

NOTE. When taking measurements in the Run mode, you must stop the sequencing before you can use

some plot features.

Jitter and Eye Diagram Analysis Tools

N ‘lﬂwmremem  Source(s) I &
TIE1 ™ cm ) )

| Time Trend Data Array  Histogram

R oL oD U

TJ@BER1 Lajcm

RJ-561 Ljcm Spectrum

DJ-561 Elcm
Width@BER1 lcm
Period1 Ljcm

Table 70: Plot type definitions

Histogram TIE1,Ch1

. Spectrum TIE1,Ch1
Eye Diagram
Eye Diagram  Height1,Ch1

Bathtub TJ@BER1,Ch1

Item Description

Time Trend Represents the measurement values versus the time
location.

Data Array Represents the measurement values versus the index
number of the measurement array.

Histogram 1 Represents measurements sorted by value as a distribution
of measurement values versus the number of times the
value occurred.

Spectrum Represents the frequency content computed using the FFT
of the Time Trend of the measurement data.

Transfer Represents the magnitude ratio of spectrum of time trend

data of two measurements from the following set; Clock
Period, Clock Frequency, Clock TIE, Clock PLL TIE, Data
Period, Data Frequency, Data TIE, Data PLL TIE.

Phase Noise 2

Represents the phase noise of a clock signal and is plotted
in the frequency domain for only Clock TIE measurements.

Eye Diagram 3

Represents data for the eye diagram based on the
recovered clock as the timing reference; used for mask
testing.

Waveform 4 Represents the acquired waveform. It is available for use
with eye diagram mask tests to locate bit errors in the
real-time waveform.

Bathtub 5 Represents the Bit Error Rate versus the unit interval for
measurements that include RJ/DJ analysis.

Q-Bathtub 6 Represents Q-Scale value versus the Unit interval for the

PCle 3 Uncorrelated Jitter Measurements.

DPOJET Jitter and Eye Diagram Analysis Tools
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Table 70: Plot type definitions (cont.)

Item Description

Q-PulseWidth 7 Represents Q-Scale value versus Time for the PCle 3
Uncorrelated Pulse Width Jitter Measurements.

Composite Jitter Hist Plots four Histograms (TJ, RJ+BUJ, PJ, DDJDCD) together.

1 Available for all measurements except Mask Hits, DDR tJIT(duty), DDR tJIT(per), DDR tERR(n), DDR tERR(m-n), PCle Tmin-Pulse, PCle Ul
and PCle Med-Mx Jitter.

Available only for Phase Noise measurement.

Available only for all Eye, TIE and PCle-T-TXA measurements.

Available only for Mask Hits measurement.

Available only for TJ@BER and Width@BER measurements.

Available only for PCle TTX-UDJDD and PCle TTX-UTJ measurements.
Available only for PCle TTX-UPWTJ and PCle TTX-UPWDJDD measurements.

You can select the measurements from the displayed measurement list table on the left. The Plots for the

selected measurements are displayed in Select Plots. The plots which are not applicable for the selected
measurement are not available under Select Plots. You can select up to 4 plots.

N o o AW N

Plot Usage
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This section provides a description of various plots such as Histogram, Time Trend, Data Array, Spectrum,
Transfer, Phase Noise, Eye Diagram, Waveform, and Bathtub.

Histogram Plot Usage

A Histogram plot displays the results such that the horizontal axis represents the measurement values and
the vertical axis represents the number of times that each value occurred. Unlike most other plots, a
histogram plot can accumulate measurements over multiple acquisitions, up to atotal population size of
2.1 billion.

Histograms are particularly useful in analyzing jitter. A histogram of the Time Interval Error (TIE)
represents the basis of jitter analysis using a histogram approach. In a histogram, Deterministic Jitter (DJ)
is bounded so that the horizontal span of the plot will remain relatively constant. Random Jitter (RJ) is
unbounded and amplitude (horizontal span) will continue to grow as more population is acquired. The TIE
histogram provides a good way to quickly and informally assess jitter.

Spectrum Plot Usage

A Spectrum plot is obtained from the Fourier Transform of measurement data from a Time Trend.
This plot is useful in identifying periodic frequency components that contribute to timing errors, such
as phase modulation.

When the signal has arepetitive data pattern, an analysis of the TIE Spectrum of the signal can be used to
separate Random Jitter (RJ) from Deterministic Jitter (DJ) as well as to separate subcomponents such as
Periodic Jitter (PJ), ISl and DCD. Spectral components (spikes) that do not correlate with the frequencies
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contained in the data pattern can be a clue that external deterministic noise sources are coupling into a
system.

Data Array Plot Usage

A Data Array plot shows measurement values versus measurement index, where the indexes are always
equally spaced along the horizontal axis. In contrast, the measurement values on a Time Trend plot are
not equally spaced along the horizontal time axis.

Time Trend Plot Usage

A Time Trend plot is awaveform trace of a measurement versus time. Each measurement value is placed
precisely at the time at which the measurement took place. Measurements that involve two timing points
are placed at the midpoint between those two time. For example, a Risetime measurement is placed
halfway between the low threshold crossing and the high threshold crossing.

A Time Trend plot is useful, for example, in determining if the embedded clock in a serial bit streamis
modulated outside the capabilities of your receiver to recover the clock. If the TIE time trend plot starts
to take an unexpected periodic shape, then this could indicate that you have uncorrelated periodic jitter
from crosstalk or from power supply coupling.

Bathtub Plot Usage

A Bathtub curve is the industry standard way of viewing the statistical Jitter Eye Opening. A Bathtub
curve represents eye opening as a function of the BER (Bit Error Ratio). Most serial standards call for
Total Jitter to be measured at a BER of 10-12. The eye opening represented by the Bathtub Curveiswhat is
left of the unit interval after the total jitter measurement is subtracted.

The Jitter Eye opening and the Total Jitter have the following relationship:
Total Jitter + Jitter Eye Opening = 1 Unit Interval

DPOJET Jitter and Eye Diagram Analysis Tools 183



Operating Basics Plot Usage
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The Bathtub Curve plot shows the eye opening and total jitter values as functions of the BER level. The
plot is obtained from jitter analysis that performs RJDJ separation.
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Q-Bathtub Plot Usage

TTX-UTJand TTX-UDJDD are two jitter measurementsin the PCI Express 3.0 Compliance Specification.
The Q-Bathtub plot provides a graphic visualization of the Q-Scale extrapolation used to arrive at the
measurement value. The plot represents the Q-Factor value on the y-axis over one unit interval on the
x-axis and the extrapolation points are clearly indicated.

Q-PulseWidth Usage

TTX-UPWTJ and TTX-UPWDJDD are two critical jitter measurements in the PCI Express 3.0
Compliance Specification. The Q-PulseéWidth plot provides a graphic visualization of the Q-Scale
extrapolation used to arrive at the measurement value. The Q-Factor valueslie on the y-axis, and the x-axis
represents a part of one unit interval significant for the measurement.

Phase Noise Plot Usage

A Phase Noise plot shows a frequency domain view of the jitter noise on a waveform normalized in
an industry-standard way. The vertical axisis logarithmic and uses the units of dBc/Hz, which means
“decibels (relative to the carrier) per Hertz”. The horizontal axisislogarithmic with units.

Transfer Function Plot Usage

A Transfer Function plot shows the magnitude ratio of the frequency spectrums of two measurements
on logarithmic axes. This can be a useful way to depict the response of a system to stimuli at various
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frequencies, or to identify poles and zeros in a system characteristic equation. Suppose that x(t) isa
jitter measurement at the input of a device, and y(t) is a corresponding jitter measurement at the output
of the device. The Transfer Function plot can be used to show the following function, where X(f) is
the Fourier Transform of x(t):

Hip= fripnd
12463}

The horizontal axis of the Transfer Function plot goes up to the Nyquist frequency of X or Y, whichever is
lower. These plots work best if averaged across multiple acquisitions to reduce the effects of measurement
noise.

Waveform Plot Usage

The waveform plot is only applicable to the Mask Hits measurement. It depicts a copy of the source
waveform, with all mask violations denoted in a highlight color. These are the same violations that
appear on the Mask Hits eye diagram, but the waveform plot allows them to be seen in the context of a
continuous-time waveform.

Eye Diagram Plot Usage

An eyediagram is aplot of the voltage versus time for a serial bit stream, with the time axis “wrapped”
so that all unit intervals are superimposed on top of each other in atime-aligned fashion. Because the
resulting plot has many waveforms overlaid, color grading is used to separate areas with many coincident
waveforms from areas that are only rarely crossed.

If there is an area free of waveforms in the center of the diagram, the eye is said to be “open”,

and a comparator circuit repetitively sampling the waveform at this point in the unit interval could
unambiguously separate the two logic states. For experienced signal integrity engineers, the eye diagram
allows many common problems to be recognized instantly.

Composite Jitter Histogram Plot Usage

Composite Jitter Histogram plots 4 histograms (TJ, PJ, R*+BUJ, DDJDCD) together. Thiswill be helpful
in analyzing 4 components of jitter together. Configurations for this plot are the same as that of Histogram
Plot. Thisplot isonly applicable for Jitter measurements.
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Selecting Plots

Before or after you take measurements, you can set up plots for the sel ected measurements by following
these steps:

Jitter and Eye Diagram Analysis Tools

TIEY
Time Trend Data Array  Histogram
oL GO

TJ@BER1
RJ-551 " Spectrum Transfer

@ @ Eye Diagram  Height1,Ch1
.~ Transt
P (T [rranster _[penoatc

Histogram TIE1,Ch1
Spectrum TIE1,Ch1

1. Click Plotsin the navigation panel (see page 82) to view the Select Plot window. The currently active
measurements and source(s) are displayed in the table on the left (measurement table).

2. Click any of the plot icons that are available for the selected measurement. The corresponding plot
type and measurement are then added to atable on the right (plot table).

3. Add another plot for the current measurement, or select a different measurement and choose from its
plot types. A maximum of four plots can be selected at any given time.

Table 71: Plot selections

Item Description

Plots Lists only the plots which are available for the selected
measurement. Click a plot icon to add the plot type to the
table on the right.

Clear Selected Clears the selected plot from the plot table.
Clear All Clears all plots from the plot table.
Configure Allows you to adjust display options for the selected plot.

About Configuring Plots

Most plot types (except Data Array and Waveform) have display options that can be adjusted for each
instance of the selected plot.
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Jitter and Eye Diagram Analysis Tools

| Measurement |Sourcels) | Plots

TIE1 et

Time Trend Data Array  Histogram

Height1 (ajem =% [PlotType | Measurement

N | Hist TIE1,Ch1
TJ@BER1 cm ’ \ it

RJ-551 Wllcnt Spectrum  Transfer

Spectrum TIE1,Ch1

Eye Dii Height1,Ch1
oo o || G . T

Width@BER1 @cm J HEIRATLGIE

The steps to configure a plot are;

1. Select aplot instance by clicking on arow from plot table on the right.

2. Click Configureto display a pop-up window with the available configuration options.

3. Adjust the configuration options and click OK to accept the changes and close the window.
4

Click Show Plotsin the control panel to view the configured plot.

NOTE. The Show Plotsicon appears in the control panel (see page 82) only when one or more plots
are defined.

Related Topics
m  Configuring a Time Trend (see page 190)

m_ Configuring a Histogram Plot (see page 190)

B Configuring a Spectrum Plot (see page 189)

m  Configuring a Transfer Plot (see page 192)

B Configuring a Phase Noise Plot (see page 193)

B Configuring an Eye Diagram for Mask Hits (see page 195)

= Configuring an Eye Diagram Plot for Eye Height (see page 193)

B Configuring a Bathtub Plot (see page 187)

= Configuring a Composite Jitter Histogram Plot (see page 196)

Configuring a Bathtub Plot

Select a Bathtub plot in the table on the right and click Configure to configure the plot.
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—Conﬁgure Bathtub

Item Description

Vertical Scale

Log Selects logarithmic scaling for the vertical axis.

Linear Selects linear scaling for the vertical axis.

Minimum Displayed BER=1E? Sets the lower axis limit for logarithmic plots to this value
(expressed as the negative of a base-10 exponent).

OK Accepts the changes and closes the window.
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Configuring a Spectrum Plot

Configuring a Spectrum Plot

Select a Spectrum plot in the table on the right to and click Configure to configure the plot.

Configure Spectrum

Normal n

Item Description

Vertical Scale

Log Selects logarithmic scaling for the vertical axis.

Linear Selects linear scaling for the vertical axis.

Base Sets the lower axis limit for logarithmic plots to this value

(expressed as a base-10 exponent). Available only when
the vertical scale is log.

Horizontal Scale

Log

Selects logarithmic scaling for the horizontal axis.

Linear

Selects linear scaling for the horizontal axis.

Mode

Selects whether the plot shows only the most recent
spectrum, the uniform average of all spectrums since
the last time the results were cleared, or the peak of the
envelope of all spectrums since the last time the results
were cleared.

Normal - Shows magnitude values from the most recent
acquisition.

Average - Averages the magnitude values at each
frequency.

Peak Hold - Keeps the maximum value at each frequency.

OK

Accepts the changes and closes the window.
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Configuring a Time Trend

Select a Time Trend plot in the table on the right and click Configure to configure the plot.

Item Description

Vector Connects measurement points with straight lines to form a
continuous waveform.

Bar Places a vertical bar at the horizontal position of each
measurement with a height (positive or negative) that
represents the value of that measurement; a horizontal
baseline represents the mean value of the Time Trend.

OK Accepts the changes and closes the window.

Configuring a Histogram Plot

Select a Histogram plot in the table on the right and click Configure to configure the plot.

: L
—Conﬂgune Histogram

[ foons |
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Configuring a Histogram Plot

Item Description

Vertical Scale

Linear Selects linear scaling for the vertical axis.

Log Selects logarithmic scaling for the vertical axis.

Number of Bins

Resolution

Defines resolution by the number of bins into which Span is
divided: 25, 50, 100, 250, 500, 2000, and Maximum.

Horizontal Scale

Auto Scale

Causes the horizontal scale of the histogram to be adjusted
automatically based on the accumulated data points.

If subsequently acquired data falls outside the current
horizontal scale, histogram bins are consolidated so that the
number of bins is preserved and the horizontal scale allows
all data to be plotted. When checked, disables the “Center”
and “Span” numerical inputs.

Center

Manually sets the value for the horizontal center of the
Histogram, for subsequent plot updates. You can set values
up to 1 as (atto second) using your keyboard.

Span

Manually sets the value for the total horizontal range of the
Histogram, for subsequent plot updates. You can set values
up to 1 as (atto second) using your keyboard.

Autoset

Uses the results of the latest acquisition to determine
the logical values for the Center and Span options (if the
population of the measurement is three or more).

OK

Accepts the changes and closes the window.
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Configuring a Transfer Plot

Configuring a Transfer Plot

Select a Transfer Function plot in the table on the right and click Configure to configure the plot.

Item Description
Definition
Numerator Measurement for which the magnitude spectrum is used as

a reference.

Denominator

Measurement for which the magnitude spectrum is used
to normalize the numerator.

Vertical Scale

Linear Selects linear scaling for the vertical axis.

Log Selects logarithmic scaling for the vertical axis (default).

Horizontal Scale

Linear Selects linear scaling for the vertical axis.

Log Selects logarithmic scaling for the horizontal axis (default).

Mode Selects whether the plot shows only the most recent
spectrum, or the uniform average of all spectrums since the
last time the results were cleared (default).
Normal - updates the plot with current values.
Average - averages the magnitude values at each
frequency.

OK Accepts the changes and closes the window.
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Configuring a Phase Noise Plot

Select a Phase Noise plot in the table on the right and click Configure to configure the plot.

Item Description

Vertical Position

Baseline Sets the lower axis limit for logarithmic plots to this value.
OK Accepts the changes and closes the window.

Configuring an Eye Diagram Plot for Eye Height

Select an Eye Diagram plot (for all eye measurements other than Mask Hits) in the table on the right and
click Configure to configure the plot.

X
_Conﬁgune Eye Diagram

C:Users'Public’ Tektronic Tekapplications\DPOJET Masks"\FI f
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Configuring an Eye Diagram Plot for Eye Height

Item Description

Mask

On Enables display and mask testing.

Off Disables display and mask testing.

Browse Select a mask file to import from the C:\Users\Pub-

lic\Tektronix\TekApplications\DPO-
JET\Masks directory.

Horizontal Scale

Auto Scale When checked, causes the horizontal scale to be adjusted
automatically.
Resolution Manually sets the horizontal resolution, when Auto Scale

is unchecked.

Superimpose Reference Clock Eye (if available)

When checked, superimposes DQS eye onto the data eye
diagram.

Ref Clock Amplitude

Scale to Ref Clock

Scales the waveform to the one which is larger among the
superimposed eye when the Superimpose Reference Clock
Eye option is checked.

Scale to Data

Autoscales to the vertical height of the data signal (DQ as in
DDRA) without regard to the reference clock (DQS) signal
amplitude.

Ref Clock Alignment

Determines how an eye diagram is positioned on the plot.
The position is determined by the eye reference point,
which is the location of overlapping recovered or explicit
clock edge locations. Typically, the eye is located so that
waveform edges are approximately at 25% and 75% of the
width of the diagram. This ensures that the eye opening is
centered on the plot facilitating cursor measurements and
mask testing.

Auto

Determines the alignment property automatically. Eye
diagram is aligned automatically. Auto is typically equivalent
to Left.

Center

Eye reference point is centered on the plot. Center
alignment is appropriate for DDR Write bursts or other
signals with explicit reference clock where the clock and
data signals are out of phase.

Left

Eye reference point is positioned on the left of the plot so
that eye opening is centered. Left alignment is appropriate
for DDR Read bursts and signals with recovered clock or
explicit clock where the clock and data signals are in phase.

OK

Accepts the changes and closes the window.

Related Topics

m Effect of Nominal Clock Offset on Eye Diagrams (see page 140)
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NOTE. If thereisunwanted skew between the data and explicit clock signals, the channels must be properly
deskewed. Refer to your oscilloscope online help on how to deskew the channels.

Configuring an Eye Diagram for Mask Hits

An eye diagram plot is activated whenever a mask hits measurement is selected. Click Configurein
the plots panel to configure the plot.

Configure Eye Diagram for Mask Hits

PCE_Rev20 RX.msk

Item Description

Mask Shows which mask has been selected (for the Mask Hits
measurement, the mask selection is performed as part of
measurement configuration rather than plot configuration).

Horizontal Scale

Auto Scale When checked, causes the horizontal scale to be adjusted
automatically.

Resolution Manually sets the horizontal resolution, when Auto Scale
is unchecked.

Superimpose Reference Clock Eye (if available) When checked, superimposes DQS eye onto the data eye
diagram.

Ref Clock Alignment Determines how an eye diagram is positioned on the plot.

The position is determined by the eye reference point,
which is the location of overlapping recovered or explicit
clock edge locations. Typically, the eye is located so that
waveform edges are approximately at 25% and 75% of the
width of the diagram. This ensures that the eye opening is
centered on the plot facilitating cursor measurements and
mask testing.

Auto Determines the alignment property automatically. Eye
diagram is aligned automatically. Auto is typically equivalent
to Left.
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Configuring a Composite Jitter Histogram Plot

Item Description

Center Eye reference point is centered on the plot. Center
alignment is appropriate for DDR Write bursts or other
signals with explicit reference clock where the clock and
data signals are out of phase.

Left Eye reference point is positioned on the left of the plot so
that eye opening is centered. Left alignment is appropriate
for DDR Read bursts and signals with recovered clock or
explicit clock where the clock and data signals are in phase.

OK Accepts the changes and closes the window.

Related Topics

m Effect of Nomina Clock Offset on Eye Diagrams (see page 140)

NOTE. If thereisunwanted skew between the data and explicit clock signals, the channels must be properly
deskewed. Refer to your oscilloscope online help on how to deskew the channels.

Configuring a Composite Jitter Histogram Plot

196

Select a Composite Jitter Histogram plot from the list on the right and click Configure to configure the plot.

o

—Gonﬁgure Composite

AN RN
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Table 72: Composite jitter histogram plot

Item Description

Vertical Scale

Linear Selects linear scaling for the vertical axis.

Log Selects logarithmic scaling for the vertical axis.

Number of Bins

Resolution Defines resolution by the number of bins into which Span is divided: 25, 50, 100, 250, 500,
2000, or Maximum.

Jitter Components

TJ Plot TJ values
RJ+BUJ Plot RJ+BUJ values
PJ Plot PJ Values
DDJDCD Plot DDJ+DCD Values
By default , all Jitter components will be checked
OK Accepts the changes and closes the window

About Viewing Plots

You can create and configure up to four plots. If you aready have measurement results, creating a plot will
cause it to be displayed immediately. If there are no current results, the plot will be created when you
sequence the application and results have been calculated. The Show Plots icon appears in the control

panel whenever at least one plot is defined. The Show Plotsm icon appears in the control panel
whenever at least one plot is defined. By default, all defined plots windows are grouped in a single window
on the upper half of the display, but the window can be moved, resized, or dragged to a second monitor.
The application includes tools to help you select which plots to view, to size and position the plot windows,
to save plot information, to use the zoom function, and to use the cursors functions.

If your Windows desktop is extended to a second monitor, you can drag the plots window to the second
monitor.

NOTE. When sequencing is complete, the plot window displays with the last plot selected. The plot window
also updates whenever you reconfigure a plot.

Using a Second Monitor to View Plots

If your oscilloscope setup includes a second monitor that extends the Windows desktop, you can select and
drag thetitle bar of the plot window to position it in the second monitor. This alows you to simultaneously
display awaveform on the oscilloscope, measurement results, and the plot for easy viewing.
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Toolbar Functions in Plot Windows

Toolbar Functions in Plot Windows

The Plot Toolbar window includes the following functions:

Be ABANK

Table 73: Plot toolbar functions

" Wekknld S BFL0 BER o aa

Icon Functions
(= Export Figure.
= Print Figure.

QG Q&

Zoom and Pan.

F W walil i Ewa i Vertical and Horizontal Cursor controls.
|F 0™ |RESET REZET HUEE
e Moving and Resizing Plots.

&

Plot properties.

— /=

o= =
00 = 00

Plot Summary Views.

T &g a

Full view of plots 1 to 4.

Moving and Resizing plots

You can move and resize plot windows the same way you would move and resize any window.

You can change the plot size to the whole display of the oscilloscope, or to half the display. When
viewing a plot in half the display, you can position the plot to the top or bottom. The tools also return
the plot to the original size. To position a plot quickly on the oscilloscope, select one of the following

tools in the plot window:

198

enlarges the plot to fill the entire display.
== "

T positions the plot to the top.

=) positions the plot to the bottom.

always keep the plot on top layer.
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Using Zoom in a Plot

Once you have created a plot, you can use the Zoom tools to examine the data at various scales.

TIP. If you prefer to use the zoom functions in a plot window with your finger, you can activate the Touch
Screen on the oscilloscope.

Table 74: Zoom functions in a plot

Item Description

@ Zoom in (Horizontal and Vertical) — Expands part of the plot;
the data appears in more detail.

Zoom out — Contracts part of the plot; the data appears in
less detail.

Zoom in (Horizontal only) — Expands the horizontal axis only
and retains the vertical axis.

Resets the zoom to 100%.

;?I;.E. i

Changing the Scale of Data in a Plot (Zoom)

To change the scale of the datain a Plot Details window, select one of the following plot zoom tools:

u % zooms in to expand the scale.

] = Zooms out to contract the scale.

L 2} zooms in to expand the horizontal axis only.
L & moves the plot anywhere within the scale.

= & zoomsin to restore the entire waveform data.

When you select the 2\ tool, you can use a select-drag-release action to expand part of the waveform
(zoom in) by an arbitrary amount on both axes. After you select (touch with a finger or click with the
mouse) and begin dragging, a bounding box shows what part of the waveform will be expanded upon
release.

Select any part of the plot to expand the data by a factor of two (2X) equally on both axes. Double
selecting expands the data to the maximum factor.

To contract an expanded part of the data (zoom out), select anywhere on the data. The view contracts to
the values that existed before the most recent expansion of the data. Selecting multiple times will restore
successively earlier views. To expand the scale of the horizontal axis only by afactor of two (2X), click a
part of the waveform. The plot retains the scale of the vertical axis.
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TIP. Select ™ to see the entire available waveform.

Using Cursors in a Plot

Cursors allow you to view numerical values associated with a plot based on cursor locations. There are
two types of cursors:

®  Horizontal cursors

m  Vertical cursors

Table 75: Cursor functions in a plot

Item Description

il Displays the vertical coordinate where each cursor touches
the plot and the difference (A) between the cursors.

Y Displays the horizontal coordinate where each cursor

touches the plot and the difference (A) between the cursors.
Brings the cursors into the visible part of the plot.

o

ESET

ﬁ Displays the plot properties.

Cursors in a Plot

You can use cursors to read the coordinate where each cursor (line) touches the plot and also view the
difference (A) between the two cursors. The steps to use cursors in a plot details window are:

1. Select any of the following cursors:
A to use horizontal cursors.
- Ld to use vertical cursors.

o to bring cursors into the visible plot.

2. Select and drag either cursor to move the cursor to the desired part of the plot. The cursor readout
changes to reflect the cursor position.

NOTE. You can drag cursors only when the Zoom functions are disabled.

TIP. If you prefer to move the cursors in the plot window with your finger, you can activate the touch
screen on the oscilloscope.
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Exporting Plot Files

You can export plot image in Plot Toolbar window. Click B (o save the contents of the plot window in
any of the format asa MATLAB figure format (.fig), .bmp, .jpg, .png, .emf, .tif, .mat and .csv.

The steps to export a plot file are:

1.

2.
3.
4,

Set up the plot window.

Sdect M o save the plot as afigure.
Select the directory and enter afile name.

Click Save. The application saves the file in C:\%USERPROFILE%\Tektronix\TekApplica-
tions\DPOJET\images, where %USERPROFILE% represents your user location.

Printing Plots

The steps to print a plot are:

1
2.

3.

4,

Verify that the printer is configured.

Set up the plot window with zoom, cursors, or grid functions.
Click € iconinthe plot details/summary window. The Print Preview dialog is displayed.

Click & to set up the printing options and print a plot file.

NOTE. You can customize the print layout using the MATLAB page setup options. The DPOJET online
help does not provide information on MATLAB page setup. For more information, refer to the MATLAB
documentation.

About Reports

You can use the Reports to configure and generate a compliance report to view later or to share with others.
You can also access reports using Analyze > Jitter and Eye Analysis (DPOJET) > Reports. You can
select the option which you want to display in the report as shown in the following table:
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202

Jitter and Eye Diagram Analysis Tools

Report Name IC:\TekﬁppIications\D POJET \Reporis'MeasReport. mht

[ s L
[ Display units in separate column

Content To Save

|+ Include pass/fail results summary
[+/| Include detailed resuits
[/ Include plot images

About Reports

NOTE. When only the Mask Hits measurement is selected, the report shows only the Pass/Fail information.
If any other measurement having limits is selected along with the Mask Hits measurement, limit
information section is also included in the generated report.

Table 76: Report generation options

Item

Description

Auto increment report name if duplicate

Select/Clear the option to auto increment the report name
if its already existed. The auto generated report is of
YYMMDD_HHMMSS_savedfi le.mht format.

Display units in separate column

Select this option to display units in separate column

View report after generating

Select this option to view the report after generation.

Report Name

Lists the directory path where the last generated report is
stored.

Save

Saves the changes in the default report directory.
Manipulates the report name based on “Auto increment
report name if duplicate” option.

Save As

Displays the browser where you specify the directory

to save the generated report. You can also edit the

report name in the Save As browser. By default, the
generated report is saved in C:\%USERPROF ILE%\Tek-
tronix\TekApplications\DPOJET\Reports,
where %USERPROFILE% represents your user location.

Append

Adds the current settings to an existing report.

View

Opens the generated report in the default browser.

Content To Save

Include pass/fail results summary

Select/Clear the option to include/exclude the pass/fail
status in the generated report.

Included detailed results

Select/Clear the option to include/exclude the measurement
result details in the generated report.
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Table 76: Report generation options (cont.)

Item

Description

Include plot images Select/Clear the option to include/exclude the plot images

like measurement plots and oscilloscope waveform in the
generated report.

Saving a report from Internet Explorer does not save plot
images.

Include setup configuration Select/Clear the option to include/exclude the setup

information like DPOJET version, oscilloscope version, and
status in the generated report.

Include complete application configuration Select/Clear the option to include/exclude the complete

configuration details in the generated report.

Save waveform file(s) along with report Select/Clear the option to include/exclude the oscilloscope

waveform details in the generated report.

Include user comments Select the option to include any comments in the generated

report. To do so, click the Add/Edit Comments button.

Reports Format

The generated reports are in .mht format and includes the following configured set of information:

Comments displays any user comments.
Setup Configuration such as DPOJET version and oscilloscope version.

M easurement Configuration such as measurement name, source and other configuration parameters.
Click on the measurement name to view the oscilloscope waveform details.

Source Reference L evels displays the reference voltage levels for the high, mid, and low thresholds
for the rising edge and for the falling edge of all sources, and the hysteresis.

Miscellaneous Settings such as Gating, Qualify and Population status.

Pass/Fail Summary indicating the Pass/Fail status for the selected measurements. Also displays the
limits information for measurements selected along with Mask Hits.

M easurement Results with statistics.
Plot Images includes both selected plots and oscilloscope waveforms.

Reference wavefor ms stored at includes the location of the waveforms used.
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Append Reports

Click the Append button to add the generated report to an existing report of the same format. The
application prompts you with a message “ Do you wish to append the current results to xxx.mht”? before
the append action.

izh to append the current results to
Lkt ?

NOTE. Time stamp differentiates various appended reports.

Reports compatibility.

The application displays awarning when you try to append the report with other reports, generated using
previous versions of DPOJET. Click Yesto overwrite an old report with a newer format.

uze the Append feature iz e

ave to a new report]?

NOTE. If thereis not enough disk space to save the report, the application displays “ Cannot save file:
There may not be enough free disk space. Delete one or more files to free disk space, and then try again” .

Printing reports. You need to set the following while printing reports to get the alternate gray and white
rows in the table:

®  Select Internet Explorer, go to Tools > Internet Options.
B |nthe Advanced tab, select the option Print Background Color and I mages under Printing as shown.
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Internet Options

£

Gemneral | Security || Privacy | Content | Connections | Programs | Advanced

Sethings:

Cﬁ Printing

Q Search from the Address bar

5y Security

Flay videos in web pages s
[] Show image download placehalders

Show pictures

Smart image dithering

Print backaraund colars and images

q When searching
() Dizplay rezults, and go to the most likely site
() Do not gearch from the Address bar
(0 Just digplay the results in the main window
(%) Just go to the most likely site

[] &llow active content from COs to run on My Computer

[ &llow active content to i in files on My Computer

[ &llowe zofveare ta rn or install even if the signature i invalid %
>

[ Restore Defaults ]

[ k. H Cancel H Apply ]

About Reports

Saving waveform files. You can save waveform(s) used for the measurement by checking the option
“Save Waveform file(s) along with report” in the reports screen. The waveforms are stored under
C:\%USERPROFILE%\Tektronix\TekApplications\DPOJET\Reports, where %USERPROFILE%
represents your user location.

If one or more waveforms are to be saved, the report name is incremented for every append action by
including a number in the parenthesis as shown:

fddress |2 Ci\TekApplications\DPOJETReports

Marne Size

File and Folder Tasks # ) Mew Folder
j Make a new Folder E ------ 129 kB
' S BB test_ReFL1) 129 KB
IIF"ﬁl;ll:lfull:sl'u this folder o the E kest ReF1(2) 120 KB

Tvpe
File Folder
W aveform
W aveform
W avefiarm

NOTE. If the waveform path name is greater than 128 characters, the applications displays a warning
even though the waveform is created with a truncated name (without a .wfm extension).
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Add Comments

Check “Include user comments’ option to include the comments in the generated report. Click Add
comments in the report panel to include comments in the report. Add Comments changes to Edit
Commentsin the report panel until al the contents are cleared in the Comment dialog box.

Comments

Contents to he added|

Item Description

Clear Clears the edited contents.

Copy Copies the edited contents.

Paste Pastes the copied contents in the new comments dialog box even after closing the window
without clicking “Ok”".

Cancel Closes the dialog box without saving any added contents.

Ok Saves the edited text.
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Introduction to the Tutorial

Thistutorial teaches how to set up the application, take measurements, and view results as plots or statistics.
Before you begin the tutorial, perform the following tasks:

m  Set up the oscilloscope.

m  Start the application.

m  Recdl the tutorial waveform.

NOTE. The screen captures shown in this section are from a DPO7254 oscill oscope.

Setting Up the Oscilloscope

The steps to set up the oscilloscope are:
1. Click File> Recall Default Setup in the oscilloscope menu bar to recall the default settings.

2. Presstheindividua CH1, CH2, CH3, and CH4 buttons as needed to add or remove active waveforms
from the display.

Starting the Application

Click Analyze > Jitter and Eye Analysis (DPOJET) > Select to open the application.

Waveform Files

The application provides the following tutorial waveforms:
= Rt-EyeTutoria.wfm

m  ckminus 50gs 18g 20m_patl.wfm

m  ckplus 50gs 18g_20m patl.wfm

®  dplus 50gs 18g_20m patl.wfm

B dminus 50gs 189 20m_patl.wfm

The waveform files are found at C:\Users\Public\Tektronix\TekApplications\DPOJET\Exam-
ples.
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Recalling aWaveform File

Recalling a Waveform File

To recall awaveform file, follow these steps:

1. Click File> Recall in the oscilloscope menu bar to display the Recall dialog box.

NOTE. If the application isin button mode, select the Recall button to recall the tutorial waveform.

Click Waveform icon in the left of the Recall dialog box.
Select Refl, Ref2, Ref3, or Ref4 as the Destination option.
Browse to select the waveform. Use the keypad to edit the waveform file name.

Click Recall. The oscilloscope recalls and activates the Reference Waveform control window.

o g &~ w N

Click On to display the waveform.

7. Click E to return to the application. Alternatively, DPOJET can aso be accessed from Analyze >
Jitter and Eye Analysis (DPOJET) > Select.

Raference 5
Reference Display Red 2
Ref2 T

In the Summary tutorial, the tutorial waveforms are recalled as Math waveforms using the following setup:

B dplus 50gs 189 20m_patl.wfmisrecalled as Refl and dminus 50gs 18g 20m patl.wfm as Ref2.

NOTE. Using Math Setup ( Select Math > Math Setup in the menu bar to view the Math Setup dialog.
For more details, refer to the “ Math Equation Editor: Controlsin your oscilloscope online help), set
Math1=Ref1-Ref2 (Data signals)..

B ckplus 50gs 18g 20m_patl.wfmisrecaled as Ref3 and ckminus 50gs 18g 20m_patl.wfm as Ref4.

NOTE. Using Math Setup, set Math2 =Ref3-Ref4 (Clock Signals).

Taking a Period Measurement

208

In thislesson, you will learn how to take a period measurement and view the results. You can also learn the
following tasks:
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m  Select a measurement and a source
B Configure measurement

m  Take measurements

m  View results as plots or statistics

= View reports

B Return to the application

Setting up a Period Measurement
Follow these steps to take a period measurement:

1. To set the application to default values, click File > Recall Default Setup. Thisis not necessary if
you have just started the application.

2. Toview the DPOJET application, select Analyze > Jitter and Eye Analysis (DPOJET) > Select.

3. Goto Select in the left navigation panel. Click Period in the Measurements area. The application
shows the measurement and source selection on the right of the display. The current measurement
selection is displayed as Periodl. The subsequent selections will be Period2, Period3 and so on. In
this example, Rt-EyeTutorial.wfm is recalled as Ref1 and is selected as source for Periodl. New
measurements initially use the same source as the earlier measurement, or the most recently used
source.

Jitter and Eye Diagram Analysis Tools

Measurements Measurement Source(s)

periou Pos Width  Neg Width Freg % Rert

N—PB[IIJI:I +Duty Cycle —Duty Cycle
@ @ @
m CC-Period  +CC-Duty  —CC-Duty

4. Click Ld or the row which lists the selected measurement to configure the source. Select Refl for
Periodl. For more details, refer to Source Setup (see page 84).

5. Click Ref Levels Setup. The Configure Reflevel menu appears. For more details, refer to Ref
Levels (see page 96).

6. Click Configurein the left navigation panel of the main application window to view the configure
tabs. For more details, refer to About Configuring a Measurement (see page 105).

7. Click Plotsto view the available plots for the selected measurement. Select Time Trend for Period.
For more details, refer to Configuring Time Trend (see page 190).

8. Click Single to run the application. When complete, the result statistics is shown in the results tab.
The plots are displayed as shown:
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L DPOJET Plois |':|['E|||'E

NOTE. You can log result statistics (see page 48), measurement data points (see page 49) to a .csv file and
worst case waveforms (see page 59) to a .wfm file.

Taking a TIE Measurement

For jitter application, use the PLL TIE measurement. The steps to take a TIE measurement are:

1. To set the application to default values, click File > Recall Default Setup. Thisis not necessary if
you have just started the application.

2. Goto Select in the left navigational panel. Click Jitter tab to select TIE in the Measurements area.
The application shows the measurement and source selection on the right of the display. In this
example, Rt-EyeTutorial.wfm isrecalled as Ref1 and is selected as source for TIEL.

Jitter and Eye Diagram Analysis Tools
' Measurements )

Jitter
RJ-00 Summary

TIE RJ
m TJ@BER DJ DJ-55 Phase Noise

3. Click Ld or the row which lists the selected measurement to configure the source. Select Refl for
TIEL. For more details, refer to Source Setup (see page 84).
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4. Click Ref Levels Setup in the source configuration dialog. The Configure Reflevel menu appears. For
more details, refer to Ref Levels (see page 96).

5. Click Configurein the left navigation panel to view the configure tabs. For more details, refer to
Configuring Measurements (see page 105).

6. Click Plotsto view the available plots for the selected measurement. Select Time Trend and Spectrum
plots for TIE measurement. For more details, refer to Configure Plots (see page 186).

7. Click Single to run the application. When complete, the result statistics is shown in the results tab.
The plots are displayed as follows:

<} DPOJET Plots
CEIEEEY L=l =

TIE1: Time Trend TIE1: Spectrum

NOTE. You can log result statistics (see page 48), measurement data points (see page 49) to a .csv fileand
worst case wavefor ms (see page 59) to a .wfm file.

Taking an Eye Height and Width Measurement

For signal integrity application, use the Eye Height and Width measurements.
1. Select Analyze > Jitter and Eye Analysis (DPOJET) > Select to run the DPOJET application.

2. Goto Select in the left navigation panel. Click Eye tab to select Height and Width measurement. In
this example, Rt-EyeTutorial.wfm isrecalled as Ref1 and is selected as source for Height1 and Width1l.
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Jitter and Eye Diagram Analysis Tools

Measurements
Height

Taking an Eye Height and Width Measurement

Preferences ¥

Measurement Source(s}

Width1 Jch1

Height1 ¥ cn1

Clear Selected ¢ pyign [Ladem

Width Width@BER @BER

Height Eye High Q-Factor ! / Eye Low1 _Jcn

~ m m : :,. Q-Factor1 Ch1
@ @Ww @ Coarra a

Autofit Mask ; &
-

3. Select Refl as source for Height and Width measurements. For more details, refer to Source Setup
(see page 84).

4. Click Plotsto view the available plots for the selected measurement. Select Eye Diagram for Height
measurement.

5. Select Eye diagram Plot type and click Configure to turn on the Mask in the Configure Eye Diagram
for Eye Height dialog. For more details, refer to the Configuring Eye Diagram Plot for Eye Height

(see page 193).
6. Select Histogram plot for Width measurement.

7. Click Singleto run the application. When complete, the result statistics is shown in the results tab.

8. The Plot summary window is displayed as shown in the following figure:

A DROUET Plats

Wips A

NOTE. You can log result statistics (see page 48), measurement data points (see page 49) to a .csv fileand
worst case waveforms (see page 59) to a .wfm file.
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Summary Tutorial

For a summary tutorial, the following example is considered:

Case 1: Period measurement with Low pass filters to show SSC profile:

1

Select Analyze > Jitter and Eye Analysis (DPOJET) > Select to run the DPOJET application. For
more details on waveforms recalled on Mathl, Refer Recalling a Waveform File (see page 208).

Select Period measurement on Mathl.

Click Configure. In the Filters configuration tab, select 2nd order low pass filter and specify the
cut-off frequency as 33 kHz. (F2= Fyad/1667).

Go to Plots. Select Time Trend for Period measurement.

Click Single to run the application. When complete, the result statistics is shown in the results tab.
The Time Trend plot is as shown.

B& aganeaw ol FEFS0

Case 2: A pair of TIE for showing jitter integration caused by SSC and the effect of a high pass filter
on SSC spectrum plots:

1. Click Jitter to select TIE measurement.

2. Select Mathl (see page 208) as the source for both TIE1 and TIE2.
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Measurements e @ 3 I Source(s)
er i | 5
TIE RJ RJ-50 Summary (L Matni
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TJ@BER D.J-55 Phase Noise

W W

3. Click Configure. Do the following settings for TIEL and TIE2 in the Filters configuration tab:

- Select “No Filter” for TIEL.

= Select 2nd order High Passfilter for TIE2. In this example, the F1 cut-off frequency isset to 1 GHz.
Go to Plots. Select Time Trend for both TIE1 and TIE2.

Select Spectrum plot for both TIEL and TIE2.

Click Single to run the application. When complete, the result statistics is shown in the results tab.

N o g &

A Plot Summary window shows Time Trend plotsfor TIEL, TIE2 and Spectrum plotsfor TIEL, TIE2.

BS agasas ool A BFs0BERE deaga

TIEY: Times Trond LA A Thme Ll o Trend
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/]
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NOTE. You can log results as statistics (see page 48), measurement data points (see page 49) to a .csv file
and worst case waveforms (see page 59) to a .wfmfile.
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Stopping the Tutorial

If you need more than one session to compl ete the tutorial 1essons, you can stop the tutorial and return
to it later.

To save the application setup, refer to Saving a Setup File (see page 18). To exit the DPOJET application,

click present at the right corner of the application.

Returning to the Tutorial

To return to the tutorial setup, you can start the application and then recall the saved setup. To recall the
application setup, refer to Recalling a Saved Setup File (see page 18).
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About Parameters

This section describes the DPOJET application parameters and includes the menu default settings. Refer to
the user manual for your oscilloscope for operating details of other controls, such as front-panel buttons.

The parameter tables list the selections or range of values available for each option, the incremental unit of
numeric values, and the default selection or value.

Refer to the GPIB (see page 331) section for a complete list of the GPIB Command Syntax. The topics
include a complete list of the GPIB commands along with the arguments, variables, and variable values
that correspond to the DPOJET parameters.

Measurement Select Parameters

The Measurement Select includes the following measurement categories:

B Period/Freq: Freguency, Period, CC—Period, N—Period, Pos Width, Neg Width, +Duty Cycle, —-Duty
Cycle, +CC-Duty, and -CCDuty.

m  Jitter: TIE, RJ, DJ, PJ, DDJ, DCD, RJ-56, DJ-86, TI@BER, J2, 39, SRJ, F/N, Jitter Summary,
and Phase Noise.

B Time: Rise Time, Fall Time, High Time, Low Time, Setup, Hold, Rise Slew Rate, Fall Slew
Rate, Skew, SSC Profile, SSC Mod Rate, SSC Freq Dev, SSC Freq Dev Min, SSC Freq Max, and
tCMD-CMD.

m  Eye: Height, Width, Mask Hits, Autofit Mask Hits, Width@BER, Height @BER, Q-Factor, Eye
High, Eye Low, and AutoFit Mask Hits.

= Ampl: High, Low, DC Common Mode, AC Common Mode, High-Low, T/nT Ratio, Overshoot,
Undershoot, V-Diff —Xovr, Cycle Min, Cycle Max, and Cycle Pk-Pk.

B Standard: Standard-specific measurements are as follows:

- DDR: DDR Setup-SE, DDR Setup-Diff, DDR Hold-SE, DDR Hold-Diff, DDR tCK(avg),
DDR tCH(avg), DDR tCL (avg), DDR tERR(n), DDR tERR(m-n), DDR tRPRE, DDR tWPRE,
DDR tPST, DDR tJI T(duty), DDR tJI T(per), DDR Over Area, DDR VID(ac), DDR Under Area,
DDR tDQSS, GDDRS tBurst-CMD, GDDRS5 tCK SRE, GDDR5 tCKSRX, DDR2 tDQSCK,
DDR3 Vix(ac).

= PCI Express. PCle T-Tx-Diff-PP, PCle T-TX, PCle T-Tx-Fall, PCle Tmin-Pulse, PCle DeEmph,
PCle T-Tx-Rise, PCle Ul, PCle Med-Mx-Jitter, PCle T-RF-Mismch, PCle MAX-MIN Ratio
(Custom name is PCle VRX-MAX-MIN Ratio), PCle SSC FREQ DEV, PCle SSC PROFILE,
PCle AC Common Mode.

- USB 3.0 Essentials: USB VTx-Diff-PP, USB TCdr-Slew-Max, USBTmin-Pulse-Tj, USB
Tmin-Pulse-Dj, USB SSC MOD RATE, USB SSC FREQ DEV MAX, USB SSC FREQ DEV
MIN, USB SSC PROFILE, USB Ul, USB AC Common Mode.
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You can set the Source option as any of the following waveforms: Chl, Ch2, Ch3, Ch4, Refl, Ref2, Ref3,
Ref4, Mathl, Math2, Math3, Math4, B1, B2, B3, B4, B5, B6, B7, Bg, B9, B10, B11, B12, B13, B14, B15,
or B16 (bus source types are applicable for bus measurements only).

Table 77: Source parameters

Option Parameters Default

Sourcel Ch1-Ch4, Math1-Math4, Ref1-Ref4 Chl

Sourcel B1-B16 User should configure
Source2 Ch1-Ch4, Math1-Math4, Refl-Ref4 Ch2

Autoset Parameters

The Configure Source Autoset includes the following command buttons:
= Vert Scale

®  Horiz Res

®  Vert & Horiz

= Undo
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Ref Level Menu Parameters

Ref Level Menu Parameters

The Configure Ref Level menu parameters includes the following command buttons:

= Autoset
= Setup
Option Parameters Default setting
Source Ch1-Ch4, Refl-Ref4, Math1-Math4
Autoset Set, Clear Set
Rise High -20Vto20V 1V
Rise Mid -20Vto20V oV
Rise Low -20Vto20V -1V
Fall High -20Vto20V 1V
Fall Mid -20Vto20V oV
Fall Low -20Vto20V -1V
Hysteresis Oto10V 30 mv
Autoset Ref Levels Parameters
Option Parameters Default setting
Base Top Method = Min-Max Auto

B Low-High Histogram (Full

Waveform)
= |ow- High Histogram (Center of
Eye)

= Auto
Rise High 1t0 99% 90%
Rise Mid 1 t0 99% 50%
Rise Low 1 to 99% 10%
Fall High 1 to 99% 90%
Fall Mid 1 to 99% 50%
Fall Low 1 t0 99% 10%
Hysteresis 0 to 50% 3%
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Preferences Parameters

The Analyze > Jitter and Eye Analysis (DPOJET) > Preferences includes the following tabs:

= Generd
®m  Measurement

®  Path Defaults

Option Parameters Default setting

General

Display Units Seconds, Unit Intervals Seconds

Default Image Type PNG, JPG, BMP PNG

Notifier Duration 2t020s 5s

Measurement

Limit Rise/Fall measurements to Set, Clear Clear

transition bits only

Enable high-performance eye Set, Clear Set

rendering

Halt free-run on a limit failure for any Set, Clear Clear

measurement

Dual Dirac Model Fibre Channel, PCI/FB-DIMM
PCI/FB-DIMM

Waveform Interpolation Type Linear, Sin(x)/x Linear

Path Defaults

Default image export directory Browser C:\%USERPROFILE%\Tektronix\TekAp-
plications\DPOJET\Images'

Default logging export directory Browser C:\%USERPROFILE%\Tektronix\TekAp-
plications\DPOJET\Logs'

Default report output directory Browser C:\%USERPROFILE%\Tektronix\TekAp-

plications\DPOJET\Reports'

1 %USERPROFILE% represents your user location.
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Deskew Parameters

The Analyze > Jitter and Eye Analysis (DPOJET) > Deskew includes the following command buttons:
= Perform Deskew

= Summary

Option Parameters Default setting
Reference Channel

Source Chl, Ch2, Ch3, Ch4 Chl
Mid -20Vto20V oV
Hysteresis Otol0V 30 mv
Channel to be Deskewed

Source Ch1, Ch2, Ch3, Ch4 Ch2
Mid -20Vto20V oV
Hysteresis Otol10V 30 mV
Edges Rise, Fall, Both Rise
Deskew Range

Max Value -24.9 nsto 25 ns 1ns
Min Value -25.0nst0 24.9 ns -1ns
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Data Logging Parameters

222

The application includes the following Log menus:

m Statistics

®m  Measurement

Data L ogging Parameters

B Worst Case

Option Parameters Default

Statistics

Select Target Measurements Set, Clear Set

Log Statistics Off, On Off

Data Log File Browser C:\%USERPROFILE%\Tek-
tronix\TekApplica-
tions\DPOJET\Logs\Sta-
tistics'

Measurement

Select Target Measurements Set, Clear Set

Log Measurements Off, On Off

Folder Browser C:\%USERPROFILE%\Tek-
tronix\TekApplica-
tions\DPOJET\Logs\Mea-
surements!

Worst Case

Select Target Measurements Set, Clear Set

Log Worst Case Waveforms Off, On Off

Folder Browser C:\%USERPROFILE%\Tek-

tronix\TekApplica-
tions\DPOJET\Logs\Wave-
forms '

1 %USERPROFILE% represents your user location.
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Control Panel Parameters

The Control Panel menu includes the following command buttons:

m  Clear

®  Recalc

®  Single

®E  Run

= Show Plots

NOTE. Show Plots appearsin the control panel only when one or more plots are selected.
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Bit Config Parameters

The Eye configure menu has the following parameters.

Bit Config Parameters

Option Parameters Default setting

Bit Type All Bits, Transition, Non-Transition All Bits

Mask * Browser C:\Users\Public\Tek-
tronix\TekApplica-
tions\DPOJET\Masks

Measure the Center of the Bit t 1 to 100% 1%

Method * Mean, Mode Mean

Measurement range (% Ul)

Start, End, # of Bins

50%, 50%, 1

*

The Mask selector is available only for Mask Hits measurement.

T Available only for High, Low, and High-Low measurements.

¥ Available only for Height@BER measurement

Edges Parameters

The Edges configure menu depends on the measurement selected.

Edges-Two Source Parameters

Option Parameters Default setting
Clock Edge Rise, Fall, Both Rise

Data Edge Rise, Fall, Both Both
Edges-Phase Noise Parameters

Option Parameters Default setting
Active Edge Rise, Fall, Both Rise

Noise Integration Limits

Upper Frequency OtolT 1 MHz

Lower Frequency OtolT 0 Hz
Edges-CrossOver Parameters

Option Parameters Default setting
Main Edge Rise, Fall, Both Both
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Edges-TIE Parameters

Option Parameters Default setting
Signal Type Clock, Data, Auto Auto
Clock Edge Rise, Fall, Both Rise

Edges-Skew Parameters

Option Parameters Default setting
From Edge Rise, Fall, Both Both
To Edge Same as From, Opposite as From Same as From

Edges-N-Period Parameters

Option Parameters Default setting
Signal Type Clock, Data, Auto Auto

Clock Edge Rise, Fall, Both Rise

N= 1to 1M 6

Edge Increment 1,10K 1

Edges-DCD Parameters

Option Parameters Default setting

Signal Type Clock, Data, Auto Auto

Edges-DDR tCH(avg) and DDR tCL(avg)

Option Parameters Default setting
Window Size 200 to 1M 200

Edges-DDR tERR(m-n)

Option Parameters Default setting
Clock Edge Rise, Fall Rise
Number of Periods

Maximum 610 50 The value varies for different DDR
generations. For example, for DDR
(6-10) measurement, the maximum
default is 10.
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Option Parameters Default setting

Minimum 21050 The value varies for each DDR
generation. For example, for DDR
(6-10) measurement, the minimum

default is 6.
Window Size 200 to 1M 200
Edges-DDR tERR(n)
Option Parameters Default setting
Clock Edge Rise, Fall Rise
Number of Periods 2t0 50 The value varies for each DDR

generation. For example, for DDR
tERR(7per) measurement, the default

value is 7.
Window Size 200 to 1M 200
Edges-DDR tJIT(per), DDR tCK(avg) and DDRtJIT(duty)
Option Parameters Default setting
Clock Edge Rise, Fall Rise
Window Size 200 to 1M 200
Edges-Overshoot/Undershoot Measurements
Option Parameters Default setting
Ref Voltage -100 V to 100 V ov
Edges-Rise Slew Rate
Option Parameters Default setting
From Level Mid, Low Low
To Level High, Mid High
Slew Rate Technique Nominal Method, DDR Method Nominal Method
Edges-Fall Slew Rate
Option Parameters Default setting
From Level High, Mid High
To Level Mid, Low Low
Slew Rate Technique Nominal Method, DDR Method Nominal Method

226 DPOJET Jitter and Eye Diagram Analysis Tools



Parameters

Edges-Time Outside Level

Clock Recovery Parameters

Option Parameters Default setting
Level High, Low, Both High
High Ref Voltage User selectable oV

Clock Recovery Parameters

The Clock recovery configure menu depends on the clock recovery method being selected.

PLL Clock Recovery Method Parameters

Option Parameters Default setting
PLL Standard BW

PLL Model Type |, Type |l Type |
Standard: b/s IBA2500: 2.5G, PCI-E: 2.5G, PCI-E: 2.5G

PCI_E_GEN2: 5.0G

FC133: 132.8M, FC266: 265.6M,
FC531: 531.2M, FC1063: 1.063G,
FC2125:2.125G,

SerATAG1:1.5G, SerATAG2:3.0,
SerATAG3:6.0G

USB 3.0: 5.0G

1394b S400b: 491.5M, 1394b S800b:
983.0M, 1394b S1600b: 1.966G

GB Ethernet; 1.25G
100BaseT:125M

0C1:51.8M, OC3:155M, OC12:622M,
0C48:2.488G,

FC4250:4.25G, FC8500:8.5G
IBA_GEN2: 5.0G

FBD1:3.2G, FBD2: 4.0G, FBD3:
4.8G

XAUI: 3.125G, XAUI_GEN2: 6.25G
SAS15:1.5G (no SSC), SAS3: 3.0G
(no SSC), SAS6: 6.0G (no SSC),
SAS12; 12.0G (no SSC)
SAS15:1.5G (SSC), SAS3: 3.0G
(SSC), SASE: 6.0G (SSC), SAS12:
12.0G (SSC)

RI0125: 1.25G, RI0250: 2.5G,
RI03125: 3.125G

Damping !

05t02 700 m
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Option Parameters Default setting
Loop BW 1t0 2.5 GHz 1.5 MHz
PLL Custom BW
PLL Model Type |, Type Il Type |
Loop BW 11025 GHz 1.5 MHz
1 Enabled only for Type Il PLL models.

Constant Clock Recovery Method Parameters

Option Parameters Default setting
Constant Clock-Mean

Auto Calc First Acq, Every Acq Every Acq
Constant Clock-Median

Auto Calc First Acq, Every Acq Every Acq
Constant Clock-Fixed

Clock Frequency 1 Hz to 25 GHz 2.5 GHz
Explicit Clock Recovery Method Parameters

Option Parameters Default setting
Explicit Clock-Edge/Explicit Clock-PLL

Clock Source Ch1-Ch4, Refl-Ref4, Math1-Math4 Ch2

Clock Edge Rise, Fall, Both Both

Clock Multiplier 1to1K 1
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SSC

Advanced Clock Recovery Configuration Parameters

SSC Parameters

Option Parameters Default setting

PLL Custom BW/PLL Standard BW/ Constant Clock-Mean/Constant Clock-Median

Nominal Data Rate Auto, Manual Auto

Bit Rate 0 b/s to 100 Gh/s Auto TBD
Manual 2.5 Gb/s

Known Data Pattern On, Off Off

Pattern Filename Browse C:\Users\Public\Tek-
tronix\TekApplica-
tions\DPOJET\Patterns

Explicit Clock: Edge

Nominal Clock Offset Relative to Data Auto, Manual Manual

Recalculate

Every acquisition, When required

When required

Explicit Clock:PLL

PLL Method Type I, Type Il Type |
Damping 05t02 700 m
Loop B/W 1 Hzto 2.5 GHz 1.5 MHz
Nominal Clock Offset Relative to Data  Auto, Manual (-1s to 15) Manual

Recalculate

When required, Every acquisition

When required

Parameters

The Spread Spectrum Clock menu has the following parameters:

Option Parameters Default setting

Nominal frequency

Auto Determined by instrument TBD

Manual User selectable 2.5 GHz
RJDJ Analysis Parameters

The RJIDJ configure menu has the following parameters.

Option Parameters Default setting

Pattern Detection/Control

Pattern Detection Auto, Manual Auto

Pattern Type Repeating, Arbitrary Auto TBD

Manual Repeating
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Option Parameters Default setting
Pattern Length * 2 Ulto IM UI 2Ul

Window Length t 210 24 Ul 10 Ul

Jitter Target BER

BER = 1E-?% 2 to 18 in whole numbers 12

*

Only for Repeating Patterns.
T Only for Arbitrary Patterns.
¥ Only for TIE, TI@BER, and Width@BER measurements.

Filters Parameters
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The Filter configure menu has the following parameters:

Option Parameters Default setting
High Pass (F1)

Filter Spec No Filter, 1st order, 2nd order, 3rd order No Filter

Freq (F1) 10 Hzto 1 THz 1 kHz

Low Pass (F2)

Filter Spec No Filter, 1st order, 2nd order, 31 order No Filter

Freq (F2) 10 Hzto 1 THz 1 kHz

Advanced Filter Configure Parameters

The Advanced Filter Configuration includes the following parameters:

Option Parameters Default setting
Ramp Time O/F to 10/F 2IF
Blanking Time O/F to 10/F 4/F
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Bus State

The Bus State configure menu has the following parameters:

Table 78: Bus state options

Option Parameters Default setting
Use symbol file On, Off On

Enter pattern On, Off Off

Symbol MODE_REG, REFRESH, PRECHARGE, PDE

ACTIVATE, WRITE, READ, SRX,
DESELECT, SRE, PDE

Measure at Clock Edge, Start, Stop Clock Edge
Clock Source Chl, Ch2, Ch3, Ch4, Mathl, Math2, Ch2
Math3, Math4, Refl, Ref2, Ref3, Ref4
Clock Polarity Rising, Falling Rising
From Symbol MODE_REG, REFRESH, PRECHARGE, MODE_REG

ACTIVATE, WRITE, READ, SRX,
DESELECT, SRE, PDE

To Symbol MODE_REG, REFRESH, PRECHARGE, MODE_REG
ACTIVATE, WRITE, READ, SRX,
DESELECT, SRE, PDE

Clock Edge Settings

To Symbol MODE_REG, REFRESH, PRECHARGE, MODE_REG
ACTIVATE, WRITE, READ, SRX,
DESELECT, SRE, PDE

Measure at Clock Edge, Start, Stop Clock Edge

General Parameters

The General configure menu has the following parameters:

Option Parameters Default setting
Measurement Range Limits Off, On Off

Maximum and minimum values vary for different measurements. For more details, refer to Measurement
Range Limit Values.
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Global Parameters
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The Global configure menu has the following parameters:

Global Parameters

Option Parameter Default setting

Gating

Gating Off, Zoom, Cursors Off

Qualify

Qualify Off, On Off

Qualify With Logic

Source Ch1-Ch4, Refl-Ref4, Math1-Math4, Chl
Search0-Search8, Burst Search

Mid -20Vto20V ov

Hysteresis Oto10V 30 mv

Active High, Low High

Population

Population Off, On Off

Population Limit

Limits By Population, Acquisitions Acquisitions

Limit 1to 23t 1K

Stop Condition Each Measurement, Last Each Measurement
Measurement
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Histogram Plot Parameters

The Histogram plot has Autoset as the command button.

Histogram Plot Parameters

Option Parameters Default setting
Vertical Scale Log, Linear Linear
Number of Bins
Resolution 25, 50, 100, 250, 500 250
Horizontal Scale
Auto Scale Set, Clear Set
Center -ImstolTs 100 ns
Span 1stolTs 4ns
Eye Diagram Plot Parameters
The Eye Diagram plot has the following parameters:
Option Parameters Default setting
Mask On, Off Off
Browser C:\Users\Public\Tek-
tronix\TekApplica-
tions\DPOJET\Masks
Horizontal Scale
Auto Scale Set, Clear Set
Resolution 2.00E-13 to 2.00E-08 1.00E-12
Superimpose Reference Clock Eye Set, Clear Clear
(if available)
Ref Clock Alignment Auto, Centre and Left Auto
Spectrum Plot Parameters
The Spectrum plot has the following parameters:
Option Parameters Default setting
Vertical Scale Log, Linear Log
Base -20t0 15 -15
Horizontal Scale Log, Linear Linear
Mode Normal, Average, Peak Hold Normal
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Time Trend Plot Parameters

The Time Trend plot has the following parameters:

Time Trend Plot Parameters

Option Parameters Default setting

Mode Vector, Bar Vector
Phase Noise Plot Parameters

The Phase Noise plot has the following parameters:

Option Parameters Default setting

Vertical Position

Baseline -200to 0 -170
Bathtub Plot Parameters

The Bathtub plot has the following parameters:

Option Parameters Default setting

Vertical Scale Log, Linear Log

Minimum displayed BER= 1E-? 2t018" 14

* Applicable for Log and Linear scale only.
Transfer Function Plot Parameters

The Transfer Function plot has the following parameters:

Option Parameters Default setting

Vertical Scale Log, Linear Log

Horizontal Scale Log, Linear Log

Mode Normal, Average Average
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Composite Jitter Histogram Plot Parameters

The Composite Jitter Histogram plot has the following parameters:

Option Parameters Default setting
Vertical Scale Log, Linear Linear
Number of Bins

Resolution 25, 50, 100, 250, 500 250
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Reports
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The Reports menu has the following command buttons:

= Save
= Save As
= Append
" View

= Add/Edit Comments

Option Parameters Default setting

Auto increment report name if Set, Clear Set

duplicate

Display units in separate column Set, Clear Clear

View report after generating Set, Clear Set

Display units in separate column Set, Clear Clear

Content To Save

Include pass/fail results summary Set, Clear Set

Include detailed results Set, Clear Set

Include plot images Set, Clear Set

Include setup configuration Set, Clear Set

Include user comments Set, Clear Set

Include complete application Set, Clear Set

configuration

Save Waveform file(s) along with Set, Clear Clear

report

Report Name Browser C:\%USERPROFILE%\Tek-
tronix\TekApplica-
tions\DPOJET\Reports,

where %USERPROFILE% represents
your user location.
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Progress Bar Status Messages

Function/Measurement module Status/Message Description

Autoset-Source Autoset

VertAuto-Chx

Vertical autoset for Chx is going on.

Autoset-Source Autoset

HorizAuto-Chx

Horizontal autoset for Chx is going on.

Autoset-Source Autoset

Zooming Horiz

Zooming the horizontal scale after
horizontal autoset.

Autoset-Ref Level Autoset RefAuto-Chx Reference level autoset for Chx is
going on.

Autoset-Ref Level Autoset RefAuto-Refx Reference level autoset for Refx is
going on.

Autoset-Ref Level Autoset

RefAuto-Mathx

Reference level autoset for Mathx is
going on.

Sequencing Sequencing Refers to the measurement
setup-edge extraction.
Measurement Name Running the measurement specified
by name.
Plots Plotting Plotting is started.
Bathtub Creating Bathtub plot.
Spectrum Creating spectrum plot.
Time Trend Creating time trend plot.
Histogram Creating Histogram plot.

Transfer Func

Creating Transfer Function plot.

Eye Mask Hits

Creating Eye Diagram plot.

Eye Height Creating Eye Diagram plot.
Data Array Creating Data Array plot.
Phase Noise Creating Phase noise plot.

Edge Extraction

Finding Edges

Extracting Edges from signal
waveform.

Clock Data Recovery Recovery Clk Clock and Data recovery.

Worst case logging Saving WC Wfm Logging the worst case waveform.
Trigger Slow Trigger Waiting for trigger/trigger not available.
Measurements Name Progress Bar Display

Amplitude High Low Ampl High-Low

Amplitude HighV Amp High

Amplitude LowV Ampl Low

CMV Common Mode

DCD DCD

DDJ DDJ

DiffXovrV V-Diff-Xovr

DJ DJ
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Error Codes

Function/Measurement module Status/Message Description

DJdd DJ-36

EdgeExtractor Edge Extractor

EyeHeight Eye Height

EyeHeightBER Eye Height@BER

EyeMaskHits Eye Mask Hits

EyeWidth Eye Width

EyeWidthBER Eye Width@BER

FallTime Fall Time

Frequency Freq

HighTime High Time

Hold Hold

LowTime Low Time

NegativeDutyCycle -Duty Cycle

NegativeDutyCycleCycle —-CC-Duty

NegativeWidth Neg Width

NPeriod N-Period

PerCycleCycle CC—Period

Period Period

PhaseNoise Phase Noise

PJ PJ

PositiveDutyCycle +Duty Cycle

PositiveDutyCycleCycle +CC-Duty

PositiveWidth Pos Width

RiseTime Rise Time

RJ RJ

RJOd RJ-06

Setup Setup

Skew Skew

TIE TIE

TJ TJ@BER

TNTRatio T/nT Ratio
Error Codes

Code Description

E102 File does not exist

E103 DPOJET is not able to open the help file. In order to use the help file, please reinstall

DPOJET.
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Code Description

E104 Mask Hits measurement requires an Eye diagram plot but no more plots can be
assigned. Please remove a plot before adding a Mask Hits measurement.

E105 The maximum number of plots you can select is 4.

E106 No Spectrum plot data is available.

E107 This plot type is not configurable.

E109 The SSC PROFILE measurement requires an Time Trend plot but no more plots can be
assigned. Please remove a plot before adding a SSC PROFILE measurement.

E202 The upper range must be greater than the lower range.

E400 A measurement failed to complete successfully.

W410 Number of edges are not sufficient for a measurement.

E411 In at least one zone, there are too few edges to complete a measurement.

E424 No edges or Ul of the required type were found in the waveform. If this is not a clock
signal, check the Vref threshold and record length.

E425 No transitions of the selected Bit Type were found in the waveform.

E426 Result has 0 population since all measurement points fall within the PLL's settling time.
Either acquire a longer waveform, or increase the PLL's bandwidth.

E500 The record lengths of the source waveforms differ. Please configure for sources with
equivalent record lengths.

E1001 Vertical Autoset Failed: Signal on Source x has extreme offset.

E1002 Vertical Autoset Failed: Amplitude of Source X is too smalll.

E1003 Vertical Autoset Failed: Amplitude or DC offset of Source x is too high.

E1004 Vertical Autoset Failed: No signal on Source x.

E1005 Vertical Autoset Failed: Signal on Source x exceeds top of scale.

E1006 Vertical Autoset Failed: Signal on Source x exceeds bottom of scale.

E1007 Vertical Autoset Failed: Signal on Source x is clipped on top.

E1008 Vertical Autoset Failed: Signal on Source x is clipped on bottom.

E1009 Vertical Autoset Failed: Measurement error ( ISDB error code = 6 ) on Source x.

E1010 Vertical Autoset Failed: Measurement error ( ISDB error code =7 ) on Source x.

W1011 A change to Source x vertical settings caused overload disconnect. Original settings
are restored and Source x is reconnected. Ignore oscilloscope message.

E1012 Vertical Autoset Failed: None of the selected measurements use live sources
(Ch1-Ch4). Vertical autoset works for live sources only.

E1013 Vertical Autoset Failed: Invalid signal on Source x.

E1020 Horizontal Autoset Failed: None of the selected measurements use live sources
(Ch1-Ch4). Horizontal autoset works for live sources only.

E1021 Horizontal Autoset Failed: On Source x, cannot determine resolution of rising/falling
edges.

E1022 Horizontal Autoset Failed: Horizontal resolution is at the maximum.

E1026 Horizontal Autoset Failed: Source amplitude is too low.

E1027 Horizontal Autoset Failed: Signal is clipped at the top - positive clipping.

E1028 Autoset Failed: Signal is clipped at the bottom - negative clipping.
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Error Codes

Code Description

E1029 Horizontal Autoset Failed: Signal frequency is extremely low.

E1035 Oscilloscope has gone into invalid state. Please restart the system.

E1040 Autoset Failed: None of the live sources (Ch1-Ch4) selected.

W1051 Ref Level Autoset: Waveform for the source x is clipped.

W1053 Ref Level Autoset: Source amplitude is extremely low.

E1054 Ref Level Autoset: Error in setting reference levels.

E1055 Ref Level Autoset Failed: No waveform to measure.

E1056 Ref Level Autoset: Unstable Histogram for waveform on source x.

E1057 Ref Level Autoset: No selected source.

E1058 Ref Level Autoset Failed: Invalid signal on source X.

E1059 Ref Level Autoset Failed: High/Low Method measures High = Low on.

E1060 Ref Level Autoset Failed: Max/Min Method measures Max = Min on.

E1061 Since Digital Filters (DSP) Enabled, Maximum sampling rate has been retained.
To enable adaptive use of lower sampling rate, please choose Analog Only under
Vertical->Bandwidth Enhanced.

E1062 The maximum Record Length (RL) in autoset is restricted to 25M, set the RL manually
for > 25M.

E1063 The minimum Record Length (RL) in autoset is restricted to 500K, set the RL manually
for < 500K.

W1064 Ref Level Autoset: Unable to trigger.

E2001 The maximum number of measurements has been reached.

E2002 All the refs are used as sources by the measurements. Export to Ref is not possible.

E2003 Ref '’ is already used as a measurement source.

E2004 Ref 'x’ is already used as a destination for other measurement.

E2005 No measurement(s) are selected. Export to Ref is not possible.

E2006 No results available to export to ref.

E2007 There are no time trend results for the selected measurement(s).

E2008 No ref destination is selected. Results will not be exported to ref.

E3001 Could not open or create a log file. Please ensure that you have read/write permission
to access log folders and files.

E3002 The specified path is invalid (for example, the specified path is not mapped to a drive).

E3003 The specified path, file name or both exceed the system defined length. For example,
on Windows-based platforms, the path name must be less than 248 characters and file
names less than 260 characters.

E3004 The specified path directory is read-only or is not empty.

E3005 Please ensure that the file is currently not in use by other process and/or has not
exceeded the file size limit.

E3006 Invalid filename: Check whether the file name contains a colon (:) in the middle of
the string.

E3007 Select at least one measurement from the table before you save.

E3008 There are currently no results to save. Please run a measurement.
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Code

Error Codes

Description

E3009

Current statistics is successfully saved at C:\%USERPROFILE%\Tektronix\TekApplica-
tions\DPOJET\Logs\Statistics, where %USERPROFILE% represents your user location.

E3010

Access to file/directory denied. Please ensure that the file/directory has read/write
permissions.

E3011

Mask Hits Measurements will not be selected as this feature is not available for Mask
Hits measurement.

E3012

Folder does not exist.

E4000

Not enough data points. Unable to render plot(s).

E4001

Internal measurement error. Please remove a measurement and try again.

E4002

Not enough data points for spectrum computation.

E4003

Due to high memory usage, only a portion of the waveform could be processed. Please
reduce your record length or the number of measurements.

E4004

An error occurred in the edge extraction process.

E4005

Qualifier: The record length and sample interval must match across the waveforms.

E4006

A maximum of 4096 qualifier zones is supported. The entire waveform will not be
processed and hence partial measurement results are available.

E4007

Logic Qualifier enabled and no qualifier zones found.

W4008

The configured Ref voltage for Overshoot must be greater than or equal to the mid
autoset ref levels.

W4009

The configured Ref voltage for Undershoot must be lesser than or equal to the mid
autoset ref levels.

E4013

The configured Ref voltage must be greater than or equal to the mid autoset ref levels.

E4014

The configured Ref voltage must be lesser than or equal to the mid autoset ref levels.

E40151%

One or more qualifier zones had too few edges for measurement calculation.

E4016

Not enough edges in the waveform for measurement calculation.

E4017

Qualifier not enabled and hence no qualifier zones found. Please enable the qualifier.

E4018

The preamble is incomplete in all the qualifier zones.

E4019%

The preamble is incomplete in one or more qualifier zones.

E4020

The postamble is incomplete in all the qualifier zones.

E4021%

The postamble is incomplete in one or more qualifier zones.

E4022+%

Not enough samples present in the qualifier zones. Please increase the sampling
rate and reacquire the waveform.

E4023

The configured ref levels are not correct. The high ref level should be >= Mid and Mid
should be >= Low for both Rise and Fall slopes. Reconfigure the ref levels and run
the measurement.

E4024

Could not compute proper High and Low values.

W4025

The signal does not cross the configured Ref Voltage and hence the result shows zero
population. Please adjust the Ref voltage value.

W4026

Command Patterns were not found in the required order.

E4027

From Symbol not found in the acquisition.

E4028

To Symbol not found in the acquisition.
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Code Description

E4029 The configured High Ref voltage must be = to the mid autoset ref levels.

E4030 The configured Low Ref voltage must be < to the mid autoset ref levels.

E4031 The configured High Ref voltage must be = to the mid autoset ref levels and the
configured Low Ref voltage must be < to the mid autoset ref levels.

E4032 Set up the DDR Search and turn on the Qualifier to run this measurement.

E4033 Required command was not found after the burst.

E4034 Self Refresh Entry command is not registered in the current acquisition.

E4035 Self Refresh Exit command is not registered in the current acquisition.

E5005 1 Occurs while running setup. Please make sure you have finished any previous setup
and closed other applications.

W5005 The path or file name exceeds the system limit of 260 characters.

W9005 Derating value calculated using single Slew Rate measurement value.

W9006 Derating value cannot be computed since the calculated Slew Rate is not present in
the derating table T.

E9007 Derating Error .

Slew Rate measurements used to calculate the derated value failed to Run as there are no sufficient edges on the Rise and Fall slopes of
the waveform.

Base measurement limits are not defined as per the specification.

T Signal Slew Rate value is outside the derating table (Example: If DDR2-800 MT/s tDS derating with a differential probe has a DQS differential slew
rate of 0.65 V/ns, this warning message is displayed as the derating table definition starts from 0.8 V/ns).

Derating value is not supported (TBD) in the specification (Example: If the DQS differential slew rate is 2.0 V/ns and the DQ slew rate is 0.7 V/ns,
then the value is -(TBD).

Derating will not be applied for the above cases and the base limit will be displayed in the results table.
¥ Displays the zone number for which the preamble/postamble fails.

1 This error occurs during DPOJET installation on a DPO/MSO oscilloscope. Delete the Installshield folder under C:\Program files\Common Files
and delete all files and folders under C:\Windows\Temp folder. Restart the installation again.

Measurement Range Limit Values
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The following table lists the maximum and minimum values of al measurement range limits:

NOTE. Measurement Range Limits are provided for each measurement under the General configure tab
of the DPOJET application. The range limits are turned off by default. For two-source measurements
such as Skew, Setup, Hold and a few others, these range limits are always ON (OFF is disabled). In
these cases, the range limits are used by the algorithms to associate the valid edge of first source to the
valid edge of the second source.

Measurement range limits (Max) Measurement range limits (Min)
Name Default Max Min Default Max Min
Period/Freq measurements
Period 1ms 1ks 0s 0s 1ks 0s
CC-Period 1ns ls 1fs -1ns -1fs -1s
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M easurement Range Limit Values

Measurement range limits (Max) Measurement range limits (Min)
Name Default Max Min Default Max Min
Freq 10 GHz 50 GHz 1 MHz 1 MHz 50 GHz 1 MHz
N-Period 1ms 1ks 0s 0s 1ks 0s
Pos Width/ 10 ns 1Ms 1ps 1ns 1Ms 1ps
Neg Width
+Duty 90 % 100 % 0% 10 % 100 % 0%
Cycle/-Duty
Cycle
+CC-Duty/ 90 % 100 % 100 % 10 % 100 % 0%
—CC-Duty
Jitter Measurements
TIE 1ns 1ps -1ps -1ns 1ps -1 s
RJ 1ns 1us 0s 1ns 1us 0s
RJ-06 1ns 1 s 0s 0s 1pus 0s
TJ@BER 1ns 1ps 0s 0s 1ps 0s
DJ 1ns 1ps 0s 0s 1ps 0s
DJ-00 1ns 1ps 0s 0s 1ps 0s
Phase Noise 1ms 1ms 0s 0s 1ms 0s
DCD 1ns 1ps Os 0s 1ps 0s
DDJ 1ns 1us 0ns 0s 1us 0s
PJ 1ns 1ps 0s 0s 1ps 0s
J2 1ns 1pus 0s 0s 1ps 0s
J9 1ns 1us 0s 0s 1us 0s
FIN 1ns 1us Os 0s 1us 0s
SRJ 1ns 1ps 0s 0s 1us 0s
Time Measurements
Rise Time 200 ns 1ks 0s 0s 1ks 0s
Setup 10 ns ls -1s 0s ls -1s
High Time 10 ns 1 Ms 1ps 0s 1 Ms 1ps
Fall Time 200 ns 1ks 0s 0s 1ks 0s
Rise Slew 1 Vins 100 V/ns 1 uVins 0 Vins 100 Vins 0 Vins
Rate
Fall Slew 0 Vins 0 Vins -100 Vins -1Vins -1 uVins -100 VIns
Rate
Hold 10 ns ls -1s 0s 1s -1s
Low Time 10 ns 1Ms 1ps 1ps 1 Ms 1ps
Skew 10 ns 1s -1s -10 ns 1s -1s
SSC Profile 1ms 1ks 0s 0s 1ks 0s
SSC Mod 10 kHz 50 GHz 100 Hz 1 kHz 50 GHz 100 Hz
Rate
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Measurement range limits (Max)

Measurement Range Limit Values

Measurement range limits (Min)

Name Default Max Min Default Max Min
SSC Freq 1 kppm 1 Gppm -1 Gppm -1 kppm 1 Gppm -1 Gppm
Dev

SSC Freq 1 kppm 1 Gppm -1 Gppm -1 kppm 1 Gppm -1 Gppm
Dev Min

SSC Freq 1 kppm 1 Gppm -1 Gppm -1 kppm 1 Gppm -1 Gppm
Dev Max

Time Outside 1ms 1ks 0s 0s 1ks 0s
Level

tCMD-CMD 1ms 1ks 0s 0s 1ks 0s
Eye Measurements

Height 500 mV 1kv ov 50 mV 1kv oV
Height@ 500 mV 1kv ov 50 mV 1kV oV
BER

Width 1ns ls 0s 50 ps ls 0s
Mask Hits 500 Hits 1 MHits 0 Hits 0 Hits 1 MHits 0 Hits
Autofit Mask 500 Hits 1 MHits 0 Hits 0 Hits 1 MHits 0 Hits
Hits

Width@BER 0.9 Ul 10Ul 0 Ul 0.1Ul 1.0Ul oul
Eye High 500 mv 10V 10V -500 mv 10V 10V
Eye Low 500 mV 10V 10V -500 mV 10V 10V
Q-Factor 1k 1G 0 0 1G 0
Amplitude Measurements

DC Common 500 mv 10V -0V -500 mv 10V -0V
Mode

AC Common 500 mv 10V -0V -500 mv 10V -10V
Mode

High 500 mv 10V -10V =500 mV 10V -10V
T/nt-Ratio 8 dB 12 dB -12.dB 0dB 12 dB -12 dB
High-Low 500 mv 10V -10V -500 mV 10V -10V
Low 500 mv 10V -0V -500 mv 10V -10V
V-Diff-Xovr 500 mv 10V -0V -500 mv 10V -0V
Overshoot 500 mVv 10V oV 0omv 10V ov
Undershoot 500 mV 10V ov ov 10V ov
Cycle Pk-Pk 500 mv 10V 10V -500 mv 10V -0V
Cycle Min 500 mv 10V 10V -500 mv 10V -0V
Cycle Max 500 mV 10V 10V -500 mV 10V -0V
Standard-Specific Measurements

DDR 10 ns ls -1s 0ns ls -1s
Setup-SE
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Measurement range limits (Max)

Measurement range limits (Min)

M easurement Range Limit Values

Name Default Max Min Default Max Min
DDR 10 ns 1ls -1s 0ns 1ls -1s
Setup-Diff

DDR 10 ns 1ls -1s 0ns 1s -1s
Hold-SE

DDR 10 ns 1ls -1s 0ns 1s -1s
Hold-Diff

DDR 1ms 1ks 0ns 0ns 1ks 0ns
tCK(avg)

DDR 1ms 1ks 0ns 0ns 1ks 0ns
tCH(avg)

DDR 1ms 1ks 0ns 0ns 1ks 0ns
tCL(avg)

DDR 10 ns 1ms -1ms -10 ns 1ms -1ms
tJIT(duty)

DDR 10 ns 1ms -1ms -10 ns 1ms -1ms
tJIT(per)

DDR 10 ns 1ms -1ms -10 ns 1ms -1ms
tERR(n)

DDR 10 ns 1ms -1ms -10 ns 1ms -1ms
tERR(m-n)

DDR tRPRE 2.5ns 1ks 0s 0s 1ks 0s
DDR tWPRE 2.5ns 1ks 0s 0s 1ks 0s
DDR tPST 2.5ns 1ks 0s 0s 1ks 0s
DDR Over 660 mVs 1kVs 0Vs 0Vs 1kVs 0Vs
Area

DDR 660 mVs 1kVs 0Vs 0Vs 1kVs 0Vs
UnderArea

DDR VID(ac) 500 mVv 0oV -10V -500 mV 0oV -10V
DDR tDQSS 1ms 1ks 0s 0s 1ks 0s
DDR2 1ms 1ks 0s 0s 1ks 0s
tCKSRE

DDR3 Vix- 500 mV 0oV -10V -500 mV 0oV -10V
(ac)

PCle Med- 1ms 1ks 0s 0s 1ks 0s
Mx-Jitter

GDDR5 1ms 1ks 0s 0s 1ks 0s
tCKSRX

GDDR5 0s 0s -100 s -1s -1ys -100 s
tBurst-CMD

GDDR5 1ms 1ks -1ks -1 ms 1ks 0s
tDQSCK
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Measurement range limits (Max) Measurement range limits (Min)

Name Default Max Min Default Max Min
PCle AC 500 mV 10V -10V -500 mV 10V -0V
Common
Mode
PCle T-RF- 1ns 1ks 0s 0s 1ks 0s
Mismch
PCle MAX- 1V 10V -10V -1V 10V -0V
MIN Ratio*
PCle SSC 200 ns 1ks 0s 0s 1ks 0s
FREQ DEV
PCle SSC 1ms 1ks 0s 0s 1ks 0s
PROFILE
PCle-T-Tx- 1V 10V -10V -1V 10V -0V
Diff-PP
PCle T-TX 1ns ls 0s 50 ps 1s 0s
PCle T-Tx- 200 ns 1ks 0s 0s 1ks 0s
Fall
PCle Tmin- 1ms 1ks 0s 0s 1ks 0s
Pulse
PCle 8 dB 12 dB -12.dB 0dB 12 dB -12 dB
DeEmph
PCle T-Tx- 200 ns 1ks 0s 0s 1ks 0s
Rise
PCle Ul 1ms 1ks 0s 0s 1ks 0s
T-TX-DDJ 1ns 1ys 0s 0s 1ps 0s
T-TX-UTJ 1ns 1ps 0s 0s 1ps 0s
T-TX- 1ns 1ps 0s 0s 1ps 0s
ubJDD
T-TX- 1ns 1us 0s 0s 1ps 0s
UPW-TJ
T-TX-UPW- 1ns 1ps 0s 0s 1ps 0s
DJDD
V-TX NO-EQ 12V 2V ov oV 2V oV
V-TX EIEOS 12V 2V ov oV 2V ov
ps21TX 8dB 12 dB -12dB 0dB 12 dB -12dB
V-TX- 8 dB 12 dB -12.dB 0dB 12 dB -12 dB
BOOST
USB AC 500 mV 10V -0V -500 mv 10V -10V
Common
Mode
USB VTx- 1V 10V -10V -1V 10V -0V
Diff-PP
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Measurement range limits (Max) Measurement range limits (Min)
Name Default Max Min Default Max Min
USB TCdr- 200 ns 1 ks 0s 0s 1ks 0s
Slew-Max
USB Tmin- 1ms 1ks 0s 0s 1ks 0s
Pulse-Tj
USB Tmin- 200 ns 1ks 0s 0s 1ks 0s
Pulse-Dj
USB SSC 200 ns 1 ks 0s 0s 1ks 0s
MOD RATE
USB SSC 200 ns 1ks 0s 0s 1ks 0s
FREQ DEV
MAX
USB SSC 200 ns 1ks 0s 0s 1ks 0s
FREQ DEV
MIN
USB SSC 1ms 1ks 0s 0s 1ks 0s
PROFILE
USB Ul 1ms 1ks 0s 0s 1ks 0s

Custom name for PCle MAX-MIN Ratio is PCle VRX-MAX-MIN Ratio.
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Measurement Units

The following table lists the engineering multipliers that the DPOJET application uses.

Table 79: Measurement units

Abbreviation Unit Multiplier
y yocto or septillionths 1E-24)
z zepto or sextillionths 1E-21)
a atto or quintillionths 1E-18)
f femto or quadrillionths 1E-15)
p pico or trillionths 1E-12)
n nano or billionths 1E-09)
u micro or millionths 1E-06)
m milli or thousandths 1E-03)
one 1E+00)
k kilo or thousands 1E+03)
M mega or millions 1E+06)
G giga or billions 1E+09)
T tera or trillions 1E+12)
P peta or quadrillions 1E+15)
E exa or quintillions 1E+18)
z zetta or sextillions 1E+21)
Y yotta or septillions 1E+24)
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Custom Mask File Requirements

DPOJET uses mask definition files that are compatible with TekScope firmware user masks, and consist of
ASCII text but are identified with a.msk file extension. Any firmware mask can be saved as a user mask
and imported into DPOJET. Alternatively, DPOJET mask files can be manually created using an ASCI|
text editor such as Notepad, or copied from an existing mask and then edited. DPOJET doesn't require most
of thefields found in a TekScope mask file, so the minimum DPOJET mask fileis substantially smpler.

The following fields are required:

“MASK:USER:SEG1:POINTS x1,yl,x2,y2,x3,y3,x4,y4;
“MASK:USER:SEG2:POINTS x1,yl,x2,y2,x3,y3,x4,y4;
*MASK:USER:SEG3:POINTS x1,yl,x2,y2,x3,y3,x4,y4;

Segl represents the top mask segment, typically used to detect overshoot. Similarly, Seg3 is the base mask
segment that detects undershoot. Seg? is the center-of-eye mask, which typically has four or six vertices.
The mask vertices are represented by xy pairs where x isin seconds and y isin volts. All mask segments
must be convex. The center of the eye is the time reference point t = 0.

For reasons beyond the scope of this document, it isnot valid to have ALL time values for ALL segments
greater than zero.

The top and base segments can affect the eye diagram scale. The eye diagram will always be scaled such
that these segments are fully displayed.

If it is desired to disable a mask segment, use four identical vertices (conceptually describing arectangle
with zero width and zero height). Such a segment will cause no mask hits, although it can still affect eye
diagram scaling. For example, -MASK:USER:SEG1:POINTS 0,4,0,4,0,4,0,4; would disable the
upper segment, but it would force the top edge of the eye diagram to at least +4 V.

All other fields are optional, at the time of this writing, and are ignored by DPOJET. It is possible that
future versions of DPOJET software will use additional fields as new features are added to TekScope
firmware or DPOJET.

An example mask fileis as follows. Only the last three lines are mandatory:

-MASK:-USER:WID 400.0000E-12;

:MASK:USER:LAB "'User Mask';

:MASK:USER:VSCA 200.0000E-3;

-MASK:USER:BITR 2.5000E+9;

“MASK:USER:SEG1:POINTS -200.0000E-12,600.0000E-3,200.0000E-12,600.0000E-
3,200.0000E- 12,800.0000E-3,-200.0000E-12,800.0000E-3;
“MASK:USER:SEG2:POINTS -140.0000E-12,0.0000,25.8494E-27,-400.0000E-
3,140.0000E- 12,0.0000,25.8494E-27,400.0000E-3;

*MASK:USER:SEG3:POINTS -200.0000E-12,-800.0000E-3,200.0000E-12,-800.0000E-
3,200.0000E-12,- 600.0000E-3,-200.0000E-12,-600.0000E-3;
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About Algorithms

The DPOJET application can take measurements from one or two waveforms. The number of waveforms
used by the application depends on the type of measurement being taken.

Oscilloscope Setup Guidelines
For all measurements, use the following guidelines to set up the oscilloscope:
1. Thesignal isany channel, reference, or math waveform.

2. Thevertica scale for the waveform must be set so that the waveform does not exceed the vertica
range of the oscilloscope.

3. The sample rate must be set to capture sufficient waveform detail and avoid aliasing.

4. Longer record lengths increase measurement accuracy but the oscill oscope takes longer to measure
each waveform.

Period

If the Signal Type is Clock

The Period measurement cal culates the duration of a cycle as defined by a start and a stop edge. Edges
are defined by polarity, threshold, and hysteresis. The application calculates clock period measurement
using the following equation:

ﬂﬁ?ﬁ.&- - T

n+l

- %

Where:
PClock js the clock period.

T isthe VRefMid crossing time for the selected polarity.
If the Signal Type is Data

The Period measurement calculates the duration of a Unit Interval. The application calculates this
measurement using the following equation:

P = (T e _TPa0/ K,

Where:
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PData s the data period.
TPata js the VRefMid crossing time in either direction.

K, =C—C,.1 isthe estimated number of unit intervals between two successive edges. C, isthe calculated
data bit index of T,Paa,

Each measurement result P, Paa is repeated K, times in the measurement result vector, so that the
measurement population is equal to the number of unit intervalsin the qualified waveform, rather than the
number of edge pairs.

Positive and Negative Width

Amount of time the waveform remains above/below the mid reference voltage level.

The application cal culates these measurements using the following equations:

W;— = ?:é_ - TI‘:
W;’é— = ?1:: - T?!—
Where:

W+ is the positive pulse width.

W is the negative pulse width.

T—isthe VRefMid crossing on the falling edge.
T+ isthe VRefMid crossing on the rising edge.
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Frequency

Frequency measurement calculates the inverse of the data period for each cycle.

If the Signal Type is Clock
The application calculates clock frequency measurement using the following equation:

FHCEMR- - ]..'II P::E.x.t

Where:
FClock js the clock frequency.

PClock js the clock period measurement.

If the Signal Type is Data

The application cal culates data frequency measurement using the following equation:

Fﬁm:; - 1 lI.' aﬂﬂﬂ.
Where:

FData jis the data frequency.

Ppata js the data period measurement.

DPOJET Jitter and Eye Diagram Analysis Tools 253



Algorithms N-Period

N-Period

If the Signal Type is Clock

The N—Period measurement calcul ates the elapsed time for N consecutive crossings of the mid reference
voltage level in the direction specified.

The application calculates this measurement using the following equation:

Wﬂock _ g llock TC‘?ch}c
" Tt N "
Where:
NPClock js the accumul ated period for N clock cycles.

TClock js the VRefMid crossing time for the selected edge polarity.

If the Signal Type is Data

The N—Period measurement cal culates the elapsed time for N consecutive unit intervals.

The application calculates this measurement using the following equation:

Dyt e Dty Dt
NE =1 v —1,

Where:
NPPata js the duration for N unit intervals.
Thata js the VRefMid crossing time in either direction.

If T..nPat2 does not exist for a given n, no measurement is recorded for that position.
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Positive and Negative Duty Cycle

The +Duty Cycle and —Duty Cycle measurements calculate the ratio of the positive (or negative) portion of
the cycle relative to the period.

The application cal culates these measurements using the following equations:

D;— - I‘i'-’:- faﬂ'&:ck.
Dy =W, i B

Where:

D+ is the positive duty cycle.
D—is the negative duty cycle.
WH is the positive pulse width.
W—is the negative pulse width.

PClock js the period.

Related Topics
B Period (see page 251)

m Positive and Negative Width (see page 252)

CC-Period

The CC—Period measurement cal culates the difference in period measurements from one cycle to the next.

The application calculates CC—Period measurement using the following equation:

= =PC§J£F:. _Plﬁﬂﬁ.‘;

#+1

Where:
AP is the difference between adjacent periods.

P Clock js the clock period measurement.
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Positive and Negative CC Duty

TIE

256

The + CC-Duty and — CC-Duty measurements cal culate the difference in positive (or negative) pulse
widths from one cycle to the next.

The application cal culates these measurements using the following equations:
AW} = A ~ AT
AW = N, ~ A

Where:

AW isthe difference between positive pulse widths of adjacent clock cycles.
AW—is the difference between negative pul se widths of adjacent clock cycles.
W s the positive pulse width measurement.

W—is the negative pulse width measurement.

TIE (Time Interval Error) is the difference in time between an edge in the source waveform and the
corresponding edge in areference clock. The reference clock is usually determined by a clock recovery
process performed on the source waveform. For Explicit-Clock clock recovery, the processis performed
on an explicitly identified source.

If the Signal Type is Clock

The application calculates Clock TIE measurement using the following equation:

TIECEMR- - Tﬁc’c—'.‘; -7 CIek

Where:
TIEClock s the clock time interval error.
TClock s the VRefMid crossing time for the specified clock edge.

TClock js the corresponding edge time for the specified reference clock.
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RJ

If the Signal Type is Data

The application calculates Data TIE measurement using the following equation:

TIED® = Tpae _ bac

Where:

TIEDaa js the data time interval error.

TData js the VRefMid crossing time in either direction.

TData js the corresponding edge time for the specified reference clock.

The subscript k is used to indicate that there is one measurement per Unit Interval, rather than one
measurement per actual edge.

Random Jitter (RJ) isthe rms magnitude of al timing errors not exhibiting deterministic behavior. A single
RJ value is determined for each acquisition, by means of RJDJ separation analysis.

Related Topics
m Jitter Analysis Through RIDJ Separation (see page 324)

Dual Dirac Random Jitter

Dual Dirac Random Jitter (RJ-66) is the rms magnitude of al timing errors not exhibiting deterministic
behavior, calculated based on a simplifying assumption that the histogram of al deterministic jitter can
modeled as a pair of equal-magnitude dirac functions (impulses). A single RJ-66 value is determined for
each acquisition, by means of RJ/DJ separation analysis.

Related Topics
m Jitter Analysis Through RIDJ Separation (see page 324)

m Jitter Estimation Using Dual-Dirac Models (see page 328)

DPOJET Jitter and Eye Diagram Analysis Tools 257



Algorithms Jitter Summary

Jitter Summary

The Jitter Summary is not a single measurement. The Jitter Summary button on the graphical user interface
simply creates one each of all the other jitter measurements, as a convenience. This convenience function
is not supported via the programmable interface.

TJ@BER

DJ

258

Total Jitter at a specified Bit Error Rate (BER). This extrapolated value predicts a peak-to-pesk jitter that
will only be exceeded with a probability equal to the BER. It is generally not equal to the total jitter
actually observed in any given acquisition. A single TI@BER value is determined for each acquisition, by
means of RYDJ separation analysis.

Related Topics
m Jitter Analysis Through RJDJ Separation (see page 324)

B Estimation of TIBER and Eye WidthBER (see page 327)

Deterministic Jitter (DJ) is the peak-to-peak amplitude for all timing errors that follow deterministic
behavior. A single DJvalue is determined for each acquisition, by means of RJDJ separation analysis.

Related Topics
m Jitter Analysis Through RJDJ Separation (see page 324)
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Dual Dirac Deterministic Jitter

Dual Dirac Deterministic Jitter (DJ-00) the peak-to-peak magnitude for all timing errors exhibiting
deterministic behavior, calculated based on a simplifying assumption that the histogram of all deterministic
jitter can modeled as a pair of equal magnitude dirac functions (impulses). A single DJ-56 value is
determined for each acquisition, by means of R¥DJseparation analysis.

Related Topics
m_Jitter Analysis Through RIDJ Separation (see page 324)

m Jitter Estimation Using Dual-Dirac Models (see page 328)

Phase Noise

PJ

The Phase Noise measurement performs a jitter measurement, converts the result into the frequency
domain, and reports the rms jitter integrated between two specific frequencies selected by the user.

The phase noise measurement is defined only for clock signals. If the source waveform appearsto be a
datasignal, awarning message will be produced but the measurement will proceed.

A Phase Noise measurement is required in order to enable the Phase Noise plot.

Periodic Jitter (PJ) is the peak-to-peak amplitude for that portion of the deterministic jitter which is
periodic, but for which the period is not correlated with any data pattern in the waveform. A single PJ
value is determined for each acquisition, by means of R¥DJ separation analysis.

Related Topics
m Jitter Analysis Through RIDJ Separation (see page 324)
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NPJ

DDJ

DCD
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Non-Periodic Jitter (NPJ) is the dual-dirac magnitude of that portion of Bounded Uncorrelated Jitter (BUJ)
that is not periodic. Sinceit is not periodic and is not correlated with the data pattern, NPJ is frequently
difficult to distinguish from (Gaussian) RJ.

This component of jitter is not analyzed by default, but you can enable it by switching the jitter analysis
mode to Spectral + BUJ. Since it typically requires high populations to distinguish, you may need to
acquire multiple waveforms before jitter results are available when Spectral + BUJ mode is enabled.

Related Topics
B Separation of Non-Periodic Jitter (NPJ) (see page 327)

m_Preferences Jitter Decomp (see page 73)

Data-Dependent Jitter (DDJ) is the peak-to-peak amplitude for that portion of the deterministic jitter
directly correlated with the data pattern in the waveform. A single DDJ value is determined for each
acquisition, by means of RJDJ separation anaysis.

Related Topics
= Jitter Analysis Through RIDJ Separation (see page 324)

Duty Cycle Distortion (DCD) is the peak-to-peak amplitude for that portion of the deterministic jitter
directly correlated with signal polarity, that is the difference between the mean positive edge displacement
versus that on negative edges. A single DCD value is determined for each acquisition, by means of
RJDJ separation analysis.

Related Topics
m Jitter Analysis Through RJDJ Separation (see page 324)
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J2

J9

SRJ

J2 is Total Jitter at a Bit Error Rate (BER) value of 2.5E-3. This statistical value predicts a peak-to-peak
jitter that will only be exceeded with a probability equal to the BER.

Related Topics
m Jitter Analysis Through RIDJ Separation (see page 324)

Jois Total Jitter at a Bit Error Rate (BER) value of 2.5E-10. This statistical value predicts a peak-to-peak
jitter that will only be exceeded with a probability equal to the BER.

Related Topics
m Jitter Analysis Through RIDJ Separation (see page 324)

Sub-Rate Jitter is periodic jitter at arate that integrally divides the datarate. For example, if the datarateis
F bits/second, sub-rate jitter components could occur at F/2 or F/4. 1t typically occurs when a serial data
stream is formed by multiplexing (interleaving) an integral number of lower-rate bit streams together,
although there can be other causes. Sub-rate jitter is a sub-component of PJ.

The SRJ measurement is the peak-to-peak amplitude for the sum of al F/N jitter components that are
tracked by DPOJET. Since different F/N components are correlated with each other, the peak-to-peak SRJ
depends on relative phases and is not simply the sum of the individual F/N components.

The SRJ measurement always tracks and accounts for N = 2, 4 and 8 regardless of whether the
corresponding F/N measurements have been selected.

Related Topics
m F/N (see page 262)

®m Jitter Analysis Through RJDJ Separation (see page 324)
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Conceptually, F/N jitter is the peak-to-peak amplitude of periodic jitter occurring at arate that dividesthe
datarate (F) by the integer N. However, it excludes jitter occurring at harmonics of F/N. For example,
F/4 jitter occurs at one fourth the data rate (but the measurement excludes jitter attributable to F/2 before
determining the peak-to-peak amplitude).

For arepeating data pattern, some deterministic jitter can be interpreted either as DDJ or as F/N jitter.
This condition occurs when the pattern length, P, is an integer multiple of N. By convention, such jitter
isreported as DDJ, and the corresponding F/N is reported as zero. For example, asignal with a pattern
length of 10 would report F/2 = 0 since jitter at half the bit rate can be interpreted as DDJ. But F/4 and F/8
may be non-zero since they cannot be DDJ for this pattern length.

The measurement uses adivisor (N) of 2 by default but adivisor of 2, 4 or 8 can be selected.
For agiven N, the value of F/N is computed as follows:

For a data stream of | bits, the mean jitter for each of the phasesn e{1, 2, ... N} iscalculated as:

K
JHZEE_OTIE'(H+@*N) where K = |I/N|

The jitter-per-phase is collected into a jitter trend or array:

'J']N}

Ty = [J1.J 2,

From this trend, the trends attributable to higher harmonics are removed (for example, the T2 and T4
trends are subtracted from the T8 trend):

UN - TN Z (THarmonicsofN)

The peak-to-peak jitter is then:

F/N =max (Uy) — min (Ux)
n n

From this trend, the trends attributable to higher harmonics are removed (for example, the T2 and T4
trends are subtracted from the T8 trend):

For arepeating data pattern with repeat length N, some deterministic jitter falls in an ambiguous category
where it could be interpreted either as DDJ or as F/N jitter. By convention, such jitter is reported as
DDJ, and the corresponding F/N is reported as zero.
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Related Topics
B SRJ (see page 261)
m_ Jitter Analysis Through RIDJ Separation (see page 324)

Rise Time

The Rise Time measurement is the time difference between when the VRefHi reference level is crossed

and the VRefL o reference level is crossed on the rising edge of the waveform. The Rise Time algorithm
uses the VRef values as the reference voltage level. Each edge is defined by the slope, voltage reference
level (threshold), and hysteresis.

The application calculates this measurement using the following equation:

Rise _ o H+ _ rlot
L TR T

Where:

T Rise js the Rise Time.

T Hi+ isthe VRefHi crossing on the rising edge.
T Lo+ jsthe VRefLo crossing on the rising edge.

Fall Time

The Fall Time measurement is the time difference between when the VRefL o reference level is crossed
and the VRefHi reference level is crossed on the falling edge of the waveform. The Fall Time algorithm
uses the VRef values as the reference voltage level. Each edge is defined by the slope, voltage reference
level (threshold), and hysteresis.

The application cal culates this measurement using the following equation:

TE‘JH - TL:J— _ TH—

Where:

T Fal js the Fall Time.

T Lo isthe VRefL o crossing on the falling edge.
T Hi- is the VRefHi crossing on the falling edge.
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Skew

The Skew measurement cal culates the difference in time between the designated edge on a principle
waveform to the designated edge on another waveform. The closest data edge to the clock edge that falls
within the range limits is used.

The application calculates this measurement using the following equation:

TS‘:E‘W =Tm _Tﬂ?&f

Where:

T Sew js the timing skew.

T Main js the Main input VRefMidMain crossing time in the specified direction.
T 2nd js the 2nd input VRefMid2nd crossing time in the specified direction.

High Time

264

The High Time Measurement is the amount of time that a waveform cycle is above the VRefHi voltage
reference level.

The application cal culates the measurement using the following equation:

T;!—.ﬁg.& _ T;!:ﬁ— _ T;!—.h

Where:

T High js the high time.

T Hi- s the VRefHi crossing on the falling edge.
T Hi+ isthe VRefHi crossing on the rising edge.
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Low Time

The Low Time measurement is the amount of time that a waveform cycle is below the VRefLo voltage
reference level.

The application calculates this measurement using the following equation:

TL::'W - TL:H _ TL::'—

Where:

T Low js the low time.

T Lo+ isthe VRefLo crossing on the rising edge.
T Lo isthe VRefLo crossing on the falling edge.

Setup

The Setup Time measurement is the elapsed time between the designated edge of a data waveform and
when the clock waveform crosses its own voltage reference level. The closest data edge to the clock edge
that falls within the range limits is used.

The application cal culates this measurement using the following equation:

Sehy _ rebdin _ eldnd
L= T

Where:

T Setwp s the setup time.

T Main jsthe Main input (clock) VRefMidMain crossing time in the specified direction.
T 2nd js the 2nd input (data) VRefMid2nd crossing time in the specified direction.

NOTE. The order of the input sources for Setup and Hold measurements (Sourcel = Clock, Source2 =
Data) differs from the order of input sources on the Setup/Hold Trigger menu in the oscilloscope.
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Rise Slew Rate

The Rise Slew Rate is defined as the rate of change of the voltage between the crossings of the specified
Vrerr @Nd Vger o reference voltage levels. The voltage difference is measured between the Vgery reference
level crossing and the VrerLo reference level crossing on the rising edge of the waveform. The time
difference is measured as the difference between the low time, and the low time at which V ger o and V gerni
are crossed. The Rise Slew Rate algorithm uses the high and low rise reference voltage levels to configure
the values. Each edge is defined by the slope, voltage reference level (threshold), and the hysteresis.

__________________________ ——— YREFHI
[High)

————————————————————————— ———— WREF

———————————————————— ———— “WREFLO
[Lam]

The application cal culates this measurement using the following equation:

; = ¥eeFer~VaEFic
Fige Slew Rate ~EERE A0

Reference

B High Mid and Low Reference Voltage Levels (see page 97)
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Fall Slew Rate

The Fall Slew Rate is defined as the rate of change of the voltage at the specified Vrero and Vrerni
reference voltage levels. The voltage difference is measured between the Vrer o reference level crossing
and the Vrery reference level crossing on the falling edge of the waveform. The time differenceis
measured as the difference between the high time and low time at which V gern and Vger o are crossed.
The Fall Slew Rate algorithm uses the low time and high fall reference voltage levels to configure the
values. Each edge is defined by the slope, voltage reference level (threshold), and the hysteresis.

__________________________ ——— YREFHI
[High)

————————————————————————— ———— REF

———————————————————— ———— “WREFLO
[Law]

The application calculates this measurement using the following equation:

= ¥eErio VemFom
Fall Slew Fafe ~REC A

Reference

m High Mid and Low Reference Voltage Levels (see page 97)
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Hold

The Hold Time measurement is the elapsed time between when the clock waveform crosses its own
voltage reference level and the designated edge of a data waveform. The closest data edge to the clock
edge that falls within the range limits is used.

The application calculates this measurement using the following equation:

i Ind M
T =T -

Where:

THold js the hold time.

TMain js the Main input (clock) VRefMidMain crossing time in the specified direction.
T2nd js the 2nd input (data) VRefMid2nd crossing time in the specified direction.

NOTE. The order of the input sources for Setup and Hold measurements (Sourcel = Clock, Source2 =
Data) differs fromthe order of input sources on the Setup/Hold Trigger menu in the oscill oscope.

SSC PROFILE

SSC Profile shows the modulation profile of the Spread Spectrum Clocking (SSC). It isthe time trend plot
of the SSC profile. All SSC measurements use the Period measurement with a second order low pass filter.
Using the profile you can analyze the SSC modulation rate by using the horizontal cursors. You can also
analyze the peak-to-peak frequency deviation by using the vertical cursors.

The following are the default configurations that are required:
B Constant Clock Recovery (CCR) Mean set as the Clock Recovery method.

B Low passfilter with 1.98 MHz cut off frequency set by default. Thisis the standard FiberChannel
cut off frequency.

= Available plots are Time Trend, Data Array, Histogram and Spectrum plots.
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SSC MOD Rate

SSC Mod Rate measurement computes the SSC modulating frequency.
The following are the default configurations that are required:
m  Constant Clock Recovery (CCR) Mean set as the Clock Recovery method.

B Low passfilter with 1.98 MHz cut off frequency set by default. Thisisthe standard FiberChannel
cut off frequency.

m  Available plots are Time Trend, Data Array, Histogram and Spectrum plots.

SSC FREQ DEV MIN

The SSC FREQ DEV MIN is defined as the minimum frequency shift as a function of time. It represents
the frequency deviation in terms of ppm (parts per million).

= Find the 50% edges on the SSC profile.

B Cdculate the LOW value between the n and n+1 edge.

®  Find the Minimum frequency deviation as LOW.

The application cal culates the measurement using the eguation:

Freq Dev Min(ppm)= ((Minimum Freg—Nominal Data Rate)/Nominal Data Rate)* 1e6
Available plots are Time Trend, Data Array, Histogram and Spectrum plots.
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SSC FREQ DEV MAX

SSC FREQ DEV MAX isdefined as the maximum frequency shift as a function of time. It represents the
frequency deviation in terms of ppm (parts-per-million).

= Find the 50% edges on the SSC profile

B Cadculate the HIGH value between the n and n+1 edge

= Find the Maximum frequency deviation as HIGH

The application cal culates the measurement using the equation:

Freq Dev Max(ppm)= ((Maximum Freg — Nominal Data Rate)/Nominal Data Rate)* 1e6

The difference between the SSC FREQ DEV MAX and SSC FREQ DEV MIN measurements are that
they compute the maximum freguency deviation and minimum frequency deviation separately. By doing
this the limits can be applied separately.

Available plots are Time Trend, Data Array, Histogram and Spectrum plots.

SSC FREQ DEV

270

SSC FREQ DEV is defined as the SSC frequency deviation in ppm (parts per million).

®  Thelow passfilter is turned on by default with 1.98 MHz as the cut off frequency. Thisis set to the
standard FiberChannel cut off frequency.

= Time Trend, Data Array, Histogram, and Spectrum plots are alowed for this measurement.
The application cal culates the measurement using the equation:
FREQ DEVIATION = HIGH-LOW

Related Topics
B High (see page 278)

B Low (see page 278)
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tCMD-CMD

tCMD-CMD measures the elapsed time between two bus states, for example CMD_1 and CMD_2. For
each state, the relevant timing point can be specified as the start of the state, the end of the state, or arising
or falling edge on a separatel y-specified clock source. The timing resolution of this measurement is

dependent on the sample clock used. For example, if the busis composed of digital channels sampled
as 12.5 Ggps, the resolution is 80 ps.

tCMD-CMD

0048002
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Time Outside Level

Time Outside Level is defined as the time interval of overshoot or undershoot. The measurement is taken

on both the rising and falling slopes.

— -« Time outside level

High Ref
Voltage

<« Halfcycle ———» Lower half cycle

Time outside level —

272

0048-001
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Eye Width

The Eye Width measurement is the measured minimum horizontal eye opening at the zero reference level.

The application calculates this measurement using the following equation:

Tovp —wimrsr = Ul gy — TIE

Where:
Ul avs is the average UI.

TIE e i the Peak-Peak TIE.

Width@BER

Width@BER is the Eye Width at a specified Bit Error Rate (BER). This extrapolated value predicts a
horizontal eye opening that will be violated with a probability equal to the BER. It is generally not equal to
the eye width actually observed in any given acquisition. A single Width@BER value is determined for
each acquisition, by means of RJ/DJ separation anaysis.

Related Topics
m Jitter Analysis Through RIDJ Separation (see page 324)

= Estimation of TJ@BER and Eye Width@BER (see page 327)
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Eye Height

The Eye Height measurement is the measured minimum vertical eye opening at the Ul center as shown in
the plot of the eye diagram. There are three types of Eye Height values.

The application cal culates this measurement using the following equation:

VF}'F—JEFJ‘GH = VF}'F—HI—W - P;‘PF—ID—M

Where:
Vevenvin 1S the minimum of the High voltage at mid UL.

TIEgveLo-wax 1S the maximum of the Low voltage at mid UI.

Eye Height-Transition

The application calculates this measurement using the following equation:

VE}'F—HEIGBT—TM = VE}'F—HI—TM—W - }':?}'F—ID—TM—M

Where:
Veve-Hi-Tran-min 1S the minimum of the High transition bit eye voltage at mid UI.

TIEgve-Lo-Tran-max IS the maximum of the Low transition bit eye voltage at mid Ul.

Eye Height-Non-Transition

The application calculates this measurement using the following equation:

VE}'F—HEJ‘GH'—MM = 'P:?}'F—HI—J‘I.TM—W - VEE‘F—EG—MM—M
Where:

Vevenintran-min 1S the minimum of the High non- transition bit eye voltage at mid Ul.

TIEeveLonTran-max 1S the maximum of the Low non-transition bit eye voltage at mid UI.
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Height@BER

Height@BER is the Eye Height at a specified Bit Error Rate (BER). This extrapolated value predicts a
vertical eye opening that will be violated with a probability equal to the BER. It is generally not equal
to the eye height actually observed in any given acquisition. A single Height@BER value, in the given
interval, is determined for each acquisition by means of Q-scale extrapolation.

Eye High

Eye High calculates the voltage at a selected horizontal position across the unit interval, for al High bits
in the waveform. You specify the offset at which the measurement takes place from 0% to 100% of the
unit interval. Configure the measurement to include al bits, only transition bits, or only non-transition
bits. (Note that some of the waveform can be omitted from the measurement due to initialization of clock
recovery or filtering.) A histogram of the Eye High measurement corresponds to a vertical dlice through
the upper half of athree-dimensional eye diagram.

"% 105

0%
ki Wnit Inte
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Eye Low

Eye Low calculates the voltage at the selected horizontal position across the unit interval, for all Low bits
in the waveform. A histogram of the Eye Low measurement corresponds to a vertical slice through the
lower half of athree-dimensional eye diagram.

Q-factor

Quality Factor is the ratio of eye size to noise. Eye and Q factor measurements can be run together
and displayed onto a single window.

The final measurement value would be computed according to the equation below:

Q-factor = [mean(EyeHigh) - mean(EyeLow)] / [stddev(EyeHigh) + stddev(EyeLow)]
Where:

Eye High: the sample values of positive Ul at x%.

Eye Low: the sample values of negative Ul at x%.

For more details refer Eye Height
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Mask Hits

The Mask Hits measurement reports the number of unit intervalsin the acquisition for which mask hits
occurred, for a user-specified mask. In the Results Summary view, the Mask Hits measurement reports
the total number of unit intervals for which amask hit occurred in at least one mask zone. In the Results
Details view, the number of hitsin each of three segmentsis reported.

The Mask Hits measurement has several unique properties:

= Unlike other measurements, it requires aMask hits plot. Adding a Mask Hits measurement will cause
the corresponding plot to be created automatically. If you delete a Mask Hits plot, the application will
remove the corresponding Mask Hits measurement after verifying the action with you.

m  The Mask Hits measurement does not support the Worst-Case Waveforms logging feature.
B The Mask Hits measurement does not support Measurement Range Limits.

m  The Mask Hits measurement does not support Population Limit.

Autofit Mask Hits

Autofit Mask hits measurement reports the number of pixels in the acquisition for which mask hits
occurred, for a user specified mask. In the results summary view, Autofit Mask Hits measurement reports
the total number of Pixel Hits for which amask hit occurred. In the Results Details View, the number of
hits in each of three segmentsis reported. The population field shows the total number of unit intervals
measured.

The AUTOFIT Mask Hits measurement has several unique properties:

= Unlike other measurements, it requires a Mask hits plot. Adding an Autofit Mask Hits measurement
will cause the corresponding plot to be created automatically. If you delete a Mask Hits plot, the
application will remove the corresponding Autofit Mask Hits measurement after verifying the action
with you.

B The Autofit Mask Hits measurement does not support Worst-Case Waveforms logging.

= The Autofit Mask Hits measurement does not support Measurement Range Limits.
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High

Low
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The High Amplitude measurement cal culates the mean or mode of a selected portion of each unit interval
corresponding to a“1” bit.

The application cal culates this measurement using the following equation:

Vign)=0OP [‘“'PERCEM (n }]

Where:
Vi is the high amplitude measurement result.
OPJ[ ¢ ] isthe selected Operation (either Mean or Maode).

Veercent 1S the set of voltage samples over the selected portion (percent) of the unit interval, ranging
from 1% to 100%.

nistheindex of a high bit, a high transition bit, or a high non-transition bit.

The Low Amplitude measurement calcul ates the mean or mode of a selected portion of each unit interval
corresponding to a“0” bit.

The application calculates this measurement using the following equation:

Vigln) = OP[”PERCEM(H }]

Where:
Viow is the low amplitude measurement result.
OPJ[ ¢ ] isthe selected Operation (either Mean or Maode).

Veercent 1S the set of voltage samples over the selected portion (percent) of the unit interval, ranging
from 1% to 100%.

nistheindex of alow bit, alow transition bit, or alow non-transition bit.
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DC Common Mode

The Common Mode Voltage measurement (also called DC Common Made) cal culates the mean of the
Common Mode voltage waveform.

The application calculates this measurement using the following equation:

Foage = Mean (v, (7))

Where;

Veu is the common mode voltage measurement.

—_ (vSourcel + V.S‘ource 2)
Voue =
2

is the common mode voltage waveform.

i isthe sample index of common mode waveform values.

AC Common Mode

The AC Common Mode Voltage measurement is the common mode voltage between two single-ended
signals. AC isdefined as al the frequency components above the cutoff frequency (30 kHz).

The application calculates this measurement using the following equations (based on two single-ended
sources from the DUT):

CM_Voltage = (Sourcel + Source2) + 2

AC_CMMp-p = Peak-to-Peak(High Pass filter (CM_Voltage))
Where:
AV_CMV,, is the peak-to-peak common mode voltage.

T/nT Ratio

The T/nT Ratio measurement reports the amplitude ratio between transition and non-transition bits.

The measurement calculates the ratios of all non-transition eye voltages (2nd and subsequent eye voltages
after one edge but before the next) to their nearest preceding transition eye voltage (1st eye voltage
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succeeding an edge). In the accompanying diagram, it is the ratio of the Black voltages to the Blue
voltages. The results are given in dB.

Voltage Recovered edge times

i P A,

3 =T ime

The application calculates the T/nT Ratio using the following equations:

T (m) = dB Vore_ - wrean (72

VpyE - Hr- Tran (2)

following arising edge.

TuT (m) = dB Verz_1o-nrraw (72)
Verg-Lo-TRaw( )

following afalling edge.
Where:

Veve_ni-ran 1S the High voltage at the interpolated midpoint of the first unit interval following a positive
transition.

Veve-Lo-Tran 1S the Low voltage at the interpolated midpoint of the first unit interval following a negative
transition.

Veve_ninTran 1S the High voltage at the interpolated midpoint of al unit intervals except the first following a
positive transition.

Veve_LonTran 1S the Low voltage at the interpolated midpoint of al unit intervals except the first following
a negative transition.

m s the index for all non-transition Uls.

nisthe index for the nearest transition Ul preceding the Ul specified by m.
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Inatime trend plot of the measurement results, there is one measurement for each non-transition bit in the
waveform (that is the black arrows in the diagram).

High-Low

The High—L ow measurement calcul ates the change in voltage level across atransition in the waveform.

The application calculates the High—L ow using the following equation:

Virer_row (1) = ’VLEVEL(I- )=V gy + 1)‘

Where:

Vhich-Low 1S the high-low amplitude measurement result.

n isthe index of a selected transition.

i istheindex of the Ul (bit) location preceding the transition.
i+1istheindex of the Ul (bit) location following the transition.

Viever = OP[ Veercent(i)] isthe state level of the unit interval (bit period).
OPJ* ] isthe selected Operation (either Mean or Mode).

Veercent 1S the set of voltage samples over the selected portion (percent) of the unit interval, ranging
from 1% to 100%.

NOTE. If there are no waveform samples that fall within the identified percentage of the unit interval, the
single nearest waveform sample preceding the center point of the unit interval will be used.
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V-Diff-Xovr

The Differential Crossover Voltage measurement (V-Diff—Xovr) calculates the voltage level at the
crossover voltage of a differential signal pair. If there istiming jitter on one of the pair of signal lines
relative to the other, the crossover point will be modulated by the jitter. The measurement is calculated
using the following equation:

Crossover prboureel Crossover
'171'1 - '1;/;1 (‘T M )

Where:
\/Crossover s the crossing voltage.
V Soureel s the voltage of the first source waveform.

TCrossover js the crossover time, when the Sourcel and Source2 waveforms are equal in voltage.

Overshoot

Overshoot is the maximum peak amplitude above the reference voltage level (see page 97) (Vger).
Non-differential signals (Single Ended) are required for this measurement such as DQS (SE) and CK(SE).
For DQS signals, Search and Mark should be enabled.

Mzzitmim ] P Cerzhodt Region
Ampitude————*
Wioits W
R
(v}
Time 1)
Reference

m High Mid and Low Reference Voltage Levels (see page 97)
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Undershoot

Undershoot is the maximum peak amplitude below the reference voltage level (see page 97) (Vrer).
Non-differential signals (Single Ended) are required for this measurement such as DQS(SE) and CK(SE).
For DQS signals, Search and Mark should be enabled.

“olts W
Rt
M i
Mazirm L
Ampitice b st
Tirne (re)
Reference

® High Mid and Low Reference Voltage Levels (see page 97)

Cycle Max
Cycle Max is a voltage measurement which measures positive peak voltage for al cycles. It isthe
maximum voltage for each cycle from the mid level of rise to the fall slope.
The application calculates this measurement using the following equation:
Veyaemax = Max(f(Riselndex(i) to Falllndex(i+ 1))
Where:
| =1 to the valid edge of the last cycle.

f is the function, which finds the maximum sample point in the defined region.
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Cycle Min

Cycle Min is a voltage measurement which measures negative peak voltage for al cycles. Itisthe
minimum voltage for each cycle from the mid level of Fall to the Rise slope.

The application cal culates this measurement using the following equation:
Veyemin = Min(f(Falllndex(i) to Riselndex(i+1))

Where:

| =1 to the valid edge of the last cycle.

f is the function, which finds the minimum sample point in the defined region.

Cycle Pk-Pk

Cycle Pk-Pk is a voltage measurement which measures the absol ute difference between the maximum and
minimum amplitude for every cycle of the waveform. It calculates the peak-to-peak value for al cycles
of the waveform. The peak value is measured from Fall slope to the next rise if the valid lopeisaFall.
The next peak would be from Rise to next fall slope. The peak-to-peak value is calculated on all the
pairs of minimum and maximum values available.

The application calculates the Cycle Pk-Pk using the following equation:

Vor—pr () Voete Max ¥ CyeledMin

for consecutive cycles

Where:

V max(n 1S the maximum peak amplitude.
V min 1S the minimum peak amplitude.

n is the number of cycles from 1 to the last valid edge.

DDR Setup and Hold Measurements

284

The following four measurements are modified versions of the basic Setup and Hold measurements found
on the Time tab. In contrast to the basic measurements which always use the Mid voltage reference to
determine edge times, these measurements use the High and L ow references as required to conform to
some DDR specifications. For al these measurements, the Strobe signal (DQS) is assigned to Sourcel and
the Data signal is assigned to Source2.
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The measurements with names ending in “—Diff” are appropriate if you have a have a differential Data
Strobe (DQS) signal. Either connect to DQS+ and DQS- with a differential probe, or acquire these
signals with two single-ended probes and create a (pseudo-) differential signal using a Math expression
(for example: “Mathl = Chl — Ch2"). Inthis case, the data (DQ) signal uses thresholds other than the
mid threshold, but the DQS signal uses amid threshold set to O V.

Check that the DPOJET reference levels for the data source are set to match the proper values of VIH(ac),
VIH(dc), VIL(ac) and VIL(dc) for the DDR technology that you are measuring. Depending on which
edges you choose to measure (Rising, Falling or Both), you may not need to set up all of these levels.
For more details on reference level setup, refer to DDR Setup/Hold Reference Levels. Differential DQS

(see page 285).

The measurements with names ending in “—SE” are appropriate if you have a single-ended data strobe
(DQS) signal. Thisisalowedin DDR2 but not in DDR3. In this case, both the clock (DQS) and data (DQ)
signals use thresholds other than the mid threshold.

Check that the DPOJET reference levels for the strobe and data sources are set to match the proper
values of VIH(ac), VIH(dc), VIL(ac), and VIL(dc) for the DDR technology that you are measuring.
Depending on which edges you choose to measure (Rising, Falling or Both), you may not need to set up
all of these levels. For more details on the reference level setup, refer to DDR Setup/Hold Reference
Levels. Single-ended DQS (see page 287).

DDR Setup/Hold Reference Levels: Differential DQS

For systems with a differential DQS signal, the waveform reference points for the Setup (tDS) and Hold
(tDH) measurements details are as shown:

DOS# S — — 7
D05 — — — 7/ N\ —_———

DDR DPOJET
RefLevel N e y * i > Ref Level
Designations D3 DH 03 tDH Designations
4 ¥
g MIN High (Rise)
"‘-v'"||-||;i;|g min ngh (Fa||:|

YReFag
Wiy Max —————4 Lowe [Rise]
Ly Max Lo (Fall)
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286

For the Strobe channel (Sourcel), the mid reference level should be set to 0 V and the High and Low
references are not used. The reference levels for the Data channel (Source2) are mapped to the source
configuration panel as follows:

Typical values for the reference levels for some current technologies can be found here:
®  DDR2-400, DDR2-533 Reference Levels (see page 288)

= DDR2-667, DDR2800 Reference Levels (see page 288)

®  DDR3-800 through DDR3-1600 Reference Levels (see page 289)
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DDR Setup and Hold M easurements

DDR Setup/Hold Reference Levels: Single-Ended DQS

For systems with a single-ended DQS signal, the waveform reference points for the Setup (tDS) and

Hold (tDH) measurements details are as shown:

Do

DDR
Ref Level

Designations

W

i g MMIN

D

High (Rise]
High (Fall

Low (Rise)
Lawe (Fall)

&*
DPOJET
Ref Level
esignations

.
High (Rise]

High (Fall

Low (Risa]
Lo (Fall)

For both the Strobe channel (Sourcel) and the Data channel (Source2), the reference levels are mapped to
the source configuration panel as follows:

[

[
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288

Typical values for the reference levels for some current technologies can be found here:
= DDR2-400, DDR2-533 Reference Levels (see page 288)

®  DDR2-667, DDR2800 Reference Levels (see page 288)

= DDR3-800 through DDR3-1600 Reference Levels (see page 289)

DDR2-400, DDR2-533 Reference Levels

The following reference levels are typical for single-ended signals in DDR2-400 and DDR2-533
technologies.

The best levels depend on many variables, including the supply voltage, probe point and any spec
amendments, so use thisinformation only for general guidance.

DDR2-667, DDR2-800 Reference Levels

The following reference levels are typical for single-ended signals in DDR2-667 and DDR2-800
technologies.
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The best levels depend on many variables, including the supply voltage, probe point and any spec
amendments, so use this information only for general guidance.

DDR3-800 through DDR3-1600 Reference Levels

The following reference levels are typical for single-ended signals in DDR3-800 through DDR3-1600
technologies.

925 mv 850 mv

750 mv 750 mv

650 mv ST mv Jomv

The best levels depend on many variables, including the supply voltage, probe point and any spec
amendments, so use this information only for general guidance.

DDR Setup-SE

The DDR Setup—SE measures the elapsed time between the designated edge of a data waveform and when
the single-ended strobe (DQS) waveform crosses its own voltage reference level. The closest data edge to
the clock edge that falls within the range limits is used. The strobe is placed on Sourcel and the Data

is placed on Source2. This s the base Setup measurement, which does not include slew-rate derating.
Slew-rate derating tables can be found in the applicable JEDEC specification.

This measurement is identical to the basic Setup measurement except that instead of using the Mid
reference voltage for determining edge times, it uses the High and Low reference voltages for both the
Data and Strobe (DQS). For more details on the reference voltage setup, refer to DDR Setup/Hold
Reference Levels. Single-ended DQS (see page 287).

The application cal culates this measurement using the following equation:

Sty _ oeddbin _ oeldnd
L =T T,

Where;

T Setwp s the setup time.
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T Main jsthe Main input (strobe or DQS) crossing time of VRefHighFall (for falling strobe edges) or
VRefLowRise (for rising strobe edges).

T 2nd jsthe 2nd input (data or DQ) crossing time of VRefLowFall (for falling data edges) or VRefHighRise
(for rising data edges).

DDR Setup-Diff

290

The DDR Setup-Diff measures the elapsed time between the designated edge of a data waveform and
when the differential strobe (DQS) waveform crosses its own voltage reference level. The closest data
edge to the clock edge that falls within the range limits is used. The strobe is placed on Sourcel and the
Datais placed on Source2. Thisis the base Setup measurement, which does not include slew-rate derating.
Slew-rate derating tables can be found in the applicable JEDEC specification.

This measurement is identical to the basic Setup measurement except that instead of using the Mid
reference voltage for determining edge times, it uses the High and Low reference voltages for the Data.
The Mid reference level is still used for the Strobe (DQS). For more details on the reference voltage setup,
refer to DDR Setup/Hold Reference Levels. Differential DOS (see page 285).

The application cal culates this measurement using the following equation:

Setp _ redbin _ reldnd
L= T

Where:
TSetwp s the setup time.
TMain js the Main input (strobe or DQS) crossing time of VRefMid in the specified direction.

T2nd jsthe 2nd input (data or DQ) crossing time of VRefLowFall (for falling data edges) or VRefHighRise
(for rising data edges).
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DDR Hold-SE

The DDR Hold—SE measures the elapsed time between the designated edge of the single-ended strobe
(DQS) waveform and the designated edge of a data waveform. The closest data edge to the clock edge that
falls within the range limitsis used. The strobeis placed on Sourcel and the Data is placed on Source2.
Thisisthe base Hold measurement, which does not include slew-rate derating. Slew-rate derating tables
can be found in the applicable JEDEC specification.

This measurement is identical to the basic Hold measurement except that instead of using the Mid
reference voltage for determining edge times, it uses the High and Low reference voltages for both the data
and strobe (DQS). For more details on the reference voltage setup, refer to DDR Setup/Hold Reference
Levels. Single-ended DQS (see page 287).

The application calculates this measurement using the following equation:

i 2nd I
o =T -T

Where:
THold |s the hold time.

TMain jsthe Main input (strobe or DQS) crossing time of VRefLowFall (for falling strobe edges) or
VRefHighRise (for rising strobe edges).

T2nd jsthe 2nd input (data or DQ) crossing time of VRefHighFall (for falling data edges) or VRefLowRise
(for rising data edges).
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DDR Hold-Diff

The DDR Hold-Diff measures the elapsed time between the designated edge of the single-ended strobe
(DQS) waveform and the designated edge of a data waveform. The closest data edge to the clock edge that
falls within the range limitsis used. The strobe is placed on Sourcel and the Datais placed on Source2.
Thisis the base Hold measurement, which does not include slew-rate derating. Slew-rate derating tables
can be found in the applicable JEDEC specification.

This measurement is identical to the basic Hold measurement except that instead of using the Mid
reference voltage for determining edge times, it uses the High and Low reference voltages for the data.
The mid reference level is still used for the strobe (DQS). For more details on the reference voltage setup,
refer to DDR Setup/Hold Reference Levels. Differential DQS (see page 285).

The application cal culates this measurement using the following equation:

?;.EE:'H - T:E?éﬂ’ _ ?;fmx

Where:
THold js the hold time.
TMain js the Main input (strobe or DQS) crossing time of VRefMid in the specified direction.

T2nd jsthe 2nd input (data or DQ) crossing time of VRefHighFall (for falling data edges) or VRefLowRise
(for rising data edges).

DDR tCL(avg))

292

DDR tCL (avg) is defined as the average low pulse width calculated across 200-cycle window of
consecutive low pulses.

The application cal culates this measurement using the following equation:

N
g(:"[,[avg) = 3 fCLJ f(NKﬁCK[ﬂVE))
j=1

Where:
N=200, which is configurable.
Range: 200<N<1M
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DDR tCK(avg)

DDR tCK(avg) is calculated as the average clock period across 200-cycle window.

The application calculates this measurement using the following equation:

200
(CK(avg) =| T tCK; |/ N
i=1

Where:
N=200, which is configurable.
Range: 200<N<1M

DDR2 tDQSCK

tDQSCK isthe DQS output access time from CK or CK#. tDQSCK is measured between the rising edge
of clock before or after the DQS Preamble time.
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The application cal culates this measurement using the following equation:

tDQSCK =T,-Tpas(m)

for mid level

Where:

T, specifies the clock edges.
Toosm Specifies the DQS edges.

(31001

The edge locations are determined by the mid-reference voltage levels. Thisis a skew measurement
between the rising edge of DQS and the rising edge of clock.

NOTE. The JEDEC standard specifies that tDQSCK is the actual position of a rising strobe edge relative
to CK, CK#. Hence, DQS should be in phase with CK. When DQS and CK are not in phase, there could
be possibility of probe polarity interchange. You can overcome this by changing the edge direction to

“ Opposite as From” under edges configure tab for Skew measurements.

For more details, refer to the topic “ Configuring Edges for Skew Measurement” of the DPOJET help.

294
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DDR tDQSQ-Diff

tDQSQ-Diff isthe DQS-DQ skew for DQS and associated DQ signals. Set JEDEC standard reference
levels for DQ.

tDQSQ-Diff uses the DPOJET measurement, Setup.

DOS#

DOS/Das# DOs

DQ

Upagamar—

For more details, refer to the topic “ Setup” of the DPOJET help.
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DDR tDQSS

296

tDQSS measures the time taken from WRITE event in DDR bus to the first DQS latching transition. This
measurement has two sources. One bus source (B1) and a DQS source (analog).

Measurement internally sets up Bus search to look for WRITE events. For every WRITE event in the bus
search output, the algorithm finds and associates the first rising edge of DQS within the DDR Write burst.

Prerequisites for this measurement are: DDR Parallel Bus source, Search and Mark to be setup for DDR
Write search and DPOJET Global tab Qualifier to be turned On and Qualifier source configured to DDR
Write. This measurement is available only on 64-bit MSO instruments. Measurement gets selected
only if there is a bus source configured.

Command :)(WF{ilTE)( X Né‘)P X XN

t

> DQSS > |
DQS |\ £ 1\ /
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DDR tERR(n) and DDR tERR(m-n)

DDR tERR(n) is defined as the cumulative error across multiple consecutive cycles from tCK (avg). DDR
tERR(m-n) is defined asthe cumul ative error across multiple consecutive predefined cycles from tCK (avg).

The application calculates this measurement using the following equation:

i+x—1
tERF (nper) = B :CKj - xfCK(avg)

4=l

Where:

n=2 for tERR(2 per)

n=3 for tERR(3 per)

n=4 for tERR(4 per)

n=5 for tERR(5 per)

6 < n < 10 for tERR(6-10 per)
11 < n < 50 for tERR(11-50 per)

DDR tHZDQ

DDR tHZDQ is atwo source timing measurement defined as time duration from the extrapolated point
(at VDD — VDD (34/(50+34)) established by extending the slope between V,; and V,, to the nearest
rising edge of clock.
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DDR tJIT(duty)

DDR tJIT(duty) is defined as the cumulative set of the largest deviation of any single tCH from tCH(avg)
and the largest deviation of any single tCL from tCL (avg).

The application calculates this measurement using the following equation:

tJITduty) = Minfmazx of (tJIT(CH), tJITCL))

Where:

tJIT(CH) = {tCH; — tCH(avg)}
tJIT(CL) = {tCL; —tCL(avg)}
Where:

i=1to 200

DDR tJIT(per)

DDR tJIT(per) is defined as the largest deviation of any single tCK from tCK (avg).

The application calculates this measurement using the following equation:

LT per) = Mindmax of (10K, — iCKjavg)}

Where:
i =1 to 200
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DDR tLZDQ

DDR tLZDQ is atwo source timing measurement defined as time duration from the extrapolated point (at
VDD = 1.2V) established by extending the slope between Vs, and Vg, to the nearest rising edge of clock.

tLZ(DQ): CK_t - CK_c rising crossing at RL

Begin point : Extrapolated point at VDDQ

tLZ(DQ) begin point is above-mentioned extrapolated point.

DDR tCH(avg)

DDR tCH(avg) is defined as the average high pulse width and is calculated across 200-cycle window of
high pulses.

The application calculates this measurement using the following equation:

W
tCH(avg)=| T, CH ; H(VxtCE (avg))
J=1
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DDR tRPRE

DDR tRPRE is defined as the width of the READ preamble from the exit of tristate to the first rising edge
on DQS. tRPRE in DDR3-Write bursts uses DDR tWPRE (see page 301).

DQS Differential Ne 0

T

t2

t1 {RPRE_end

tRPRE_begin

The application cal culates this measurement using the following equation:
fREPRE (1) = [(RPRE end {?22 N — ((RPRE  start (?zl )

Where:

n, is the start time of the preamble.

n; is the end time of the preamble.
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DDR tWPRE

DDR tWPRE is defined as the width of WRITE preamble from the exit of tristate to the first rising edge on
DQS. This measurement is applicable only for DDR3 generation.

DQS Differential /_\ ’[ v
/4u tWPRE ‘\ .
2

t1 tWPRE_end
tWPRE _begin

The application calculates this measurement using the following equation:

(WERE = (WPRE _end(n,)) ~ (WPRE _start(n)))

Where:
n, is the start time of the preamble.

n, is the end time of the preamble.
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DDR tPST

DDR tPST is defined as the width of the postamble, from the last falling mid reference level crossing to the
start of an undriven state (as judged by arising trend per JEDEC specs), for either a Read or Write burst.

trpsT
DQS Differential

t2
tRPST_end

t1
tRPST_begin

(EST
#

o) = ((PST _end (;zz N = ((PST _ start (nl j).

Where:
n, is the start time of the postamble.

N, is the end time of the postamble.
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DDR Over Area

DDR Over Areais defined as the area of atriangle for which the base is defined by the crossings of the
configured reference level and the peak is the maximum voltage level attained between those crossings.

The area of focusis atriangular areain which the start and stop points are identified as closest to the
maximum point in the defined region.

The application calculates this measurement using the equation:

Maximum e Overshoot Area
Amplitude = 7|

Volts VDD
(V) Vss

Over Area= 0.5*Base*Height
Where:
Base is the width of the triangle.

Height isthe atitude of the triangle which specifies the maximum sample point from the triangular base.
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DDR Under Area

DDR Under Areais defined as the area of an inverted triangle for which the base is defined by the
crossings of the configured reference level and the (downward pointing) peak is the minimum voltage
level attained between those crossings.

The area of focusis an triangular areain which the start and stop points are identified as closest to the
maximum point in the defined region.

Volts VDD
(V) Vss

Maximum_—
Amplitude T ’LAJ\Pedaershoot

Time (ns)

The application calculates this measurement using the equation:
Under Area= 0.5*Base*Height
Base is the width of the triangle

Height is the altitude of the triangle which specifies the maximum sample point from the triangular base.

DDR VID(ac)

DDR VID(ac) specifies the AC differential input voltage. Thisis measured on a differential voltage DQS
signal, which is equivalent to using two single-ended signals such as DQS and DQS# separately. For more
details, refer to High-Low (see page 281) measurement.

The application calculates this measurement using the following equation:
VID(ac)= Maximum (High,—Low)

Where:

High is the worst-case value from positive to zero.

Low is the worst-case value from negative to zero.
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DDR3 Vix(ac)

DDR3 Vix(ac) is defined as the differential input cross-point voltage measured between the actual
crossover voltage of DQSDQS and VDD/2. It represents the differential input cross-point voltage relative
to VDD/2 for (CK/CK) or (DQS/DQS).

VDD
e N A N CK#, DSQ#
/ \ ,//
r/ \\ //
/// \\\ /',’
/
/ ¢ ) VIX / ¢
, /
\ / VD2
\
\
¢ Viy / Vi
/// \\\ ,//
/ A //
/// \\\ /
,,,,,,,,, / CK, DQS#
V8S

The application calculates this measurement using the following equation:

Crossover _ _
Vn - {Vmcn.!afcmssover VREf }

Where:
Vactualcrossover 1S the crossing between positive and compliment signals (DQS/DQS)

Vre= Vpbp/2
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PCle T-Tx-Diff-PP

PCle T-Tx-Diff-PP voltage swing calculates the change in voltage level across a transition in the
waveform. It is the peak-to-peak differentia voltage swing.

A A

The application calculates this measurement using the following equation:

Voign—p = Viigh = PLow)

Where:

Vir-pp 1S the differential peak-to-peak voltage.

Vhigh IS the maximum voltage calculated between i and i+1 points.
V Low IS the minimum voltage calculated between i and i+1 points.
i isthe index of the Ul (bit) location preceding the transition.

i+1 istheindex of the Ul (bit) location after the transition.
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PCle T-TX
PCle T-TX is based on the DPOJET measurement, Eye width. For more details, refer to the Eye width
(see page 273).

PCle T-Tx-Fall

PCle T-Tx-Fall is the time difference between the VRefLo(20%) reference level crossing and the
VRefHi(80%) reference level crossing on the falling edge of the waveform. The VRefLo and VRefHi are
calculated based on the voltage level of the previous Ul. There are two distinct thresholds corresponding to
de-emphasized transitions from high to low, and full swing transitions for VRefLo and VRefHi.

0.4 =) )

- &T%—F ‘ E%—F 20% /
0.2 + ,

00 +——3- \:
i ~ 20% l !l;
0.2 i R
P R G T
0.4 — — —
0.6 T T T T 7 e e L

The application cal culates this measurement using the following equation:
i L Hr

T;Fa :(Tn o _Tn z—}

Where:

TFdl jsthe fall time

TLo-isthe VRefLo crossing on the falling edge

THi- isthe VRefHi crossing on the falling edge
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PCle Tmin-Pulse

PCle Tmin-Pulse (minimum single pulse width Twinrus) IS Measured from one transition center to the next.

The application calculates this measurement using the following equation:

Til-ﬂ'z'n—PuI.se = (T::ﬂ _Tn)

Where:
Twin-ruse 1S the minimum pulse width

T isthe transition center

PCle DeEmph

PCle DeEmph is based on the DPOJET measurement, T/nT Ratio. For more details, refer to the TnT
Ratio (see page 279).

NOTE. PCle DeEmph measurement uses Brick Wall filter.
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PCle T-Tx-Rise

PCle T-Tx-Rise is the time difference between the VRefHi(80%) reference level crossing and the
VRefL0(20%) reference level crossing on the rising edge of the waveform. The VRefHi and VRefLo are
calculated based on the voltage level of the previous Ul. There are two distinct thresholds corresponding to
de-emphasized transitions from low to high, and full swing transitions for VRefHi and VRefLo.

0.4

- E%% ‘ E%% +22“:":. /
0.2 - H .

. 20% Tm-m _"15"_ Tm’.ss___i iq-_
00 = [

o |
S A N S

04

0.6 T T ! T 'I T ! T T 'I ! ! T T

The application cal culates this measurement using the following equation:

j-;ﬁ.se — (f-::fﬁ _E.-;!I.o+}

Where:

TRise js the Rise time

THi+ s the VRefHi crossing on the rising edge
TLo+ isthe VRefLo crossing on the rising edge

PCle Ul

PCle Ul isbased on the DPOJET measurement, Period. For more details, refer to the Period (see page 251).

NOTE. PCle Ul uses a 3rd order LPF with the cut-off frequency of 198 kHz.
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PCle Med-Mx-Jitter

PCle Med-Mx-Jitter is the maximum time between the jitter median and the maximum deviation from
the median.

The application cal culates this measurement using the following equation:

T—Jl—fed—Max—ﬁﬁer _ maX(Tﬁ'ﬁer—Median _ TfEn :I

Where:
TMed-Max-Jitter j5 the median to max jitter
TAitter-Median js the jitter median

TIE isthe Time interval error

PCle T-RF-Mismch

310

PCle T-RF-Mismch (Rise and Fall Time mismatch measurement) is the mismatch between Rise time
(TRi=e) and Fall time(TFal). Risetime and Fall time are calculated using the “PCle T-Tx-Rise” and “PCle
T-Tx-Fall” measurements.

The application cal culates this measurement using the following equation:

Jismateh Rise Fall
T =abyI™ -T")
Where:

TMismatch js the rise and fall time mismatch
TRise js the rise time

TFl s the fall time
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PCle MAX-MIN Ratio

PCle MAX-MIN Ratio (custom nameis PCle VRX-MAX-MIN Ratio) is defined as the voltage range
ratio over which a particular receiver must operate for the consecutive Ul. Locate the mid edges crossover

points. On the rising edge of the waveform, find the Vswyinemin. At the V swinemin pOiNt, trace back two unit
intervals to find the Vswinemax-

0.3

0.2 Y\

— 2 Ul «—
o /~ VSWING-MIN // \

Differential
Zero Crossing

/A
B A LAV
I Y.

-02

03 T T T T T T T T T [ T T T T T T T T T [1 ]

The application cal culates this measurement using the following equation:

Vvt i rario = Vswinamax 'V swicay
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Where:
Vswinemax 1S the maximum voltage swing on the rising edge of the waveform.

Vswinemin 1S the minimum voltage swing on the rising edge of the waveform.

PCle SSC PROFILE

PCle SSC Profile measurement uses the Period (see page 251) measurement with a second order low pass
filter of 1.98 MHz. The PCle SSC Profile shows the modulation profile of the Spread Spectrum Clocking.

Using the SSC profile, you can find the SSC modulation rate by using vertical bar cursors and peak-to-peak
frequency deviation by using horizontal bar cursors. The configurations required to be set are:

B Constant Clock Mean as the Clock Recovery method
= Low passfilter to get the SSC components

®  Time Trend Plot for the Period measurement

PCle SSC FREQ DEV

PCle SSC FREQ DEV is defined as the SSC frequency deviation in ppm (parts per million).

m  Usethe PCle SSC Profile measurement to locate the mid edge cross points.

m  Calculatethe HIGH value between the n and n+1 edge and the LOW value between n+1 and n+2 edges.
The application cal culates the measurement using the equation:

FREQ DEVIATION = HIGH-LOW

PCle AC Common Mode

312

The AC Common Mode Voltage measurement is the common mode voltage between two single-ended
signals. AC is defined as al the frequency components above the cutoff frequency (30 kHz).

The application calculates this measurement using the following eguations (based on two single-ended
sources from the DUT):

CM_Voltage = (Sourcel + Source2) + 2

AC_CMMp-p = Peak-to-Peak(High Pass filter (CM_Voltage))
Where:
AV_CMV,, is the peak-to-peak common mode voltage.
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GDDRS5 tBurst-CMD

GDDR5tBurst-CMD (WCK, DQ, CMD_BUS) is defined as the elapsed time between the last data element
of aREAD or WRITE burst to the next bus state. The next bus state depends on the command of interest
which is configured in the search. This measurement is available only on 64-bit MSO instruments.

This measurement requires that the Bus source and DPOJET Qualifiers should be turned on for DDR
read or DDR Write searches.
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CK
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GDDRS tCKSRE

The GDDR5 tCK SRE measurement is a Bus measurement for the GDDRS standard. This measures valid
CK clocks required after the self refresh entry (SRE). This measurement is available only on 64-bit MSO
instruments. The measurement requires Clock source and Bus as inputs.

|
| |
| | t
| |
| |

CMD:>< NOP ><:>< SRE ><:>< NOP ><2§/>< NOP ><

048-014

TO =time at which clock stops toggling, after self refresh entry.
T1 = Rising edge of clock where SRE command gets registered.
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GDDRS tCKSRX

The tCKSRX measurement is a Bus measurement for the GDDRS standard. Thisis the time elapsed
between the SRX command to valid clock cycles. The clock cycles get into continuous 1s or CK (#) Os
after the SRX. After the SRX command the algorithm searches forward on the CK source to lock onto the
clock cycles with continuous 1s. This measurement is only available on 64-bit M SO instruments.

0048015

ThO = time at which clock starts toggling, before self-refresh exit.
Th2 = Rising edge of clock where SRX command gets registered.

T-TX-DDJ

314

T-TX-DDJ s defined as the time delta between the PDF's mean for each zero crossing point and the
corresponding recovered clock edge.

= Recover the clock to convert it to a bit stream.
®  Find the repeating patterns to locate Pattern Length and Pattern Repeat Count.
m  For k=0 to Pattern_L ength, find the correlated jitter.
For i=0 to Pattern_Repeat_Count, find the edge jitter using:
Edgelitter; = Edge, — Recovered Edge
Correlated Jitter, = mean (Edgelitter)
The application calculates the measurement using the equation:

Data dependent Jitter (T-TX-DDJ) = max (CorrelatedJitter) — min (CorrelatedJitter)
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T-TX-UTJ

T-TX-UTJis referenced to a recovered data clock generated by means of a CDR tracking function.
Uncorrelated total jitter may be derived after removing the DDJ component from each PDF and combining
the PDFs for all edges in the pattern.

= Recover the clock to convert it to a bit stream.
B Find the repeating patterns to locate Pattern Length and Pattern Repeat Count.
= For k=0 to Pattern_Length, find the correlated jitter.
For i=0 to Pattern_Repeat_Count, find the edge jitter using:
Edgelitter; = Edge — Recovered Edge
Correlated Jitter, = mean (Edgelitter)
= Find uncorrelated jitter max and min values by removing the correlated jitter values using:
Max_Uncorrelated Jitter= Max ( Max_Uncorrelated Jitter, ( EdgeJitter — Corrolated Jitter,))
Min_Uncorrelated Jitter= Max ( Min_Uncorrelated Jitter, ( Edgelitter — Corrolated Jitter))
®  Find the absolute maximum uncorrelated jitter (max_abs_uj).
m  Usethe absolute value to create a histogram plot with appropriate bin values (used for creating PDFs).
= Create PDF and combine the PDFs of all edges.

®  Convert the PDF into Q scale and draw a gaussian line (Gaussian Fit) to calculate the vertical opening
on left and right side of the Q-scale curve.

The application cal culates the measurement using the equation:

Uncorrelated Total Jitter (T-TX-UTJ) = Vertical left opening— Vertical right opening
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T-TX-UDJDD

T-TX-UDJDD is defined as the uncorrelated jitter at the zero crossing point and at the corresponding
recovered clock edge.

m  Recover the clock to convert it to a bit stream.
B Find the repeating patterns to locate Pattern Length and Pattern Repeat Count.
= For k=0 to Pattern_Length, find the correlated jitter.
For i=0 to Pattern_Repeat_Count, find the edge jitter using:
Edgelitter; = Edge — Recovered Edge
Correlated Jitter, = mean (Edgelitter)

- Find uncorrelated jitter max and min values by removing the correlated jitter values using:
Max_Uncorrelated Jitter= Max ( Max_Uncorrelated Jitter, ( Edgelditter — Corrolated Jitter,))
Min_Uncorrelated Jitter= Max ( Min_Uncorrelated Jitter, ( Edgelitter — Corrolated Jitter,))

®  Find the absolute maximum uncorrelated jitter (max_abs _uj).
B Use the absolute value to create a histogram plot with appropriate bin values (used for creating PDFS).
m  Create PDF and combine the PDFs of all edges.

B Convert the PDF into Q scale and draw a gaussian line (Gaussian Fit) to calculate the vertical opening
on left and right side of the Q-scale curve.

= Calculate the Uncorrelated Total Jitter (T-TX-UTJ) = Vertical left opening— Vertical right opening

B Find where the gaussian line crosses the zero crossing and calculate T-TX-UDJ-DD.
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T-TX-UPW-TJ

T-TX-UPW-TJis defined as an edge-to-edge phenomenon on consecutive edges.

Recover the clock to convert it to a bit stream.

Find the repeating patterns to locate Pattern Length and Pattern Repeat Count.
For k=0 to Pattern_Length, find the correlated jitter.

For i=0 to Pattern_Repeat_Count, find the edge jitter using:

Edgelitter; = Edge, — Recovered Edge

Correlated Jitter, = mean (Edgelitter)

Replicate the correlated jitter for each of the repeated pattern.

Calculate the mean_pwij referencing to afixed leading edge and having jitter contributions from
both edges appear at the trailing edge.

Use the mean_pwij value to find a histogram plot to accommodate al the PWJ values to create the PDF.
Calculate the Q-Scale extrapolation for this PWJ-PDF.
Calculate the vertical opening on left and right side of the Q-scale curve.

Calculate the Uncorrelated Total Power Jitter (T-TX-PWJ-TJ) = Vertical left opening— Vertical right
opening
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T-TX-UPW-DJDD

T-TX-UPW-DJDD is defined as the Uncorrelated Pulse Width Jitter (PWJ) at the zero crossing.

= Recover the clock to convert it to a bit stream.

Find the repeating patterns to locate Pattern Length and Pattern Repeat Count.
For k=0 to Pattern_L ength, find the correlated jitter.

For i=0 to Pattern_Repeat_Count, find the edge jitter using:

Edgelitter; = Edge, — Recovered Edge

Correlated Jitter, = mean (Edgelitter)

= Replicate the correlated jitter for each of the repeated pattern.

= Calculate the PWJreferencing to afixed leading edge and having jitter contributions from both edges
appear at the trailing edge and calculate the mean_pw;j.

= Usethe absolute value to create a histogram plot with appropriate bin values (used for creating PDFS).
= Create PDF and combine the PDFs of al edges.

m  Convert the PDF into Q scale and draw a gaussian line (Gaussian Fit) to calculate the vertical opening
on left and right side of the Q-scale curve.

The application calculates the measurement using the equation:

Uncorrelated Total Jitter (T-TX-UTJ) = \ertical |eft opening— Vertical right opening

V-TX-EQ-NO

V-TX-EQ-NO is defined by setting c.; and ¢.; to zero and measuring the peak-to-peak voltage on the
64-ones/64-zeroes segment of the compliance pattern.

Find the 64 zeros/64 ones between two consecutive edges.

Find the voltage between the 57th to 62nd Ul of both positive and negative cycle.

Calculate the average voltage of both positive and negative cycle.

Find the voltage difference between positive and negative cycles.
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V-TX-EIEOS

V-TX-EIEOS is defined by setting c., coefficient value of —0.33 and a c.; coefficient value of 0.0 and
measuring the peak-to-peak voltage on the 8-ones/8-zeroes segment of the compliance pattern, where the
pattern is repeated for atotal of 128 UI.

B Find the 8 zeros/8 ones between two consecutive edges.
B Find the voltage between the 3rd to 7th Ul of both positive and negative cycle.
m Calculate the average voltage of both positive and negative cycle.

B Find the voltage difference between positive and negative cycles.

ps21TX

Package loss (ps21TX) is measured by comparing the 64-zeroes/64-ones PP voltage (V111) against a
1010 pattern (V101)

®  Find the 1010 bit pattern (V1) for 64 Ul in the compliance pattern.
B Find 64 ones/64zeros bit pattern (V111) adjacent to 1010 pattern.

= Find the 50,52 and 54t bits from the positive Uls and 49,51 and 53rd bits from the negative Uls of
the 1010 bit pattern.

m  Caculate the peak-to-peak voltage difference between positive and negative Uls.
= Find the voltage between 57th Ul to 62nd Ul of both positive and negative cycle.
B Calculate the average voltage of the positive and negative cycle.

= Find the voltage difference between positive and negative cycles.

The application calculates this measurement using the following equation:

Package Loss Ratio = 20109;0(V101/V111)
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V-Tx-Boost

320

V-Tx-Boost is when the ¢-1 and c+1 are nonzero and measuring the PP voltage on the 64-ones/64-zeroes
segment of the compliance pattern and with immediate single transition bit voltage.

Find 64-ones/64-zeros bit pattern.

Find the voltage between 57th Ul to 62nd Ul of positive cycle and negative cyclein V111 pattern.
Calculate the average voltage of the positive and negative cycle (V111) in each 4680 pattern.

Add all averaged voltages for entire waveform.

Average again by number of repetitions of 4680 bit patterns in the entire waveform. ThisisVb.
Find Single Ul pulse after 64-ones/64-zeros.

Calculate the peak-to-peak voltage difference between the positive and negative Ul (V1UI).
Average al V1UI for the entire waveform.

Calculate the VBoost = 20log10(V 1UI/V111).
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USB VTx-Diff-PP

VTx-Diff-PP voltage swing cal culates the change in voltage level across a transition in the waveform.
It is the peak-to-peak differential voltage swing.

M 7

s VTX-DIFF-PP

The application calculates this measurement using the following equation:

VTsz_ﬁ'—p—p = ':Vm'gh —VLow

Where:

Viti-pp 1S the differential peak-to-peak voltage.

Vign 1S the maximum voltage calculated between i and i+1 points.
VLow IS the minimum voltage calculated between i and i+1 points.
i isthe index of the Ul (bit) location preceding the transition.

i+1 isthe index of the Ul (bit) location after the transition.
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USB TCdr-Slew-Max

Slew rate measurement finds the peak-to-peak period jitter. Period jitter can be obtained by taking the
first difference of the filtered phase jitter. The application uses the Period measurement with an LPF of
1.98 MHz to find the period jitter. It calculates the phase jitter by taking the cumulative sum of the period
jitter. Filters the phase jitter with the CR transfer function using the following equation:

2

2elar, ta,

H (&) =
CDR 52+25.§mﬂ+m3

The filtered period jitter is obtained from the phase jitter to calculate peak-to-peak period jitter.

USB Tmin-Pulse-Tj

Tmin-Pulse-Tj (minimum single pulse width Tyinruse) IS Measured from one transition center to the
next including all jitter sources.

The application calculates this measurement using the following equation:

Thtin-Putse 7y = T — I)

Where:
Twinruse 1S the minimum pulse width

T isthe transition center

USB Tmin-Pulse-Dj

322

USB Tmin-Pulse-Dj is defined as the minimum pulse width with only deterministic jitter components.
= Plot the time trend for the TIE measurement.

m  Takethe FFT of the TIE time trend to get the TIE spectrum. Then separate the RJ and DJ values
from the spectrum.

m  Takethe IFFT of the TIE spectrum without the RJ components and reconstruct the clock based on the
TIE trend without the RJ components.

®  Find the minimum pulse width within the reconstructed clock.
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USB SSC MOD RATE

USB SSC MOD RATE is defined as the SSC modulation rate in terms of Hz. Use the SSC Profile
measurement to locate the mid edge crossover points. Determine the time difference between the
consecutive mid reference voltage levels as shown:

At= Toer—Th

Where:

T, is the Vgermig Crossing time

The1 isthe N+1 Vgermig Crossing time

The application calculates this measurement using the following equation:

Modulation Rate= 1/4t

USB SSC FREQ-DEV-MAX

USB SSC FREQ DEV MAX is defined as the maximum frequency shift as a function of time. It represents
the frequency deviation in terms of ppm (parts per million).

B Find the 50% edges on the SSC profile.

m  Caculate the HIGH value between the n and n+1 edge.

= Find the Maximum frequency deviation as HIGH.

The application cal cul ates the measurement using the equation:

Freq Dev Maxpm= ((Maximum Freg—Nominal Data Rate)/Nominal Data Rate)* 1e6

USB SSC FREQ-DEV-MIN

USB SSC FREQ DEV MIN is defined as the minimum frequency shift as a function of time. Represents
the frequency deviation in terms of ppm (parts per million).

= Find the 50% edges on the SSC profile.

m  Caculate the LOW value between the n and n+1 edge.

®m  Find the Maximum frequency deviation as LOW.

The application cal cul ates the measurement using the equation:

Freg Dev Mingm= ((Minimum Freg—Nominal Data Rate)/Nominal Data Rate)* 1e6
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USB SSC PROFILE

USB SSC Profile measurement uses the Period (see page 251) measurement with a second order low pass
filter of 1.98 MHz. The USB SSC Profile shows the modulation profile of the Spread Spectrum Clocking.
Using the SSC profile, you can find the SSC modulation rate by using horizontal cursors and peak-to-peak
frequency deviation by using vertical cursors. The configurations required to be set are:

m  Constant Clock Mean as the Clock Recovery method
m  Low passfilter to get the SSC components

®  Time Trend Plot for the Period measurement

USB Ul

USB Ul isbased on the DPOJET measurement, Period. For more details, refer to the Period (see page 251).

NOTE. USB Ul usesa 3rd order LPF with the cut-off frequency of 198 kHz.

USB AC Common Mode

The USB AC Common Mode Voltage measurement is the common mode voltage between two
single-ended signals. AC is defined as all the frequency components above the cutoff frequency (30 kHz).

The application cal culates this measurement using the following equations (based on two single-ended
sources from the DUT):

CM_Voltage = (Sourcel + Source2) + 2

AC_CMMp-p = Peak-to-Peak(High Pass filter (CM_Voltage))
Where:
AV_CMV,, is the peak-to-peak common mode voltage.

Jitter Analysis Through RJ/DJ Separation

324

Many of the jitter measurements are based on the concept of RYDJ separation. The application beginswith
the measured jitter-versus-time (as represented by the TIE measurement array) and analytically determines
the random and deterministic components of the jitter. The deterministic part is further separated into
independent subcomponents with specific characteristics.
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The random jitter (RJ) is assumed to be zero-mean Gaussian, and is assumed to have aflat spectrum when
viewed in the frequency domain. The measured RJ s fitted to a Gaussian mathematical model, which is
parameterized by its standard deviation. Using the mathematical model for RJ, statistically probable jitter
extremes may be predicted for much greater populations than actually measured.

The deterministic jitter (DJ) is predictable and can be generated consistently given known circumstances.
The various DJ measurements each report the peak-to-peak value of the corresponding DJ subcomponent.

Once all the jitter components have been identified and the random jitter has been converted to a
mathematical model, the components can be reassembled such that performance may be extrapolated

to extremely low bit error rates. The probabilistic Total Jitter (TJ@BER) and probabilistic Eye Width
(Width@BER) are examples of such measurements. The reported values are predictions that correspond to
a user-specified Bit Error Rate, rather than observed values.

Two approaches are supported for performing jitter separation. The first method is based on spectrum
analysis. It isonly possible when the data pattern is repetitive. A clock waveform is always repetitive.
Other repetitive testing data patterns are used, such asthe K28.5 data pattern. Patterns may have rather long
repetition lengths; for example, the CITPAT pattern is 2640 bits. When using this method, you must specify
the pattern length, and you will receive awarning if the pattern length appears to differ from that specified.

The second RYDJ separation method, known as arbitrary pattern analysis, may be used when the data
pattern is not necessarily repetitive. This method works by correlating deterministic jitter observed over
many repetitions with the bit pattern within a time-domain window surrounding each observation.

RJ/DJ Separation via Spectrum Analysis

When the source waveform represents a repeating data pattern, Deterministic Jitter (DJ) has a frequency
spectrum of impulses. The impulses due to the data pattern are equally spaced and occur at predictable
frequencies related to the pattern length and bit rate. Specifically, the pattern-related jitter impulse must
occur at multiples of fo/N, where f, is the data bit rate and N is the data pattern length. Other spectral
impulses may occur due to periodic jitter not correlated with the data pattern.

To obtain measurements of DJ and RJ, all the components of the jitter spectrum that exceed the noise floor
by a chosen margin are attributed to deterministic jitter. Those components that fall at the frequency
increment corresponding to the pattern length are identified as data-dependent jitter, and those occurring
at other frequencies are attributed to uncorrelated periodic jitter. The remaining spectral noise floor
(appropriately normalized to account for the removed deterministic jitter) is integrated to predict the
standard deviation of the underlying Gaussian random noise process.

Once the spectral components corresponding to each deterministic jitter type have been identified, each
component is inverse-transformed back to the time domain. From these waveforms, the peak-to-peak jitter
for each component is determined. For the random jitter, the RMS deviation is directly computable

from the standard deviation of the Gaussian model.
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RJ/DJ Separation for Arbitrary Patterns

326

When the data pattern borne by the source waveform is not cyclically repeating, any periodic jitter still has
afrequency spectrum consisting of impulses but this is not true of the data-dependent jitter.

In this case, analysis of the data-dependent jitter may proceed based on the assumption that any given
bit is affected by afinite (and relatively small) number of preceding bits. By averaging all events for
which a given bit is preceded by a particular bit sequence, the data-dependent jitter attributable to that
bit sequence is obtained. Thisis because PJ and RJ are not correlated to a particular data sequence and
thus are averaged out.

If each bit is assumed to be affected by N preceding bits, there are atotal of 2N possible data sequences.
The sequence length N is a configurable parameter. To get statistically sound average values for the
data-dependent jitter, a minimum population of observationsis required for each individual pattern that
occurs at least once. This population limit is also configurable by the user.

By the above means, the data-dependent jitter is characterized. Once characterized, the data-dependent
jitter, on a bit-by-bit basis, may be removed from the origina jitter versus time record. The remaining
jitter is composed of periodic and random jitter. Thisjitter is transformed into the frequency domain,
and the spectral analysis approach is used to separate the impulsive periodic jitter from the broad noise
floor of random jitter.
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Separation of Non-Periodic Jitter (NPJ)

Bounded Uncorrelated Jitter (BUJ) refersto all bounded jitter that is not correlated to the data pattern
on the waveform. Thus, it excludes DDJ, DCD and RJ. It can be further subdivided into PJ (which is
deterministic, and easily recognized using a spectral approach) and Non-Period Jitter (NPJ).

Depending on its precise nature, NPJ is often difficult to distinguish from RJ. It typically cannnot be
isolated using frequency domain techniques, so a different domain is used. The important difference
between RJ and NPJis that RJ has a Gaussian distribution (with unbounded tails) whereas NPJ is bounded
by definition. Thisfact is used as a basis for separation.

In DPOJET, the jitter separation algorithms are modified as follows when the Spectral + BUJ method
is selected:

1. Data-Dependent Jitter (DDJ) and Duty-Cycle jitter (DCD) are first removed using either a spectral
approach for repeating patterns or a correlation approach for arbitrary data patterns.

2. PJisidentified and removed using a spectral approach.

3. Theremaining jitter is assumed to contain (Gaussian) RJ and possibly NPJ. (In the Spectral Only
method of jitter analysis, no further processing is done and thisjitter is reported as RJ.)

4. When Spectral + BUJ processing is selected, the RJ + NPJjitter is collected into a histogram that is
typically accumulated over multiple waveform acquisitions. When the (user-configurable) minimum
histogram population has been acquired, the histogram is converted to an estimate of the Cumulative
Density Function (CDF) and plotted using the Q-scale for the vertical axis. The Q-scale plot has
the property that a true Gaussian distribution appears as a straight line, with a slope equal to /o
(where ¢ is the standard deviation of the Gaussian distribution). If the distribution is a mixture of a
true Gaussian plus some bounded distribution, the plotted curve has |eft and right extremes that
asymptotically approach straight lines with a slope of 1/6. The horizontal offset between the two
asymptotes represents the dual-dirac magnitude of the NPJ.

Estimation of TJ@BER and Eye Width@BER

One of the outcomes of the R¥DJ separation was a mathematical model for random jitter’s probability
density function (PDF) and measured values for the PDFs of the deterministic jitter components. Since
al of these components are assumed to be statistically independent, the PDF of the total jitter can be
calculated by convolution.

Integration of the PDF yields the cumulative distribution function (CDF), which can then be used to create
the bit error rate curve (bathtub curve). Based on the bathtub curve, the eye opening (Width@BER) and
eye closure (TJ@BER) can be estimated for a given bit error rate.

The application calculates the eye opening at the specified BER using the following equation:
Eye opening = 1-TJ@BER when TI@BER is less than one Unit Interval
Eye opening = 0 when TJ@BER exceeds one Unit Interval
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Jitter Estimation Using Dual-Dirac Models

Jitter estimation based on R¥DJ separation depends in part on the specific jitter components model ed.
For the purposes of analyzing jitter and identifying root cause, it is very useful to identify components
as specifically as possible. But for the purposes of determining compliance, it has been found that a
simplified jitter model yields results that are more consistent across different measurement instruments
and different vendors.

A simplified model that has found acceptance in several industry standards is known as the Dual-Dirac
model. Thisis because the probability density function (PDF) of al the deterministic jitter is replaced
with a PDF consisting of two Dirac functions such that the total jitter and eye opening at very low bit
error rates is unchanged. The Random Jitter and Deterministic Jitter values derived from this model
are identified as RJ-66 and DJ-03, respectively.

Two dlightly different Dual-Dirac models have been defined. Both models begin with a jitter versus
BER (bathtub) curve, either created from afull jitter analysis based on RJDJ separation, or from direct
measurement of error rate versus sample point offset. The two models differ in how the R}-66 and DJ-66
values are extracted from the curve.

For the Fibre-Channel standard, values for R}-66 and DJ-36 are chosen such that the Dual-Dirac bathtub
curve exactly matches the measured curve at the BER = 10-5and BER=10-? points.

For the PCI Express and FB-DIMM standards, the bathtub curve is re-plotted using a different y-axis.
Instead of directly plotting against the log of the BER, the y-axisis converted to the Q-scale. The BER to
Q-scale transformation was designed such that Gaussian distributions are converted to straight lines, with a
slope that is directly related to the standard deviation of the Gaussian.

When using the Dual-Dirac jitter measurements, it is critical that you select the model that matches
the applicable standard. This may be configured in the DPOJET preferences, which are found under
Analyze > Jitter and Eye Analysis (DPOJET) > Preferences, on the Measurement tab.

Results

328

The application calculates statistics for all selected measurements. The application displays the following
statistics in the Results menu:

®  Mean

= Std Dev (Standard Deviation)
B Max (Maximum Value)

®  Min (Minimum Value)

m  p-p (Peak-to-Peak)

B Population
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m  Max-cc (Maximum positive cycle-to-cycle variation)

B Min-cc (Maximum negative cycle-to-cycle variation)
Mean
The application calculates the mean value using the following equation:

_ 1 2
Mean( X =X=—M%X%
0-%- 137,

H=1

Standard Deviation

The application calculates the standard deviation using the following equation:

1 & =
Six - X

widDev( X)) =, = \/(I‘J )
H=1

It may seem odd that the equation for the estimate of the Standard Deviation contains a 1/(N-1) scaling

factor. If you knew the true mean of X and used it in place of the estimated mean X then you would, in fact,
scale by 1/N. But, Xis an estimate and islikely to bein error (or bias), causing the estimate of the Standard
Deviation to betoo small if scaled by 1/N. Thisisthereason for the scaling shown in the equation. (Refer to
Chapter 9.2 in A. Papoulis, Probability, Random Variables, and Stochastic Processes, McGraw Hill, 1991.)

NOTE. RMSvalue can be calculated using the relation (rms)2= (mean value)2+ (stddev)2.

Maximum Value
The application cal culates maximum value using the following equation:

Max(X) = Most Positive Value of X

Minimum Value
The application calculates minimum value using the following equation:

Min(X) = Most Negative Value of X
p-p

The application calculates peak-to-peak using the following equation:
p-p(X) = Max(X )— Min(X)
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Population
Population is the total number of events or observations over which the other statistics were calculated.

Population (X) =N

Max-cc

The application calculates Max-cc using the following equation:
Max-cc(X) = Max(Xcc )

Where:

Xcc isthe first difference of X.

Ao =&, 4

Min-cc

The application calculates Min-cc using the following equation:
Min-cc(X) = Min(Xcc )

Where:

Xcc is the first difference of X.

Hop =&, — X,
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About the GPIB Program

You can use remote GPIB commands to communicate with the DPOJET application. An example
of a GPIB program that can execute the DPOJET application is included with the application in
C:\Users\Public\Tektronix\TekApplications\DPOJET\Examples.

The example shows how a GPIB program executes the application to do the following tasks:
1. Start the application.

2. Recdl asetup.

3. Take a measurement.

4. View measurement results and plots.

5

Exit the application.

NOTE. Commands are not case and space sensitive. Your program will operate correctly even if you do
not follow the capitalization and spacing precisely.

GPIB Reference Materials

To use GPIB commands with your oscilloscope, you can refer to the following materials:

m  The GPIB Program Examplein C:\Users\Public\Tektronix\TekApplications\DPOJET\Ex-
amples for guidelines to use while designing a GPIB program.

B The Parameters topics for range of values, minimum units and default values of parameters.

= The programmer information in the online help of your oscilloscope.
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Argument Types

332

The syntax shows the format that the instrument returnsin response to aquery. Thisis also the preferred
format when sending the command to the instrument though any of the formats will be accepted. This
documentation represents these arguments as follows:

Table 80: Argument types

Symbol Meaning

<NR1> Signed integer value.

<NR2> Floating point value without an exponent.
<NR3> Floating point value with an exponent.
double Double precision floating point with exponent.
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GPIB Commands DPOJET: ADDMeas

DPOJET: ADDMeas

This set-only command adds the specified measurement to the bottom of the current DPOJET list of
measurements and will appear in the results summary page.

Syntax

DPOJET:ADDmeas {PERIod | CCPeriod | FREQuency | NPERiod | PWidth | NWIdth

| PDUTy | NDUTy | PCCDuty | NCCDuty | TIE | RJ | RJIDirac | TJdber | DJ |
DJDirac | PHASENoise | DCD | DDJ | PJ | J2 | J9 | SRI | FN | RISEtime |

SETup | HIGHTime | FALLtime | HOLD | LOWTime | SKEW | HElght | WIDth |
MASKHits | WIDTHBer | HEIGHTBer | COMmonmode | HIGH | TNTratio | HIGHLOW

| LOW | VDIFFxovr | DDRSETUPSe | DDRSETUPDiff | DDRHOLDSe | DDRHOLDDiff

| DDRTCLaverage | DDRTJITDuty | DDRTCKaverage | DDRTDQSS | DDRTERrn |
DDRTJITper | DDRTCHaverage | DDRTERRMN | RISESLEWrate | FALLSLEWrate |
OVERShoot | UNDERShoot | CYCLEPktopk | DDRTRpre | DDRTPst | CYCLEMIn |
CYCLEMAX | ACCommonmode | DDROverarea | DDRTWpre | DDRVIDac | DDR3VIXac

| JITTERSummary | PCIETTXDiffpp | PCIEDEemph | PCIETTx | PCIETTXRise |
PCIETTXFall | PCIEUlI | PCIETMinpulse | PCIEMEdmxjitter | PCIETRFfmismch |
PCIESSCFReqdev | PCIEMAXMINratio | PCIESSCPROFile | PCIEVEye | PCIETTXUTJ |
PCIETTXUDJDD | PCIETTXUPWTJ | PCIETTXUPWDJDD | PCIETTXDDJ | PCIEVTXBOOST |
PCIEVTXNOEQ | PCIEVTXEIEOS | PCIEPS21TX | PCIEACCommonmode | |VTXDiffpp |
TMINPULSETJ | TCDRslewmax | USBUI | USBACCommonmode | TMINPULSEDJ | DDR2TDQSCK
| GDDR5TBursttocmd| GDDR5TCKSRX | GDDR5TCKSRE | QFACTOR | EYELOW | EYEHIGH

| TCMDTOCMD | TIMEOUTSIDELEVEL | SSCFREQDEVMAX | SSCFREQDEVMIN | SSCFREQDEV

| SSCMODrate | SSCPROfile | USBSSCFREQDEVMAX | USBSSCFREQDEVMIN | USBSSCMODrate
| USBSSCPROFile | AUTOFITMaskhits}

Inputs

Same as syntax for measurement options.

Outputs

None
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GPIB Commands DPOJET:APPLYAII

DPOJET:APPLYAI

This command applies configuration of specified type of the specified DPOJET measurement to all other
DPOJET measurements.

Syntax

DPOJET: APPLYAIl {FILTers | CLOCKRecovery| RJDJ}, MEAS<x>

Inputs
{FILTers | CLOCKRecovery|] RJDJ}, MEAS<x>

For example: DPOJET:APPLYAIl FILTers, MEAS2
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GPIB Commands DPOJET:BURST Config:BUS

DPOJET:BURSTConfig:BUS

This command sets or queries the required Bus source.

Syntax
DPOJET:BURSTConfig:BUS <string>
DPOJET :BURSTConfig:BUS?

Inputs

<string>

Outputs

<string>

DPOJET:BURSTConfig:CSACTIve

This command sets or queries the Active selection for the Chip select source.

Syntax
DPOJET:BURSTConfig:CSACTIve {L | H}
DPOJET:BURSTConfig:CSACTIve?

Inputs
{L | H}

Outputs
{L | H}
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GPIB Commands DPOJET:BURST Config: CSSource

DPOJET:BURSTConfig:CSSource

This command sets or queries the required source for Chip select.

Syntax
DPOJET:BURSTConfig:CSSource {CH1 — CH4 | MATH1 — MATH4 | REF1 — REF4}
DPOJET :BURSTConfig:CSSource?

Inputs

{CH1 - CH4 | MATH1 — MATH4 | REF1 — REF4}

Outputs
{CH1 — CH4 | MATH1 — MATH4 | REF1 — REF4}

DPOJET:BURSTConfig:CUSTOMRate

This command sets or queries the custom data rate values for a particular DDR generation.

Syntax
DPOJET:BURSTConfig:CUSTOMRate <NR3>

DPOJET :BURSTConfig:CUSTOMRate?

Inputs

<NR3>

Outputs

<NR3>
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GPIB Commands DPOJET:BURST Config:DATA

DPOJET:BURSTConfig:DATA

This command sets or queries the required source for Data.

Syntax
DPOJET:BURSTConfig:DATA {CH1 — CH4 | MATH1 — MATH4 | REF1 — REF4}
DPOJET :BURSTConFig:DATA?

Inputs

{CH1 — CH4 | MATH1 — MATH4 | REF1 — REF4}

Outputs
{CH1 — CH4 | MATH1 — MATH4 | REF1 — REF4}

DPOJET:BURSTConfig:DATARate

This command sets or queries the standard data rate values for a particular DDR generation.

Syntax
DPOJET :BURSTConfig:DATARate <string>
DPOJET:BURSTConfig:DATARate?

Inputs

<string>

Outputs

<string>
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GPIB Commands DPOJET:BURST Config:DETECTMethod

DPOJET:BURSTConfig:DETECTMethod

This command sets or queries the burst detection method used for burst identification.

Syntax
DPOJET :BURSTConfig:DETECTMethod {DQDQS | CHIPSelect | LOGICState}
DPOJET :BURSTConfig:DETECTMethod?

Inputs

{DQDQS | CHIPSelect | LOGICState}

Outputs
{DQDQS | CHIPSelect | LOGICState}

DPOJET:BURSTConfig:GENERation

This command sets or queries the required DDR generation.

Syntax

DPOJET :BURSTConFig:GENERation {DDR | DDR2 | DDR3 | LPDDR | LPDDR2 | GDDR3 |
GDDR5}

DPOJET :BURSTConfig:GENERation?

Inputs

{DDR | DDR2 | DDR3 | LPDDR | LPDDR2 | GDDR3 | GDDR5}

Outputs
{DDR | DDR2 | DDR3 | LPDDR | LPDDR2 | GDDR3 | GDDR5}
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GPIB Commands DPOJET:BURST Config:L ATEncy

DPOJET:BURSTConfig:LATEncy

This command sets or queries the required burst latency.

Syntax
DPOJET :BURSTConfig:LATEncy <NR3>
DPOJET :BURSTConfig:LATEncy?

Inputs

<NR3>

Outputs
<NR3>

DPOJET:BURSTConfig:LENGth

This command sets or queries the required burst length.

Syntax
DPOJET:BURSTConfig:LENGth <NR3>

DPOJET:BURSTConfig:LENGth?

Inputs

<NR3>

Outputs

<NR3>

DPOJET Jitter and Eye Diagram Analysis Tools 339



GPIB Commands DPOJET:BURST Config:SEARch

DPOJET:BURSTConfig:SEARch

This command sets or queries the type of search required.

Syntax
DPOJET :BURSTConfig:SEARch {DDRRead | DDRWrite | DDRREADWRITE}
DPOJET :BURSTConfig:SEARch?

Inputs

{DDRRead | DDRWrite | DDRREADWRITE}

Outputs
{DDRRead | DDRWrite | DDRREADWRITE}

DPOJET:BURSTConfig:STRObe

This command sets or queries the required source for the strobe.

Syntax
DPOJET:BURSTConfig:STRObe {CH1 - CH4 | MATH1 - MATH4 | REF1 - REF4}
DPOJET :BURSTConfig: STRObe?

Inputs

{CH1 - CH4 | MATH1 - MATH4 | REF1 - REF4}

Outputs
{CH1 - CH4 | MATH1 - MATH4 | REF1 - REF4}
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GPIB Commands DPOJET:BURST Config: TOL ERance

DPOJET:BURSTConfig:TOLERance

This command sets or queries the required burst tolerance.

Syntax
DPOJET :BURSTConfig: TOLERance
DPOJET :BURSTConfig: TOLERance?

Inputs

<NR3>

Outputs
<NR3>

DPOJET.CLEARALLMeas

This set-only command clears the entire current list of defined measurements in DPOJET.

Syntax
DPOJET : CLEARALLMeas

Outputs

None
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GPIB Commands DPOJET:DESKEW

DPOJET:DESKEW

This command performs a DPOJET deskew operation with the settings specified in DPOJET:DESKEW.

Syntax
DPOJET:DESKEW {EXEcute}

Inputs

{EXEcute}

DPOJET:-DESKEW:DESKEWchannel

This command sets or queries the channel to be deskewed.

Syntax
DPOJET : DESKEW: DESKEWchannel {CH1-CH4}

DPOJET : DESKEW: DESKEWchannel?

Inputs

{CH1 - CH4}

Outputs
{CH1 - CH4}
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GPIB Commands DPOJET:DESKEW:DESK EWHYysteresis

DPOJET:DESKEW:DESKEWHysteresis

This command sets or queries the deskew channel hysteresis value.

Syntax
DPOJET : DESKEW: DESKEWHysteresis <NR3>

DPOJET : DESKEW : DESKEWHysteresis?

Inputs

<NR3>

Outputs
<NR3>

DPOJET:DESKEW:DESKEWMidlevel

This command sets or queries the deskew channel midlevel value.

Syntax
DPOJET : DESKEW:DESKEWMidlevel <NR3>
DPOJET : DESKEW: DESKEWMidlevel?

Inputs

<NR3>

Outputs

<NR3>
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GPIB Commands DPOJET:DESKEW:EDGE

DPOJET:-DESKEW:EDGE

This command sets or queries the edge types used when calculating deskew.

Syntax
DPOJET:DESKEW:EDGE {RISE | FALL | BOTH}
DPOJET : DESKEW : EDGE?

Inputs

{RISE | FALL | BOTH}

Outputs
{RISE | FALL | BOTH}

DPOJET:DESKEW:MAXimum

This command sets or queries the maximum deskew value possible.

Syntax
DPOJET :DESKEW:MAXimum <NR3>
DPOJET : DESKEW : MAXimum?

Inputs

<NR3>

Outputs

<NR3>
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GPIB Commands DPOJET:DESKEW:MINimum

DPOJET:DESKEW:MINimum

This command sets or queries the minimum deskew value possible.

Syntax
DPOJET :DESKEW:MINimum <NR3>

DPOJET : DESKEW:MINimum?

Inputs

<NR3>

Outputs
<NR3>

DPOJET:DESKEW:REFChannel

This command sets or queries the reference channel used for deskew operation.

Syntax
DPOJET :DESKEW:REFChannel {CH1 - CH4}
DPOJET : DESKEW:REFChannel?

Inputs

{CH1 - CH4}

Outputs
{CH1 - CH4}
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GPIB Commands DPOJET:DESKEW:REFHysteresis

DPOJET:DESKEW:REFHYysteresis

This command sets or queries the reference channel hysteresis value.

Syntax
DPOJET : DESKEW: REFHysteresis <NR3>

DPOJET : DESKEW: REFHysteresis?

Inputs

<NR3>

Outputs
<NR3>

DPOJET:DESKEW:REFMidlevel

This command sets or queries the reference channel midlevel value.

Syntax
DPOJET :DESKEW:REFMidlevel <NR3>
DPOJET :DESKEW:REFMidlevel?

Inputs

<NR3>

Outputs

<NR3>
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GPIB Commands DPOJET:DIRacmodel

DPOJET:DIRacmodel

This command sets or queries the current dirac model.

Syntax
DPOJET:DIRacmodel {FIBREchannel | PCIExpress}

DPOJET:DIRacmodel?

Inputs

{FIBREchannel | PCIExpress}

Outputs
{FIBREchannel | PCIExpress}

DPOJET:EXPORT

This set-only command saves the specified DPOJET plot to the specified file path. The Format is
determined through the filename extension, with a default of png if no extension is specified.

Supported extensions include jpeg, jpg, tif, tiff, bmp, emf, and png. For example: DPOJET.EXPORT
PLOT1, “savedimage.tif”.

Syntax

DPOJET:EXPORT {PLOT1-PLOT4, <Ffile string>}

Inputs

{PLOT1-PLOT4, <file string>}
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GPIB Commands DPOJET:GATING

DPOJET:GATING

This command sets or queries the gating state.

Syntax
DPOJET:GATING {OFF | ZOOM | CURSOR | MARKS}
DPOJET :GATING?

Inputs
{OFF | ZOOM | CURSOR | MARKS}

Outputs
{OFF | ZOOM | CURSOR | MARKS}

DPOJET:HALTFreerunonlimfail

This command sets or queries the halt free-run on limit failure (On or Off).

Syntax
DPOJET:HALTFreerunonlimfail {1 | O}
DPOJET :HALTFreerunonlimfail?

Inputs
{110}

Outputs
{11 0}
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GPIB Commands DPOJET:HIGHPerfrendering

DPOJET:HIGHPerfrendering

This command sets or queries the current high-performance eye rendering setting.

Syntax
DPOJET:HIGHPerfrendering <NR1>

DPOJET:HIGHPerfrendering?

Inputs

<NR1>

Outputs
<NR1>

DPOJET:INTERp

This command sets or queries the current interpolation model.

Syntax
DPOJET: INTERp {LINear | SINX}
DPOJET: INTERp?

Inputs

{LINear | SINX}

Outputs
{LINear | SINX}
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GPIB Commands DPOJET:JI Ttermode?

DPOJET:JITtermode?

This command queries the current jitter mode.

Syntax

DPOJET:JITtermode?

Outputs

<string>

DPOJET:JITtermodel

This command sets the current jitter model.

Syntax

DPOJET:JITtermodel {BUJ | Legacy}

Inputs

{BUJ | Legacy}

DPOJET:LASTError?

This query-only command returns the contents of the last pop-up warning dialog box. If no errors have
occurred since startup, or sincethelast cal to DPOJET:LASTError?, this command returns an empty string.

Syntax

DPOJET :LASTError?

Outputs

<string>
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GPIB Commands DPOJET.LIMITRise

DPOJET:LIMITRise

This command turns on or off the ability to limit Rise/Fall measurements to transition bits only.

Syntax
DPOJET:LIMITRise {1 | 0}

Inputs

{11 0}
Outputs

{11 0}

DPOJET:MINBUJUI

This command sets or queries the minimum number of Ul for BUJ analysis.

Syntax
DPOJET:MINBUJUI <NR3>
DPOJET :MINBUJUI?

Inputs

<NR3>

Outputs

<NR3>
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GPIB Commands DPOJET:LIMits.:FILEName

DPOJET:LIMits:FILEName

This command sets or queries the current limits filename.

Syntax
DPOJET:LIMits:FILEName <string>

DPOJET:LIMits:FILEName?

Inputs

<string>

Outputs

<string>

DPOJET:LIMits:STATE

This command turns on or off the pass-fail limit system. Pass-fail status can be queried using the
DPOJET:MEAS <x>:RESULTS node.

Syntax
DPOJET:LIMits:STATE {1 | O}

Inputs
{110}

Outputs
{11 0}
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GPIB Commands DPOJET:LOGging:MEA Surements:FOL Der

DPOJET:LOGging:MEASurements:FOLDer

This command sets or queries the current folder used for measurement logging.

Syntax
DPOJET:LOGging:MEASurements:FOLDer <string>

DPOJET:LOGging:MEASurements:FOLDer?

Inputs

<string>

Outputs

<string>

DPOJET:LOGging:MEASurements:STATE

This command turns on or off the future logging of measurements. Individual measurementsincluded in
the logging are selected using the DPOJET:MEA S<x>:LOGging node. This parameter turns on or off the
entire set of included measurements.

Syntax
DPOJET:LOGging:MEASurements: {1 | 0}

Inputs

{110}

Outputs
{11 0}

DPOJET Jitter and Eye Diagram Analysis Tools 353



GPIB Commands DPOJET:LOGging: SNAPshot

DPOJET:LOGging:SNAPshot

This command performs a DPOJET export of the specified type, either for statistics or measurements.

Syntax

DPOJET:LOGging:SNAPshot {STATistics | MEASurements}

Inputs

{STATistics | MEASurements}

Outputs

{STATistics | MEASurements}

DPOJET:LOGging:STATistics:FILEName

This command sets or queries the current file used for statistics logging.

Syntax
DPOJET:LOGging:STATistics:FILEName <string>
DPOJET:LOGging:STATistics:FILEName?

Inputs

<string>

Outputs

<string>
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GPIB Commands DPOJET:LOGQging:STATIstics:STATE

DPOJET:LOGging:STATistics:STATE

This command turns on or off the future logging of statistics. Individual measurements included in the
logging are selected using the DPOJET:MEA S<x>:LOGging node. This parameter turns on or off the
entire set of included measurements.

Syntax
DPOJET:LOGging:STATistics:STATE {1 | O}

Inputs
{110}

Outputs
{11 0}

DPOJET:LOGging:WORSTcase:FOLDer

This command sets or queries the current folder used for worst case logging.

NOTE. Waveform filenames generated while worst case logging is on will follow the syntax of
“Measurement Name” - Source” _Minl.wfm and “ Measurement Name” - Source” _Max1.wfm, For
example: Periodl-Chl Max1.wfm, Period1l-Chl_Minl.wfm, Rise Timel-Chl Maxl.wfm, Rise
Timel-Chl Minl.wfm.

Syntax
DPOJET:LOGging:WORSTcase:FOLDer <string>
DPOJET :LOGging:WORSTcase:FOLDer?

Inputs

<string>

Outputs

<string>
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GPIB Commands DPOJET:LOGging:WORSTcase:STATE

DPOJET:LOGging:WORSTcase:STATE

This command turns on or off the future logging of worst case waveforms. Individual measurements
included in the logging are selected using the DPOJET:MEA S<x>:LOGging node. This parameter turns
on or off the entire set of included measurements.

Syntax
DPOJET:LOGging:WORSTcase:STATE {1 | O}

Inputs
{110}

Outputs
{11 0}

DPOJET:MEAS<x>

This command returns the branch query for the application measurement slot with index <x>. Thiswill
always match the measurement defined at the associated index <x> displayed on the DPOJET screen,
where index 1 isthefirst, or top, of the measurement list.

Branch queries will only contain the measurement branches for those branches that have measurements
defined. This means queries to branches that do not exist will time out. Thisis required because the
number of measurements that can be defined in DPOJET, is 99.

Syntax
DPOJET :MEAS<x>

DPOJET :MEAS<x>?

356 DPOJET Jitter and Eye Diagram Analysis Tools



GPIB Commands DPOJET:MEAS<x>:BER:TARGETBER

DPOJET:MEAS<x>:BER:TARGETBER

This command sets or queries the current TargetBER value.

Syntax
DPOJET :MEAS<x>:BER: TARGETBER <NR3>

DPOJET : MEAS<x>:BER: TARGETBER?

Inputs

<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:BITCfgmethod

This command sets or queries the measurement bit configure method.

Syntax
DPOJET :MEAS<x>:BITCfgmethod {MEAN | MODE}
DPOJET :MEAS<x>:BITCfgmethod?

Inputs

{MEAN | MODE}

Outputs
{MEAN | MODE}
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GPIB Commands DPOJET:MEAS<x>:BITPcnt

DPOJET:MEAS<x>:BITPcnt

This command sets or queries the percentage value to be measured for the Bit type sel ected.

Syntax
DPOJET :MEAS<x>:BI1TPcnt <NR3>

DPOJET :MEAS<x>:BITPcnt?

Inputs

<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:BITConfig:STARTPercent

This command sets or queries the starting percentage of the bit to measure.

Syntax
DPOJET :MEAS<x>:BITConfig:STARTPercent <NR3>
DPOJET :MEAS<x>:BITConfig:STARTPercent?

Inputs

<NR3>

Outputs

<NR3>
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GPIB Commands DPOJET:MEA S<x>:BITConfig:ENDPercent

DPOJET:MEAS<x>:BITConfig:ENDPercent

This command sets or queries the ending percentage of the bit to measure.

Syntax
DPOJET :MEAS<x>:BITConfig:ENDPercent <NR3>

DPOJET :MEAS<x>:BITConfig:ENDPercent?

Inputs

<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:BITConfig:NUMBins

This command sets or queries the number of bins per window.

Syntax
DPOJET:MEAS<x>:BITConfig:NUMBins <NR3>
DPOJET :MEAS<x>:BITConfig:NUMBins?

Inputs

<NR3>

Outputs

<NR3>
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GPIB Commands DPOJET:MEAS<x>:BITType

DPOJET:MEAS<x>:BITType

This command sets or queries the measurement bit type setting.

Syntax
DPOJET :MEAS<x>:BITType {ALLBits | NONTRANsition | TRANsition}

DPOJET :MEAS<x>:BITType?

Inputs

{ALLBits | NONTRANsition | TRANsition}

Outputs

{ALLBits | NONTRANsition | TRANsition}

DPOJET:MEAS<x>:BUSState:CLOCKPolarity

This command sets or queries the clock polarity for the clock edge.

Syntax
DPOJET :MEAS<x>:BUSState:CLOCKPolarity {RISING | FALLING}

DPOJET :MEAS<x>:BUSState:CLOCKPolarity?

Inputs
{RISING | FALLING}

Outputs
{RISing | FALLing}
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GPIB Commands DPOJET:MEA S<x>:BUSState:FROM Pattern

DPOJET:MEAS<x>:BUSState:FROMPattern

This command sets or queries the Pattern from which the Bus state is configured.

Syntax
DPOJET :MEAS<x>:BUSState:FROMPattern <string>

DPOJET : MEAS<x>:BUSState :FROMPattern?

Inputs

<string>

Outputs

<string>

DPOJET:MEAS<x>:BUSState:FROMSymbol

This command sets or queries the symbol from which the Bus state is configured.

Syntax
DPOJET :MEAS<x>:BUSState:FROMSymbol <string>
DPOJET :MEAS<x>:BUSState:FROMSymbol?

Inputs

<string>

Outputs

<string>
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GPIB Commands DPOJET:MEA S<x>:BUSState: MEA SUREType

DPOJET:MEAS<x>:BUSState:MEASUREType

This command sets or queries the type for which the bus state is configured.

Syntax
DPOJET :MEAS<x>:BUSState :MEASBUSType {SYMbol | PATTern}

DPOJET :MEAS<x>:BUSState:MEASBUSType?

Inputs
{SYMbol | PATTern}

Outputs
{SYMbol | PATTern}

DPOJET:MEAS<x>:BUSState:MEASUREFrom

This command sets or queries where the bus is measured from.

Syntax
DPOJET :MEAS<x>:BUSState :MEASUREFROM {CLOCKEdge | START | STOP}
DPOJET :MEAS<x>: BUSState : MEASUREFROM?

Inputs
{CLOCKEdge | START | STOP}

Outputs
{CLOCKEdge | START | STOP}
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GPIB Commands DPOJET:-MEAS<x>:BUSStatee MEASURETO

DPOJET:MEAS<x>:BUSState:MEASURETO

This command sets or queries from where the bus is measured to.

Syntax
DPOJET :MEAS<x>:BUSState:MEASURETO {START | STOP | CLOCKEdge}

DPOJET : MEAS<x>:BUSState :MEASURETO?

Inputs

{CLOCKEdge | START | STOP}

Outputs
{CLOCKEdge | START | STOP}

DPOJET:-MEAS<x>:BUSState:TOPattern

This command sets or queries the Pattern to which the Bus state is configured.

Syntax
DPOJET :MEAS<x>:BUSState: TOPattern <string>
DPOJET :MEAS<x>:BUSState: TOPattern?

Inputs

<string>

Outputs

<string>

DPOJET Jitter and Eye Diagram Analysis Tools 363



GPIB Commands DPOJET:MEAS<x>:BUSState: TOSymbol

DPOJET:MEAS<x>:BUSState:TOSymbol

This command sets or queries the symbol to which the Bus state is configured.

Syntax
DPOJET :MEAS<x>:BUSState: TOSymbol <string>

DPOJET :MEAS<x>:BUSState: TOSymbol?

Inputs

<string>

Outputs

<string>

DPOJET:MEAS<x>:CLOCKRecovery:CLOCKBitrate

This command sets or queries the clock bit rate. Used if DATARate is 1.

Syntax
DPOJET :MEAS<x>:CLOCKRecovery:CLOCKBitrate <NR3>
DPOJET :MEAS<x>:CLOCKRecovery:CLOCKBitrate?

Inputs

<NR3>

Outputs

<NR3>
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GPIB Commands DPOJET:MEA S<x>:CL OCK Recovery:CL OCK Freguency

DPOJET:MEAS<x>:CLOCKRecovery:CLOCKFrequency

This command sets or queries the clock frequency. Used with Constant Clock - Fixed clock recovery
method.

Syntax
DPOJET :MEAS<x>:CLOCKRecovery :CLOCKFrequency <NR3>
DPOJET :MEAS<x>:CLOCKRecovery:CLOCKFrequency?

Inputs

<NR3>

Outputs

<NR3>

DPOJET:MEAS<x>:CLOCKRecovery:CLOCKMultiplier

This command sets or queries the clock multiplier.

Syntax
DPOJET :MEAS<x>:CLOCKRecovery:CLOCKMultiplier <NR3>
DPOJET :MEAS<x>:CLOCKRecovery:CLOCKMultiplier?

Inputs

<NR3>

Outputs
<NR3>
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GPIB Commands DPOJET:MEA S<x>:CL OCKRecovery:CL OCK Path

DPOJET:MEAS<x>:CLOCKRecovery:CLOCKPath

This command sets or queries the current known clock pattern path.

Syntax
DPOJET :MEAS<x>:CLOCKRecovery:CLOCKPath <string>

DPOJET :MEAS<x>:CLOCKRecovery :CLOCKPath?

Inputs

<string>

Outputs

<string>

DPOJET:MEAS<x>:CLOCKRecovery:DAMPing

This command sets or queries the clock recovery damping value.

Syntax
DPOJET :MEAS<x>:CLOCKRecovery:DAMPing <NR3>
DPOJET :MEAS<x>:CLOCKRecovery:DAMPing?

Inputs

<NR3>

Outputs

<NR3>
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GPIB Commands DPOJET:MEAS<x>:CLOCKRecovery:DATARate

DPOJET:MEAS<x>:CLOCKRecovery:DATARate

This command turns on or off DATArate usage.

Syntax
DPOJET :MEAS<x>:CLOCKRecovery:DATARate {1 | O}

Inputs

{11 0}
Outputs

{11 0}

DPOJET:MEAS<x>:CLOCKRecovery:BWType

This command sets or queries the clock recovery bandwidth type.

Syntax
DPOJET :MEAS<x>:CLOCKRecovery:BWType {LOOPBW | JTFBW}
DPOJET :MEAS<x>:CLOCKRecovery :BWType?

Inputs

{LOOPBW | JTFBW}

Outputs
{LOOPBW | JTFBW}
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GPIB Commands DPOJET:MEA S<x>:CL OCK Recovery:L OOPBandwidth

DPOJET:MEAS<x>:CLOCKRecovery:LOOPBandwidth

This command sets or queries the clock recovery loop bandwidth.

Syntax
DPOJET :MEAS<x>:CLOCKRecovery:LOOPBandwidth <NR3>

DPOJET :MEAS<x>:CLOCKRecovery:LOOPBandwidth?

Inputs

<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:CLOCKRecovery:MEANAUTOCalculate

This command sets or queries how often the clock is calculated, either FIRST, or on EVERY acquisition.

Syntax
DPOJET :MEAS<x>:CLOCKRecovery :MEANAUTOCalculate {FIRST | EVERY}
DPOJET :MEAS<x>:CLOCKRecovery:MEANAUTOCalculate?

Inputs

{FIRST | EVERY}

Outputs
{FIRST | EVERY}
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GPIB Commands DPOJET:MEA S<x>:CLOCKRecovery:METHod

DPOJET:MEAS<x>:CLOCKRecovery:METHod

This command sets or queries the current Clock recovery method.

Syntax

DPOJET :MEAS<x>:CLOCKRecovery:METHod {STANDARD | CUSTOM | CONSTMEAN |
CONSTFIXED | EXPEDGE | EXPPLL | CONSTMEDIAN}

DPOJET :MEAS<x>:CLOCKRecovery :METHod?

Inputs
{STANDARD | CUSTOM | CONSTMEAN | CONSTFIXED | EXPEDGE | EXPPLL | CONSTMEDIAN}

Outputs
{STANDARD | CUSTOM | CONSTMEAN | CONSTFIXED | EXPEDGE | EXPPLL | CONSTMEDIAN}

DPOJET:MEAS<x>:CLOCKRecovery:MODel

This command sets or queries the current clock recovery model.

Syntax
DPOJET :MEAS<x>:CLOCKRecovery:MODel {ONE | TWO}

DPOJET :MEAS<x>:CLOCKRecovery:MODel?

Inputs

{ONE | TWO}

Outputs
{ONE | TwO}
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GPIB Commands DPOJET:MEAS<x>:CLOCKRecovery:NOMINAL OFFset

DPOJET:MEAS<x>:CLOCKRecovery:NOMINALOFFset

This command sets or queries the clock offset.

Syntax
DPOJET :MEAS<x>:CLOCKRecovery :NOMINALOFFset <NR3>

DPOJET :MEAS<x>:CLOCKRecovery :NOMINALOFFset?

Inputs

<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:CLOCKRecovery:NOMINALOFFset:AUTO?

370

This query-only command returns the value in the Auto text box for the Nominal Clock Offset controls. If
the nominal clock offset method selection typeis set to Auto and an acquisition cycle has been completed,
thisfield shows the clock-to-data offset that was automatically determined. A positive value means that the
clock leads the data (precedesit in time). If the offset has not been determined, the returned string is TBD.

Syntax
DPOJET :MEAS<x>:CLOCKRecovery :NOMINALOFFset:AUTO?

Outputs

<string>
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GPIB Commands DPOJET:MEAS<x>:CL OCKRecovery:NOMINALOFFset:MANual

DPOJET:MEAS<x>:CLOCKRecovery:NOMINALOFFset:MANual

This command sets or queries the value for Manual text box.

Syntax
DPOJET :MEAS<x>:CLOCKRecovery :NOMINALOFFset:MANual <NR3>

DPOJET :MEAS<x>:CLOCKRecovery :NOMINALOFFset:MANual?

Inputs

<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:CLOCKRecovery:NOMINALOFFset:Recalctype

This command sets or queries the recalculation list box.

Syntax
DPOJET :MEAS<x>:CLOCKRecovery :NOMINALOFFset:Recalctype {FIRST | EVERY}
DPOJET :MEAS<x>:CLOCKRecovery :NOMINALOFFset:Recalctype?

Inputs

{FIRST | EVERY}

Outputs
{FIRST | EVERY}
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GPIB Commands DPOJET:MEA S<x>:CLOCKRecovery:NOMINAL OFFset: SEL ECTIONtype

DPOJET:MEAS<x>:CLOCKRecovery:NOMINALOFFset:SELECTIONtype

This command sets or queries the selection type.

Syntax
DPOJET :MEAS<x>:CLOCKRecovery :NOMINALOFFset:SELECTIONtype {AUTO | MANUAL}
DPOJET :MEAS<x>:CLOCKRecovery :NOMINALOFFset:SELECTIONtype?

Inputs

{AUTO | MANUAL}

Outputs
{AUTO | MANUAL}

DPOJET:MEAS<x>:CLOCKRecovery:PATTern

This command turns on or off the usage of CLOCK Path to a specific known data pattern.

Syntax

DPOJET :MEAS<x>:CLOCKRecovery:PATTern {1 | 0}

Inputs
{110}

Outputs
{11 0}
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GPIB Commands DPOJET:MEA S<x>:CL OCK Recovery:STAndard

DPOJET:MEAS<x>:CLOCKRecovery:STAndard

This command sets or queries the current clock recovery standard, as specified in the user interface.

Syntax
DPOJET :MEAS<x>:CLOCKRecovery:STAndard <string>

DPOJET :MEAS<x>:CLOCKRecovery:STAndard?

Inputs

<string>

Outputs

<string>

DPOJET:MEAS<x>:COMMONMode:FILTers:STATE

This command sets or queries the state of the common mode filter frequency.

Syntax
DPOJET :MEAS<x>:COMMONMode :FILTers:STATE {ON | OFF}
DPOJET :MEAS<x>:COMMONMode : FILTers:STATE?

Inputs

{ON | OFF}

Outputs
{11 0}
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GPIB Commands DPOJET:MEAS<x>:CUSTomname

DPOJET:MEAS<x>:CUSTomname

This command sets or queries the custom measurement name for the measurement in slot x.

Syntax
DPOJET :MEAS<x>:CUSTomname <string>

DPOJET :MEAS<x>:CUSTomname?

Inputs

<string>

Outputs

<string>

DPOJET:MEAS<x>:DATA?

This query-only command returns the measurement data. Thisis similar to the curve query, where the
output isin the format #<x><yyy><data><newline>, where <x> is the number of <y> bytes.

For Example: If <yyy>=500, <x>=3

NOTE. <x> ishexadecimal format. The letters A-F denote the number of y bytes between 10 and 15 digits.

<yyy> is the number of bytes to transfer.
<data> is curve data.

<newline> is a single-byte new line character at the end of the data.

Syntax

DPOJET :MEAS<x>:DATA?

Outputs

The measurement values as a stream of doubles.
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GPIB Commands DPOJET:MEAS<x>:DDR:MPERCycle

DPOJET:MEAS<x>:DDR:MPERCycle

This command sets or queries the MPercycle value used in various DDR measurements.

Syntax
DPOJET :MEAS<x>:DDR:MPERCycle <NR3>

DPOJET :MEAS34 :DDR:MPERCycle?

Inputs

<NR3>

Outputs
<NR1>

DPOJET:MEAS<x>:DDR:NPERCycle

This command sets or queries the NPercycle value used in various DDR measurements.

Syntax
DPOJET :MEAS<x>:DDR:NPERCycle <NR3>

DPOJET:MEAS34 :DDR:NPERCycle?

Inputs

<NR3>

Outputs

<NR1>
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GPIB Commands DPOJET:MEAS<x>:DDR:WINDowsize

DPOJET:MEAS<x>:DDR:WINDowsize

This command sets or queries the window size used in various DDR measurements.

Syntax
DPOJET :MEAS<x>:DDR:WINDowsize <NR3>

DPOJET :MEAS34 :DDR:WINDowsize?

Inputs

<NR3>

Outputs
<NR1>

DPOJET:MEAS<x>:EDGE1

This command sets or queries the Sourcel edge type.

Syntax
DPOJET:MEAS<x>:EDGE1 {RISe | FALL | BOTH}
DPOJET :MEAS<x>:EDGE1?

Inputs

{RISe | FALL | BOTH}

Outputs
{RISe | FALL | BOTH}
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GPIB Commands DPOJET:MEAS<x>:EDGE2

DPOJET:MEAS<x>:EDGE2

This command sets or queries the Source2 edge type.

Syntax
DPOJET:MEAS<x>:EDGE2 {RISe | FALL | BOTH}
DPOJET :MEAS<x>:EDGE27?

Inputs

{RISe | FALL | BOTH}

Outputs
{RISe | FALL | BOTH}

DPOJET:MEAS<x>:EDGEIncre

This command sets or queries the measurement edge increment value.

Syntax
DPOJET :MEAS<x>:EDGEIncre <NR3>
DPOJET :MEAS<x>:EDGEIncre?

Inputs

<NR3>

Outputs

<NR1>
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GPIB Commands DPOJET:MEAS<x>:EDGES:FROMLevel

DPOJET:MEAS<x>:EDGES:FROMLevel

This command sets or queries the FromLevel edge for the measurement.

Syntax
DPOJET :MEAS<x>:EDGES:FROMLevel {HIGH | MID | LOW}

DPOJET :MEAS<x>:EDGES:FROMLevel?

Inputs
{HIGH | MID | LOW}

Outputs
{HIGH | MID | LOW}

DPOJET:MEAS<x>:EDGES:LEVel

This command sets or queries the level used for the edges configuration.

Syntax
DPOJET :MEAS<x>:EDGES:LEVel
DPOJET :MEAS<x>:EDGES:LEVel?

Inputs
{HIGH | MID | LOW}

Outputs
{HIGH | MID | LOW}
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GPIB Commands DPOJET:MEAS<x>:EDGES:SL EWRATETechnique

DPOJET:MEAS<x>:EDGES:SLEWRATETechnique

This command sets or queries the slew rate technique for the measurement.

Syntax
DPOJET :MEAS<x>:EDGES : SLEWRATETechnique {NOMinalmethod | DDRmethod}
DPOJET :MEAS<x>:EDGES : SLEWRATETechnique?

Inputs

{NOMinalmethod | DDRmethod}

Outputs
{NOMinalmethod | DDRmethod}

DPOJET:MEAS<x>:EDGES:TOLevel

This command sets or queries the ToL evel edge for the measurement.

Syntax
DPOJET :MEAS<x>:EDGES:TOLevel {HIGH | MID | LOW}

DPOJET :MEAS<x>:EDGES:TOLevel?

Inputs

{HIGH | MID | LOW}

Outputs
{HIGH | MID | LOW}
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GPIB Commands DPOJET:-MEAS<x>:FILTers:.BLANKingtime

DPOJET:MEAS<x>:FILTers:BLANKingtime

This command sets or queries the current filter blanking time.

Syntax
DPOJET :MEAS<x>:FILTers:BLANKingtime <NR3>

DPOJET :MEAS<x>:FILTers:BLANKingtime?

Inputs

<NR3>

Outputs
<NR3>
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GPIB Commands DPOJET:MEAS<x>:FILTers:HIGHPass:FREQ

DPOJET:MEAS<x>:FlILTers:HIGHPass:FREQ

This command sets or queries the current high pass filter frequency.

Syntax
DPOJET :MEAS<x>:FILTers:HIGHPass:FREQ <NR3>

DPOJET :MEAS<x>:FILTers:HIGHPass:FREQ?

Inputs

<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:FILTers:HIGHPass:SPEC

This command sets or queries the current high pass filter specification.

Syntax
DPOJET :MEAS<x>:FILTers:HIGHPass:SPEC {NONE | FIRST | SECOND | THIRD}
DPOJET :MEAS<x>:FILTers:HIGHPass:SPEC?

Inputs

{NONE | FIRST | SECOND | THIRD}

Outputs
{NONE | FIRST | SECOND | THIRD}
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GPIB Commands DPOJET:MEAS<x>:FILTers.L OWPass.FREQ

DPOJET:MEAS<x>:FlLTers:LOWPass:FREQ

This command sets or queries the current low pass filter frequency.

Syntax
DPOJET :MEAS<x>:FILTers:LOWPass:FREQ <NR3>

DPOJET :MEAS<x>:FILTers:LOWPass:FREQ?

Inputs

<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:FlILTers:LOWPass:SPEC

This command sets or queries the current low pass filter specification.

Syntax
DPOJET :MEAS<x>:FILTers:LOWPass:SPEC {NONE | FIRST | SECOND | THIRD}
DPOJET :MEAS<x>:FILTers:LOWPass:SPEC?

Inputs

{NONE | FIRST | SECOND | THIRD}

Outputs
{NONE | FIRST | SECOND | THIRD}
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GPIB Commands DPOJET:MEAS<x>:REFVoltage

DPOJET:MEAS<x>:REFVoltage

This command sets or queries the reference voltage for the measurement.

Syntax
DPOJET :MEAS<x>:REFVoltage {100 | -100}

DPOJET :MEAS<x>:REFVoltage?

Inputs

{100 | -100}
Outputs

{100 | -100}

DPOJET:MEAS<x>:FILTers:RAMPtime

This command sets or queries the current filter ramp time.

Syntax
DPOJET:MEAS<x>:FILTers:RAMPtime <NR3>
DPOJET :MEAS<x>:FILTers:RAMPtime?

Inputs

<NR3>

Outputs

<NR3>
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GPIB Commands DPOJET:MEAS<x>:FROMedge

DPOJET:MEAS<x>:FROMedge

This command sets the FROMedge value for the measurement.

Syntax
DPOJET :MEAS<x>:FROMedge {R1Se | FALL | BOTH}

Inputs

{RISe | FALL | BOTH}

Outputs
{RISe | FALL | BOTH}

DPOJET:MEAS<x>:HIGHREFVoltage

This command sets or queries the high reference voltage value for the selected configuration.

Syntax
DPOJET :MEAS<x>:HIGHREFVoltage <NR3>
DPOJET :MEAS<x>:HIGHREFVol tage?

Inputs

<NR3>

Outputs

<NR3>
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GPIB Commands DPOJET:MEA S<x>:L OWREFVoltage

DPOJET:MEAS<x>:LOWREFVoltage

This command sets or queries the low reference voltage value for the selected configuration.

Syntax
DPOJET :MEAS<x>:LOWREFVoltage <NR3>

DPOJET :MEAS<x>:LOWREFVoltage?

Inputs

<NR3>

Outputs
<NR3>
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GPIB Commands DPOJET:MEA S<x>:L OGging:M EA Surements:FIL Ename?

DPOJET:MEAS<x>:LOGging:MEASurements:FILEname?

This command queries the current file name that will be used for the measurement when measurement
logging is turned on.

Syntax
DPOJET :MEAS<x>:L0Gging:MEASurements:FILEname?

Outputs

<string>

DPOJET:MEAS<x>:LOGging:MEASurements:SELect

This command sets or queries the given measurement to be included in any measurement logging. Statistic
logging isturned on or off as awhole, using the DPOJET:LOGging branch.

Syntax
DPOJET :MEAS<x>:L0Gging:MEASurements:SELect {1 | 0}

DPOJET :MEAS<x>:L0Gging:MEASurements:SELect?

Inputs
{110}

Outputs
{11 0}
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GPIB Commands DPOJET:MEA S<x>:LOGging: STATistics: SEL ect

DPOJET:MEAS<x>:LOGging:STATistics:SELect

This command sets or queries the given measurement for inclusion in any statistic logging. Statistic
logging is turned on or off as awhole, using the DPOJET:LOGging branch.

Syntax
DPOJET:MEAS<x>:L0Gging:STATistics:SELect {1 | 0}

DPOJET :MEAS<x>:L0Gging:STATistics:SELect?

Inputs

{11 0}

Outputs
{11 0}

DPOJET:MEAS<x>:LOGging:WORSTcase:SELect

This command sets or queries the given measurement for inclusion in any worst-case logging. Statistic
logging is turned on or off as awhole, using the DPOJET:LOGging branch.

Syntax
DPOJET :MEAS<x>:L0Gging:WORSTcase:SELect {1 | O}

Inputs

DPOJET :MEAS<x>:L0OGging:WORSTcase:SELect?

{11 0}
Outputs
{11 0}
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GPIB Commands DPOJET:MEAS<x>:MASKfile

DPOJET:MEAS<x>:MASKfile

This command sets or queries the current mask file name.

Syntax
DPOJET :MEAS<x>:MASKFfile <string>

DPOJET :MEAS<x>:MASKFile?

Inputs

<string>

Outputs

<string>

DPOJET:MEAS<x>:MASKOffset:HORIzontal:SELECTIONtype

This command sets or queries the selection type.

Syntax
DPOJET:MEAS<x>:MASK Offset:HORI zontal: SELECTIONtype { AUTOFIT | MANUAL}
DPOJET:MEA S<x>:MASK Offset:HORI zontal: SEL ECTIONtype?

Inputs
{AUTOFIT | MANUAL}

Outputs
{AUTOFIT | MANUAL}
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GPIB Commands DPOJET:MEAS<x>:MASK Offset:HORI zontal : AUTOfit?

DPOJET:MEAS<x>:MASKOffset:HORIzontal:AUTOfit?

This query-only command returns the value in the Autofit text box for the Mask Offset controls. If the
mask offset method selection type is set to Autofit and an acquisition cycle has been completed, thisfield
shows the displacement of the mask offset that was automatically determined. A positive value means that
the mask has moved to theright. If the offset has not been determined, the returned string is TBD.

Syntax
DPOJET:MEA S<x>:MASK Offset:HORI zontal :AUTOfit?

Outputs

<string>

DPOJET:MEAS<x>:MASKOffset:HORIzontal:MANual

This command sets or queries the value for Manual text box.

Syntax
DPOJET:MEA S<x>:MASK Offset:HORI zontal:MANual <NR3>
DPOJET:MEA S<x>:MA SK Offset:HORI zontal:MANual ?

Inputs
<NR3>

Outputs
<NR3>
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GPIB Commands DPOJET:-MEAS<x>:MEASRangeMAX

DPOJET:MEAS<x>:MEASRange:MAX

This command sets or queries the maximum measurement range limit value.

Syntax
DPOJET :MEAS<x>:MEASRange :MAX <NR3>

DPOJET :MEAS<x>:MEASRange :MAX?

Inputs

<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:MEASRange:MIN

This command sets or queries the minimum measurement range limit value.

Syntax
DPOJET :MEAS<x>:MEASRange:MIN <NR3>
DPOJET :MEAS<x>:MEASRange :MIN?

Inputs

<NR3>

Outputs

<NR3>

390 DPOJET Jitter and Eye Diagram Analysis Tools



GPIB Commands DPOJET:-MEAS<x>:MEASRange:STATE

DPOJET:MEAS<x>:MEASRange:STATE

This command turns on or off the measurement range limits.

Syntax
DPOJET :MEAS<x>:MEASRange:STATE {1 | 0}

Inputs

{110}

Outputs
{11 0}

DPOJET:MEAS<x>:MEASStart

This command sets or queries the measurement start value.

Syntax
DPOJET :MEAS<x>:MEASStart <NR3>
DPOJET :MEAS<x>:MEASStart?

Inputs

<NR3>

Outputs

<NR1>
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GPIB Commands DPOJET:MEAS<x>:N

DPOJET:MEAS<x>:N

This command sets or queries the measurement N value.

Syntax
DPOJET :MEAS<x>:N <NR3>

DPOJET :MEAS<x>:N?

Inputs

<NR3>

Outputs
<NR1>

DPOJET:MEAS<x>:NAME?

This query-only command returns the measurement name for the measurement in slot X. For measurements
that include 16-hit charactersin their Ul names, such as DJDirac, the string returned will contain question
marks where the Ul contains nontext characters.

Syntax

DPOJET :MEAS<x>:NAME?

Outputs

<string>
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GPIB Commands DPOJET:MEAS<x>:PHASENoise:HIGHL imit

DPOJET:MEAS<x>:PHASENoise:HIGHLimit

This command sets or queries the upper phase noise integration limit.

Syntax
DPOJET :MEAS<x>:PHASENoise:HIGHLimit <NR3>

DPOJET : MEAS<x>:PHASENoise:HIGHLImit?

Inputs

<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:PHASENoise:LOWLimit

This command sets or queries the lower phase noise integration limit.

Syntax
DPOJET :MEAS<x>:PHASENoise:LOWLimit <NR3>
DPOJET :MEAS<x>:PHASENoise:LOWLimit?

Inputs

<NR3>

Outputs

<NR3>
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GPIB Commands DPOJET:MEAS<x>:REFVoltage

DPOJET:MEAS<x>:REFVoltage

This command sets or queries the reference voltage for the measurement.

Syntax
DPOJET :MEAS<x>:REFVoltage {100 | —-100}

DPOJET :MEAS<x>:REFVol tage?

Inputs

{100 | -100}
Outputs

{100 | -100}
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GPIB Commands DPOJET:MEA S<x>:RESULtSs?

DPOJET:MEAS<x>:RESULts?

This query-only command returns the measurement branch for the currently selected measurement for
measurement slot <x>.

Syntax

DPOJET :MEAS<x>:RESULts?

Outputs

The measurement branch for the selected measurement for measurement s ot x.

DPOJET:MEAS<x>:RESULts:ALLAcqs?

This query-only command returns the measurement results from all acquisitions.

Syntax

DPOJET :MEAS<x>:RESULts:ALLAcgs?

Outputs

<NR3>

DPOJET:MEAS<x>:RESULts:ALLAcqgs:HITPopulation?

This query-only command returns the mask hit population.

Syntax

DPOJET :MEAS<x>:RESULts:ALLAcgs:HITPopulation?

Outputs

<NR3>
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GPIB Commands DPOJET-MEAS<x>:RESULtsALLAcgsHITS?

DPOJET:MEAS<x>:RESULts:ALLAcqs:HITS?

This query-only command returns the mask hits measurement for all segments.

Syntax

DPOJET :MEAS<x>:RESULts:ALLAcqs:HITS?

Outputs
<NR3>

DPOJET:MEAS<x>:RESULts:ALLacqs:LIMits:STATus?

This query-only command returns the pass/fail status per measurement. If any of the statistics fails, the
cumulative result is fail, otherwise pass.

Syntax
DPOJET :MEAS<x>:RESULts:ALLacqgs:LIMits:STATus?

Outputs
{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:ALLacqs:LIMits:HIgh:STATus?

396

This query-only command returns the pass/fail status for high limit.

Syntax
DPOJET :MEAS<x>:RESULts:ALLacqgs:LIMits:HIgh:STATus?

Outputs
{PASS | FAIL}
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GPIB Commands DPOJET:MEAS<x>:RESULts.ALLacgs.LIMits:L Ow:STATus?

DPOJET:MEAS<x>:RESULts:ALLacqs:LIMits:LOW:STATus?

This query-only command returns the pass/fail status for low limit.

Syntax

DPOJET :MEAS<x>:RESULts:ALLacqs:LIMits:LOw:STATus?

Outputs
{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:ALLAcqs:MAX?

This query-only command returns the maximum value for al accumulated measurement acquisitions
for dot <x>.

Syntax

DPOJET :MEAS<x>:RESULts:ALLAcqgs:MAX?

Outputs

<NR3>

DPOJET:MEAS<x>:RESULts:ALLAcqs:MAXCC?

This query-only command returns the maximum positive cycle-to-cycle delta of the selected measurement.

Syntax

DPOJET :MEAS<x>:RESULts:ALLAcqs:MAXCC?

Outputs

<NR3>
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GPIB Commands DPOJET:MEAS<x>:RESULts:ALLAcgsMAXCC:STATus?

DPOJET:MEAS<x>:RESULts:ALLAcqs:MAXCC:STATus?

This query-only command returns the pass/fail status for the maximum positive cycle-to-cycle delta of the
selected measurement (set via :DPOJET:LIMits:FILEName).

Syntax

DPOJET :MEAS<x>:RESULts:ALLacqs:MAXCC:STATus?

Outputs
{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:ALLAcqs:MAXHits?

This query-only command returns the maximum mask hits measurement for all segments.

Syntax

DPOJET :MEAS<x>:RESULts:ALLAcgs:MAXHIts?

Outputs

<NR3>

DPOJET:MEAS<x>:RESULts:ALLAcqs:MAX:STATus?

398

This query-only command returns the pass/fail status for the max measurement for the currently loaded
limit file (set via :DPOJET:LIMits.:FILEName).

Syntax

DPOJET :MEAS<x>:RESULts:ALLacqs:MAX:STATus?

Outputs
{PASS | FAIL}
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GPIB Commands DPOJET:-MEAS<x>:RESULtsALLAcgsMEAN?

DPOJET:MEAS<x>:RESULts:ALLAcqs:MEAN?

This query-only command returns the mean value for all accumulated measurement acquisitions for
sot <x>.

Syntax
DPOJET :MEAS<x>:RESULts:ALLAcQs :MEAN?

Outputs

<NR3>

DPOJET:MEAS<x>:RESULts:ALLAcqs:MEAN:STATus?

This query-only command returns the pass/fail status for the mean measurement for the currently loaded
limit file (set via :DPOJET:LIMits.:FILEName).

Syntax
DPOJET :MEAS<x>:RESULts:ALLAcQs :MEAN:STATus?

Outputs
{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:ALLAcqgs:MIN?

This query-only command returns the minimum value for all accumulated measurement acquisitions
for dot <x>.

Syntax
DPOJET :MEAS<x>:RESULts:ALLAcqgs:MIN?

Outputs

<NR3>
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GPIB Commands DPOJET:-MEAS<x>:RESULtsALLAcgs:MINCC?

DPOJET:MEAS<x>:RESULts:ALLAcqs:MINCC?

This query-only command returns the maximum negative cycle-to-cycle delta of the selected measurement.

Syntax

DPOJET :MEAS<x>:-RESULts:ALLAcqgs:MINCC?

Outputs
<NR3>

DPOJET:MEAS<x>:RESULts:ALLAcqs:MINCC:STATus?

This query-only command returns the pass/fail status for the negative cycle-to-cycle delta of the selected
measurement.

Syntax

DPOJET :MEAS<x>:RESULts:ALLAcqs:MINCC:STATus?

Outputs
{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:ALLAcqgs:MINHits?
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This query-only command returns the minimum mask hits measurement for al segments.

Syntax

DPOJET :MEAS<x>:RESULts:ALLAcgs:MINHits?

Outputs

<NR3>
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GPIB Commands DPOJET:-MEAS<x>:RESULtsALLAcgs:MIN:STATus?

DPOJET:MEAS<x>:RESULts:ALLAcqs:MIN:STATus?

This query-only command returns the pass/fail status for the minimum measurement for the currently
loaded limit file (set via :DPOJET:LIMits:FILEName).

Syntax
DPOJET :MEAS<x>:RESULts:ALLAcqs:MIN:STATus?

Outputs
{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:ALLacqs:PK2PK?

This query-only command returns the peak-to-peak value for all accumulated measurement acquisitions
for dot <x>.

Syntax
DPOJET :MEAS<x>:RESULts:ALLacqs:PK2PK?

Outputs

<NR3>

DPOJET:MEAS<x>:RESULts:ALLacqs:PK2PK:STATus?

This query-only command returns the pass/fail status for the peak-to-peak measurement for the currently
loaded limit file (set via :DPOJET:LIMits:FILEName).

Syntax
DPOJET :MEAS<x>:RESULts:ALLacqs:PK2PK:STATus?

Outputs
{PASS | FAIL}
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GPIB Commands DPOJET:MEAS<x>:RESULts:ALLAcgs:POPUlation?

DPOJET:MEAS<x>:RESULts:ALLAcqgs:POPUlation?

This query-only command returns the mean measurement value for the currently selected measurement for
measurement slot <x>.

Syntax

DPOJET :MEAS<x>:RESULts:ALLAcgs:POPUlation?

Outputs

<NR1>

DPOJET:MEAS<x>:RESULts:ALLacqs:POPUlation:STATus?

This query-only command returns the pass/fail status for the population measurement for the currently
loaded limit file (set via :DPOJET:LIMits:FILEName).

Syntax

DPOJET :MEAS<x>:RESULts:ALLacgs:POPUlation:STATus?

Outputs
{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:ALLAcqs:SEG<x>:Hits?

402

This query-only command returns the mask hits measurement for the given segment, either SEG1,
SEG2 or SEG3.

Syntax

DPOJET :MEAS<x>:RESULts:ALLAcQs:SEG<x>:Hits?

Outputs

<NR3>

DPOJET Jitter and Eye Diagram Analysis Tools



GPIB Commands DPOJET:MEAS<x>:RESULts:ALLACcQgs. SEG<x>:MAXHits?

DPOJET:MEAS<x>:RESULts:ALLAcqgs:SEG<x>:MAXHits?

This query-only command returnseturns the maximum mask hits measurement for the given segment,
either SEG1, SEG2 or SEG3.

Syntax

DPOJET :MEAS<x>:RESULts:ALLAcQgs:SEG<x>:MAXHits?

Outputs

<NR3>

DPOJET:MEAS<x>:RESULts:ALLAcqgs:SEG<x>:MINHits?

This query-only command returns the minimum mask hits measurement for the given segment, either
SEG1, SEG2 or SEG3.

Syntax

DPOJET :MEAS<x>:RESULts:ALLAcqs:SEG<x>:MINHits?

Outputs

<NR3>

DPOJET:MEAS<x>:RESULts:ALLAcqs:STDDev?

This query-only command returns the standard deviation for all accumulated measurement acquisitions
for dot <x>.

Syntax

DPOJET :MEAS<x>:RESULts:ALLAcqs:STDDev?

Outputs

<NR3>
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GPIB Commands DPOJET:MEAS<x>:RESULts. ALLacqs.STDDEV:STATus?

DPOJET:MEAS<x>:RESULts:ALLacqs:STDDEV:STATus?

This query-only command returns the pass/fail status for the standard deviation measurement for the
currently loaded limit file (set via :DPOJET:LIMits:FILEName).

Syntax

DPOJET :MEAS<x>:RESULts:ALLacqs:STDDEV:STATus?

Outputs
{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:CURRentacq:MAX?

This query-only command returns the maximum value of the measurement value for the currently selected
measurement for measurement slot <x>.

Syntax

DPOJET :MEAS<x>:RESULts:CURRentacq:MAX?

Outputs
<NR3>

DPOJET:MEAS<x>:RESULts:CURRentacq:MAXCC?

404

This query-only command returns the maximum positive cycle-to-cycle delta of the selected measurement.

Syntax

DPOJET :MEAS<x>:RESULts:CURRentacq:MAXCC?

Outputs

<NR3>
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GPIB Commands DPOJET:MEA S<x>:RESUL ts:. CURRentacq:MAXCC:STATus?

DPOJET:MEAS<x>:RESULts:CURRentacq:MAXCC:STATus?

This query-only command returns the pass/fail status for the Max cycle-to-cycle measurement for the
currently loaded limit file. (Set using DPOJET:LIMits:FILEName).

Syntax
DPOJET :MEAS<x>:RESUL ts : CURRentacq:MAXCC:STATus?

Outputs
{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:CURRentacq:MAX:STATus?

This query-only command returns the pass/fail status for the max measurement for the currently loaded
limit file. (Set using DPOJET:LIMits:FILEName).

Syntax

DPOJET :MEAS<x>:RESULts:CURRentacq:MAX:STATus?

Outputs
{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:CURRentacq:MEAN?

This query-only command returns the mean measurement for the currently loaded limit file.

Syntax
DPOJET :MEAS<x>:RESUL ts : CURRentacq:MEAN?

Outputs

<NR3>
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GPIB Commands DPOJET:MEA S<x>:RESULts:CURRentacq:MEAN:STATus?

DPOJET:MEAS<x>:RESULts:CURRentacq:MEAN:STATus?

This query-only command returns the pass/fail status for the mean measurement for the currently loaded
limit file. (Set using DPOJET:LIMits:FILEName).

Syntax

DPOJET :MEAS<x>:RESULts:CURRentacq:MEAN:STATus?

Outputs
{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:CURRentacq:MIN?

This query-only command returns the minimum value for the currently selected measurement for
measurement slot <x>.

Syntax

DPOJET :MEAS<x>:RESULts:CURRentacq:MIN?

Outputs
<NR3>

DPOJET:MEAS<x>:RESULts:CURRentacq:MINCC?

406

This query-only command returns the maximum negative cycle-to-cycle delta of the selected measurement.

Syntax

DPOJET :MEAS<x>:RESULts:CURRentacq:MINCC?

Outputs

<NR3>
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GPIB Commands DPOJET:MEA S<x>:RESUL ts:CURRentacq:MINCC:STATus?

DPOJET:MEAS<x>:RESULts:CURRentacq:MINCC:STATus?

This query-only command returns the pass/fail status for the min cycle-to-cycle measurement for the
currently loaded limit file. (Set using DPOJET:LIMits:FILEName).

Syntax
DPOJET :MEAS<x>:RESULts:CURRentacq:MINCC:STATus?

Outputs
{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:CURRentacq:MIN:STATus?

This query-only command returns the pass/fail status for the minimum measurement for the currently
loaded limit file. (Set using DPOJET:LIMits.FILEName).

Syntax
DPOJET :MEAS<x>:RESULts:CURRentacq:MIN:STATus?

Outputs
{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:CURRentacq:PK2PK?

This query-only command returns the peak-to-peak value for the currently selected measurement for
measurement slot <x>.

Syntax
DPOJET :MEAS<x>:RESUL ts : CURRentacq:PK2PK?

Outputs

<NR3>
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GPIB Commands DPOJET:MEA S<x>:RESULts:CURRentacq: PK2PK:STATus?

DPOJET:MEAS<x>:RESULts:CURRentacq:PK2PK:STATus?

This query-only command returns the pass/fail status for the peak-to-peak measurement for the currently
loaded limit file. (Set using DPOJET:LIMits:FILEName).

Syntax

DPOJET :MEAS<x>:RESULts:CURRentacq: PK2PK:STATus?

Outputs
{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:CURRentacq:POPUlation?

This query-only command returns the population measurement value for the currently selected
measurement for measurement slot <x>.

Syntax

DPOJET :MEAS<x>:RESULts:CURRentacq:POPUlation?

Outputs

<NR1>

DPOJET:MEAS<x>:RESULts:CURRentacq:POPUlation:STATus?

408

This query-only command returns the pass/fail status for the population measurement for the currently
loaded limit file. (Set using DPOJET:LIMits.FILEName).

Syntax

DPOJET :MEAS<x>:RESULts:CURRentacq:POPUlation:STATus?

Outputs
{PASS | FAIL}
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GPIB Commands DPOJET:MEAS<x>:RESULts:CURRentacq:STDDev?

DPOJET:MEAS<x>:RESULts:CURRentacq:STDDev?

This query-only command returns the standard deviation of the measurement value for the currently
selected measurement for measurement slot <x>.

Syntax

DPOJET :MEAS<x>:RESULts:CURRentacq:StdDev?

Outputs

<NR3>

DPOJET:MEAS<x>:RESULts:CURRentacq:STDDev:STATus?

This query-only command returns the pass/fail status for the standard deviation measurement for the
currently loaded limit file. (Set using DPOJET:LIMits:FILEName).

Syntax

DPOJET :MEAS<x>:RESULts :CURRentacq:STDDev:STATus?

Outputs
{PASS | FAIL}

DPOJET:MEAS<x>:RESULTS:STATus?

This query-only command returns the status of the given measurement valuesin slot MEAS<x>. Valid for
currently valid measurements, or the error status such as “Not enough edges’.

Syntax

DPOJET :MEAS<x>:RESULTS:STATus?

Outputs

<string>
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GPIB Commands DPOJET:MEAS<x>:RESULtsVIew?

DPOJET:MEAS<x>:RESULts:View?

This query-only command returns the results view type.

Syntax

DPOJET : MEAS<x>:RESULts:Vlew?

Outputs
{SUMmary | DETails}

DPOJET:MEAS<x>:RJDJ:BER

This command sets or queries the current RJIDJ BER value.

Syntax
DPOJET :MEAS<x>:RJDJ:BER <NR3>

DPOJET :MEAS<x>:RJDJ:BER?

Inputs

<NR3>

Outputs

<NR3>
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GPIB Commands DPOJET:MEAS<x>:RIDJ.DETECTPLEN

DPOJET:MEAS<x>:RJDJ:DETECTPLEN

This command sets or queries the current detect plan.

Syntax
DPOJET :MEAS<x>:RJDJ:DETECTPLEN {O | 1 | ON | OFF}

Inputs
<NR3>

0 is Manual
1isAuto

Outputs
<NR3>

DPOJET:MEAS<x>:RJDJ:PATLen

This command sets or queries the current RIDJ pattern length.

Syntax
DPOJET :MEAS<x>:RJDJ:PATLen <NR3>
DPOJET :MEAS<x>:RJDJ:PATLen?

Inputs

<NR3>

Outputs

<NR3>
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GPIB Commands DPOJET:MEAS<x>:RIDJTY Pe

DPOJET:MEAS<x>:RJDJ:TYPe

This command sets or queries the current RIDJ measurement type.

Syntax
DPOJET :MEAS<x>:RJDJ:TYPe {ARBITrary | REPEating}

DPOJET : MEAS<x>:RJDJ:TYPe?

Inputs

{ARBitrary | REPEating}

Outputs
{ARBitrary | REPEating}

DPOJET:MEAS<x>:RJDJ:WINDOwlength

This command sets or queries the current RIDJ window length.

Syntax
DPOJET :MEAS<x>:RJDJ:WINDOwlength <NR3>
DPOJET :MEAS<x>:RJDJ:WINDOwlength?

Inputs

<NR3>

Outputs

<NR3>
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GPIB Commands DPOJET:-MEAS<x>:SIGNALType

DPOJET:MEAS<x>:SIGNALType

This command sets the signal type for various measurements.

Syntax
DPOJET :MEAS<x>:SIGNALType {CLOCK | DATA | AUTO}

Inputs

{CLOCK | DATA | AUTO}

Outputs
{CLOCK | DATA | AUTO}

DPOJET:-MEAS<x>:SOUrce1

This command sets or queries the Sourcel value.

Syntax
DPOJET:MEAS<x>:SOUrcel {CH1 - CH4 | MATH1 - MATH4 | REF1 - REF4 | DO — D15}
DPOJET :MEAS<x>:SO0Urcel1?

Inputs

{CH1 - CH4 | MATH1 - MATH4 | REF1 - REF4 | DO — D15}

Outputs
{CH1 - CH4 | MATH1 - MATH4 | REF1 - REF4 | DO — D15}
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GPIB Commands DPOJET:MEAS<x>:SOUrce2

DPOJET:MEAS<x>:S0Urce2

This command sets or queries the Source2 value. May return NONE for single-source measurement.
Source2 may be the second source used in dual-source measurements, or the clock source in others. In
either caseg, it is aways the same as the rightmost displayed source on the Ul.

Syntax
DPOJET :MEAS<x>:SOUrce2 {CH1 - CH4 | MATH1 - MATH4 | REF1 - REF4 | DO — D15}

DPOJET :MEAS<x>:S0Urce2?

Inputs
{CH1 - CH4 | MATH1 - MATH4 | REF1 - REF4 | DO — D15}

Outputs
{CH1 - CH4 | MATH1 - MATH4 | REF1 - REF4 | DO — D15}

DPOJET:MEAS<x>:SSC:NOMinalfreq:AUTO?

This query-only command returns the automatically-cal culated nominal frequency value for SSC
configurations.

Syntax
DPOJET :MEAS<x>:SSC:NOMinal freq:AUTO?

Outputs

<string>
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GPIB Commands DPOJET:MEA S<x>:SSC:NOMinalfreq:MANual

DPOJET:MEAS<x>:SSC:NOMinalfreq:MANual

This command sets or queries the user-defined nominal frequency value for SSC configurations.

Syntax
DPOJET :MEAS<x>:SSC:NOMinalfreq:MANual <NR3>
DPOJET :MEAS<x>:SSC:NOMinalfreq:MANual?

Inputs

<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:SSC:NOMinalfreq:SELECTIONtype

This command sets or queries the Nominal frequency selection type for the SSC configurations.

Syntax
DPOJET :MEAS<x>:SSC:NOMinalfreq:SELECTIONtype
DPOJET :MEAS<x>:SSC:NOMinalfreq:SELECTIONtype?

Inputs

{AUTO | MANUAL}

Outputs
{AUTO | MANUAL}
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GPIB Commands DPOJET-MEAS<x>:TIMEDATa?

DPOJET:MEAS<x>:TIMEDATa?

This query-only command returns the measurement time data. 1t is similar to the curve query, where the
output isin the format #<x><yyy><data><newline>, where <x> is the number of <y> bytes.

For Example: If <yyy>=500, <x>=3

<x> is hexadecimal format. The letters A-F denote the number of y bytes between 10 and 15 digits.
<yyy> is the number of bytes to transfer.

<data> is curve data

<newline> is a single-byte new line character at the end of the data.

Syntax
DPOJET :MEAS<x>:TIMEDATa?

Outputs

After parsing the query results, the datais a stream of doubles.

NOTE. Time data is not available for all measurements. For Example: Scalar measurements.

DPOJET:MEAS<x>:TOEdge

416

This command sets the TOEdge value for the measurement.

Syntax

DPOJET :MEAS<x>:TOEdge {SAMEas | OPPositeas}

Inputs

{SAMEas | OPPositeas}

Outputs
{SAMEas | OPPositeas}
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GPIB Commands DPOJET:-MEAS<x>:ZOOMEVENT

DPOJET:MEAS<x>:ZOOMEVENT

This command zooms into the waveform where a max/min value occurs in a measurement.

Syntax
DPOJET:MEAS<x>:ZOOMEVENT {"MAX" | "MIN"}

Inputs

{"MAX" | "MIN"}

DPOJET:NUMMeas?

This query-only command returns the current number of defined measurements.

Syntax
DPOJET :NUMMeas?

Outputs
<NR1>
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GPIB Commands DPOJET:ADDPlot

DPOJET:ADDPIot

This set-only command creates a plot of the specified type on the specified DPOJET measurement. Up
to four plots can be created.

Syntax

DPOJET:ADDPlIot {TIMEtrend | DATAarray | HISTOgram | SPECtrum | TRANSfer
| PHASEnoise | EYE | WAVEform | BATHtub | QBathtub | QPulsewidth |
COMPOSITEJitterhist}, MEAS<x>}

Inputs

{TIMEtrend | DATAarray | HISTOgram | SPECtrum | TRANSfer | PHASEnoise | EYE |
WAVEform | BATHtub | QBathtub | QPulsewidth | COMPOSITEJitterhist}, MEAS<x>}

For example: DPOJET :ADDPlot HISTOgram, MEAS2

DPOJET.CLEARALLPIots

This set-only command clears the entire current list of defined plotsin DPOJET.

Syntax
DPOJET:CLEARALLPlots
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GPIB Commands DPOJET:PLOT<x>:COMPOSITEJitterhist:VERTical:SCALE

DPOJET:PLOT<x>:COMPOSITEJitterhist:VERTical:SCALE

This command sets or queries the vertical scale setting for applicable plots, either Linear or Log.

NOTE. Undefined for non-composite jitter histogram plots.

Syntax
DPOJET:PLOT<x>:COMPOSITElitterhist:VERTical:SCALE { LINEAR | LOG}
DPOJET:PLOT<x>:COMPOSITEJitterhist:VERTical : SCALE?

Inputs
{LINEAR | LOG}

Outputs
{LINEAR | LOG}

DPOJET:PLOT<x>:COMPOSITEJitterhist:NUMBins

This command sets or queries the current composite jitter histogram resolution.

NOTE. Undefined for non-composite jitter histogram plots.

Syntax

DPOJET:PLOT<x>:COMPOSI TEJitterhist:NUMBIins { TWENtyfive | FIFTY | HUNdred | TWOFifty
| FIVEHundred | TWOThousand | MAXimum}

DPOJET:PLOT<x>:COMPOSITEJitterhist:NUMBIins?

Inputs
{TWENtyfive | FIFTY | HUNdred | TWOFifty | FIVEHundred| TWOThousand | MAXimum}

Outputs
TWENtyfive | FIFTY | HUNdred | TWOFifty | FIVEHundred| TWOThousand | MAXimum}
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GPIB Commands DPOJET:PLOT<x>:COMPOSITEJitterhist:TJ

DPOJET:PLOT<x>:COMPOSITEJitterhist:TJ

This command sets or queries the TJ Jitter component settings.

NOTE. Undefined for non-composite jitter histogram plots.

Syntax
DPOJET:PLOT<x>:COMPOSI TElitterhist: TI{1 | 0}
DPOJET:PLOT<x>:COMPOSITEJitterhist: TJ?

Inputs

{110}

Outputs
{110}

DPOJET:PLOT<x>:COMPOSITE Jitterhist:RJBUJ

This command sets or queries the RJ+BUJ Jitter component settings.

NOTE. Undefined for non-composite jitter histogram plots.

Syntax
DPOJET:PLOT<x>:COMPOSITEJitterhist:RIBUJ{1 | 0}
DPOJET:PLOT<x>:COMPQOSITEJitterhist: RIBUJ?

Inputs

{110}

Outputs
{110}
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GPIB Commands DPOJET:PLOT<x>:COMPOSI TEJitterhist:PJ

DPOJET:PLOT<x>:COMPOSITE Jitterhist:PJ

This command sets or queries the PJ Jitter component settings.

NOTE. Undefined for non-composite jitter histogram plots.

Syntax
DPOJET:PLOT<x>:COMPOSITElitterhist:PJ {1 | O}
DPOJET:PLOT<x>:COMPOSITEJitterhist:PJ?

Inputs

{110}

Outputs
{110}

DPOJET:PLOT<x>:COMPOSITEJitterhist:DDJDCD

This command sets or queries the DDJ+DCD Jitter component settings.

NOTE. Undefined for non-composite jitter histogram plots.

Syntax
DPOJET:PLOT<x>:COMPOSITEJitterhist:DDJDCD {1 | 0}
DPOJET:PLOT<x>:COMPOSI TEJitterhist: DDJDCD?

Inputs

{110}

Outputs
{10}
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GPIB Commands DPOJET:PLOT<x>:DATA:XDATa?

DPOJET:PLOT<x>:DATA:XDATa?

422

This command returns the plot X data values. This command is similar to the curve query, where the
output isin the format #<x><yyy><data><newline>, where <x> is the number of <y> bytes.

For example: If <yyy>=500, <x>=3

<x> is hexadecimal format. The letters A-F denote the number of y bytes between 10 and 15 digits.
<yyy> is the number of bytes to transfer.

<data> is curve data

<newline> is a single-byte new line character at the end of the data.

Syntax
DPOJET :PLOT<x>:DATA:XDATa?

Outputs

After parsing the query results, the datais a stream of doubles.

NOTE. This command does not support plots such as the Eye Diagram Height plot, Waveform Plot and
Eye diagram with mask hits.
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GPIB Commands DPOJET:PLOT<x>:DATA:XDATaTJ?

DPOJET:PLOT<x>:DATA:XDATa:TJ?

This command returns the TJ plot X data values. This command is similar to the curve query, where the
output isin the format #<x><yyy><data><newline>, where <x> is the number of <y> bytes.

For example: If <yyy>=500, <x>=3
<x> is hexadecimal format. The letters A-F denote the number of y bytes between 10 and 15 digits.
<data> is curve data.

<newline> is a single-byte new line character at the end of the data.

Syntax
DPOJET:PLOT<x>:DATA:XDATaTJ?

Outputs

After parsing the query results, the datais a stream of doubles.

DPOJET:PLOTx:DATA:XDATa:RJBUJ?

This command returns the RH*+BUJ plot X datavalues. This command is similar to the curve query, where
the output isin the format #<x><yyy><data><newline>, where <x> is the number of <y> bytes.

For example: If <yyy>=500, <x>=3

<x> is hexadecimal format. The letters A-F denote the number of <y> bytes between 10 and 15 digits.
<yyy> is the number of bytes to transfer.

<data> is curve data.

<newline> is a single-byte new line character at the end of the data.

Syntax
DPOJET:PLOT<x>.DATA:XDATa:RIBUJ?

Outputs

After parsing the query results, the data is a stream of doubles.
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GPIB Commands DPOJET:PLOT<x>:DATA:XDATaPJ?

DPOJET:PLOT<x>:DATA:XDATa:PJ?

This command returns the PJ plot X data values. This command is similar to the curve query, where the
output isin the format #<x><yyy><data><newline>, where <x> is the number of <y> bytes.

For example: If <yyy>=500, <x>=3

<x> is hexadecimal format. The letters A-F denote the number of <y> bytes between 10 and 15 digits.
<yyy> is the number of bytes to transfer.

<data> is curve data

<newline> is a single-byte new line character at the end of the data.

Syntax
DPOJET:PLOTx:DATA:XDATa:PJ?

Outputs

After parsing the query results, the datais a stream of doubles.

DPOJET:PLOT<x>:DATA:XDATa:DDJDCD?

This command returns the DDJ+DCD plot X data values. This command is similar to the curve query,
where the output isin the format #<x><yyy><data><newline>, where <x> is the number of <y> bytes.

For example: If <yyy>=500, <x>=3

<x> is hexadecimal format. The letters A-F denote the number of <y> bytes between 10 and 15 digits.
<yyy> is the number of bytes to transfer.

<data> is curve data.

<newline> is a single-byte new line character at the end of the data.

Syntax
DPOJET:PLOT<x>:DATA:XDATaDDJDCD?

Outputs

After parsing the query results, the data is a stream of doubles.
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GPIB Commands DPOJET:PLOT<x>:DATA:YDATa?

DPOJET:PLOT<x>:DATA:YDATa?

This command returns the plot Y data values. This command is similar to the curve query, where the
output isin the format #<x><yyy><data><newline>, where <x> is the number of <y> bytes.

For example: If <yyy>=500, <x>=3

<x> is hexadecimal format. The letters A-F denote the number of y bytes between 10 and 15 digits.
<yyy> is the number of bytes to transfer.

<data> is curve data

<newline> is a single-byte new line character at the end of the data.

Syntax
DPOJET :PLOT<x>:DATA:XDATa?

Outputs

After parsing the query results, the datais a stream of doubles.

NOTE. This command does not support plots such as the Eye Diagram Height plot, Waveform Plot and
Eye diagram with mask hits.
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GPIB Commands DPOJET:PLOT<x>:DATA:YDATaTJ?

DPOJET:PLOT<x>:DATA:YDATa:TJ?

This command returnsthe TJ plot Y data values. This command is similar to the curve query, where the
output isin the format #<x><yyy><data><newline>, where <x> is the number of <y> bytes.

For example: If <yyy>=500, <x>=3

<x> is hexadecimal format. The letters A-F denote the number of y bytes between 10 and 15 digits.
<yyy> is the number of bytes to transfer.

<data> is curve data

<newline> is a single-byte new line character at the end of the data.

Syntax
DPOJET:PLOT<x>:DATA:YDATaTJ?

Outputs

After parsing the query results, the datais a stream of doubles.

DPOJET:PLOTx:DATA:YDATa:RJBUJ?
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This command returns the RH+BUJ plot Y datavalues. Thiscommand is similar to the curve query, where
the output isin the format #<x><yyy><data><newline>, where <x> is the number of <y> bytes.

For example: If <yyy>=500, <x>=3

<x> is hexadecimal format. The letters A-F denote the number of <y> bytes between 10 and 15 digits.
<yyy> is the number of bytes to transfer.

<data> is curve data.

<newline> is a single-byte new line character at the end of the data.

Syntax
DPOJET:PLOT<x>:DATA:Y DATaRJIBUJ?

Outputs

After parsing the query results, the data is a stream of doubles.
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GPIB Commands DPOJET:PLOT<x>:DATA:YDATaPJ?

DPOJET:PLOT<x>:DATA:YDATa:PJ?

This command returns the PJ plot Y datavalues. This command is similar to the curve query, where the
output isin the format #<x><yyy><data><newline>, where <x> is the number of <y> bytes.

For example: If <yyy>=500, <x>=3

<x> is hexadecimal format. The letters A-F denote the number of <y> bytes between 10 and 15 digits.
<yyy> is the number of bytes to transfer.

<data> is curve data

<newline> is a single-byte new line character at the end of the data.

Syntax
DPOJET:PLOT<x>:DATA:Y DATaPJ?

Outputs

After parsing the query results, the datais a stream of doubles.

DPOJET:PLOT<x>:DATA:YDATa:DDJDCD?

This command returns the DDJ+DCD plot Y data values. This command is similar to the curve query,
where the output isin the format #<x><yyy><data><newline>, where <x> is the number of <y> bytes.

For example: If <yyy>=500, <x>=3

<x> is hexadecimal format. The letters A-F denote the number of <y> bytes between 10 and 15 digits.
<yyy> is the number of bytes to transfer.

<data> is curve data.

<newline> is a single-byte new line character at the end of the data.

Syntax
DPOJET:PLOT<x>:DATA:YDATaDDJDCD?

Outputs

After parsing the query results, the datais a stream of doubles.
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GPIB Commands

DPOJET:PLOT<x>:XUnits?

This query-only command returns X units of the plot as a string.

Syntax

DPOJET :PLOT<x>:XUnits?

Outputs

<string>

DPOJET:PLOT<x>:XUnits?

NOTE. Plot units depends on the measurement type.

Click here to see the possible Measurement Units (see page 248)

DPOJET:PLOT<x>:YUnits?
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This query-only command returns Y units of the plot as a string.

Syntax

DPOJET : PLOT<x>:YUnits?

Outputs

<string>

NOTE. Plot units depends on the measurement type.

Click here to see the possible Measurement Units (see page 248)
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GPIB Commands DPOJET:PLOT<x>:SOUrce?

DPOJET:PLOT<x>:SOUrce?

This query-only command returns the source measurement for the selected plot.

Syntax

DPOJET :PLOT<x>:S0OUrce?

Outputs
{MEAS1 - MEAS99}

DPOJET:PLOT<x>:TREND:TYPe

This command sets or queries the trend type setting for Trend plots.

Syntax
DPOJET:PLOT<x>:TREND:TYPe {VECTOR | BAR}

DPOJET :PLOT<x>:TREND:TYPe?

Inputs

{VECTOR | BAR}

Outputs
{VECTOR | BAR}
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GPIB Commands DPOJET:PLOT<x>:TY Pe?

DPOJET:PLOT<x>:TYPe?

This query-only command returns the current plot type for the selected plot.

Syntax

DPOJET :PLOT<x>:TYPe?

Outputs

{TIMEtrend | DATAarray | HISTOgram | SPECtrum | TRANSfer | PHASEnoise | EYE |
WAVEform | BATHtub | QBathtub | QPulsewidth | COMPOSITEJitterhist}

DPOJET:PLOT<x>:BATHtub:BER

This command sets or queries the bathtub BER value.

Syntax
DPOJET:PLOT<x>:BATHtub:BER <NR3>
DPOJET :PLOT<x>:BATHtub:BER?

Inputs

<NR3>

Outputs

<NR1>

NOTE. Undefined for nonbathtub plots.
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GPIB Commands DPOJET:PLOT<x>:BATHtub:VERTical:SCALE

DPOJET:PLOT<x>:BATHtub:VERTical:SCALE

This command sets or queries the vertical scale setting for applicable plots, either Linear or Log.

Syntax
DPOJET:PLOT<x>:BATHtub:VERTical :SCALE {LINEAR | LOG}

DPOJET :PLOT<x>:BATHtub:VERTical : SCALE?

Inputs
{LINEAR | LOG}

Outputs
{LINEAR | LOG}

NOTE. Undefined for nonbathtub plots.

DPOJET:PLOT<x>:EYE:ALIGNment

This command sets or queries eye alignment state for eye plots.

Syntax
DPOJET:PLOT<x>:EYE:ALIGNment {AUTO | LEFT | CENter}

DPOJET : PLOT<x>:EYE:ALIGNment?

Inputs

{AUTO | LEFT | CENter}

Outputs
{AUTO | LEFT | CENter}

NOTE. Undefined for noneye plots.
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GPIB Commands DPOJET:PLOT<x>:EY E:HORIizonta :AUTOscal e

DPOJET:PLOT<x>:EYE:HORizontal:AUTOscale

This command sets or queries the horizontal auto scale setting.

Syntax
DPOJET :PLOT<x>:EYE:HORizontal :AUTOscale {1 | 0O}

DPOJET :PLOT<x>:EYE:HORizontal :AUTOscale?

Inputs

{110}

Outputs
{11 0}

NOTE. Undefined for noneye plots.

DPOJET:PLOT<x>:EYE:HORizontal:RESolution

This command sets or queries the Horizontal Eye resolution.

Syntax
DPOJET :PLOT<x>:EYE:HORizontal :RESolution <NR3>

DPOJET:PLOT<x>:EYE:HORizontal :RESolution?

Inputs

<NR3>

Outputs
<NR1>

NOTE. Undefined for noneye plots.
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GPIB Commands DPOJET:PLOT<x>:EYE:MASKfile

DPOJET:PLOT<x>:EYE:MASKfile

This command sets or queries the mask file.

Syntax
DPOJET:PLOT<x>:EYE:MASKFile <string>

DPOJET :PLOT<x>:EYE:MASKFile?

Inputs

<string>

Outputs

<string>

NOTE. Undefined for noneye plots.

DPOJET:PLOT<x>:EYE:STATE

This command sets or queries the eye state, either on or off.

Syntax
DPOJET:PLOT<x>:EYE:STATE {1 | 0}
DPOJET:PLOT<x>:EYE:STATE?

Inputs

{110}

Outputs
{11 0}

NOTE. Undefined for noneye plots.
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GPIB Commands DPOJET:PLOT<x>:EY E:SUPERImMpose

DPOJET:PLOT<x>:EYE:SUPERImpose

This command sets or queries whether superimposed eyes are generated in eye diagrams.

Syntax
DPOJET : PLOT<x>:EYE:SUPERImpose {1 | 0}

DPOJET :PLOT<x>:EYE:SUPERImpose?

Inputs

{110}

Outputs
{11 0}

NOTE. Undefined for noneye plots.

DPOJET:PLOT<x>:HISTOgram:AUTOset

This command runs a histogram autoset for the specified slot.

Syntax
DPOJET : PLOT<x>:HISTOgram:AUTOset {EXECute}

Inputs

{EXECute}

NOTE. Undefined for nonhistogram plots.
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GPIB Commands DPOJET:PLOT<x>:HISTOgram:HORizontal :AUTOscale

DPOJET:PLOT<x>:HISTOgram:HORizontal:AUTOscale

This command sets or queries the horizontal auto scale settings.

Syntax
DPOJET :PLOT<x>:HISTOgram:HORizontal :AUTOscale {1 | 0O}

DPOJET :PLOT<x>:HISTOgram:HORizontal :AUTOscale?

Inputs
{11 0}

Outputs
{11 0}

NOTE. Undefined for nonhistogram plots.

DPOJET:PLOT<x>:HISTOgram:HORizontal:CENter

This command sets or queries the histogram center.

Syntax
DPOJET : PLOT<x>:HISTOgram:HORizontal : CENter <NR3>

DPOJET : PLOT<x>:HISTOgram:HORizontal : CENter?

Inputs

<NR3>

Outputs
<NR3>

NOTE. Undefined for nonhistogram plots.
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GPIB Commands DPOJET:PLOT<x>:HISTOgram:HORizontal:SPAN

DPOJET:PLOT<x>:HISTOgram:HORizontal:SPAN

This command sets or queries the histogram span.

Syntax
DPOJET : PLOT<x>:HISTOgram:HORizontal : SPAN <NR3>

DPOJET : PLOT<x>:HISTOgram:HORizontal : SPAN?

Inputs

<NR3>

Outputs
<NR3>

NOTE. Undefined for nonhistogram plots.
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GPIB Commands DPOJET:PLOT<x>:HISTOgram:NUMBins

DPOJET:PLOT<x>:HISTOgram:NUMBins

This command sets or queries the current histogram resolution.

Syntax

DPOJET:PLOT<x>:HISTOgram:NUMBins {TWENtyfive | FIFTY | HUNdred | TWOFifty |
FIVEHundred | TWOThousand | MAXimum}

DPOJET :PLOT<x>:HISTOgram:NUMBins?

Inputs

{TWENtyfive | FIFTY | HUNdred | TWOFifty | FIVEHundred | TWOThousand |
MAXimum}

Outputs

{TWENtyfive | FIFTY | HUNdred | TWOFifty | FIVEHundred | TWOThousand |
MAXTmum}

NOTE. Undefined for nonhistogram plots.
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GPIB Commands DPOJET:PLOT<x>:HISTOgram:VERTica:SCALE

DPOJET:PLOT<x>:HISTOgram:VERTical:SCALE

This command sets or queries the vertical scale setting for applicable plots, either Linear or Log.

Syntax
DPOJET : PLOT<x>:HISTOgram:VERTical :SCALE {LINEAR | LOG}

DPOJET : PLOT<x>:HISTOgram:VERTical : SCALE?

Inputs

{LINEAR | LOG}

Outputs
{LINEAR | LOG}

NOTE. Undefined for nonhistogram plots.

DPOJET:PLOT<x>:PHASEnoise:BASEline

This command sets or queries the phase noise baseline.

Syntax
DPOJET :PLOT<x>:PHASEnoise:BASEline <NR3>

DPOJET :PLOT<x>:PHASEnoise:BASEl ine?

Inputs

<NR3>

Outputs
<NR1>

NOTE. Undefined for nonphase-noise plots.
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GPIB Commands DPOJET:PLOT<x>:SPECtrum:BASE

DPOJET:PLOT<x>:SPECtrum:BASE

This command sets or queries the spectrum base. Undefined for non-spectrum plots.

Syntax
DPOJET :PLOT<x>:SPECtrum:BASE <NR3>

DPOJET : PLOT<x>:SPECtrum:BASE?

Inputs

<NR3>

Outputs
<NR1>

DPOJET:PLOT<x>:SPECtrum:HORizontal:SCALE

This command sets or queries the horizontal scale setting for applicable plots, either Linear or Log.

Syntax
DPOJET : PLOT<x>:SPECtrum:HORizontal :SCALE {LINEAR ] LOG}
DPOJET :PLOT<x>:SPECtrum:HORizontal : SCALE?

Inputs

{LINEAR | LOG}

Outputs
{LINEAR | LOG}

NOTE. Undefined for nonspectrum plots.
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GPIB Commands DPOJET:PLOT<x>:SPECtrum:MODE

DPOJET:PLOT<x>:SPECtrum:MODE

This command sets or queries the spectrum mode.

Syntax
DPOJET :PLOT<x>:SPECtrum:MODE {NORMal | AVErage | PEAKhold}

DPOJET : PLOT<x>:SPECtrum:MODE?

Inputs

{NORMal | AVErage | PEAKhold}

Outputs
{NORMal | AVErage | PEAKhold}

DPOJET:PLOT<x>:SPECtrum:VERTical:SCALE

This command sets or queries the vertical scale setting for applicable plots, either Linear or Log.

Syntax
DPOJET :PLOT<x>:SPECtrum:VERTical :SCALE {LINEAR | LOG}

DPOJET :PLOT<x>:SPECtrum:VERTical :SCALE?

Inputs
{LINEAR | LOG}

Outputs
{LINEAR | LOG}

NOTE. Undefined for nonspectrum plots.
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GPIB Commands DPOJET:PLOT<x>:TRANSfer:DENominator

DPOJET:PLOT<x>:TRANSfer:DENominator

This command sets or queries the transfer plot denominator.

Syntax
DPOJET : PLOT<x>:TRANSfer:DENominator {MEAS1 - MEAS99}

DPOJET :PLOT<x>:TRANSfer :DENominator?

Inputs

{MEAS1 - MEAS99}

Outputs
{MEAS1 - MEAS99}

NOTE. Undefined for non-transfer plots.

DPOJET:PLOT<x>:TRANSfer:HORizontal:SCALE

This command sets or queries the horizontal scale setting for applicable plots, either Linear or Log.
Undefined for nontransfer plots.

Syntax
DPOJET :PLOT<x>:TRANSfer:HORizontal :SCALE {LINEAR | LOG}

DPOJET :PLOT<x>:TRANSfer:HORizontal : SCALE?

Inputs

{LINEAR | LOG}

Outputs
{LINEAR | LOG}
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GPIB Commands DPOJET:PLOT<x>:TRANSfer:MODE

DPOJET:PLOT<x>:TRANSfer:MODE

This command sets or queries the transfer plot mode.

Syntax
DPOJET : PLOT<x>:TRANSTer:MODE {NORMal | AVErage}

DPOJET :PLOT<x>:TRANSfer :MODE?

Inputs

{NORMal | AVErage}

Outputs
{NORMal | AVErage}

DPOJET:PLOT<x>:TRANSfer:NUMerator

This command sets or queries the transfer plot numerator.

Syntax
DPOJET :PLOT<x>:TRANSfer:NUMerator {MEAS1 - MEAS99}

DPOJET :PLOT<x>:TRANSfer :NUMerator?

Inputs

{MEAS1 - MEAS99}

Outputs
{MEAS1 - MEAS99}

NOTE. Undefined for nontransfer plots.
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GPIB Commands DPOJET:PLOT<x>:TRANSfer:VERTica:SCALE

DPOJET:PLOT<x>:TRANSfer:VERTical:SCALE

This command sets or queries the vertical scale setting for applicable plots, either Linear or Log.
Undefined for non-transfer plots.

Syntax
DPOJET:PLOT<x>:TRANSfer:VERTical :SCALE {LINEAR | LOG}

DPOJET:PLOT<x>:TRANSfer:VERTical : SCALE?

Inputs

{LINEAR | LOG}

Outputs
{LINEAR | LOG}
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GPIB Commands DPOJET:POPULATION:CONDition

DPOJET:POPULATION:CONDition

This command sets or queries the current population limit condition.

Syntax
DPOJET : POPULATION:CONDition {EACHmeas | LASTmeas}
DPOJET : POPULATION:CONDition?

Inputs

{EACHmeas | LASTmeas}

Outputs
{EACHmeas | LASTmeas}

DPOJET:POPULATION:LIMIT

This command sets or queries the current limit value.

Syntax
DPOJET :POPULATION:LIMIT <NR3>
DPOJET :POPULATION:LIMIT?

Inputs

<NR3>

Outputs

<NR1>
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GPIB Commands DPOJET:POPULATION:LIMITBY

DPOJET:POPULATION:LIMITBY

This command sets or queries the mechanism by limits, either acquisition or population.

Syntax
DPOJET : POPULATION:LIMITBY {ACQuisitions | POPUlation}
DPOJET : POPULATION:LIMITBY?

Inputs

{ACQuisitions | POPUlation}

Outputs

{ACQuisitions | POPUlation}

DPOJET:POPULATION:STATE

This command turns on or off population limits.

Syntax
DPOJET:POPULATION:STATE {1 | 0}

Inputs
{110}

Outputs
{11 0}
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GPIB Commands DPOJET:QUALIfy:ACTIVE

DPOJET:QUALIfy:ACTIVE

This command sets the active state for the qualifier source, either HIGH or LOW.

Syntax
DPOJET:QUALiFfy:ACTIVE {HIGH | LOW}

Inputs

{HIGH | Low}

Outputs
{HIGH | LOW}

DPOJET:QUALIfy:SOUrce

This command sets the qualifier source.

Syntax

DPOJET:QUALify:SOUrce {CH1 — CH4 | MATH1 - MATH4 | REF1 - REF4 | SEARCHO —
SEARCH8}

Inputs

{CH1 — CH4 | MATH1 - MATH4 | REF1 - REF4 | SEARCHO — SEARCHS8}

Outputs
{CH1 — CH4 | MATH1 - MATH4 | REF1 - REF4 | SEARCHO — SEARCH8}

446 DPOJET Jitter and Eye Diagram Analysis Tools



GPIB Commands DPOJET:QUALIfy:STATE

DPOJET:QUALIfy:STATE

This command turns on or off measurement qualification.

Syntax
DPOJET:QUALify:STATE {1 | O}

Inputs

{110}

Outputs
{11 0}
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GPIB Commands DPOJET:REFLevel:CH<x>:MI|DZero

DPOJET:REFLevel:CH<x>:MIDZero

This command turns on or off the mid reference level voltage setting.

Syntax
DPOJET:REFLevel :CH<x>:MIDZero {1 | O}

Inputs

{11 0}

Outputs
{11 0}

DPOJET:REFLevels:AUTOSet

This command performs a DPOJET ref level autoset on any sources selected using
DPOJET:REFLevels:.CH<x>:AUTOSst.

Syntax
DPOJET:REFLevels:AUTOSet {EXECute}

Inputs

{EXECute}

NOTE. All pieces of the reflevel branch have the ability to set ref levels for CH1-CH4, MATH1-MATH4,
and REF1-Ref4. Only the CH<x> portion is shown in this OLH, but it exists and matches exactly for
MATH (DPOJET: REFLevels:MATH<x> and REF (DPOJET: REFLevels:REF<x>).
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GPIB Commands DPOJET:REFLevels AUTOset:STATE?

DPOJET:REFLevels:AUTOset:STATE?

This query-only command provides the Ref Level Autoset status.

Syntax

DPOJET:REFLevels:AUTOset:STATE?

Outputs
RUNNING | STOPPED

DPOJET:REFLevels:CH<x>:AUTOSet

This command sets or clears the reflevel autoset state of the given source. When set to 1, the given source
will have aref level autoset acted on it during the next acquisition.

Syntax
DPOJET:REFLevels:CH<x>:AUTOSet {1 | O}

Inputs
{110}

Outputs
{11 0}

NOTE. The Ref Level Autoset state is shown only for Ch1-Ch4 sources. It isthe same for MATH and Ref
waveforms. For example: DPOJET: REFLevels: MATH<x>, DPOJET: REFLevels:REF<x>.
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GPIB Commands DPOJET:REFLevels:CH<x>:ABsolute

DPOJET:REFLevels:CH<x>:ABsolute

The ABSolute branch specifies the ref levelsin cases where a user chooses not to run aref level autoset on
agiven source. If auser doesrun aref level autoset, the percentage values of Rise, Fall and Hysteresis are
used.

DPOJET:REFLevels:CH<x>:ABsolute:RISEHigh

This command sets the ref level voltage relative to base top for autoset. The default is 1.0.

Syntax
DPOJET :REFLevels:CH<x>:ABsolute:RISEHigh <NR3>

Inputs

<NR3>

Outputs

<NR3>

DPOJET:REFLevels:CH<x>:ABsolute:RISELow

This command sets the ref level voltage relative to base top for autoset. The default is-1.0.

Syntax
DPOJET :REFLevels:CH<x>:ABsolute:RISELow <NR3>

Inputs

<NR3>

Outputs

<NR3>
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GPIB Commands DPOJET:REFL evels:CH<x>:ABsolute:RISEMid

DPOJET:REFLevels:CH<x>:ABsolute:RISEMid

This command sets the ref level voltage relative to base top for autoset. The default is 0.0.

Syntax

DPOJET :REFLevels:CH<x>:ABsolute:RISEMid <NR3>

Inputs

<NR3>

Outputs

<NR3>

DPOJET:REFLevels:CH<x>:ABsolute:FALLHigh

This command sets the ref level voltage relative to base top for autoset. The default is 1.0.

Syntax
DPOJET:REFLevels:CH<x>:ABsolute:FALLHigh <NR3>

Inputs

<NR3>

Outputs

<NR3>
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GPIB Commands DPOJET:REFLevels:.CH<x>:ABsolute:FALLLow

DPOJET:REFLevels:CH<x>:ABsolute:FALLLow

This command sets the ref level voltage relative to base top for autoset. The default is-1.1.

Syntax

DPOJET :REFLevels:CH<x>:ABsolute:FALLLow <NR3>

Inputs

<NR3>

Outputs

<NR3>

DPOJET:REFLevels:CH<x>:ABsolute:FALLMid

This command sets the ref level voltage relative to base top for autoset. The default is 0.0.

Syntax
DPOJET:REFLevels:CH<x>:ABsolute:FALLMid <NR3>

Inputs

<NR3>

Outputs

<NR3>
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GPIB Commands DPOJET:REFLeves.CH<x>:ABsoluteHY STeresis

DPOJET:REFLevels:CH<x>:ABsolute:HYSTeresis

This command sets the hysteresis value used for autoset. The default is 0.03.

Syntax

DPOJET :REFLevels:CH<x>:ABsolute:HYSTeresis <NR3>

Inputs

<NR3>

Outputs

<NR3>

DPOJET:REFLevels:CH<x>:BASETop

This command sets the base-top method for autoset.

Syntax
DPOJET :REFLevels:CH<x>:BASETop {MINMax | FULLhistogram | EYEhistogram | AUTO}

Inputs

{MINMax | FULLhistogram | EYEhistogram | AUTO}

Outputs
{MINMax | FULLhistogram | EYEhistogram | AUTO}

DPOJET Jitter and Eye Diagram Analysis Tools 453



GPIB Commands DPOJET:REFLevels:CH<x>:PERcent

DPOJET:REFLevels:CH<x>:PERcent

The ref level commands that follow set percent ref level parameters in the same way that the absolute
parameters do, except that these commands set the various percentage levels used by the autoset.

DPOJET:REFLevels:CH<x>:PERcent:FALLHigh

This command sets the ref level voltage relative to base top for autoset.

Syntax

DPOJET :REFLevels:CH<x>:PERcent:FALLHigh <NR3>

Inputs

<NR3>

Outputs
<NR3>

DPOJET:REFLevels:CH<x>:PERcent:FALLLow

This command sets the ref level voltage relative to base top for autoset.

Syntax
DPOJET :REFLevels:CH<x>:PERcent:FALLLow <NR3>

Inputs

<NR3>

Outputs

<NR3>

454 DPOJET Jitter and Eye Diagram Analysis Tools



GPIB Commands DPOJET:REFLevels:.CH<x>:PERcent:FALLMid

DPOJET:REFLevels:CH<x>:PERcent:FALLMid

This command sets the ref level voltage relative to base top for autoset.

Syntax

DPOJET :REFLevels:CH<x>:PERcent:FALLMid <NR3>

Inputs

<NR3>

Outputs

<NR3>

DPOJET:REFLevels:CH<x>:PERcent:HYSTeresis

This command sets the hysteresis value used for autoset.

Syntax
DPOJET:REFLevels:CH<x>:PERcent:HYSTeresis <NR3>

Inputs

<NR3>

Outputs

<NR3>
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DPOJET:REFLevels:CH<x>:PERcent:RISEHigh

This command sets the ref level voltage relative to base top for autoset.

Syntax

DPOJET :REFLevels:CH<x>:PERcent:RISEHigh <NR3>

Inputs

<NR3>

Outputs

<NR3>

DPOJET:REFLevels:CH<x>:PERcent:RISELow

This command sets the ref level voltage relative to base top for autoset.

Syntax
DPOJET :REFLevels:CH<x>:PERcent:RISELow <NR3>

Inputs

<NR3>

Outputs

<NR3>
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DPOJET:REFLevels:CH<x>:PERcent:RISEMid

This command sets the ref level voltage relative to base top for autoset.

Syntax

DPOJET :REFLevels:CH<x>:PERcent:RISEMid <NR3>

Inputs

<NR3>

Outputs

<NR3>
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DPOJET:REPORT

These are set-only commands. EXECute executes a DPOJET report save operation for the currently
defined report configuration. APPENd appends new data to the selected report.

Syntax
DPOJET:REPORT {EXECute | APPEnd}

Inputs

{EXECute | APPEnd}

DPOJET:REPORT:APPIlicationconfig

This command turns on or off including complete application configuration in reports.

Syntax

DPOJET :REPORT:APPlicationconfig {1 | O}

Inputs
{110}

Outputs
{11 0}
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GPIB Commands DPOJET:REPORT:AUTOincrement

DPOJET:REPORT:AUTOincrement

This command turns on or off auto increment of report file names.

Syntax
DPOJET :REPORT:AUTOincrement {1 | 0}

Inputs

{110}

Outputs
{11 0}

DPOJET:REPORT:COMments

This command sets or queries the comments.

Syntax
DPOJET :REPORT : COMments <string>
DPOJET : REPORT : COMments?

Inputs

<string>

Outputs

<string>
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DPOJET:REPORT:DETailedresults

This command turns on or off including detailed results in reports.

Syntax
DPOJET :REPORT:DETai ledresults {1 | 0}

Inputs

{11 0}

Outputs
{11 0}

DPOJET:REPORT:DISPunits

This command turns on or off displaying units in separate column

Syntax

DPOJET :REPORT:DISPunits {1 | O}

Inputs
{110}

Outputs
{11 0}
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DPOJET:REPORT:ENABlecomments

This command sets or queries the comments enable or disable settings.

Syntax
DPOJET : REPORT :ENABlecomments {1 | O}

DPOJET : REPORT : ENABlecomments?

Inputs

{11 0}
Outputs

{11 0}

DPOJET:REPORT:PASSFailresults

This command turns on or off including pass/fail results in reports.

Syntax

DPOJET:REPORT :PASSFailresults {1 | 0}

Inputs
{110}

Outputs
{11 0}
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DPOJET:REPORT:PLOTimages

This command turns on or off including detailed plot images in reports.

Syntax
DPOJET :REPORT:PLOTimages {1 | 0}

Inputs

{11 0}

Outputs
{11 0}

DPOJET:REPORT:REPORTName

This command sets the current report file name.

Syntax
DPOJET :REPORT :REPORTName <string>

Inputs

<string>

Outputs

<string>
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DPOJET:REPORT:SETupconfig

This command turns on or off including setup configuration in reports.

Syntax
DPOJET :REPORT : SETupconfig {1 | O}

Inputs

{11 0}
Outputs

{11 0}

DPOJET:REPORT:SAVEWaveforms

This command turns on or off saving waveforms when a report save/append is invoked.

Syntax

DPOJET :REPORT : SAVEWaveforms {1 | 0}

Inputs
{110}

Outputs
{11 0}
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DPOJET:REPORT:STATE?

This query-only command provides the report status.

Syntax
DPOJET :REPORT : STATE?

Outputs
INPROGRESS | DONE

DPOJET:REPORT:VIEWreport

This command turns on or off viewing report after generation.

Syntax
DPOJET:REPORT:VIEWreport {1 | 0}

Inputs
{110}

Outputs
{11 0}

DPOJET:RESULts:STATus?

464

This query-only command returns the overall pass/fail status.

Syntax
DPOJET:RESULts:STATuS?

Outputs
{PASS | FAIL}

DPOJET:REPORT:STATE?
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DPOJET:RESULts:View

This command sets or queries the results view type.

Syntax
DPOJET:RESULts:Vlew {SUMmary | DETails}

DPOJET:RESULts:Vlew?

Inputs

{SUMmary | DETails}

Outputs
{SUMmary | DETails}

DPOJET:SAVE

This set-only command saves the specified DPOJET measurement result to the specified ref. For Example:
DPOJET:SAVE MEA$4, REF2.

Syntax

DPOJET:SAVE {MEAS1-MEAS99 | REF1-REF4}

Inputs

{MEAS1-MEAS99 | REF1-REF4}
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DPOJET:SOURCEAutoset

This command performs a DPOJET horizontal, vertical, or autoset on both horizontal and vertical for any
sources used in current measurements.

Syntax

DPOJET : SOURCEAutoset {HORIzontal | VERTical | BOTH}

Inputs

{HORIzontal | VERTical | BOTH}

DPOJET:SOURCEAutoset:HORizontal:UlCount

This command sets or queries the UlCount for horizontal autoset.

Syntax
DPOJET : SOURCEAutoset:HORizontal :UICount <NR3>
DPOJET : SOURCEAutoset:HORizontal :UlCount?

Inputs
<NR3>. Default is 10000.

Outputs

<NR3>
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GPIB Commands DPOJET:SOURCEA utoset:HORI zontal : Ul Value

DPOJET:SOURCEAutoset:HORizontal:UlValue

This command sets or queries the Ul value for horizontal autoset.

Syntax
DPOJET : SOURCEAutoset:HORizontal :UlValue <NR3>

DPOJET : SOURCEAutoset:HORizontal :UlValue?

Inputs

<NR3>

Outputs
<NR3>

DPOJET:SOURCEAutoset:STATE?

This query-only command provides the Source Autoset status.

Syntax

DPOJET : SOURCEAutoset:STATE?

Outputs
RUNNING | STOPPED

DPOJET Jitter and Eye Diagram Analysis Tools 467



GPIB Commands DPOJET:STATE

DPOJET:STATE

This command returns the current measurement state of DPOJET.

Syntax
DPOJET:STATE {RUN | SINGLE | RECALC | CLEAR | STOP}

Inputs

{RUN | SINGLE | RECALC | CLEAR | STOP}

Outputs

The current state of the DPOJET measurement sequencer, including any of the possible inputs.

DPOJET:UNITType

This command sets or queries the current unit-type setting for DPOJET, either Unit Interval, or seconds.

Syntax
DPOJET:UNITType {UNITinterval | SEConds}
DPOJET:UNITType?

Inputs

{UNITinterval | SEConds}

Outputs

{UNITinterval | SEConds}
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GPIB Commands DPOJET:VERson?

DPOJET:VERsion?

This query-only command returns the current DPOJET version string.

Syntax

DPOJET:VERsion?

Outputs

<string>
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